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Об авторе

Стивен Гринберг (Steven Greenberg) более 17 лет отработал профессиональным
фотографом. В 1979 году он окончил школу дизайна в Род-Айленде, а с 1991 года
начал обрабатывать цифровые версии своих фотографий, что расширило его ди-
зайнерские возможности. Впоследствии он дополнительно обучался творческой
обработке фотографий в центре фирмы Kodak и в Школе изобразительных искусств
(School of Visual Arts) в Нью-Йорке. Стив является членом Международной ассо-
циации цифрового дизайна в электронике (International Design by Electronics
Association). Он читал лекции в рекламных агентствах, выступал на симпозиуме
AIGA по электронной обработке изображений, а также на конференции по новым
средствам визуальной информации и технологиям для компьютеров Apple и по-
сещал лекции в школе фотографии в Новой Англии. Стив остается практикую-
щим фотографом, работы которого побеждают на конкурсах рекламы, дизайна
и полиграфии.



Посвящения

Я хочу посвятить эту книгу и всю мою любовь своим сыновьям, Эшеру (Asher)
и Эри (Ari), которые практически не видели меня в течение нескольких месяцев.
Я хотел бы поблагодарить их за бесчисленное количество принесенных мне чашек
кофе с печеньем. Мальчики, надевайте те самые ботинки — ваш папа вернулся,
и этим летом мы поедем в горы и покорим несколько новых вершин!

Эта книга посвящается и моей прекрасной жене, Тове (Tova), терпение, любовь
и поддержка которой помогли мне завершить нелегкий труд.

Также книга посвящается моим родителям, которые научили меня усердно тру-
диться и стараться добиваться лучших результатов, моим друзьям и родственни-
кам, которые поддерживали и ободряли меня, и божественному кофе.

И, конечно же, эта книга является памятью об отце, который преподал мне множе-
ство житейских уроков. Отец, мне тебя не хватает...



Введение

Мы живем в эпоху информации. Чтобы найти практически любые сведения, до-
статочно нажать несколько клавиш на клавиатуре и взглянуть на экран монитора.
Только благодаря цифровому веку объемы информации выросли до невообрази-
мых размеров. Мы можем получить, сохранить или обработать почти любые дан-
ные в любом объеме.
Во времена моей молодости, если мне требовалось что-то узнать, я брал с книжной пол-
ки огромную энциклопедию или шел в библиотеку за дополнительной литературой.
Энциклопедии были очень тяжелыми и дорогими; всю информацию печатали на тон-
чайшей бумаге и переплетали в толстенные тома. Сейчас мои сыновья всего-навсего
вставляют компакт-диск с энциклопедией, который бесплатно прилагался к их компью-
теру, или после нескольких щелчков кнопками мыши устремляются по высокоско-
ростной магистрали в Интернет, где на веб-сайтах находят все, что им необходимо.

Быстрое получение информации и ее скоростная обработка напрямую связаны
с экспоненциальным ростом техники, который привел к развитию новых пре-
красных инструментов. В их число входят цифровые фотоаппараты. Программное
обеспечение, позволяющее улучшать качество фотографий, дешевые и легко пере-
носимые устройства хранения и постоянно повышающаяся мощность вычисли-
тельной техники сделали возможным появление фотографий без пленки.

Магазины, продающие компьютеры, есть везде. Может быть, вы прямо сейчас на-
ходитесь в таком магазине и читаете эту книгу (пожалуйста, купите ее, она вам
непременно понравится). Посмотрите на полки, и вы увидите коробки с компью-
терами, множество мониторов и огромное количество внешних устройств. Но все
больше и больше места на этих полках отдается под цифровые фотоаппараты.
Да, это правда — мы уже не в Канзасе, мы попали в прекрасный цветной мир.

Данная книга посвящена обзору цифровой фотографии. Она начинается с крат-
кой истории фотографии, затем рассматриваются основы экспозиции и компо-
зиции. Также обсуждается приобретение цифровых фотоаппаратов, их исполь-
зование и извлечение максимума из имеющихся возможностей. Улучшенное
и обработанное изображение может стать смешным или интригующим, эти вопро-
сы также затрагиваются в нашей книге.
В тексте встречаются врезки следующих типов, которые содержат дополнитель-
ную справочную информацию:

ПРИМЕЧАНИЕ
Здесь располагаются рассказы, замечания или различные премудрости, помогающие лучше
понять цифровую фотографию. Также в примечаниях расшифровываются новые термины.
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СОВЕТ
В таких врезках вы найдете советы и хитрости, связанные с цифровой фотографией.

ВНИМАНИЕ
Не пропустите эти предупреждения о непрятностях, с которыми вы можете столкнуться при
цифровой съемке и обработке фотографий!

Благодарности
Я хотел бы выразить благодарность множеству продавцов, которые позволили мне
осмотреть и протестировать фотоаппараты и другую аппаратуру, в особенности
Таре Пул (Тага Poole) за технику марки Kodak, Кайли Вэа (Kyili Ware) и Элис
Эйзенлау (Elise Eisenlaue) за оборудование фирмы Epson, Эмили Малич (Emily
Malech) за продукцию Fuji, Кэрен Томас (Karen Thomas) за Olympus, Карле
М. Вэллоне (Carla M. Vallone) за Sony, Николь Мендез (Nicole Mendez) за Nikon
и Стиву Алессандрина (Steve Alessandrin) за Minolta.

Дон Пэсинджер (Don Passenger) заслуживает отдельного поклона за его ценное
содействие моей работе над главами по Adobe Photoshop и всем чудесам обработ-
ки изображений.

Отдельная благодарность техническим
редакторам
Эта книга была дважды прочитана и откорректирована специалистами, которые
проверили правильность, наглядность и последовательность изложения материала.
Это, несомненно, придало нам уверенности в том, что в книге рассматриваются все
необходимые сведения о цифровой фотографии. Именно эксперты предложили
уделить столько внимания программе Adobe Photoshop 7.0 и сопроводить текст мно-
жеством примеров и иллюстраций. Отдельное спасибо я хочу сказать Дону Пэсин-
джеру (Don Passenger) и Тайлеру Ригасу (Tyler Regas) за выполнение этой работы.

Торговые знаки
Все термины в книге, которые известны как фабричные марки или автор предпо-
лагал, что это торговые марки, были выделены заглавными буквами. Издательство
Alpha Books and Pearson Education не проверяло правильность данной информации,
поэтому использованные в тексте названия не претендуют на безошибочность.

От издательства
Ваши замечания, предложения, вопросы отправляйте по адресу электронной почты
comp@piter.com (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!

На веб-сайте издательства www.piter.com вы найдете подробную информацию
о наших книгах.



Часть!

Цифровая фотография —
будущее наступило

Когда будущее становится настоящим? Когда описанные в фантастических рас-
сказах устройства превращаются в новинки техники? Когда у всех пользователей
будут трикодеры? Техника становится реальной, если ее можно увидеть, подер-
жать в руках и почувствовать в действии. Я профессиональный фотограф и в тече-
ние последних 10 лет пользуюсь в основном цифровыми фотоаппаратами. Инфор-
мацию о них можно найти в рекламном разделе любой газеты или в каталогах
компьютерной продукции, которые выпускаются каждую неделю. Все фотогра-
фии, которые вы увидите в этой книге, сняты на цифровую фотокамеру. Будущее
наступило!

Теперь я буду фотографировать
цифровым фотоаппаратом, и
каждый мой снимок будет
состоять из тысячи БИТОВ.



Глава 1

Зачем нужна цифровая
фотография?

Q История фотографии

Q Преимущества цифровой фотографии

Q Недостатки цифровой фотографии

Почему цифровая фотография появилась на свет и стала развиваться? Потому что
людям нравится управлять окружающим миром. Они хотят по-разному обрабаты-
вать сделанные снимки, менять их цвет, яркость и размеры. Ведь так приятно сра-
зу увидеть фотографию и показать ее друзьям. Эти снимки можно также отпра-
вить по электронной почте или разместить в Интернете для всеобщего обозрения.
(Но, конечно, самое главное то, что я могу быстро получить замечательные фото-
графии нашего пса Ринклса, подобные представленной на рис. 1.1.)

Рис. 1.1. Цифровая фотография Ринклса уже много раз становилась «изюминкой»
нашего семейного веб-сайта
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Краткая история фотографии
Первые фотоаппараты ничем не походили на используемую сегодня технику, но,
тем не менее, они имели то же самое назначение — они улавливали свет. В каче-
стве самых первых камер фигурировали затемненные комнаты. Через маленькое
отверстие в оконной шторе или в стене свет проникал внутрь и создавал на даль-
ней стене комнаты или на другой поверхности перевернутое изображение предме-
тов, которые находились за пределами комнаты (рис. 1.2). Это устройство называ-
лось камерой-обскурой (дословно «темная комната»). В 1558 году была впервые
опубликована книга Джованни Батиста делла Порта «Реальная магия» (Giovanni
Batticta della Porta, «Natural Magic»), в которой рассказывалось о том, как камера-
обскура использовалась для помощи чертежникам и иллюстраторам. Кроме того,
она стала источником развлечений для обычной публики.

Рис. 1.2. Некоторые камеры-обскуры были величиной с комнату, в то время как другие имели
меньший размер, были переносными и устанавливались на конных повозках

ПРИМЕЧАНИЕ
И сегодня все еще можно найти камеры-обскуры. К сожалению, многим из них угрожает
демонтаж или же их крайне сложно реставрировать. В их число входит и 50-летняя «Каме-
ра-великан» (Giant Camera), направленная на Seal Rock в Сан-Франциско, которую плани-
ровалось закрыть в конце 1999 года. После кампании, проведенной приверженцами ка-
мер-обскур, 23 мая 2001 года эту камеру включили в Национальный реестр исторических
мест. Дополнительную информацию о камерах-обскурах можно получить на странице
www.brightbytes.com/cosite/conome.html. Также большое количество сведений можно най-
ти, выполнив поиск в Интернете.

Постепенно размеры камер-обскур уменьшались, и в итоге она приняла вид
коробки, обычно деревянной, в одну из боковин которой была встроена линза.
Напротив линзы под углом 45° помещалось зеркало, над которым располагалась
матовая или грунтованная стеклянная пластинка. Художник накладывал на нее
лист тонкой бумаги и вручную копировал спроектированное изображение, как по-
казано на рис. 1.3. Теперь рисовать мог каждый — для этого требовалось совсем
немного умения.
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Рис. 1.3. Уменьшенные в размерах камеры-обскуры стали использоваться в качестве
инструмента, помогающего художнику передать контуры изображения

ПРИМЕЧАНИЕ
Когда я учился в колледже, некоторые из моих друзей создавали камеры-обскуры прямо в
своих комнатах. Они выключали свет, завешивали светонепроницаемой бумагой окно, вы-
ходящее в парк; в бумаге вырезали маленькую дырочку и делали заслонку. Противополож-
ная стена являлась фокусной плоскостью — на ней подвешивался рулон прозрачной диапо-
зитивной пленки. Затем заслонка убиралась, и свет попадал на пленку, которую сворачивали
в рулон, клали в светонепроницаемую коробку и затем проявляли. Для демонстрации гото-
вых изображений мои друзья сделали большую, освещаемую сзади камеру с матовым кусоч-
ком оргстекла. Это было великолепно!

В 1764 году граф Франческо Альгаротти (Count Francesco Algarotti) посвятил ка-
мерам-обскурам одну из глав своей книги «Эссе о живописи» («Essay on Painting»).
Он написал: «Если бы лучшие итальянские художники не пользовались этим изоб-
ретением, они не смогли бы создавать столь совершенные изображения». Из источ-
ника развлечений камера превратилась в полезный инструмент.

Серебряное вещество Шульце
В 1727 году немецкий физик Йохан Генрих Шульце (Johann Heinrich Schulze) об-
наружил, что свет может влиять на структуру веществ. Он смешал в бутылке се-
ребро, мел и азотную кислоту, сделал над ней пассы руками и встряхнул ее. Затем
Щульце выставил смесь на яркий солнечный свет и увидел, что она потемнела.
Чтобы доказать, что реакция была вызвана именно воздействием света, а не повы-
шением температуры, он повторил процесс, но на этот раз субстанция была не осве-
щена, а сильно нагрета. Второй эксперимент не привел к изменению состава, что
послужило доказательством теории Шульце.

Гелиография
Француз Жозеф Ньепс (Joseph Niepce) начал эксперименты со светочувствитель-
ными материалами примерно в начале 1800-х годов. Ньепс обнаружил, что асфальто-
подобное вещество битумин становится тверже, если на него воздействовать светом.
Он покрывал битумином металлические пластинки и освещал их в камере-обскуре.
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После длительного воздействия света пластинки мыли, удаляя не подвергшийся
воздействию света битумин, а затем макали в кислоту, которая вытравливала не-
освещавшиеся участки металла. После этого пластинки покрывали чернилами и
прижимали к бумаге, печатая таким способом исходное изображение. Ньепс на-
звал этот процесс гелиографией.

Дагерротипы
Примерно в 1825 году исследованиями того же самого фотографического процес-
са занимался другой француз, Луи Дагер (Louis Daguerre). Хотя он работал над
тем же экспериментом, что и Ньепс, он действовал немного в другом направлении.
На медную пластинку наносилось серебро, на которое затем воздействовали испа-
рениями йода, чтобы получить йодид серебра. После того как на пластинке появ-
лялось светочувствительное покрытие, ее помещали в камеру-обскуру и довольно
долго освещали. Как следует из опытов Шульце, йодистое серебро темнеет под
воздействием света. При этом хотя бы раз подвергнутая действию света серебря-
ная соль обычно продолжала темнеть, пока, в конце концов, все изображение не
становилось черным.

Дагер случайно решил эту проблему, оставив экспонированную пластинку в каби-
нете, в котором хранилась ртуть. Когда он снова взял в руки пластинку, то заме-
тил, что изображение перестало изменяться, оно не потемнело до конца. Пары ртути
зафиксировали изображение. Так как этот способ проявки фотографий или удале-
ния неиспользованного серебра был небезопасным для здоровья, британский аст-
роном и ученый сэр Джон Херсчель (John Herschel) в 1819 году предложил мыть
пластинку в растворе гипосульфита натрия, в котором неэкспонированное сереб-
ро удалялось в результате химической реакции. Дагер называл свои фотографии
дагерротипами (рис. 1.4).

Изначально дагерротипы встречались редко из-за своей высокой цены; их могли
позволить себе только очень богатые люди. Позже, после «Серебряной войны»,
они стали доступны и для обычных граждан.

Рис. 1.4. Дагерротип
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ПРИМЕЧАНИЕ
Люди, занимающиеся фотографией, называют гипосульфит натрия, также известный как
тиосульфат натрия (Na2S203), фиксажем. Кстати, если с ним не смешивать дубитель (алюми-
ниевые квасцы), от него не будет исходить столь характерный запах.

Талботипы
В одно время с Дагером работал англичанин Вильям Генри Фокс Талбот (William
Henry Fox Talbot). Он реализовал тот же процесс, что и Дагер, используя в каче-
стве «пластин» бумагу, а не металл. В результате получился негатив. (Помните,
что серебро темнеет при попадании на него света и сохраняет свой цвет там, где
этого не происходит. Дагерротипы являются негативными изображениями, и чтобы
они выглядели «позитивными», их следует держать под особым углом.) Затем бумаж-
ный негатив покрывался воском — это делало его полупрозрачным, и процесс фото-
графирования повторялся, что приводило к появлению позитивного изображения.
Как вы уже, наверное, догадались, Талбот называл свои снимки талботипами.

ПРИМЕЧАНИЕ
Одни из самых красивых фотографий, которые я когда-либо видел, были отпечатаны на
бумаге с помощью альбумина и серебряной эмульсии с негатива, созданного на стеклянной
пластине размером 16 на 20 дюймов. Производимый в основном из яичных белков альбумин
образует суспензию, способную удерживать частицы нитрата серебра. Эта смесь называет-
ся эмульсией. Ею можно покрывать бумагу, стекло или даже олово.

Прародитель желтой коробочки
В 1888 году Джордж Истмэн (George Eastman) освоил технологический процесс
освещения серебра, нанесенного на гибкую пластиковую пленку. Новая компания
Истмэна, Kodak1, продавала фотокамеры в комплекте со свернутой в рулон плен-
кой, которая позволяла отснять примерно 100 кадров. Когда пленка заканчивалась,
покупатель приносил использованную камеру продавцу. После обработки пленки
и печати фотографий — это выполняла компания Kodak — заново заряженная ка-
мера возвращалась владельцу.

ПРИМЕЧАНИЕ
Существует множество слухов о том, как Джордж Истмэн придумал слово Kodak. Некоторые
считают, что оно произошло от звука, который издавал затвор его фотоаппарата. Но Истмэн
объяснял это по-другому: «Я сам выдумал это название. Больше всего я люблю букву К —
мне кажется, она принадлежит к сорту сильных, острых букв, Затем я составлял огромное
количество комбинаций букв, образующих слова, которые начинались с буквы К и заканчи-
вались ею. В результате я выбрал слово Kodak».

Цифровые фотоаппараты
Как и большинство современных изобретений, цифровая фотография многим обя-
зана военным и космическим исследованиям. Необходимость максимально быст-
ро получать резкие изображения оказала большое влияние на развитие цифровых

Kodak — зарегистрированная торговая марка компании Eastman Kodak Company. — Примеч. рей.
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фотоаппаратов и технологию формирования изображения. Сейчас цифровые техноло-
гии позволяют с расстояния нескольких миль над землей передавать изображения,
которые помогают обнаружить замаскированное ракетное оружие или предсказать
урожай. Беспилотные космические корабли, оснащенные цифровыми фотоаппарата-
ми, дали возможность впервые заглянуть на темную сторону Луны и дальше в космос.

В 1981 году фирма Sony выпустила первую потребительскую электронную камеру,
название которой Mavica было составлено из первых двух букв слов magnetic video
camera — магнитная видеокамера. Но она создавала только видеоизображения,
которые фактически записывались на пленку, то есть не была настоящей цифро-
вой камерой. Так началась гонка по производству «беспленочного» фотоаппарата.

Первая полностью цифровая камера Quick Take была разработана компанией Apple
Computers в сотрудничестве с фирмой Kodak. (Обе фирмы проявили потрясающе
передовое мышление.) Портативная камера имела объектив с постоянным фокусным
расстоянием и могла вместить от 8 до 32 изображений в зависимости от выбранного
разрешения. Затем их можно было передать на компьютер PC или Macintosh че-
рез последовательный порт. Стоимость этого фотоаппарата составляла около $700.

Фирма Kodak также выпустила одну из первых «профессиональных» цифровых
фотокамер, которая называлась DCS 2. С помощью этого аппарата можно полу-
чать цветные фотографии «размером» 4 Мбайт. Камера была сконструирована на
базе зеркального 35-миллиметрового фотоаппарата Nikon, к задней стенке корпу-
са которого прикреплялась цифровая микросхема.

Если спросить компании Kodak, Fuji, Agfa или Polaroid, почему они производят
фотоаппараты, мы получим интересный ответ: чтобы продавать пленку. Это именно
та область, в которой они могут получить максимальную прибыль. Тогда почему
же они вступают на рынок цифровых фотоаппаратов? Могу предположить, что
они тоже видели древние письмена на стене. С тех пор появилось многое, в том
числе и фотография. Вероятно, производители пленки считают, что будущее оста-
нется за цифровой фотографией, а пленка и связанные с ней фотографические
процессы, подобно древним письменам, уйдут в прошлое — поэтому нужно уже
сейчас осваивать новые области рынка.

Конечно, большинство основных производителей пленочных фотоаппаратов
выпускают цифровые фотокамеры; при этом некоторые из них, например Ricoh,
полностью прекратили продажу обычных пленочных фотоаппаратов в США.
Существуют также компании, которые никогда не производили пленочные фото-
аппараты, например Dicomed и PhaseOne, но теперь они торгуют профессиональны-
ми высококачественными фотокамерами. Интересно отметить, что такие фирмы,
как Leaf/Scitex и Agfa, производящие оборудование для предпечатной подготовки
и сканирования, теперь также выпускают цифровые фотоаппараты. На основе соб-
ственных технологий сканирования они создали оборудование для цифровых фо-
токамер. Многие цифровые фотоаппараты, в сущности, являются «сканерами
с встроенной оптической системой».

ПРИМЕЧАНИЕ
Первым моим цифровым фотоаппаратом был DCS 2. Знакомство с миром цифровой фото-
графии обошлось мне в $35 000, и это не считая необходимых для данного процесса компь-
ютера, программного обеспечения, обучения и аспирина, помогающего от головной боли.
Но не бойтесь — в наши дни увлечение цифровой фотографией обойдется не так дорого.
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Преимущества цифровой фотографии
Цифровые фотоаппараты есть везде. Ими заполнены полки магазинов, а рекламные
разделы в газетах пестрят объявлениями об их продаже. Давайте поговорим о том,
почему люди покупают цифровые фотоаппараты.

Если вас целиком и полностью устраивают фотографии, снятые на пленочный
фотоаппарат, вряд ли стоит тратить деньги на цифровую камеру. Однако при этом
у вас отсутствует возможность сразу же посмотреть на результат своего труда. Тре-
буется отснять целую пленку, отнести ее в фотоателье и подождать, пока фотогра-
фии напечатают, всего лишь для того, чтобы узнать, что кто-то на «единственном
в жизни» снимке неудачно моргнул. Также не стоит забывать о необходимости по-
стоянно покупать пленку и платить деньги за печать фотографий. Кроме того,
для съемок в помещении и на улице лучше иметь несколько фотоаппаратов с раз-
ными пленками.

Итак, перечислим преимущества цифровой фотографии:

Q Отсутствие пленки. Леди и джентльмены, а также дети всех возрастов, только
представьте, что вам никогда больше не придется покупать пленку. Вы пере-
станете тратить на нее деньги и ломать голову над тем, какой тип пленки по-
дойдет в данной ситуации.

Q «Пленка» не заканчивается. Если аккуратно и внимательно использовать за-
поминающие устройства, у вас всегда будет место для новых изображений. Один
из видов запоминающих устройств — карты памяти PCMCIA, которые встав-
ляются в боковую часть камеры, — вмещают больше 100 изображений. Многие
камеры теперь допускают подключение миниатюрных жестких дисков, емкос-
тью до 1 Гбайт. Наличие нескольких подобных накопителей дает возможность
фотографировать много дней без перерыва. И вы больше никогда не испытаете
ни с чем не сравнимое чувство, появляющееся, когда неожиданно заканчивает-
ся вся захваченная с собой в отпуск пленка.

а Бесплатная -«проявка»-. Не имеет значения, как вы проявляете пленку и печа-
таете снимки, в любом случае это стоит денег. Цифровая фотография избавля-
ет вас от необходимости тратить деньги на этот процесс. Кроме того, вам не
потребуется решать, матовые или глянцевые фотографии лучше печатать — ведь
цифровые снимки можно вообще не печатать, а просто просмотреть на компь-
ютере. Если же вы все-таки решили отпечатать фотографии, то у вас есть воз-
можность выбрать только самые лучшие кадры, а не печатать всю «пленку».

Q «Я хочу увидеть их сейчас!» Цифровая фотография позволяет немедленно
увидеть фотографии; вам не придется ждать, пока пленку вернут из фотолабо-
ратории. Многие камеры оснащены жидкокристаллическими экранами, позво-
ляющими мгновенно просмотреть снятые фотографии, кроме того, снимки мож-
но сразу скопировать на жесткий диск компьютера.

а Повторная съемка. Если кто-то случайно попал в тщательно скомпонованный
кадр или же ребенок закрыл глаза, испугавшись щелчка затвора, вы узнаете об
этом немедленно. И тут же сможете снять объект еще раз. Кроме того, никому
не запрещено удалить непонравившиеся фотографии, освобождая место для
новых снимков.
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Q Возможность редактирования. Если никак не получается приблизиться к объек-
ту съемки на достаточное расстояние или вы не очень ровно держите фото-
аппарат, ничего страшного! Это достаточно легко исправить. Просто скопируйте
файл в компьютер, а потом обрежьте или поверните изображение в графиче-
ском редакторе. Также вы всегда вправе удалить пятна, скорректировать цвет,
контрастность, яркость и резкость изображения. Имея минимальные навыки
работы с программами для редактирования изображений, вы сможете даже доба-
вить на семейную фотографию дядюшку Гарри, несмотря на то, что он приехал
после съемки.

а Выход на «белый свет». Тем, кто часами просиживает в темном закутке, пыта-
ясь напечатать всего несколько снимков, вы покажетесь свободным человеком.
А компьютер, с помощью которого осуществляется редактирование изображе-
ний, обычно находится в освещенной комнате. Только представьте! Вы общае-
тесь с родственниками и одновременно обрабатываете фотографии; вас видят
семья и друзья. Если вы обладаете особыми талантами, можно даже работать
на компьютере и одновременно смотреть футбол!

Q Возможность легко показать фотографию другим людям. При наличии моде-
ма появляется возможность послать фотографию новорожденного сына дале-
ко живущим родственникам или разместить ее в сети Интернет. Теперь больше
не придется тратить время и деньги на печать и рассылку нескольких экземп-
ляров одного кадра.

Q Качество снимка не меняется. Негативы и фотографии со временем блекнут.
На них воздействует ультрафиолетовое излучение и влажность, и обязательно
появляются следы от грязных пальцев. Зато качество заботливо сохраненного
цифрового изображения останется неизменным! И если напечатанный снимок
будет поврежден или вам потребуется его копия, достаточно найти нужный файл
и распечатать его. При этом вам придется заплатить только за лист бумаги
и краску.

О Экологичность. Цифровая фотография служит делу сохранения окружающей
среды. Для получения снимков не используются химикаты, которые смывают-
ся в канализацию, а для обработки пленки больше не требуется огромного ко-
личества воды. Кроме того, у фотографов отпала нужда заботиться о малень-
ких пластиковых коробочках из-под пленки. (Вы ведь обычно их выкидываете?)

Q И наконец, это интересно! Фотография увлекательна сама по себе, а цифровая
фотография — еще занятнее. И поскольку не нужно волноваться о наличии до-
статочного количества пленки или о том, получится ли изображение с первого
раза, можно даже сказать, что цифровая фотография предоставляет больше
свободы для творчества.

ПРИМЕЧАНИЕ
Для меня как для профессионального фотографа цифровая камера стала необходимым ин-
струментом. Обычно клиенты просматривают только что сделанные снимки на мониторе
компьютера, на месте одобряют их или же требуют внести коррективы. Когда одно изобра-
жение закончено, я могу перейти к работе над следующим. Не нужно ждать, пока пленки
вернутся из лаборатории, или беспокоиться о том, что что-то пропущено в снимках на Polaroid.
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Теперь плохие новости...
К сожалению, цифровая фотография имеет не только достоинства, но и недостат-
ки. Технология пока не идеальна, и потребителям все еще приходится оплачивать
исследования производителей и новые разработки. Хотя устройства для хранения
фотографий постоянно падают в цене, они до сих пор не так дешевы, как хотелось
бы. Перечислим некоторые недостатки.

Q Качество изображения. Кадр пленки содержит примерно в десять раз больше
данных, чем изображение, полученное с помощью цифрового фотоаппарата.
Примерно такое же количество информации требуется для создания фотогра-
фии на бумаге. Камера с матрицей, позволяющей получать фотографии, каче-
ство которых аналогично качеству пленочных снимков, была бы очень дорогой
(помните $35 000, о которых я упоминал?). При этом дешевый пластмассовый
фотоаппарат (заслуживший прозвище «мыльница») сохраняет больше нюан-
сов, чем весьма, дорогая цифровая камера.

О Ограниченное разрешение. Если вы собираетесь использовать полученное
цифровой камерой изображение в газете или разместить его в Интернете, скорее
всего, проблем с качеством снимка не возникнет. Если же планируется увели-
чить картинку до размеров плаката и повесить ее на стене, лучше взять обычный
фотоаппарат. Например, когда я в течение многих часов поднимался на вершину
горы, чтобы сфотографировать отрывающуюся оттуда панораму, которая пред-
назначалась для создания обоев и для продажи, естественно, я пользовался про-
фессиональным зеркальным фотоаппаратом. Но при этом свою жену, прыгаю-
щую по скалам или через ручей, я с удовольствием снимал цифровой камерой.

Q Высокая стоимость комплектующих. Цена цифровых фотоаппаратов класса
«навел-и-снял» составляет около $200-300, наличие дополнительных функций
и комплектующих увеличивают их стоимость до $1200 и выше. Словом, эти
камеры стоят достаточно дорого. Кроме того, существует ограничение на ис-
пользование таких аксессуаров, как сменные объективы, фильтры и т. п., не го-
воря уж о том, что все аксессуары от обычного фотоаппарата, скорее всего, не
подойдут к цифровой камере.

Q Модернизация оборудования. Предположим, что у вас уже есть компьютер.
Тогда, скорее всего, вам потребуется увеличить объем оперативной памяти
(RAM). Если у вас нет хорошего цветного принтера, лучше положить один из
них в свою тележку для покупок, а также, раз уж вы зашли в магазин, пожалуйста,
купите приличный стабилизатор напряжения. Если вы собираетесь серьезно
заняться цифровой фотографией, имеет смысл приобрести также монитор
с большим экраном, чтобы свести к минимуму усталость глаз.

Q Печать фотографий. Итак, вы купили фотоаппарат и необходимые для него
аксессуары, а также обновили компьютер. Это обошлось совсем не дешево.
Теперь вы можете совершенно бесплатно фотографировать, затем просматривать
снимки на экране, редактировать их по своему желанию, выкладывать в Интер-
нете или готовить для печатных изданий. Если же вы любите печатать фотогра-
фии, желательно купить фотопринтер и фотобумагу (и с учетом стоимости цвет-
ного картриджа каждый отпечаток окажется не намного дешевле обычных
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снимков, если не дороже) или вам потребуется найти фотолабораторию, в ко-
торой печатают снимки с цифровых носителей, и заплатить за печать каждого
кадра вдвое дороже, чем в случае традиционных фотографий.

Q Я уже перечислил все необходимые расходы? Не забудьте про аспирин!

Q Дополнительное освещение. Цифровые камеры требуют для экспозиции го-
раздо больше света, чем их пленочные собратья. Скорее всего, при съемке на
улице это не вызовет проблем, но в помещении могут возникнуть осложнения,
как на рис. 1.5. Даже при использовании вспышки необходимо или увеличить
освещение, или смириться с затемненными фотографиями.

Рис. 1.5. Результат съемки цифровым фотоаппаратом темного интерьера, такого как на
бостонском Южном вокзале, может огорчить вас. Автоматическую экспозицию еще более

затрудняет наличие освещенных пространств, например окон

Q Шум. Если внимательнее посмотреть на темные области изображения, например
на тень или черную поверхность, можно увидеть «ш/л*». Он обычно появляется
в виде синих или красно-синих помех в затененных участках. Если провести
аналогию между цифровой информацией и телевизионным сигналом, шум подо-
бен помехам, получаемым при попытке настроиться на прием слабой станции.

Q Разбиение на пикселы. При сильном увеличении снимка, полученного цифровой
камерой, становятся видны пикселы — маленькие квадратики, из которых со-
стоит изображение. Они проявляются резче, когда файл содержит недостаточно
сведений для правильного отображения картинки определенного размера,
то есть имеет недостаточное разрешение, как на рис. 1.6 (разрешение подробно
обсуждается в главе 11). Конечно, можно продолжать увеличивать изображе-
ние, но тогда компьютер сам будет вычислять несуществующие данные, необ-
ходимые для формирования картинки, путем интерполяции.

ПРИМЕЧАНИЕ
Интерполяцией называется метод, применяемый для обработки изображения при вычис-
лении цвета пиксела, который должен появиться между двумя уже имеющимися пикселами.
Его также принято называть обоснованным предположением. Разумеется, намного лучше
иметь точные данные, а не придуманные компьютером.
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Р

Рис. 1.6. Изображение с низким разрешением, на котором заметны составляющие его пикселы

D Появление ступенчатых границ. Другим результатом низкого разрещения яв-
ляются ступеньки из пикселов, обычно возникающие на любых линиях изоб-
ражения, не являющихся строго вертикальными и горизонтальными (рис. 1.7).
Размер ступенек уменьшается по мере увеличения разрещения фотоснимка.
Данный эффект также можно увидеть на круглых или искривленных объектах,
таких как овалы или колеса.

Рис. 1.7. Как видно по контурам ножниц, избежать ступенчатых границ очень сложно.
Единственным способом борьбы с ними является правильно подобранное разрешение

Q Искажение цветов. Иногда цифровые камеры способны искажать цвета. Конеч-
но, вы вряд ли увидите на фотографии голубую траву или красное небо (если
только вы снимали не на Марсе), но желтый цвет вполне может выглядеть, как
оранжевый, а синий — как фиолетовый. Обычно причиной этого явления ста-
новится плохо выполненная программным обеспечением фотоаппарата интер-
поляция. О способах борьбы с этим эффектом мы поговорим в главе 15.

Q Вынужденное ожидание. Большинство камер с целью сохранения энергии ба-
тареек автоматически переключаются в режим сохранения энергии, или спящий
режим, если они не используются в течение нескольких минут. В зависимости
от типа фотоаппарата и от метода выхода из этого состояния между открытием
объектива и моментом, когда камера будет готова к работе, может пройти одна-
две секунды. Возможно, после очередного снимка вам придется также ждать
несколько секунд, пока аппарат готовится к следующему кадру. Ведь камера
должна обработать изображение и сохранить его в памяти.
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а Необходимость обучения. Процесс фотографирования на цифровую камеру
не сложнее, чем на обычную. Возможно, он даже будет легче для вас. Но пере-
дача фотографий на компьютер, их обработка и последующая печать окажутся
не так просты, как раньше (по крайней мере, поначалу). Вам потребуется полу-
чить новые навыки и потратить некоторое время на обучение.

Если вам нравится общаться с компьютером и совершенствовать свое мастерство,
цифровая фотография может стать вашим любимым занятием. Если же у вас не
лежит к этому душа, есть вероятность, что вы останетесь приверженцем традици-
онных фотоаппаратов.

Кому нужны цифровые фотоаппараты?
Когда вы освоите принципы цифровой фотографии, она станет для вас как источни-
ком развлечений, так и относительно недорогим способом получения снимков.
Вы сможете фотографировать, не беспокоясь о пленке, ее последующей обработке
и деньгах, которые потребуется на это потратить. Цифровая фотография позволяет
свободно творить и создавать произведения искусства. Она также может быть бес-
ценным деловым инструментом. Но в любом случае это замечательный способ для
выражения ваших идей, как при непосредственном контакте, так и через Интернет.
Итак, кому нужны цифровые фотоаппараты?

а Страховые агенты используют цифровые камеры при составлении отчетов по
искам. Ведь сделать снимок помятого крыла автомобиля или разбитого окна,
присоединить его к бланку иска и отправить по электронной почте в централь-
ный офис можно практически мгновенно. К радости клиентов, это сокращает
срок платежа. Кроме того, изображение становится частью электронного отче-
та, доступного любому сотруднику фирмы.

О Агенты по продаже недвижимости могут использовать цифровую фотографию
для показа клиентам имеющихся в наличии вариантов (рис. 1.8). Снимки также
можно опубликовать в рекламном разделе газеты или даже разместить в Интер-
нете. Технология QTVR (Quick Time Virtual Photography) позволяет устраивать
для клиентов виртуальные путешествия по дому или офису.

.

Рис. 1.8. Агенты по продаже недвижимости могут получать фотографии домов для будущих
покупателей, не выходя из офисов
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ПРИМЕЧАНИЕ
Технология QTVR (QuickTime Virtual Photography), разработанная компанией Apple Software,
позволяет несколько раз сфотографировать объект или сцену, а затем анимировать изобра-
жение. Сначала объект вращают перед камерой и снимают его через каждые 10° до тех пор,
пока не будет выполнен полный оборот (360°). При съемке сцены имеет место тот же самый
процесс с одним исключением: теперь на 360° поворачивается камера, которая фотографи-
рует окружающую обстановку через каждые 10°. В итоге получается 36 кадров. Получен-
ные QTVR-изображения можно разместить в Интернете или представить их как часть муль-
тимедиа-презентации. Зрители видят объект со всех сторон или совершают виртуальную
прогулку по вестибюлю отеля или музею. Не так давно преимуществами данной технологии
стало пользоваться спортивное телевидение. Оно устанавливает несколько камер в опреде-
ленных положениях вокруг игрового поля или другого места соревнований, что позволяет
показывать повторы и изменять точку обзора в процессе игры.

Владельцы маленьких коммерческих фирм, а также художники и иллюстрато-
ры могут использовать цифровую фотографию, чтобы избежать традиционно-
го процесса сканирования. Это экономит время, а мы все знаем, что время —
это деньги! Поэтому лучше вложить часть финансов в качество и скорость, чем
содержать издательство, исправляющее ваши ошибки, и оплачивать пропущен-
ные сроки сдачи работы.
Базы данных могут содержать фотографии всех товаров, которыми торгует ваша
фирма. В результате вашим клиентам не потребуется напрягать воображение,
чтобы представить вещь другого размера или другого цвета. Это даст вам зна-
чительное преимущество перед конкурентами! Кроме того, с помощью QTVR-
фотографии нетрудно создать небольшой ролик, демонстрирующий товар с раз-
ных сторон.

Цифровые изображения превосходно подходят для размещения в Интернете
(рис. 1.9). Имейте в виду, что чем меньше изображение, тем быстрее его сможет
увидеть человек, посетивший ваш сайт.

Рис. 1.9. Разрешения снимков, получаемых цифровыми камерами, более чем достаточно для их
размещения в Интернете
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а Цифровая фотография замечательно подходит для издания информационных
бюллетеней и для снабжения торговых агентов фотографиями продукции.
С помощью цифрового фотоаппарата можно быстро получить снимок нового
клиента, чтобы все сотрудники и отдел продаж узнавали его по внешнему виду
и приветствовали по имени. Также это позволяет сделать внутреннюю почту
офиса более персонализированной, а веб-сайты — более информативными.

Доктора, дантисты и хирурги могут с помощью цифровых фотоаппаратов де-
лать снимки своих пациентов. Полученные таким образом фотографии паци-
ента до и после лечения годятся для использования в медицинских отчетах или
для присоединения к требованию по выплате страховки.

Все чаще и чаще используют цифровые камеры фотографы-журналисты. Разре-
шение фотоаппаратов среднего и высокого качества предоставляет достаточ-
но информации для обычной газеты или журнала (рис. 1.10). Фактически, мно-
гие из этих цифровых изображений доставляются через спутник. Фотографы
носят с собой маленькие устройства, взаимодействующие по спутниковому ка-
налу связи, что позволяет передавать снимки прямиком на письменный стол
редакторов.

а

Рис. 1.10. В газете я сообщаю клиентам о последних событиях в моей студии.
Цифровая фотография облегчает процесс создания газеты и повышает

ее визуальную привлекательность

У себя дома можно сфотографировать все ценности на случай, если когда-ни-
будь понадобится предоставить отчет страховой компании. При этом копию
файлов имеет смысл хранить в безопасном месте за пределами дома.

Цифровые фотоаппараты можно брать с собой куда угодно. В вашей власти
сделать сотни снимков и позднее удалить неудавшиеся. Вас удивит качество
фотографий, которые получаются, когда не нужно беспокоиться о количестве
потраченных кадров.
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Вы получите изысканное удовольствие от творческой обработки изображений.
Можно сфотографировать много видов или вариантов одной и той же сцены
или сделать снимки в разное время и с разных точек съемки, а затем создать из
них коллаж. Здесь вам предоставляется полная свобода.

1
Рис. 1.11. Цифровая фотография как нельзя лучше подходит для «усовершенствования

реальности». Вы в состоянии сказать, какие цветы здесь были изначально, а какие —
добавлены с помощью инструментов графического редактора?

Следует запомнить
а Фотография, как мы теперь знаем, появилась с изобретением камеры-обскуры.

Q Существует много доводов за использование цифровых фотоаппаратов, но также
есть и аргументы против.

Q Цифровая фотография применяется для различных целей.

Q Несмотря на удобство цифровых фотоаппаратов, качество изображения пока
не может конкурировать с получаемым при съемке на пленку.



Глава 2

Фотопленка и пикселы

О Что такое пиксел

О Все о свете
Q Как устроены цифровые фотоаппараты

Итак, что представляет собой пиксел и что такое свет? Как работает фотоаппарат
и как лучи света преобразуются в цифровое представление? Читайте эту главу!

Трехцветный мир (RGB)
Когда белый свет проходит через призму, он расщепляется на составляющие, и ста-
новится виден полный спектр оттенков. Этот процесс можно обратить и вернуться
к белому свету, пропуская через призму весь спектр цветов. На самом деле для
получения белого света необходимы только красный, зеленый и синий цвета.
Попробуйте сами выполнить описанный ниже эксперимент — он производит впе-
чатление.

Опыт заключается в следующем: возьмите три мощных фонарика и закрасьте один
из них красной прозрачной краской или гелем, второй — синей и третий — зеле-
ной. Затем повесьте на стену лист белой бумаги. Затемните комнату и посветите
одновременно всеми тремя фонариками на бумагу — должен получиться белый
свет1. (Подобное научное исследование можно поручить даже детям.)

Этот мир мы называем RGB-цветным миром (где RGB означает red, green, blue
(красный, зеленый, синий)). И поскольку требуется смешать три цвета, чтобы
получить белый, последний называют дополнительным цветом, В данной модели

' Настоящий белый свет получить таким образом сложно, но понять, как смешиваются разные цвета,
можно. Чтобы убедиться в том, что все цвета можно получить из трех базовых, достаточно рассмот-
реть экран обыкновенного телевизора через увеличительное стекло. Вы увидите, что изображение
состоит из точек всего трех цветов... красного, синего и зеленого. — Примеч. ред.
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указанные выше три цвета — красный, зеленый и синий — называются первичны-
ми, или аддитивными.

Возможно, некоторые из читателей возмутятся и скажут, что зеленый не является
первичным цветом. Да, вы правы и неправы одновременно. Базовые цвета светового
спектра — это красный, синий и зеленый. А для любых красящих веществ, таких
как краски и красители, основными цветами являются красный (точнее, пур-
пурный), желтый и голубой. Если вы мне не верите, обратитесь к книгам по тео-
рии цветов.

Данный раздел может показаться сложным, но его обязательно нужно прочитать —
в конце все приобретет смысл. Переведите дыхание, я обещаю, что в дальнейшем
экспериментов не будет. Вернемся к призме. Пусть при пропускании цветов через
призму отсутствует зеленый свет. В результате полечится пурпурный, вторичный
цвет, который находится напротив зеленого в классическом двойном треугольнике,
изображенном на рис. 2.1, и представляет собой комбинацию двух оставшихся
первичных цветов, красного и синего. Следующим вторичным цветом является
желтый, располагающийся напротив синего, и последним — голубой, который до-
полняет красный цвет. Поскольку пурпурный, желый и голубой получаются вы-
читанием соответствующих цветов из белого света, их также называют субтрак-
тивными.

Желтый

Зеленый

Голубой

Красный

•Пурпурный

Синий

\ / Аддитивные первичные (цвета света)

Субтрактивные первичные (цвета красок)

--- Дополняющие друг друга цвета находятся
на концах пунктирных линий

Рис. 2.1. Классический двойной треугольник

Чтобы соотнести это рассуждение с фотографическим процессом, предположим,
что в снимке уменьшено количество зеленого. Как вы уже догадались, изображе-
ние приобретет пурпурный оттенок.
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RGB-изображение в файле
Красный канал

Зеленый канал

Синий канал

Рис. 2.2. Фотография, разделенная на три канала

Фотоаппарат имитирует человеческий глаз
Цвет, видимый человеческим глазом, является результатом отражения света
от объекта. Глаз видит красное яблоко, потому что кожица яблока поглощает зеле-
ный и синий света и отражает один только красный. Конечно, если яблоко изна-
чально не было зеленым или желтым.

Человеческий глаз состоит из трех частей, как показано на рис. 2.3:

Q хрусталик фокусирует свет на задней поверхности глаза;

Q радужная оболочка помогает формировать зрачок, маленькое черное отверстие,
которое регулирует количество света, попадающего в глаз;

Q на задней поверхности глазного яблока находится сетчатка. На сетчатке рас-
положены нервы, которые воспринимают свет и посылают соответствующие
импульсы в мозг. Часть этих нервов улавливает красный, другая — зеленый
и третья — синий свет. Мозг обрабатывает всю информацию, и в результате че-
ловек видит цвет. (Теперь понятно, что я имел в виду, называя RGB первичны-
ми цветами?)

Радужка

Рис. 2.3. В фотоаппарате имитируется устройство человеческого глаза

Не вызывает ни малейшего удивления, что фотоаппарат практически точно ими-
тирует человеческий глаз. Здесь используются те же самые два фундаментальных
закона оптики:

О Свет распространяется по прямой за исключением тех случаев, когда он пре-
ломляется. Это свойство помогает объяснить, почему изображение переворачи-
вается при прохождении через объектив. Световой луч проходит через вершину
объекта съемки, затем через отверстие в фотоаппарате (объектив) и попадает
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на заднюю стенку камеры. Аналогично, луч, проходящий через основание объек-
та съемки, преодолевает объектив и попадает в верхнюю часть задней стенки
камеры. В итоге изображение переворачивается. Эта теория применима для
глазного яблока, маленьких отверстий, объективов и камер-обскур.

Когда свет пересекает границу двух разных по плотности сред, он преломляет-
ся. И в усложненной форме: при попадании в более плотную среду направле-
ние светового луча отклоняется в сторону перпендикуляра к границе двух сред.
Это объясняет принцип работы линзы (рис. 2.4).

Линза

Свет
Пленка или

матрица

Параллельные лучи преломляются
и собираются в одной точке

Фокус

Лучи, проходящие через
центр линзы, не преломляются

Ось

Двояковыпуклая Плоско-выпуклая

Двояковогнутая Плоско-вогнутая

Вогнуто-выпуклая

I Выпукло-вогнутая

li
Рис. 2.4. Линза очень похожа на хрусталик глаза

Глаз является хорошей моделью для фотоаппарата, в нем есть все необходимые
составляющие. Несколько линз объектива фокусируют свет вместо хрусталика.
Механическая диафрагма, которая заменяет радужную оболочку глаза, регулиру-
ет количество света, попадающего внутрь фотоаппарата. Наконец, в качестве сет-
чатки используется фотопленка. Свет проходит через линзы, отражается от зерка-
ла и с помощью призмы перенаправляется в видоискатель, как продемонстрировано
на рис. 2.5. Когда зеркало поднято, свет доходит до задней стенки фотоаппарата и
попадает на пленку.
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Призма

Дерево

Видоискатель

Поверхность пленки

Объектив
'— Перевернутое изображение

1— Зеркало
Рис. 2.5. Модель фотоаппарата

Сначала была пленка
Начнем наш рассказ с того, как работает черно-белая фотопленка (рис. 2.6).

1. Создается эмульсия, в которой равномерно распределены кристаллы нитрата
серебра. Эмульсия внешне похожа на желе с плавающими в нем кусочками
фруктов (кристаллами нитрата серебра). Ее наносят на прозрачную основу,
и там эмульсия затвердевает (эту основу мы называем пленкой).

2. Во время фотосъемки на серебро действует свет.

3. Затем пленка проявляется в специальном растворе. Если серебро на пленке было
засвечено полностью, покрытие пленки станет черным, а точнее, непрозрачным.
Если же реакция под действием света произошла частично, покрытие примет
оттенки черного (то есть станет серого цвета).

4. После проявки не повергшееся действию света серебро удаляется с пленки
с помощью фиксирующего раствора, который называется фиксажем или закре-
пителем.

5. Затем пленку промывают в воде и сушат. Негатив готов!

6. Чтобы получить позитив, требуется пропустить свет сквозь негатив и засветить
другую пленку или бумагу. Помните, что негатив с негатива создает позитив.

Теперь вернемся к цветной фотопленке. Если представить ее упрощенно, цветная
пленка состоит из трех основных слоев. На самом деле слоев намного больше, но
мы сейчас пытаемся сохранить простоту рассуждений.

Q Красный слой становится красным, когда на него попадает красный свет,

а Синий слой становится синим, когда он освещается синими лучами.
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а И, как вы уже несомненно догадались, зеленый слой становится таковым, ког-
да на него попадает зеленый свет.

Фотоаппарат Пленка Проявитель Промывка Фиксация Промывка Сушка

Увеличитель Темная комната

/ЯГ-Негатив

/ \ Проявитель Промывка Фиксаж Промывка

/Бумага
Экспозиция

Сушка

Типография

Сканирование

Компьютер

Рис. 2.6. Фотохимический процесс

Звучит знакомо? Когда свет проходит сквозь пленку и все цветные слои, получа-
ется цветная картинка.

Для любознательных читателей опишем принцип работы цветной фотопленки.
Свет, попадая на соответствующий слой, возбуждает находящееся на нем серебро.
Слои расположены так, что на красный слой влияет только красный свет, на синий
слой — только синий свет и т. д.

Возникают резонные вопросы: разве серебро не преобразуется в черный цвет или
серые оттенки? Каким образом серебро становится цветным? В эмульсии, наносимой
на цветную пленку, присутствует не только серебро, но и цветной соединитель.
А когда свет попадает на пленку, серебро возбуждается и активизирует этот
соединитель.

Затем в начале обработки пленку помещают в раствор, который называется про-
явителем и содержит полупрозрачные цветные краски. Возбужденные цветные
соединители поглощают эти краски из проявителя и закрепляют их на слоях
пленки. После остановки процесса проявления серебро удаляется с помощью от-
беливающего раствора, и на пленке остаются только цветные краски. То есть на
цветном негативе или цветной фотографии нет серебра — оно все извлекается
отбеливателем.
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Устройство цифровых фотоаппаратов
В цифровых фотоаппаратах свет через объектив попадает не на фотопленку, а на
матрицу, принимающую изображение. (Многие называют матрицы чипами, что
вполне допустимо, суть от этого не меняется.) На матрице расположены ПЗС-эле-
менты (CCD, или charged couple devices — приборы с зарядовой связью).

Когда на ПЗС-элементы поступает свет, они испускают электрический заряд, ко-
торый переводится в бинарную информацию аналого-цифровым преобразовате-
лем фотоаппарата. На таких цифровых данных, нулях и единицах (или состояни-
ях «включено-выключено»), основывается вся работа компьютера. Фактически,
обработка изображения процессором заключается в изменении цифровых кодов,
соответствующих цвету и яркости отдельных точек. В цветном фотоаппарате ПЗС-
элементы настроены на прием нескольких определенных цветов; можно догадать-
ся, каких именно: красного, зеленого и синего.

ПРИМЕЧАНИЕ
Итак, что же такое пиксел? Это слово уже несколько раз употреблялось в тексте. Пиксел
является сокращением от английского picture element (элемент изображения) и обозначает
минимальный элемент изображения. Если увеличивать цифровую фотографию, в конце
концов станут видны маленькие одноцветные квадратики. Это и есть пикселы, которые со-
здаются ПЗС-матрицей.

Можно предположить, что видны сами ПЗС-элементы, но это не так. ПЗС-элементы только
сообщают программному обеспечению, сколько света было уловлено в той или иной точке
и какого он был цвета. Чем больше пикселов в фрагменте изображения заданного размера,
тем большее разрешение имеет светочувствительная матрица.

Существует несколько видов светочувствительных матриц.

О КМОП-элементы(СМ08, или Complementary Metal-Oxide Semiconductor — ком-
плементарная структура металл-окисел-полупроводник) подобно ПЗС-элемен-
там вырабатывают электрические заряды, когда на них попадает свет. Прием-
ники изображений, основанные на КМОП, обычно создают больше шума
и имеют меньшую светочувствительность, чем их собратья ПЗС-элементы, но
они дешевле в производстве и потребляют меньше энергии. Такие приемники
изображений можно обнаружить в некоторых цифровых фотоаппаратах умерен-
ной стоимости и в веб-камерах, применяемых для общения через Интернет.

КМОП-датчики в настоящее время используются только двумя или тремя про-
изводителями фотоаппаратов, однако после дополнительных исследований
и усовершенствований эта технология может занять достойное место на рынке.
Профессиональные фотографы работают с КМОП-фотоаппаратами в тех слу-
чаях, когда не требуется высокое качество изображения, например, когда фото-
графия предназначается для Интернета или для небольших каталогов. Эти ка-
меры не так дороги, как фотоаппараты других типов, и являются достойной
альтернативой.

Q В матрице простейшей структуры ПЗС-элементы выровнены в линию (рис. 2.7).
Такая матрица называется линейной. Она может уловить за раз только один цвет,
поэтому чтобы воспроизвести все три цвета, приходится три раза перемещать
ее поперек длинной стороны кадра (один раз для красного, второй — для зеленого
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и третий — для синего цвета). Основным недостатком линейной матрицы
является то, что во время съемки объект не может двигаться и освещение должно
оставаться постоянным. Большинство фотографов использует для освещения
съемочной площадки фотопрожекторы или кинооборудование. Также недопу-
стимо перемещение фотоаппарата, поскольку при этом возникает проблема
совмещения изображений, полученных для каждого из цветов, — перед началом
каждого последующего сканирования матрица должна вернуться в то же самое
место, откуда она стартовала в первый раз.

Студийный
цифровой
фотоаппарат

Линейная
матрица

Ч

Рис. 2.7. Для цветной съемки линейная ПЗС-матрица должна сделать три прохода
в плоскости пленки

О Следующим звеном в цепи эволюции является трехлинейная матрица. На ней
ПЗС-элементы располагаются в три ряда; каждый ряд воспринимает один из
первичных цветов (рис. 2.8). Матрица сканирует изображение только один раз,
что значительно уменьшает время, требующееся для экспозиции. Также намного
улучшается регистрация цвета. Такие матрицы могут обеспечивать довольно
высокое разрешение изображения и производить графические файлы огром-
ного размера — 100 Мбайт и более, поэтому они часто используются в профес-
сиональных фотостудиях. Но все равно матрице необходимо дойти до конца
изображения, в это время объект не может двигаться и сцена должна иметь по-
стоянное освещение.

а Если разместить ПЗС-элементы в виде прямоугольника, то можно сделать пол-
нокадровую черно-белую матрицу. Это позволит использовать вспышку вмес-
то постоянного источника света и фотографировать объект в движении. Чтобы
получить цветную фотографию, матрица должна быть освещена три раза или,
по аналогии с рассмотренными ранее моделями, выполнить три прохода. На-
против линзы помещается вращающийся цветной светофильтр, и при первой
экспозиции линзу закрывает красный фильтр, затем зеленый и последним си-
ний (рис. 2.9). При этом очень точно передается цвет, кроме того, сильно сокра-
щается время экспозиции, поскольку для каждого из проходов может исполь-
зоваться вспышка. Однако объект все еще не имеет права двигаться.
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Красный

Зеленый

Синий

Рис. 2.8. В трехлинейной матрице ПЗС-элементы должны сделать только один проход
по задней стороне фотоаппарата

Изображение
красного канала

Rotation

RGB-изображение

Красный
фильтр атрица

Объектив

Прозрачный
для фокусировки

Рис. 2.9. Свет проходит через каждый из цветных фильтров и попадает на «черно-белую»
матрицу. Затем цвета объединяются программным обеспечением фотоаппарата —

и получается полноцветное RGB-изображение

а Некоторые производители размещают стеклянный светофильтр, называющийся
плавно перестаивающимся фильтром, перед линзой или внутри фотоаппарата
на поверхности матрицы. Фильтр быстро меняет свой вид, успевая за время
вспышки отделить красный, зеленый и, наконец, синий цвета, что позволяет
за одну вспышку прийти к тому же результату, что и за три прохода. Такой
подход сочетает в себе самое лучшее из двух областей: фотографии точного цвета
и движущегося объекта. Это новая технология, и при ее применении еще воз-
никает много ошибок, но она кажется многообещающей.

Q За один раз полный цвет можно воспроизвести также с помощью схемы с чере-
дованием элементов. Такой тип матриц наиболее часто встречается в современ-
ных цифровых фотоаппаратах. Здесь ПЗС-элементы тоже размещаются в ря-
дах и столбцах, но над каждым отдельным элементом находятся крошечные
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цветные фильтры. Фильтры располагаются в простом порядке (RGBRGB), как
показано на рис. 2.10, или по более сложной схеме (например RRGBRRGB).
Вид схемы устанавливает производитель матрицы и фотоаппарата; разреше-
ние зависит также от матрицы и от типа выполняемой интерполяции.

Рис. 2.10. В матрице с чередующимися элементами над каждым ПЗС-элементом установлены
крошечные фильтры

ПРИМЕЧАНИЕ
На цветной фотопленке красный, зеленый и синий слои размещаются один над другим. При
проходе света через эти слои получаются правильные (точные) цвета. Поскольку ПЗС-эле-
менты располагаются не друг над другом, а последовательно, могут возникнуть некоторые
проблемы с цветом. Если красный луч попадает на элемент, воспринимающий красный свет,
все будет прекрасно. Но если красный луч примет элемент, рассчитанный на другой цвет,
или же синий или зеленый цвет попадет на красный элемент, появятся проблемы. Они
разрешаются с помощью интерполирующих алгоритмов, которые изучают информацию,
поступающую от каждого ПЗС-элемента, и определяют степень корректности данных.

Следует запомнить
Q Видимый свет можно разделить на красный, зеленый и синий первичные цвета.

а Фотоаппараты и объективы имитируют человеческий глаз.

а ПЗС-элементы активируются светом и посылают электрические импульсы,
которые преобразуются в цифровые сигналы.

Q Существует множество видов цифровых фотоаппаратов. Бывают сканирующие
и полнокадровые камеры, черно-белые и цветные фотоаппараты, создающие
соответствующие изображения.



Часть II

Фотоаппараты, аппаратное
и программное обеспечение,
необходимые для обработки

цифрового снимка
Быстродействие компьютеров постоянно увеличивается, а следом за ним потряса-
ющими темпами развивается программное обеспечение. Современные программы
позволяют обрабатывать изображения так, как нам раньше даже не снилось. Ког-
да-то мы радовались, если удавалось повернуть на прямой угол черно-белую кар-
тинку. Сегодня можно, сидя перед экранами мониторов, корректировать цвета
и размеры рисунка, увеличивать резкость и создавать многочисленные вариации
изображения.

Может быть, фотография
не получилась, потому что
ты нажал не ту кнопку.
На что ты нажал?

„,..
, м- • * '•



Глава 3

Модели фотоаппаратов

а Наиболее подходящая для вас модель фотоаппарата

а Виды фотоаппаратов

а Внутренняя обработка информации

На данный момент на рынке можно найти такое количество разных цифровых
фотоаппаратов, отличающихся друг от друга размерами, конструкцией и наборов
выполняемых функций, что выбор наиболее подходящей камеры превращается
в очень сложную задачу. Кажется, что практически ежедневно появляются новые
фотоаппараты с обновленными или улучшенными характеристиками по сравнению
с предыдущими моделями. Если заняться поиском камеры со строго определен-
ными параметрами, просмотр предлагаемых моделей может не дать результатов,
поскольку производство цифровых фотоаппаратов движется вперед огромными
шагами. Даже за то время, пока вы читаете эту книгу, часть фотоаппаратов, при-
сутствующих сегодня на полках магазинов, несомненно, будет заменена более но-
выми, самыми фантастическими сородичами.
Одной из наиболее интересных для меня тем был обзор прогресса в технологии
производства фотоаппаратов и особенно матриц, размер которых увеличился
от 1 до 4 и более мегапикселов. (Определение мегапиксела будет дано далее.) При
этом больше всего поражает не гигантский рост разрешения, а отсутствие повыше-
ния цен на матрицы! Появилась масса новых полезных мелочей, но это не столь
важно. Актуальнее то, что технологии внутреннего хранения информации реально
продвинулись вперед. Теперь на самом деле можно сделать тысячу фотографий,
несмотря на то что у вас нет с собой десятка-другого запасных карт памяти.

Изучение фотоаппаратов
Лучшим способом узнать все о конкретном фотоаппарате является проведение не-
большой исследовательской работы. Большинство крупных фирм, торгующих
фототехникой и компьютерами, регулярно выпускают анонсы — примерно каждый
месяц появляется описание новой камеры. Кроме того, повсюду можно найти
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сравнительные обзоры, в которых фотоаппараты группируются по стоимости, раз-
решению или простоте использования. Часто в подобных обозрениях техника оце-
нивается, например, по десятибалльной шкале. Также в них можно найти советы
по выбору фотоаппарата. Помимо этого, огромное количество информации содер-
жится в Интернете.

Другим хорошим способом узнать последние новости является просмотр рекламы
и анонсов производителей. Наблюдайте за тем, чем они торгуют и почему, что но-
вого в появляющемся оборудовании и какие возможности оно предоставляет. Од-
нако при этом стоит остерегаться путаницы в названиях; «сверхзвуковая система
масштабирования» одного производителя может быть идентична «удивительной
волшебной технологии» другого.

СОВЕТ
Прежде чем идти покупать фотоаппарат, важно решить, сколько денег вы можете на него
потратить. Исходя из этого определяется верхняя граница стоимости камеры, принтера
и сопутствующих аксессуаров. Всегда стоит планировать на будущее. Вы собираетесь исполь-
зовать этот фотоаппарат в течение всей оставшейся жизни? (Я надеюсь, что нет.) Покупка
планируется в качестве стартовой, и вы намереваетесь обновить оборудование в ближайшее
время? Вы хотите вложить деньги в систему, которую можно будет постоянно модернизиро-
вать, или предпочитаете не покупать ничего нового в течение нескольких лет? Желаете ли
вы приобрести суперсовременную камеру, или вас привлекают уже проверенные технологии?
Но в любом случае следует покупать наилучшую фотокамеру из ряда ей подобных.

Виды фотоаппаратов
Сначала следует понять, какой фотоаппарат вам нужен. По существу, можно вы-
делить две основные группы фотокамер, каждая из которых имеет свои преиму-
щества и недостатки.
Q Дальномерные фотоаппараты. Это фотоаппараты с простым устройством (не

путайте с недорогими фотоаппаратами). Конфигурацию дальномера может
иметь как традиционный пленочный фотоаппарат, так и цифровые фотокамеры.
Обычно фотограф видит объект съемки через видоискатель, который состоит
из одной линзы или целого объектива. Дальномерный фотоаппарат отличается
тем, что в нем видоискатель предназначается только для просмотра будущего
кадра и никак не связан с системой линз, через которые свет попадает на пленку
(последнюю мы называем фотообъективом). В совсем дешевых моделях видо-
искатель может представлять собой простое отверстие в корпусе фотокамеры,
в которое вставлена прозрачная пластмасса.' В более дорогих моделях исполь-
зуется система дальномера (то есть система определения расстояния), с помощью
которой выполняется фокусировка как видоискателя, так и основного объекти-
ва, но, тем не менее, отсутствует связь объектива с видоискателем.

Преимуществом фотоаппаратов такого типа является их небольшой размер и мень-
ший вес по сравнению с другими моделями. Недостаток заключается в возникно-
вении так называемого эффекта параллакса — видимое фотографом изображение
не идентично изображению, воспринимаемому пленкой. Он возникает, поскольку
видоискатель и объектив расположены отдельно друг от друга (рис. 3.1).

К этой категории относятся фотоаппараты, именуемые «мыльницами». — Примеч. перев.
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Видоискатель

Глаз

Объектив
Съемка

с близкого
расстояния

Съемка
с дальнего
расстояния

Так видит глаз

Так видит объектив

Рис. 3.1. Явление параллакса

ПРИМЕЧАНИЕ
Можно легко продемонстрировать явление параллакса: сначала посмотрите на объект, зак-
рыв один глаз, затем закрыв другой. Вы увидите, что объект сдвигается. Какой же из этих
видов правильный? Повторите опыт снова, держа палец напротив лица. Вы заметите, что
эффект усиливается по мере приближения объекта.

О Зеркальные (Single Lens Reflex (SLR)) фотоаппараты. В зеркальных фотоап-
паратах решена проблема параллакса. Встроенная в них система зеркал и призма
позволяют видеть объект в видоискателе так же, как он воспринимается через
объектив (рис. 3.2). Прекрасным примером цифрового зеркального фотоаппара-
та является Olympus 620 DL.

Рис. 3.2. Мой верный друг
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Рис. 3.3. Бостонский Федеральный резервный банк, классический пример трапецеидальное™

Виды цифровых фотоаппаратов
Одной из наиболее важных характеристик цифровых фотоаппаратов является размер
ПЗС-матрицы. Кроме того, камеры различаются по многим другим параметрам;
они могут иметь простые или усовершенствованные системы определения экспози-
ции, фокусировки, управления цветом и т. д. Не нужно пугаться всех этих слож-
ностей, в конце концов, вам не обязательно забивать ими голову — ведь даже самый
простой цифровой фотоаппарат позволяет делать хорошие снимки, и, в принципе,
все зависит от ваших запросов. Но прежде чем решиться на покупку какой-то кон-
кретной камеры, стоит внимательно прочесть описание ее характеристик. Опреде-
лите для себя, как вы собираетесь использовать фотоаппарат и какой уровень
управления съемкой вам потребуется. Купив слишком сложную камеру, которой
вы не сможете управлять, вы впустую потратите деньги. Важнее всего, чтобы с фото-
аппаратом было удобно работать.

Фотоаппараты с мегапиксельными матрицами
Некоторое время назад в продаже чаще всего встречались фотоаппараты с матрицей
с 1280 х 960 ПЗС (подробно о ПЗС-матрицах рассказывалось в главе 2). Такие
фотоаппараты называются мегапиксельными; они позволяют делать великолепные
снимки небольшой величины. Если вы собираетесь снимать фотографии только
для размещения на веб-сайтах, вам будет вполне достаточно такой камеры.

ПРИМЕЧАНИЕ
Вы знаете, почему 35-миллиметровая пленка получила именно такое название? Может быть
потому, что длина кадра, то есть его размер по горизонтали, равна 35 мм? Или просто
потому, что все другие названия уже были заняты? Нет! Все дело в том, что пленка имеет
ширину 35 мм.
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ВНИМАНИЕ
Некоторые фотоаппараты увеличивают размер изображения посредством интерполяции.
Отнеситесь к этому внимательно и не путайте фактический размер матрицы с размером
получаемой фотографии. При интерполяции программное обеспечение камеры на основе
имеющихся данных вычисляет промежуточные значения, которые необходимы для увели-
чения снимка. Таким образом, новые данные являются результатом «наилучшего предполо-
жения», сделанного программным обеспечением, и обычно они гораздо хуже соответствуют
реальному объекту, чем получаемые от светочувствительных элементов. Неудачно или чрез-
мерно интерполированные изображения имеют плохое цветовое качество и выглядят не-
сфокусированными и недостаточно резкими. На мой взгляд, единственной причиной для
пользования фотоаппаратом, выполняющим интерполяцию большей части изображения,
является недостаток финансов. Такой фотокамерой невозможно сделать снимок с макси-
мальной детализацией.

Фотоаппараты этого типа имеют различные формы и размеры, могут быть как
простейшими дальномерными класса «навел-и-снял», так и зеркальными, и их
стоимость может изменяться от $100 до $1000 и более (зеркальные камеры за-
частую стоят дороже $1000). Фотоаппараты также различаются по сложности:
от простейших однокнопочных до имеющих массу различных функций и приспо-
соблений; пользуясь ими, стоит всегда хранить под рукой инструкцию. От мега-
пиксельных камер можно ожидать фотографии хорошего качества размером
от 4 х 5 дюймов1 до 5 х 7 дюймов (примерно от 10 х 15 см до 13 х 18 см) в зависи-
мости от изображения2.

ВНИМАНИЕ
Под «зависимостью от изображения» не скрывается никакой хитрости. При наличии на снимке
элементов, расположенных по диагонали, или сильно детализированных объектов, напри-
мер текстур, его качество пострадает, если сделать слишком большой отпечаток. Нет, пе-
чатать большие фотографии, конечно же, можно — просто не нужно рассматривать их
с близкого расстояния. А если изображение не содержит мелких деталей (например, это
фотография прекрасного огромного голубого неба), ничто не ограничивает вас в размере
отпечатков.

ПРИМЕЧАНИЕ
Одним из фотоаппаратов, который я рассматривал в рамках изучения рынка фотокамер,
был фотоаппарат для Барби, замечательная детская модель класса «навел-и-снял» (рис. 3.4).
Она продается вместе с соответствующим программным обеспечением и дает возможность
детям самостоятельно фотографировать, а затем обрабатывать изображения. Юные фото-
графы могут даже анимировать свои снимки. Я думаю, это прекрасный способ заинтересо-
вать детей фотографией.

Дюйм равен 2,54 мм. — Примеч. перев.

Согласно статистическим оценкам, на конец 2002 года на российском рынке на долю мегапиксель-
ных камер (в основном с объективами с постоянным фокусным расстоянием) досталось лишь 7% от
всех предложений. Это модели стоимостью до $200, самыми дешевыми из которых являются Volcano
DS816A ($69) и Mito DS1300F ($97). Зато 40% предложений принадлежит группе двухмегапик-
сельных камер стоимостью от $250 до $500. Розничная цена двухмегапиксельных камер уже практи-
чески не отличается от цены качественных пленочных автоматических фотоаппаратов, а тенденция
к дальнейшему снижению цен сохраняется. — Примеч. ред.
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Рис. 3.4. Лучший подарок для вашего ребенка

Двух- и трехмегапиксельные фотоаппараты
Хотя мегапиксельные фотоаппараты все еще присутствуют на рынке, сейчас более
обычными являются двух- и трехмегапиксельные модели.

Давайте выполним небольшие вычисления и посмотрим, что же означают все эти
мегапикселы (МР). Двухмегапиксельный фотоаппарат имеет ПЗС-матрицу раз-
мером 1200 х 1800 плюс-минус несколько пикселов. Трехмегапиксельный фото-
аппарат содержит матрицу величиной примерно 1536 х 2048 пикселов. Теперь по-
глядим на это с другой стороны, возможно, более знакомой для вас. При съемке
двухмегапиксельной камерой создаются файлы размером 6 Мбайт. При разреше-
нии 150 dpi (подробнее о разрешении рассказывается в главе 11) из него получается
отпечаток размером 8x10 дюймов. Результатом съемки трехмегапиксельным фото-
аппаратом будет файл размером 9 Мбайт (то есть на 50 процентов больше), и отпе-
чаток вырастает почти до 10 х 15 дюймов. Или, что еще лучше, можно увеличить
разрешение, например, до 200 пикселов/дюйм и тогда напечатать фотографию раз-
мером 8x10 дюймов. Правда, неплохо?

Итак, какой же фотоаппарат покупать? Это непростой вопрос. Можно пойти одним
из двух путей. Первый: остановиться на фотоаппарате с максимальным разреше-
нием, но имеющем небольшой набор возможностей. Или же поступить наоборот:
приобрести камеру с низким разрешением, но с максимальным набором функций.
Можно попытаться действовать и другим способом, а именно обзавестись каким-
нибудь цифровым устройством и взять его с собой, когда пойдете тестировать фото-
аппараты. Лучше всего подойдет карманный компьютер Pocket PC PDA или один
из новых Palm, поскольку большинство карманных компьютеров работают с такими
же картами памяти, что и цифровые фотокамеры. При отсутствии карманного
компьютера можно приобрести переходник — устройство для считывания карт
через порт USB или последовательный порт. Его стоимость относительно невелика,
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а вам все равно придется купить что-либо подобное, если вы серьезно настроены
на приобретение хорошего цифрового фотоаппарата. В магазине сделайте несколь-
ко снимков, запишите порядок тестирования фотоаппаратов и унесите изображе-
ния домой, чтобы их просмотреть и напечатать.

Рис. 3.5. Фотоаппарат FInerix 2600 фирмы Fuji имеет компактный размер, двухмегапиксельную
матрицу и разъем USB (снимок печатается с разрешения FujiFilm)

СОВЕТ
Цифровые фотоаппараты создают папки на картах флэш-памяти. Название папки обычно
начинается с модели фотоаппарата, что упрощает определение соответствия снимка и сде-
лавшей его камеры. Содержимое этих папок можно просмотреть на экране карманного или
обычного компьютера с помощью соответствующего программного обеспечения. Оно, как
правило, поставляется вместе с карманным компьютером или переходником для считыва-
ния карт.

Рис. 3.6. Будьте готовы запечатлеть важные моменты в жизни
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При просмотре изображения на экране монитора обратите внимание на темные
участки. В сильно затемненных или черных областях можно заметить «шум» —
маленькие цветные точки. Это хорошая проверка цветопередачи и качества обра-
ботки матрицей фотоаппарата слабого освещения. Если уровень шума высок, не
стоит покупать такую камеру.

Как уже упоминалось, цифровые фотоаппараты постоянно совершенствуются.
Ежедневно ведется работа над микросхемами и матрицами нового поколения. Это
обещает значительное улучшение качества изображений, получаемых с помощью
цифровых камер, и, возможно, в будущем полную замену традиционных пленоч-
ных фотоаппаратов1.

Полупрофессиональные фотоаппараты
Фотокамеры среднего класса, их также называют полупрофессиональными, могут
создавать изображения размером от 8 до 16 Мбайт. Неудивительно, что эти модет

ли стоят довольно дорого — их цена составляет от $1000 до $5000; за такие деньги
можно купить несколько фотоаппаратов (обычных или зеркальных) с различны-
ми возможностями и характеристиками. Но самое важное, что качество фотогра-
фии, снятой полупрофессиональной камерой, несомненно, будет значительно пре-
вышать качество изображения, полученного с помощью мегапиксельного или
двухмегапиксельного фотоаппарата. Можно быть уверенным, что отпечатки раз-
мером от 5 х 7 дюймов до 8 х 10 дюймов сохранят все мелкие детали.
Однако матрицы камер этого типа все еще принадлежат 4-мегапиксельному диа-
пазону. Фотоаппараты Minolta Dimage F100 4МР и Olympus C-4000 4.IMP стоят
около $450 и являются прекрасным решением проблемы, если вам немедленно
требуется камера с высоким разрешением. Если же вы готовы помедлить с покуп-
кой, общая тенденция показывает, что в течение следующих шести месяцев цены
на 4-мегапиксельные фотоаппараты должны сильно упасть2.

Профессиональные фотоаппараты
Фотокамеры профессионального уровня стоят, начиная примерно от $ 17 000 и не
доходя, разве что, до стоимости права на владение небольшой частью побережья3!
Ожидаемый размер изображения, полученного профессиональным фотоаппара-
том, — от 18 до 36 Мбайт.

' Бывшими двухмегапиксельными стали нынче трех- и четырехмегапиксельные модели. Например,
новинка апреля 2003 года — MINOX DC 2133, компактная двухмегапиксельная камера начального
уровня немецкой компании Minox (www.minox.de) поступила в продажу по пене около $250. Группа
трех- или четырехмегапиксельных моделей стоимостью $500-1000 на российском рынке составляла
30-40%. Новые модели могут быть даже дешевле. — Примеч. ред.

2 Сегодня на российском рынке полупрофессиональные камеры составляют около 10% предложений.
Это 4-5-мегапиксельные камеры. Их стоимость варьируется в пределах $1000-2000, и эти модели
продолжают интенсивно дешеветь. При этом доля фотоаппаратов фирмы Olympus (лидера продаж
начала 2002 года) упала с 40% до 14%. Примерно в равной пропорции предлагаются модели в основ-
ном нескольких ведущих производителей: Canon, Nikon, Casio, Hewlett-Packard, AGFA и Sony
и Minolta. — Примеч. ред.

3 Нижняя граница стоимости профессиональных камер сегодня составляет $2000 (Canon XM2 пред-
лагается за $2220), а верхняя — около $30 000. Количество предложений в Петербурге измеряется
единицами. В основном это продукция Nikon и Canon. — Примеч. ред.
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В такие модели, как Nikon D1, на место пленки встроена светочувствительная мат-
рица и набор микросхем, обрабатывающих изображение, за счет чего эти камеры
имеют небольшую толщину и облегченный вес (рис. 3.7). Их предпочитают многие
фотожурналисты и спортивные фотографы.

Рис. 3.7. Фирма Nikon предлагает профессиональным фотографам серию камер D1,
в которых используется корпус и объектив традиционного пленочного фотоаппарата

Другие компании, такие как MegaVision и Phase One, производят съемные при-
ставки, которые присоединяются к фотоаппарату (рис. 3.8). Их, как правило, уста-
навливают на фотокамеры Hasselblad и Fuji 680.

Рис. 3.8. Одноразовая цифровая приставка Phase One LightPhase

Сканирующие приставки обычно присоединяются к задней стороне крупноформат-
ных ( 4 x 5 дюйма) фотокамер. Они создают файлы размером 100-200 Мбайт.
С таким количеством информации можно сделать все, что угодно! Достойный
пример подобной приставки показан на рис. 3.9.

ПРИМЕЧАНИЕ
Вы когда-нибудь удивлялись тому, что в ежедневной газете появилась, например, фотогра-
фия награждения олимпийского чемпиона буквально через несколько часов после самого
события? Сейчас многие фотокорреспонденты пользуются радио- и спутниковым оборудо-
ванием, позволяющим пересылать изображения прямо на компьютер редактора газеты.
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Рис. 3.9. Сканирующая приставка Phase One PowerPhase FX

Следует запомнить
При всем доступном многообразии моделей с самыми различными характери-
стиками лучше всего провести небольшое исследование и найти оптимальное
решение.

Необходимо решить, какое качество фотографий является для вас приемлемым.
Не стоит покупать слишком сложный фотоаппарат, но желательно оставить
возможность и для профессионального роста.

Не следует тратить все имеющиеся деньги на приобретение самой дорогой каме-
ры. Помните о необходимости покупки также нескольких источников питания,
карты памяти и соответствующего компьютерного оборудования.

Чем большее разрешение имеет матрица фотоаппарата (количество мегапиксе-
лов), тем лучше. Но если вы ограничены в средствах, не покупайте матрицу
большую, чем требуется для ваших целей.



Глава 4

Характеристики цифровых
фотоаппаратов

а Полезные характеристики фотоаппаратов
Q Многое зависит от объектива
а Не обольщайтесь вспышкой
О Как определить качество жидкокристаллического экрана или видоискателя
О Сохранение и загрузка изображения

Потребители редко могут быстро ответить на вопрос, фотоаппарат с какими ха-
рактеристиками они хотели бы приобрести. И снова предлагается, прежде всего,
определить, как будет использоваться фотокамера. Вы собираетесь снимать в основ-
ном на открытом воздухе или в помещении? Планируете ли вы создавать фотографии
объектов с большой детализацией? Требуется ли мощная вспышка или точная
система определения экспозиции и фокусировки или желательно иметь и то
и другое? Хотите ли вы, чтобы фотоаппарат помещался в карман, или вам удобнее
носить сумку с камерой? Современные фотоаппараты часто снабжаются жидко-
кристаллическими экранами предварительного просмотра, на которых, к сожале-
нию, иногда бывает сложно как следует рассмотреть объект съемки. Чтобы оценить
экран, выйдите с камерой на улицу-и посмотрите на него при ярком свете.
Теперь перейдем к подробному рассмотрению конструкции фотоаппаратов.
Помните, что при покупке фотоаппарата не стоит доверять первому впечатлению.
Лучше всего иметь возможность протестировать фотоаппарат перед его приобре-
тением. Узнайте, может быть, продавец позволит вам прогуляться с демонстраци-
онной моделью.

Конструкция фотоаппаратов
В наше время производятся цифровые фотокамеры разных размеров и форм,
но при этом большинство из них не превосходит по величине своих пленочных
собратьев. Ведь у цифровой камеры отсутствует ряд механических ограничений,
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накладываемых на пленочные фотоаппараты. Например, не требуется место под
систему перемотки пленки. Конструкция цифровой камеры должна удовлетворять
всего лишь одному основному требованию: объектив и светочувствительная мат-
рица должны располагаться на одной линии.

Фотоаппараты с поворотным видоискателем
Конструкция новых цифровых фотоаппаратов часто допускает вращение видоис-,
кателя относительно корпуса камеры. Это в основном можно увидеть на камерах,
оснащенных жидкокристаллическим (LCD — Liquid Crystal Display) видоискателем.
При этом жидкокристаллический экран располагается в одной части камеры,
а объектив, вспышка и оптический видоискатель, если таковой имеется, — в другой.,
Конструкция вида «книжка», то есть когда жидкокристаллический видоискатель'
вращается относительно основной части фотоаппарата только в одной плоскости, ̂
в английском языке получила название split, что можно перевести как «переламы-
ваемая». Пример фотоаппарата с подобной конструкцией изображен на рис. 4.1.
Если экран можно вращать в нескольких плоскостях, например, «раскрыть книжку»
и повернуть объектив относительно экрана так, чтобы снимать небо, глядя при
этом прямо вперед, то конструкция называется pivot, или поворотной1. Наличие
жидкокристаллического экрана позволяет просматривать изображение и одновре-
менно фотографировать, что значительно облегчает процесс съемки. Эти фотоап-
параты замечательны, особенно если жидкокристаллический дисплей работает
в реальном времени (как на видеокамерах). Например, фотограф в толпе может
держать фотоаппарат над своей головой, направляя объектив на предмет съемки,
и контролировать свои действия с помощью жидкокристаллического экрана, как
будто пользуется перископом!

Рис. 4.1. Великолепный фотоаппарат Nikon 995 с «переламываемой» конструкцией имеет
единственный недостаток: к нему нужно привыкнуть

СОВЕТ
Вы, наверное, много раз видели в толпе фотографов, держащих камеры над головой
в стремлении что-то сфотографировать. Эти парни довольно неплохо представляют, что
«видит» фотоаппарат. Кроме того, они немного жульничают, используя широкоугольные
объективы, которые увеличивают область обзора. Это намного лучше, чем пропустить важный
снимок или сфотографировать затылок стоящего впереди коллеги.

1 В русскоязычной литературе достаточно часто оба вида конструкций фотоаппаратов называют по-
воротными. — Примеч. перев.
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Одна фотокамера, Minolta Mirage V, имеет разъемную конструкцию, позволяющую
отделять от основного корпуса блок, содержащий объектив и светочувствительную
матрицу (рис. 4.2). С фотоаппаратом он соединяется при помощи кабеля. Это дает
возможность фотографу отдельно использовать объектив, располагая его в трудно-
доступных местах. Я уверен, что у Джеймса Бонда было что-то подобное.

Рис. 4.2. Теперь удобно делать фотографии под разными углами

Другие конструкции камер
Зеркальные цифровые фотоаппараты также порой выглядят нетрадиционо, напри-
мер Olympus DL 620, изображенный на рис. 4.3. Например, это происходит, когда
конструкция корпуса позволяет вместить вспышку большего размера или видоиз-
менена для того, чтобы пользователю было комфортно держать ее в руках.

Рис. 4.3. Отлично выглядящий фотоаппарат Olympus DL 620

На что бы ни была похожа камера, перед тем как достать кошелек и расплатиться,
обязательно попробуйте подержать ее в руках. Ведь вам предстоит делать это
в течение долгого времени, поэтому желательно представлять свои будущие ощу-
щения. Любители «фотоохоты» (все догадались, о ком идет речь) предпочтут ка-
меру, которую максимально удобно держать в руках. Мысленно ответьте на следу-
ющие вопросы.

Q Хорошо ли фотоаппарат сбалансирован?

Q Удобно ли его держать?

Q Сможете ли вы им пользоваться, если вы левша?

а Не устанет ли ваша рука держать камеру у глаз?
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Конечно, способность фотоаппарата складываться, сворачиваться и «завязывать-
ся в узел», причем автоматически, удобна, но не первостепенна. Можно прекрасно
работать с камерой, имеющей одну из стандартных форм. Поэтому перед покуп-
кой фотоаппарата обязательно следует оценить, как вы фотографировали раньше
и как намереваетесь снимать в будущем. Немаловажным фактором в выборе каме-
ры является ваш бюджет. Можно купить более простой фотоаппарат, сэкономив
на этом довольно значительную сумму, на которую затем приобрести другие необ-
ходимые вещи, например принтер более современной модели или книгу знамени-
того фотографа с его автографом.

Элементы питания
Легко понять, что ни один цифровой фотоаппарат с разрядившимися батарейка-
ми не будет работать, поэтому следует заблаговременно узнать количество и тип
источников питания, которые требуются для функционирования вашей камеры.
При этом батарейки или аккумуляторы не только увеличивают вес фотоаппарата,
но и опустошают ваш кошелек. Следует ответить на вопрос: используемые каме-
рой элементы питания легкодоступны или это какой-то определенный нестандар-
тный тип? Внимательно прочитайте сопроводительную документацию на вашу
камеру. В большинстве случаев в ней можно найти информацию о количестве сним-
ков, которое камера может сделать на одном наборе батареек. Убедитесь, что нор-
мы рассчитаны с включением работы вспышки, так как она, несомненно, понадо-
бится вам на практике.
Сейчас в продаже можно найти элементы питания различного типа. Некоторые
батарейки (обычно они предназначаются для фотооборудования) до разрядки ра-
ботают на полную мощность; батарейки другого типа (как правило, это дешевые
щелочные батарейки) по мере разрядки дают вес меньше и меньше энергии. Ще-
лочные батарейки являются самыми стандартными и стоят дешевле всего, но пе-
резаряжать их не рекомендуется. Более дорогие литиевые батареи тоже нельзя
перезаряжать, но они имеют больший срок службы. Никель-кадмиевые аккумуля-
торы (NiCd — Nickel Cadmium) допускают перезарядку и хороши как в экономи-
ческом, так и в экологическом смысле. Аккумуляторы этого типа перед зарядкой
необходимо полностью разрядить, в противном случае в них развивается так на-
зываемый «эффект памяти». Другими словами, если перезарядить аккумулятор,
заполненный на две трети, с этой поры его всегда придется заряжать, когда он по-
лон на две трети, и он будет работать только на две трети мощности. Также в фото-
аппаратах используются никель-металлогидридные аккумуляторы (NMH — Nickel
Metal Hydride), которые имеют большую мощность и более долгий срок эксплуа-
тации по сравнению с никель-кадмиевыми элементами питания. Дополнительным
преимуществом является отсутствие у них «эффекта памяти», что дает возмож-
ность перезаряжать эти аккумуляторы в любой момент. Они стоят немного доро-
же, но заслуживают вложения денег.

ВНИМАНИЕ
Многие аккумуляторные батареи, особенно аккумуляторы NiCd, обладают так называемым
«эффектом памяти». Если они не были до конца разряжены перед перезарядкой, их емкость
уменьшится на величину неиспользованного заряда.
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ВНИМАНИЕ
Если кажется, что элементы питания почти «истощились», так как фотоаппарат работает
слишком медленно, существует прекрасный способ гарантировать полную разрядку: вставьте
аккумуляторы в фонарик и оставьте его включенным. Когда фонарик перестанет светить,
можно будет с уверенностью сказать, что аккумуляторы окончательно «выдохлись». Теперь
их можно заряжать.

Приобретая фотоаппарат, следует учесть, продается ли в комплекте с ним устрой-
ство для зарядки аккумуляторов (рис. 4.4) или же его придется покупать отдель-
но. Также важно знать, насколько быстро работает зарядное устройство, которое
вы будете использовать для своей камеры.

СОВЕТ
Если хранить аккумуляторы, объединяя их по несколько штук, процесс определения време-
ни их последней зарядки и текущего состояния упрощается. При этом имеет смысл поста-
вить на аккумуляторы цветные метки или пронумеровать их.

Рис. 4.4. NMH-аккумуляторы и зарядное устройство, входящие в комплект фотоаппарата
Olympus DL 620

Многие зарядные устройства позволяют подзаряжать аккумуляторы. Устройство
передает небольшой заряд аккумулятору до его полной зарядки и в этот момент
останавливает процесс. Это позволяет хранить аккумуляторы в зарядном устрой-
стве, что гарантирует их готовность к работе в любой момент. Если же зарядное
устройство не обладает таким свойством, рассматриваемый процесс будет продол-
жаться и после достижения максимально возможного насыщения, что в итоге при-
ведет к повреждению аккумуляторов и зарядного устройства. Нужно быть внима-
тельным при зарядке аккумуляторов. Я в свое время обнаружил, что зарядное
устройство и аккумуляторы достаточно сильно нагреваются, поэтому не следует
держать рядом с ними легковоспламеняющиеся предметы, например бумагу.

Некоторые фотоаппараты оснащаются адаптерами переменного тока, что по-
зволяет подсоединять камеру к бытовой электросети и заряжать аккумуля-
торы, не вынимая их из камеры. Если вас не смущает, что придется таскать
за собой удлинитель, можно фотографировать, подключив камеру к обычной
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штепсельной розетке. Если же вы забыли зарядить аккумулятор, то у вас просто не
будет иного выхода.

Самым слабым местом цифровых камер являются разрядившиеся или близкие
к этому состоянию элементы питания. Поэтому помните следующее.

Q Всегда имейте под рукой адаптер переменного тока. Старайтесь использовать
его, фотографируя в помещении или передавая файлы на компьютер.

Q Если в течение долгого времени вспышка не требуется, ее лучше выключить,
если такое допускает конструкция фотоаппарата. (Советы по применению
вспышки можно найти в главе 10.)

Q Включать жидкокристаллический экран предварительного просмотра желательно
на минимально возможное время и нужно не забывать его выключать. Особенно
если фотоаппарат уже давно просто болтается у вас на шее.

Q Не стоит без надобности выводить камеру из режима экономии энергии.
По легкому шуму, который издает включенный фотоаппарат, легко заме-
тить, что он производит какие-то действия для перехода в этот режим. Напри-
мер, объектив с переменным фокусным расстоянием самостоятельно «скла-
дывается» в исходное состояние. При переходе камеры в экономичный режим
в ней отключается большинство потребителей энергии. Обычно для ее возвра-
щения в рабочий режим достаточно простого касания кнопки, управляющей
затвором.

ВНИМАНИЕ
Перед съемкой следует в обязательном порядке проверять элементы питания. Желательно
иметь при себе запасной набор батареек, особенно если планируется много фотографиро-
вать, — как правило, сожалеть об этом не приходится.

Иногда в продаже встречается маленький вспомогательный батарейный блок,
содержащий от четырех до шести высокоемкостных аккумуляторов (рис. 4.5). Его
можно подключать к входному разъему для внешнего источника постоянного тока,
который размещен на боковой крышке корпуса камеры, куда обычно подсоединя-
ется зарядное устройство или источник дополнительного питания. Батарейный
блок способен работать в два или три раза дольше обычных элементов питания.
Его нетрудно найти в магазинах, продающих профессиональную фото- или видео-
технику.

Рис. 4.5. Подобные блоки питания можно подключать к внешнему разъему
для источника постоянного тока
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Объектив
Любой фотоаппарат, кроме самых первых цифровых камер с простым отверстием
в корпусе, имеет объектив. За исключением некоторых наиболее сложных зеркаль-
ных фотокамер большинство цифровых фотоаппаратов снабжаются одним несмен-
ным объективом с переменным фокусным расстоянием1, обычно представляющим
собой комбинацию широкоугольного и длиннофокусного объектива (его фокус-
ное расстояние может меняться от 28 мм до 150 мм). Более подробно объективы
рассматриваются в главе 8.

Чтобы определить, какой объектив стоит выбрать, выполните следующие действия.

а Посмотрите в видоискатель фотоаппарата. Расположите группу людей на рас-
стоянии 10-15 футов (около 3-4,5 м), переведите объектив в широкоугольный
режим (объектив в «сложенном» состоянии) и посмотрите, сколько людей по-
падает в кадр. Если требуется больший обзор, можно попробовать сразу при-
обрести фотоаппарат с более широкоугольным объективом или смириться с тем,
что придется отходить подальше от объекта съемки. (Один шаг назад равноси-
лен изменению фокусного расстояния примерно на 5 мм.) Тот же самый тест
можно применить к длиннофокусному режиму работы объектива. Чтобы сфо-
тографировать ребенка, играющего посередине поля, нужен более мощный длин-
нофокусный объектив, чем для съемки вратаря, защищающего ближние к вам
ворота. Если фотоаппарат имеет небольшую светочувствительную матрицу или
выполняет интерполяцию, важное значение имеют правильные размеры кадра.
Ведь для хорошего качества изображения требуется получить как можно боль-
ше исходных данных, а не интерполированных. Тогда изображение останется
приемлемым, если позднее его понадобится обрезать или увеличить. С точки
зрения решений подобных проблем, чем больше возможное фокусное расстоя-
ние вариообъектива, тем лучше.

ВНИМАНИЕ
Многие фотоаппараты при увеличении размера изображения, то есть при приближении
объекта, выполняют интерполяцию данных. Следовательно, их объективы фактически не
являются объективами с переменным фокусным расстоянием. Это вызывает снижение каче-
ства увеличенного изображения. Поэтому следует внимательно проверять действительное
оптическое фокусное расстояние объектива.

СОВЕТ
При сравнении фотоаппаратов различие фокусных расстояний двух объективов в несколько
миллиметров обычно не принимается во внимание. Значимая разница должна составлять
больше 10-15 процентов.

а Принцип работы объектива. Можно ли менять режим работы объектива вручную
или для этого следует нажать на кнопку, чтобы все сделал двигатель? (Не нужно
забывать о том, что на любое движение частей фотоаппарата тратится энергия
батареек!) Если все выполняется автоматически, то насколько быстро выдви-
гается и складывается объектив?

В англоязычной терминологии zoom. В русскоязычной литературе также используется термин варио-
объектив. — Примеч. перев.
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Q Качество изображения. Достаточно ли резкими получаются снимки? Насколько
хорошо выглядит изображение? Какова контрастность фотографий? Оцените
объектив по перечисленным признакам, просмотрев сделанные изображения
на экране компьютера. При сравнении объективов используйте один и тот же
монитор, не меняя его настроек! Просматривать фотографии, снятые одним
фотоаппаратом, дома, а другим — на работе, бессмысленно.

Q Резкость фотографии. Оптическая система многих объективов сделана из
пластмассы. Как правило, этого достаточно, но стеклянная оптика, несомнен-
но, работает лучше. Однако в фотоаппаратах, имеющих небольшую светочув-
ствительную матрицу или сильно интерполирующих изображение, не нужна
стеклянная оптика, поскольку такая камера все равно не в состоянии воспроиз-
вести разницу в деталях, предоставляемую стеклянной оптикой по сравнению
с пластиковой.

а Использование фильтров. Можно ли надевать на объектив фильтры? Требуют-
ся ли фотоаппарату специальные фильтры или можно воспользоваться филь-
трами с других камер? Сумеете ли вы работать с фильтрами, приобретенными
ранее? Некоторые камеры оснащаются встроенными устройствами, закрываю-
щими объектив, когда он не используется, с целью его защиты. Но из соображе-
ний безопасности неплохо иметь постоянно надетый на объектив прозрачный
ультрафиолетовый светофильтр. Он выполняет две полезных функции: филь-
трует ультрафиолетовое излучение («дымку») и защищает объектив от грязи,
отпечатков пальцев и носов собак и т. п.

а Светосила объектива. Светосила характеризует количество света, передаваемо-
го объективом на матрицу или пленку. Чем больше света пропускает объектив,
тем больше его светосила. Поскольку цифровые фотоаппараты не так чувстви-
тельны к свету, как пленочные, и плохо обрабатывают снимки, сделанные при
слабом освещении, лучше иметь максимально светосильный объектив (рис. 4.6).

Светосила объектива определяется диафрагменным числом, отвечающим
за пропускаемое объективом количество света. Чем ниже диафрагменное чис-
ло, тем больше светосила объектива. Например, объектив с диафрагменным чис-
лом 2,8 пропустит больше света, чем с диафрагмой 3,5. Почему используется
такая, на первый взгляд бестолковая, система нумерации диафрагм? Об этом
рассказывается в главе 7.

СОВЕТ
Правда ли, что объектив с диафрагменным числом 2,8 более светосильный, чем с 3,0? Да,
но не намного. Однако если бы мне пришлось выбирать из двух одинаковых моделей (в том
числе и по цене), но с разными объективами — 2,8 и 3,0, я предпочел бы купить более
светосильный объектив с диафрагменным числом 2,8.

Система автофокусировки. Во многих фотоаппаратах используются услож-
ненные методы автоматической фокусировки объектива. Иногда для опреде-
ления расстояния до объекта применяется ультразвуковой дальномер, в дру-
гих случаях с этой же целью оценивается контраст изображения. На самом деле
не имеет значения, каким образом камера выполняет автофокусировку — глав-
ное, чтобы она делала это хорошо.



62 Глава 4. Характеристики цифровых фотоаппаратов

Мой совет: возьмите камеру, которую собрались покупать, и посмотрите, сколько
времени требуется ей для фокусировки. Если аппарат издает какие-то звуки,
прислушайтесь к ним. Проверьте качество фокусировки камеры. Попытайтесь
направить ее на два объекта, находящихся на разной дистанции (например, на
одного человека, стоящего чуть ближе группы людей), и посмотрите, на каком
из объектов она будет сфокусирована.

Рис. 4.6. Следует проверить сведения об объективе, максимальное фокусное
расстояние и диафрагменное число

Самые дешевые фотоаппараты («мыльницы») обычно оснащены объективами без
системы фокусировки. Все такие камеры сфокусированы на бесконечность (на
удаленные объекты), фотограф не в состоянии приблизить объект съемки, и рез-
кими получаются только предметы, расположенные на некотором расстоянии от
объектива. Такой камерой невозможно сделать хороший портрет или, например,
сфотографировать бабочку крупным планом. Более сложные фотоаппараты име-
ют объективы с постоянным фокусным расстоянием, которые допускают фокуси-
ровку. Объективы этого типа до недавнего времени были принадлежностью боль-
шинства зеркальных фотоаппаратов. Как правило, фотографы носили с собой
целый арсенал сменных объективов, каждый из которых имел постоянное фокус-

' ное расстояние: обычный, «длиннофокусник», «широкоугольник» и т. д. Более
подробно объективы рассматриваются в главе 8, а здесь сделует сказать, что если
вам требуется сделать резкими именно листья дерева, а не цветы перед ними, объек-
тив обязательно должен иметь систему фокусировки.

Вспышка
Если фотоаппарат не оснащен встроенной лампой-вспышкой1, вряд ли стоит его
покупать. Хотя к профессиональным моделям это не относится. Как упоминалось
ранее, при съемке фотографий цифровой камерой всегда необходимо дополнитель-
ное освещение. Только в этом случае они будут иметь приличное качество.

' В англоязычной терминологии flash — читая инструкции, не путайте с памятью аналогичного назва-
ния. — Примеч. перев.
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Хотя производители фотоаппаратов должны указывать в сопроводительной доку-
ментации мощность вспышки, они не всегда делают это! Размер лампы никак не
связан с мощностью вспышки (рис. 4.7), поэтому лучшим способом проверки ее
качества является тестирование. Снимите двумя фотоаппаратами один и тот же
объект, не меняя расстояние до него (этот тест предназначен для камер с одинако-
вой чувствительностью матрицы, измеряющейся в единицах ISO (International
Standards Organization — Международная организация стандартов)), и затем, загру-
зив обе фотографии на компьютер и открыв их в программе просмотра изображений,
сравните яркость объектов. Также оцените подсветку фона. Чем больше освещен
задний план, тем лучше. Приведите объективы в короткофокусное положение
и повторите опыт. И в данном случае, чем большая область освещена, тем лучше.

Кроме того, следует принять во внимание расположение вспышки на корпусе ка-
меры. Она должна быть максимально удалена от объектива (что довольно трудно
осуществить на фотоаппаратах с маленькими корпусами). Это помогает лучше
представить тени и избежать эффекта «оленя, пойманного светом фар». Если
вспышка расположена рядом с объективом, эффект «красных глаз» значительно
усиливается. То есть люди на снимках имеют красные глаза.

Рис. 4.7. Маленькая, но эффективная вспышка, встроенная в корпус фотоаппарата Minolta

СОВЕТ
При выборе фотоаппарата попробуйте взять с собой измеритель энергии вспышки, чтобы
получить качественную оценку ее мощности. Такие приборы можно приобрести в большин-
стве магазинов, торгующих профессиональной фототехникой.

ПРИМЕЧАНИЕ
Эффект красных глаз возникает, когда вспышка находится слишком близко к объективу,
поскольку при этом свет от вспышки направляется прямо в лицо объекту, и фактически
происходит съемка сетчатки глаз. Это чаще всего случается, когда зрачок объекта расши-
рен, например при съемке в темной комнате, В некоторых камерах применяется так назы-
ваемый метод уменьшения эффекта «красных глаз» — чтобы вызвать сокращение зрачка,
перед съемкой кадра вспышкой генерируется серия предварительных световых импульсов.
Эта техника дает неплохой результат, хотя и приводит к дополнительному расходу энергии.
Кроме того, если вы замечали, часто люди на фотографии имеют раздраженное или комич-
ное выражение лица! Поэтому стоит изучить альтернативные методы освещения, о которых
пойдет речь в главе 10.
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Также важен интервал заряда вспышки, то есть время, требующееся, чтобы заря-
дить ее после съемки кадра. Нет ничего хуже, чем ждать, когда же, наконец, заря-
дится вспышка. Если в фотоаппарате находятся свежие батарейки, это происхо-
дит почти мгновенно. Если же вспышка заряжается слишком долго, это является
хорошим показателем того, что батарейки начали разряжаться. Какой промежу-
ток времени считается слишком долгим? Не вдаваясь в философские размышле-
ния, сведу понятие «слишком долго» к следующему — это когда фотографу прихо-
дится ждать, вместо того чтобы фотографировать. Значит, пришла пора менять
батарейки.

В фотоаппаратах с поворачивающимися экранами предварительного просмотра
вспышка должна перемещаться вместе с объективом и всегда быть направлена в
ту же сторону. Хотя я такого никогда не видел, в принципе возможно сделать так,
чтобы вспышка «смотрела» в сторону, отличную от оптической оси объектива. Это
применяется для создания рассеянного освещения.

Видоискатель
На непрофессиональных фотоаппаратах используются два типа видоискателей.

Q Большинство камер имеют встроенный в корпус жидкокристаллический экран
(LCD screen — liquid crystal diode screen), на котором отображается объект съемки,
видимый объективом (рис. 4.8). На нем может показываться только что сфото-
графированное изображение или — в активном режиме — демонстрироваться
в реальном времени сцена, на которую нацелен объектив. Но при ярком свете
на этом экране сложно что-либо разглядеть. Обычно в солнечную погоду я при-
крываю экран рукой, чтобы лучше видеть изображение. Фотоаппарат Epson
Photo PC 750 имеет специальный маленький козырек, позволяющий затенить
экран, что намного облегчает просмотр объекта съемки при ярком свете. Подоб-
ные приспособления можно обнаружить и на других фотоаппаратах. Я решитель-
но рекомендую перед покупкой проверять поведение жидкокристаллического
экрана камеры при ярком освещении или на улице. Если возникают проблемы
с просмотром, вряд ли стоит приобретать такую камеру.

Рис. 4.8. Яркий жидкокристаллический экран упрощает просмотр изображений
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СОВЕТ
Изображение на жидкокристаллическом экране имеет наибольшую четкость, если вы смот-
рите на него под углом 90 градусов. Следует проверять, насколько хорошо экран работает
при приглушенном или ярком освещении. Также нужно принять во внимание отображаемые
на экране дополнительные сведения (на нем может указываться количество кадров, сте-
пень сжатия, состояние элементов питания, текущие дата и время и т. п.). И еще желатель-
но, чтобы на экране фотоаппарата демонстрировалась информация о состоянии элементов
питания.

Другой вариант — простой оптический видоискатель (рис. 4.9). При отсутствии
жидкокристаллического экрана увидеть объект съемки можно только в обыч-
ный видоискатель. Если в камере имеется какая-либо измерительная система,
то в видоискателе может отображаться соответствующая информация (например,
световые сигналы и цифровые данные), также на него могут быть нанесены
отметки, обозначающие размер кадра в короткофокусном и длиннофокусном
положении объектива. Идеально, если видоискатель имеет индикатор готовности
камеры к съемке. Это приспособление позволяет искать объект съемки и фото-
графировать, не отрывая глаз от видоискателя.

Рис. 4.9. Элементы оптического видоискателя. Обратите внимание на светодиодные индикаторы

Если фотоаппарат обладает оптическим видоискателем, подумайте о следующих
факторах:

Q Удобно ли смотреть через видоискатель?

О Не слишком ли мал его размер?

Q Не мешает ли вам нос?

Q Если вы носите очки, не являются ли они помехой?

О Если на видоискателе отсутствует защита, не поцарапаете ли вы очки или свой
лоб?

Q Какая информация присутствует в видоискателе? Хорошо ли ее видно?

Если же, напротив, фотоаппарат оснащен жидкокристаллическим экраном, следует
принять во внимание:

О Как хорошо он просматривается?

Р Как работает экран при ярком освещении?

Q А при тусклом освещении?

О Достаточно ли он большой?
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Мне нравятся фотоаппараты с жидкокристаллическими экранами, но, возможно,
к ним придется некоторое время привыкать — особенно при отсутствии оптического
видоискателя. Камеру следует держать, немного отведя от лица, чтобы видеть экран.

Выборочное удаление снимков
Огромным преимуществом цифровых камер является возможность удаления из-
бранных снимков. При наличии жидкокристаллического экрана можно сразу про-
смотреть все фотографии, которые находятся в данный момент в памяти, и очис-
тить ее от неугодных вам снимков, например фотографий, на которых кто-то закрыл
глаза. Действуя так, вы экономите столь нужное место в памяти камеры,

Устройства хранения информации
Если цифровой фотоаппарат не связан с компьютером постоянно, вам не обойтись
без запоминающего устройства. Существует множество вариантов хранения ин-
формации, и самой сложной задачей при сравнении фотоаппаратов является вы-
бор типа памяти. Перечислим возможные варианты:
О Если в фотоаппарате не предусмотрено использование сменной памяти (карт

памяти), значит, он имеет встроенную память. Обычно это ОЗУ — оператив-
ное запоминающее устройство1. Очевидно, что чем больше размер памяти, тем

. реже требуется переносить изображения с камеры на компьютер. И весьма не-
приятно, если после шести или восьми снимков необходимо бежать к компью-
теру и копировать фотографии на жесткий диск.

а Некоторые камеры, обычно достаточно дорогие, имеют как встроенную, так
и сменную память. К встроенному ОЗУ камера обращается быстрее, чем к смен-
ной памяти, и поэтому именно оно обычно используется в качестве буфера.
Фотоаппарат сохраняет изображения в буфер, прежде чем передать их на карту
памяти, что ускоряет процесс подготовки камеры к следующему снимку. Кро-
ме того, пока фотографии находятся в буферной памяти и при наличии у каме-
ры соответствующей функции, можно менять степень сжатия.

Q В картах флэш-памяти (сменное устройство хранения информации)2 исполь-
зуется технология, позволяющая хранить данные без постоянного подпитывания
энергией. Существует множество карт разных размеров, форм и емкости. Напри-
мер, в фотоаппаратах с большими корпусами и/или более профессиональных
камерах применяются карты PCMCIA3 (также именуемые PC Card), которые
размером и формой напоминают толстую визитку. Карты PCMCIA бывают I,
II и III типов, флэш-память, как правило, выпускалась I и II типа. Стопка из пяти
или шести металлических карт PCMCIA занимает столько же места, что и короб-
ка из-под пленки, а их емкость измеряется десятками мегабайтов.

' В англоязычной терминологии RAM ( Random Access Memory — память с произвольным доступом). —
Примеч. перев.

2 В англоязычной терминологии flash card memory, иногда называется flash film (флэш-пленка). —
Примеч. перев.

3 Стандарт PCMCIA — Personal Computer Memory Card International Association — Международная
ассоциация карт памяти для персональных компьютеров. — Примеч. перев.
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ПРИМЕЧАНИЕ
Карты PCMCIA, PC Card, память типа I, карты АТА и AT — это разные названия одного уст-
ройства.

О Карты памяти PCMCIA типа III, фактически являющиеся миниатюрными жест-
кими дисками, вмещают больше, чем карты флэш-памяти. Их емкость достигает
1 Гбайт.

а Карты CompactFlash аналогичны картам PC Card, но меньше их в полтора раза
(рис. 4.10, 4.11). Каждая карта вмещает до 512 Мбайт информации.

Рис. 4.10. Карта CompactFlash

Рис. 4.11. Карта PC Card

О Карты SmartMedia, также называемые SSFDC1, представляют собой другой тип
сменной памяти (рис. 4.12). Они имеют длину и ширину спичечной коробки,
толщину около 1/8 дюйма и емкость от 2 до 128 Мбайт. Они выглядят достаточ-
но прочными, но на самом деле являются более хрупкими, чем карты PC Card.
Этот недостаток перевешивается широтой их распространения. Для передачи
изображений на компьютер можно использовать адаптер SmartMedia — малень-
кое устройство, в которое вставляется карта SmartMedia. Кроме того, и другая
техника, например принтеры, теперь содержит разъемы, позволяющие вставлять

Solid State Floppy Disk Card — карты твердотельных флоппи-дисков. — Примеч. перев.
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эти карты прямо в нее. Учитывая размеры и совместимость карт SmartMedia,
я вполне допускаю, что со временем они станут стандартным сменным устрой-
ством.

Рис. 4.12. Карта SmartMedia

Рис. 4.13. Сравните размеры карты SmartMedia и фотоаппарата Minolta

ПРИМЕЧАНИЕ
Приятным свойством карт памяти является возможность одновременно фотографировать,
вставив одну карту в камеру, и переносить снимки на компьютер с другой карты.

Новые устройства хранения информации постоянно совершенствуются и дешеве-
ют. Например, IBM выпускает миниатюрный жесткий диск, который называется
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Microdrive и вмещает 340 Мбайт. Кроме того, фирма Sony продает модули памяти
Memory Stick, имеющие габариты 0,85 х 1,97 х 0,11 дюймов (21,6 х 50 х 2,8 мм),
вмещающие до 128 Мбайт информации. Подобные устройства разрабатываются
для взаимосвязи между фотоаппаратами, принтерами и центральными процессо-
рами компьютеров.

ПРИМЕЧАНИЕ -
Некоторые производители фотоаппаратов конструируют и изготавливают свои собствен-
ные карты памяти, имеющие уникальные размеры и форм-фактор и подходящие только к
оборудованию, выпущенному этим производителем. Хорошим примером являются карты
CompactFlash. Поэтому перед приобретением карт памяти следует удостовериться в том,
что они совместимы с фотоаппаратом. Кроме того, возможно, в будущем вы поменяете
камеру или же попадете в компанию, в которой у всех есть фотоаппараты и принято обме-
ниваться картами или одалживать их. Карты являются капиталовложением, поэтому имеет
смысл пользоваться ими как можно дольше.

Фирма Sony также выпускает миниатюрные компакт-диски, которые подходят
к производимым ею фотоаппаратам серии Mavica CD. Эти компакт-диски встав-
ляются в камеру и могут вместить до 156 Мбайт данных! Также можно купить диск
CD-RW, который допускает многократные считывание и запись.

Виды передачи изображений
Существует два способа переноса данных с фотоаппарата на компьютер.
Q Кабельное соединение. При этом способе переноса данных лучше оставлять

кабель присоединенным к компьютеру, чтобы избежать проблем с поврежден-
ными разъемами.

Q Съемный накопитель. Для работы со съемным накопителем необходимо спе-
циальное устройство (переходник), которое также следует оставлять подсо-
единенным к компьютеру во избежание путаницы при подключении.

Перед тем как выбрать вид передачи изображений на компьютер, учтите представ-
ленную далее информацию. Кроме того, вам потребуется принять во внимание сто-
имость кабелей или адаптеров.
Q Большинство фотоаппаратов, особенно модели, не использующие сменные кар-

ты памяти, позволяют загружать изображения через кабель. Обычно это кабель
для последовательного порта, подсоединяемый к задней стенке или панели си-
стемного блока компьютера.

Q Постепенно основным стандартом становятся переходники и кабели для связи
через порт USB (Universal Serial Bus — универсальная последовательная шина);
с их помощью можно подсоединять к компьютеру и другое оборудование
(рис. 4.14). Принято считать, что USB-кабели, через которые передача данных
происходит намного быстрее, скоро заменят традиционные кабели для подклю-
чения к последовательному порту, а заодно станет не нужен и сам порт. Неко-
торые фотоаппараты имеют только USB-разъем. При покупке следует выбрать
фотоаппарат или другое устройство с портом USB вместо его последователь-
ного аналога.
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Рис. 4.14. Рабочие части кабеля USB

ВНИМАНИЕ
Всегда помните следующее.

Тем, кто любит постоянно что-то вертеть в руках (например, как я), можно предложить
гладкий камешек или небольшой мячик. Не гните, не вытягивайте и вообще не трогайте
лишний раз карту памяти. Считайте, что она хрупкая.

Это не билет мгновенной лотереи, и, стерев металлизированное напыление, вы не получите
приз, скорее наоборот. Старайтесь не поцарапать контакты.

Не трите карту о свитер и не пытайтесь прилепить к стене. К статическим зарядам следует
относиться внимательно. Даже проходя по ковру, не хватайте карту или камеру — возмож-
но, об этом придется пожалеть.

И, раз уж мы заговорили об этом, не роняйте карты. При падении они могут получить не-
большие повреждения.

Вставляя карту в фотоаппарат, правильно направляйте контакты. Затолкнув карту не той
стороной, можно серьезно повредить и карту, и камеру.

Разъемы Fire Wire являются принадлежностью профессиональных фотоаппа-
ратов (используемых вместе с компьютерами Macintosh G3 или G4), так что не
ищите их на камерах, которые стоят меньше $7000. Скорость передачи данных
через этот разъем довольно значительна, кроме того, у вас появляется возмож-
ность подключать фотоаппарат к компьютеру и отсоединять от него, не выклю-
чая машину. Это свойство называется «горячей заменой».

Для передачи изображений на компьютер с карт PC Card и CompactFlash так-
же требуются считывающие устройства, называемые переходниками (рис. 4.15).
Большинство портативных компьютеров имеют встроенный разъем PCMCIA,
кроме того, существуют адаптеры к большинству считывающих устройств для
карт PC Card. Это облегчает работу с картами CompactFlash и SmartMedia.

ВНИМАНИЕ
Никогда не следует подключать к компьютеру или отключать от него периферийные уст-
ройства при включенном в сеть компьютере (если, конечно, это не устройство FireWire или
USB). Вы можете серьезно повредить компьютер.

Q Некоторые фотоаппараты, ярким примером которых является Sony Mavica,
фактически используют стандартные 3,5-дюймовые диски. Представьте себе!
Недавно дисковод для гибких дисков исчез с компьютеров iMac, и вполне ве-
роятно, что в будущем он будет отсутствовать на всех компьютерах. Поэтому
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желательно по возможности избегать необходимости работы с 3,5-дюймовыми
дисками, иначе вскоре вам придется покупать для них отдельный дисковод.

Рис. 4.15. Переходник для карт PCMCIA

Карты SmartMedia можно помещать в адаптеры, которые вставляются в обычный
дисковод для гибких дисков (рис. 4.17). Это имеет смысл, так как большинство
компьютеров все еще оснащены такими дисководами.

Фирма Kodak разработала собственный переходник для передачи файлов
с фотоаппарата на компьютер или принтер. Он изображен на рис. 4.16. При этом
камера Kodak помещается в специальную подставку с вмонтированными разъ-
емами. Его также можно использовать в качестве зарядного устройства для акку-
муляторов и источника энергии для вставленной в него камеры. Фирма Kodak
называет этот переходник ядром своей новой «Easy Share System». Информацию
о подобных приспособлениях от других производителей можно поискать на их
веб-сайтах, в анонсах и рекламе.

Рис. 4.16. Easy Share System фирмы Kodak позволяет вставлять камеру в переходник
и передавать изображения

Рис. 4.17. Адаптер для карт SmartMedia подходит к дисководу для 3,5-дюймовых дисков
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ПРИМЕЧАНИЕ
Многие фотоаппараты оборудованы видеовыходами NTSC, позволяющими подключать ка-
меру к телевизионной технике. Это позволяет просматривать изображения на экране теле-
визора. Вы можете продемонстрировать своим друзьям и родственникам снятые фотогра-
фии, не «перекачивая» их на жесткий диск компьютера.

Непрерывная съемка
При работе с цифровым фотоаппаратом обычно проходит довольно много време-
ни между съемкой отдельных кадров. Это связано с тем, что камера должна обра-
ботать информацию и выполнить обмен между буферной памятью и устройством,
хранящим изображения. В целях борьбы с таким недостатком в некоторых про-
фессиональных камерах предусмотрен режим непрерывной съемки, когда камера
делает до 10 кадров подряд с высокой скоростью (количество кадров и время меж-
ду ними зависит от модели), что очень удобно для съемки движущихся объектов,
например спортсменов или активно ползающего малыша. Мало того, в некоторых
автоматических фотоаппаратах есть режим непрерывной съемки, при котором под-
ряд выполняется четыре или пять снимков одного и того же объекта с разной экс-
позицией, а потом фотограф может выбрать самый лучший из них.

Измерение экспозиции
Чтобы расширить возможность для творчества, требуется камера со встроенным
экспонометром (обычно его показания отображаются-в видоискателе). Этот при-
бор позволяет точно контролировать экспозицию и крайне полезен при съемке
сцен со сложным освещением, например при заднем освещении, когда автоматика
может ошибиться. Но даже при отсутствии экспонометра в некоторых фотоаппа-
ратах допускается выбор скорости работы затвора (выдержки) или размера диа-
фрагмы. Такие режимы называются приоритетными по выдержке или по диафрагме
и являются хорошим компромиссом между полностью ручным и автоматическим
выбором экспозиции.

Более подробно тема экспонирования рассматривается в главе 7.

Разрешение
Фотоаппарат обычно записывает изображения с полным разрешением в файл фор-
мата TIFF (используя при этом все ПЗС-элементы матрицы). Но в целях эконо-
мии пространства на жестком диске камера допускает сохранение изображений
с более низким разрешением. Каждый производитель понимает это по-своему. На-
пример, в одних случаях исходное изображение уменьшается в размере и только
после этого сохраняется (в некоторых фотоаппаратах после завершения данного
процесса снимки дополнительно сжимаются). Хотя такой метод и позволяет уме-
стить на карте памяти большее количество фотографий, его недостатком является
низкое разрешение получаемых изображений.

Также можно снять изображение с полным разрешением и затем упаковать его
с некоторым коэффициентом сжатия, который выбирается фотографом. Хотя
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процесс сжатия немного ухудшает качество снимков, это самый лучший способ.
Понятия разрешения и сжатия более подробно рассматриваются в главе 12.

Светочу вствител ьность
В некоторых фотоаппаратах разрешается менять светочувствительность мат-
риц, измеряющуюся в единицах ISO, что равносильно использованию более
или менее светочувствительной пленки. Не так давно эта система называлась ASA
(от American Standards Association — Американская ассоциация стандартов). Боль-
шая светочувствительность позволяет фотографировать при слабом освещении
и в некоторой степени контролировать экспозицию. Однако следует понимать, что
увеличение светочувствительности означает выполнение матрицей некоторого
типа усиления, что приводит к появлению шума, который возникает в основном
в темных областях изображения в виде синих или синих и красных точек.
Неплохим методом оценки светочувствительности фотоаппаратов является срав-
нение ее нижнего предела, указанного в единицах ISO. Если одна камера имеет
минимальную чувствительность, скажем, ISO 100, а другая — ISO 200, стоит вы-
брать камеру с ISO 200 (конечно, при условии, что цифры не преувеличены).

Вообще говоря, возможность изменения светочувствительности предлагается толь-
ко в фотоаппаратах с большой матрицей и/или в приближающихся к профессио-
нальным. Но наличие этой функции может стать решающим фактором при выборе
из двух во всем остальном одинаковых фотоаппаратов.

Дополнительные приспособления
При покупке фотоаппарата также следует обратить внимание еще на несколько деталей.
Q Фотоаппарат должен снизу иметь гнездо с резьбой, которое позволяет присоеди-

нять штатив. Если гнездо отсутствует, вряд ли стоит приобретать такую модель.
Штативное гнездо должно располагаться так, чтобы установка фотоаппарата
на штатив не затрудняла доступ к карте памяти. В противном случае для замены
карты придется снимать камеру со штатива.

Q Также желательно, чтобы фотоаппарат был оборудован гнездом подключения
кабеля вспышки. Это позволит вам использовать вспышку, не встроенную в фо-
тоаппарат. Такое гнездо можно обнаружить на более дорогих фотоаппаратах.

ВНИМАНИЕ -
Если слишком сильно затянуть винт штатива, его можно вдавить в корпус камеры. У меня
это так и получилось!

Q Как вы собираетесь оказаться на групповом снимке, если в вашем фотоаппара-
те отсутствует автоспуск? Он есть в большинстве камер, но лучше лишний раз
проверить его наличие.

О Тросик (механический или электрический кабель, присоединяемый к фотоаппа-
рату и применяющийся для спуска затвора) крайне полезен для съемки фотографий
с большой выдержкой или при слабом освещении. Использование тросика пре-
дохраняет фотоаппарат от тряски и шатания при нажатии на кнопку затвора.
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Программное обеспечение
Большинство фотоаппаратов поставляются вместе с некоторым пакетом программ.
Часть из них являются полными версиями программных продуктов, другие же
могут иметь ограниченную функциональность или время использования, то есть
они перестанут работать по истечении указанного срока. Это всегда следует
проверять.

Заключение
Всегда сложно принять решение о сроках покупки нового оборудования. Если обо-
рудование по какой бы то ни было причине требуется немедленно, извлеките все
полезное из данной главы и ступайте в магазин. С другой стороны, если на самом
деле вы никуда не торопитесь, вспомните о постоянном появлении различных но-
винок, превосходящих современные модели. Может быть, вы получите информа-
цию, что скоро будет выпущено что-то новое и невероятное, и решите, что это
именно то, что вам нужно. Если вы не прочь некоторое время попользоваться
вчерашними технологиями (которые гарантированно работают), из ожидания мож-
но извлечь пользу. Помните, что произошло, когда вышли в свет новые компьюте-
ры на платформе Intel Pentium III? Цены на Pentium II резко упали! Если же, на-
против, вам требуется все самое современное и самое передовое, приобретайте новое
оборудование, но внимательно проверяйте качество его работы. Новые технологии
могут быть несовершенны, и, возможно, в конечном счете их даже заменят. И если
вы на что-то решились, не пропустите великолепные снимки, откладывая покупку!

Следует запомнить
Q Характеристики фотоаппарата влияют на его цену. Если решить, какие требу-

ются составляющие и возможности, то становится проще определиться с самой
камерой.

Q Учитывайте срок действия элементов питания. Всегда берите с собой дополни-
тельные батарейки и не забывайте заряжать аккумуляторы.

Q Объектив является главным фактором при приобретении фотоаппарата. Вни-
мательно проверьте качество изображения перед тем, как остановиться на кон-
кретной модели.

Q Изображения хранятся на съемных картах памяти. Сэкономьте немного денег
для покупки нескольких дополнительных карт.

Q Кадры можно увидеть как через объектив, так и с помощью жидкокристалли-
ческого экрана, расположенного на обратной стороне камеры. Изображение
может демонстрироваться «в реальном времени» или «по требованию».

Q На жесткий диск компьютера фотографии можно переписать как прямо с каме-
ры, так и вынув карту и «прочитав» ее. Кроме того, многие принтеры способны
считывать файлы с карт памяти и сразу печатать изображения.



Глава 5

Системные требования

Q Какой компьютер лучше, на платформе Macintosh или IBM PC?
Q Требования к компьютеру

Q Выбор монитора
О Необходимые периферийные устройства
Q Как приобрести принтер
Q Как приобрести сканер

В наши дни на рынке представлено множество моделей автомобилей. Это и спор-
тивные модели, машины для семьи и представительские автомобили; некоторые
из них имеют огромные, мощные и потребляющие много бензина моторы, в дру-
гих можно перевозить тонны груза.
Нет, я не занялся ни с того ни с сего написанием «Руководства для начинающих
по покупке автомобиля», а хотел обратить внимание на следующее. Почти на любой
машине можно проехать по дороге. Точно так же дело обстоит и с компьютерами:
практически каждая машина позволяет сохранить и обработать полученное с по-
мощью цифрового фотоаппарата изображение. Вопрос в том, насколько хорошо
компьютер подходит для выполнения этой задачи.

Windows или Macintosh?
Прежде всего, хочется спросить: какая требуется платформа, PC или Мае? Ответ
прост: компьютеры на обеих платформах подходят для редактирования цифровых
снимков.
Программное обеспечение для обработки графики вообще и фотографий в частно-
сти впервые появилось на компьютере Apple Macintosh, и поэтому в течение некото-
рого времени большинство программ для работы с фотографиями разрабатывалось
исключительно для изделий от Apple. Именно экран компьютера Macintosh первым
смог отобразить миллион цветов, что очень важно для работы с изображениями.
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Однако с момента возникновения компьютеров, ныне работающих по преимуществу
под управлением операционной системы Windows, и до наших дней техника и про-
граммы преодолели долгий путь своего развития. Сейчас система Windows предла-
гает удобный графический интерфейс пользователя и PC способны конкурировать
с компьютерами семейства Macintosh. Машины с операционной системой Windows
представляют собой мощные графические компьютеры, также отображающие
на экране миллион оттенков с разрешением, поддерживаемым видеокартой и мони-
тором, и сохраняющие резкость изображения, если его размер и разрешение соот-
ветствуют параметрам монитора (изначально плохой рисунок дисплей не сможет
отобразить с приемлемым качеством).

В основном производители фотоаппаратов разрабатывают свое оборудование так,
чтобы оно подходило к любой платформе. Большинство из них также предостав-
ляют программное обеспечение, работающее в обеих системах. Поэтому не стоит
менять платформу только ради цифрового фотоаппарата. Если же у вас на данный
момент нет компьютера, можно провести собственное исследование проблемы.
Система Macintosh зачастую проще в изучении, но решающим фактором также
может стать и стоимость.

Можно приобрести полностью укомплектованную систему PC с операционной
системой Windows примерно за $500-600 или старый iMac за бесценок, но мне
кажется, что никто не захочет покупать такие компьютеры. Системы, имеющие
низкую цену, так дешевы потому, что в них урезаны некоторые части — именно
это позволяет производителям опустить ценовую планку. Также очень вероятно,
что такие компьютеры состоят из комплектующих, сильно отстающих от совре-
менных технологий. И если у вас нет желания экономить, например, на слесарных
инструментах, то почему нужно экономить на компьютере? Можно ожидать, что
новый компьютер со всем дополнительным оборудованием типа принтера и сканера
обойдется в сумму от $900 до $2000.

ПРИМЕЧАНИЕ -
Перечисленные здесь цены были действительными на момент написания книги. Вполне воз-
можно, что за время, прошедшее до публикации, они упали, хотя бы ненамного. Поэтому
перед покупкой компьютера, особенно модели, еще не выпущенной и не описанной в дан-
ной книге, внимательно проверьте все данные. И будет прекрасно, если вы получите луч-
шее предложение, чем представленные здесь!

Перед приобретением компьютера или фотоаппарата решите, где и как вы хотите
получать техническую помощь. Компьютер вам доставит продавец? Если вы соби-
раетесь приобрести его в крупном магазине, есть ли у них служба доставки? Кроме
того, многие производители оборудования имеют веб-сайты и телефонную служ-
бу поддержки, предлагающие свою помощь. Позвоните производителю или зай-
дите на его веб-сайт, задайте вопрос (придумайте что-нибудь!) и посмотрите, сколь-
ко придется ждать ответа. Сколько прошло часов? И правильный ли это ответ?

Представим, что у вас есть собственный компьютер. Тогда может случиться так,
что пакет программ, которым сопровождается фотоаппарат, уже устарел и не ра-
ботает в вашей новой операционной системе. Обычно обновленные версии про-
грамм можно найти на сайте производителя камеры. В противном случае звоните
в службу технической поддержки — там вам обязаны дать объяснения. Большая
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часть ныне поставляемого программного обеспечения и оборудования сохраняет
работоспособность и в системах Windows 95/98/2000, и на компьютерах Macintosh.
Все вопросы, на которые требуется получить ответ, задавайте продавцу. Будет ли
программное обеспечение функционировать в этой конкретной системе? Учитывая,
что, вероятно, придется обновить некоторые программы, спросите, будут ли но-
вые версии совместимы со старыми в данной системе? Если перед приобретением
фотоаппарата есть возможность получить демонстрационные версии программ-
ного обеспечения, установите их и просмотрите, как они работают. Это ухудшает
производительность машины? Вас беспокоит, что немного замедляется процесс
работы? В конечном счете, всегда можно начать заниматься фотографией, используя
старую систему, и позже приобрести новое оборудование.

Основные составляющие
Компьютер может оказаться бесполезным, если в нем отсутствуют необходимые
компоненты. Поэтому расставим по порядку все составляющие и требуемое до-
полнительное оборудование.

Центральный процессор
Центральный процессор1 компьютера выполняет все вычислительные операции.
Кроме того, он играет роль регулировщика уличного движения для всех других
компонентов компьютера. В системе PC встречаются процессоры от многих про-
изводителей, но наиболее популярны два из них: Intel и AMD. В серии процессо-
ров, выпускаемых фирмой Intel, самые дешевые носят название Celeron, и на дан-
ный момент самым производительным является процессор Pentium 4. Фирма AMD
предлагает процессоры Duron и Athlon, конкурирующие с процессорами от Intel.
В компьютерах от Apple используются процессоры Motorola G3 и G4.

Оперативная память
В оперативной памяти центральный процессор хранит данные, с которыми он рабо-
тает в данный момент. Процессор получает данные с жесткого диска компьютера
и после обработки возвращает их назад, на диск. Почему же тогда информация не
передается с жесткого диска процессору напрямую? Потому что оперативная па-
мять работает намного быстрее, чем жесткий диск. Для Windows 98,98SE, Me или
Windows 2000 Professional я решительно рекомендую иметь минимум 128 Мбайт
оперативной памяти. Windows XP, версии Ноте и Professional, требуют 256 Мбайт
оперативной памяти. На компьютерах Macintosh обычно вполне достаточно для
выполнения любых операций той оперативной памяти, которая входит в состав
системы, но дополнительное ее количество никогда не помешает.

Сейчас оперативная память стоит очень дешево, поэтому покупайте ее больше. Нет
ничего неправильного в том, что компьютер имеет 1 Гбайт оперативной памяти
при условии, что он может управлять таким ее количеством.

1 В англоязычной терминологии CPU (Central Processing Unit — дословно, центральное обрабатыва-
ющее устройство). — Примеч. перев.
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СОВЕТ
Если вы решили нарастить объем оперативной памяти на своей машине, то просмотрите
предложения, представленные в Интернете, в компьютерных журналах и каталогах или
в магазинах. Возможно, вы найдете прекрасные цены, но не торопитесь. Не вся оперативная
память одинакова. Старайтесь покупать продукцию производителей, имеющих достойную
репутацию. Кроме того, микросхемы памяти бывают разной конфигурации, поэтому следует
удостовериться, что конкретная микросхема будет работать на вашем компьютере.

Хотя установка дополнительной памяти на компьютер не представляет собой ничего слож-
ного, возможно, некоторые пользователи предпочтут воспользоваться помощью специали-
ста. В противном случае нужно приобрести заземляющий браслет и следовать инструкциям,
указанным на упаковке микросхемы оперативной памяти.

Шина
Шиной мы назовем трассу, по которой передается информация; она соединяет все
периферийные устройства компьютера, такие как жесткий диск, видеокарту и цент-
ральный процессор. Я обычно провожу аналогию между шиной и автомагистралью.
Чем шире магистраль и чем выше ограничение скорости на ней, тем больше ее
пропускная способность (количество проехавших машин в единицу времени).
Шина обычно связана с типом процессора, так, например, шина на G3 Macintosh
медленнее шины на G4.

Тактовая частота
С помощью тактовой частоты измеряется скорость «мышления» центрального
процессора, она также влияет на общую производительность компьютера. Про-
цессор с тактовой частотой 700 МГц медленнее процессора с частотой 1 ГГц. Что
это означает для пользователя? Если обрабатывается файл, имеющий размер от 4
до 10 Мбайт, то для поворота изображения на компьютере с частотой 700 МГц по-
требуется на несколько секунд больше, чем на компьютере с частотой 1 ГГц. Но если
речь идет о файле размером 100 Мбайт, задержка будет составлять уже несколь-
ко минут. Кроме того, всегда следует учитывать модель центрального процессора.
Так, 1.0 ГГц Celeron (то есть с частотой 1 ГГц) работает не быстрее, чем 1 ГГц
Pentium III, a AMD Athlon XP 1700+ имеет ту же скорость, что и Intel Pentium 4 2 ГГц.

ПРИМЕЧАНИЕ
В системах Apple используется процессор Motorola. Микросхемы Motorola имеют архитектору
RISC (Reduced Instruction Set Computer — компьютер с сокращенным набором команд). Про-
цессоры от Intel и AMD основаны на архитектуре CISC (Complex Instruction Set Computer —
компьютер с полным набором команд). Система RISC, работающая с частотой 1 ГГц, может
иметь равную скорость с системами CISC с частотой 1,5 и 1,7 ГГц.

Жесткий диск
Жесткий диск подобен шкафу с ящиками, на нем хранится вся информация (рис. 5.1).
Здесь действует то же самое правило: чем он вместительнее, тем легче жизнь.
Жесткие диски дешевы, разница в стоимости между моделями емкостью 20, 40,
60 и 80 Гбайт минимальна1, и получается, что диски с большей емкостью лучше

' На лето 2003 года на рынке Петербурга стоимость жестких дисков объемом 40 Гбайт составляла $55-
75, а дисков 80 Гбайт — $80-120. — Примеч. ред.
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и дешевле в пересчете на 1 Гбайт. Каким образом так происходит? Экономические
принципы просты, нужно только разобраться в принципе формирования рыноч-
ных стоимостей. Цены на диски определяются фирмами-изготовителями, такими
как Dell, Apple или HP, поскольку именно фирмы, собирающие компьютеры,
закупают основной объем комплектующих. Когда они перестанут приобретать
диски емкостью 40-80 Гбайт и переключатся на диски емкостью 120-250 Гбайт
(последние уже появились в продаже, но стоят довольно дорого в пересчете
на гигабайты), цены на первые вырастут, а на вторые — упадут. Такую тенденцию
стоит учитывать.

Рис. 5.1. Жесткий диск

На платформе PC жесткий диск подсоединяется к IDE-разъему1, расположенно-
му на материнской плате. Большинство из таких дисков совершают 5400 оборотов
в минуту, но также можно встретить модели, имеющие скорость вращения 7200 об/
мин. Хотя скорость вращения влияет на быстроту доступа к информации, это не
самое главное. И если на компьютере не планируется создавать большие мульти-
медиа-презентации, о скорости доступа к диску можно не беспокоиться.

Аббревиатура IDE образована от Integrated Drive Electronics (встроенная электроника накопите-
лей). В соответствии с этим стандартом управляющая электроника располагается в самом жестком
диске. Основные функции управления жестким диском реализуются встроенным в материнскую
плату IDE-контроллером. За весну 2003 года на российском рынке заметно увеличилось количество
IDE-моделей со скоростью вращения 7200 об/мин, и теперь скорость 5400 об/мин можно встретить
только на самых дешевых моделях. — Примеч. ред.
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ПРИМЕЧАНИЕ
Жесткие диски SCSI (Small Computer System Interface — системный интерфейс малых вычис-
лительных систем) используются в некоторых системах на базе Windows (обычно на серве-
рах), также их можно найти на компьютерах Macintosh. Диски SCSI стоят несколько дороже,
кроме того, в дополнение к ним нужно покупать специальную плату для их подключения,
это позволяет объединять вместе в системе большее количество устройств, в частности,
жестких дисков1.

Также как на компьютерах Macintosh, так и на некоторых PC можно встретить диски FireWire
(IEEE 1394). Устройства FireWire допустимо присоединять и отсоединять во время работы
компьютера. Кроме того, интерфейс FireWire позволяет сцеплять (соединять последова-
тельно) большее количество устройств, чем SCSI-интерфейс.

Соединительные порты
Соединительные порты — это внешние разъемы компьютера, к которым подсо-
единяются различные кабели. Помимо выхода на монитор, клавиатурного порта
и порта для подключения мыши, скорее всего, найдутся один или два порта, которые
подойдут для цифровой камеры (если вы не можете их обнаружить, проверьте,
не используется ли один и тот же порт для выполнения разных задач).

Ниже описаны различные типы портов:

Q Последовательный порт, возможно, окажется свободен для подключения циф-
рового фотоаппарата или другого оборудования.

Q Порты USB (Universal Serial Bus — универсальная последовательная шина) стали
стандартными как на большинстве современных компьютеров, так и для всех ци-
фровых камер. Они обеспечивают высокую скорость передачи данных и, что более
важно, эти разъемы универсальны и к ним подходит любое новое оборудование.
USB-устройства в большинстве своем являются оборудованием тш\з.plug and play
(«включай и работай»), в то время как устройства, подсоединяемые через другие
порты, иногда приходится конфигурировать вручную. Я рекомендую серьезно по-
думать, прежде чем приобретать оборудование, в котором отсутствует порт USB.

а Порты IEEE 1394 (FireWire) в наши дни обязательно имеются на компьютерах
Macintosh и довольно редко встречаются на PC. Многие периферийные уст-
ройства: большинство цифровых видеокамер, DVD-проигрыватели и даже не-
которые МРЗ-проигрыватели (особенно Apple iPod) — имеют FireWire-разъем
в качестве стандартного. Порты FireWire обеспечивают высокую производи-
тельность и надежность2.

Последнее время диски с интерфейсом SCSI становятся все менее экзотичными, в том числе и на
компьютерах IBM PC. Причиной этому является повышенное быстродействие, в частности, при рабо-
те с графикой и видеоизображениями. Это в идеале, но на практике скорость обмена IDE- и SCSI-
дисков в однопользовательских системах практически одинакова. В многозадачных и многополь-
зовательских системах SCSI-контроллеры имеют явные преимущества, так как высвобождают
процессор для выполнения других операций. К сожалению, подключение и настройка SCSI-дисков
значительно сложнее установки IDE-дисков, и дополнительные сложности вносит также разнообра-
зие разъемов для подключения внешних устройств. — Примеч. ред.

IEEE 1394 и FireWare не синонимы. Название Fire Ware — торговая марка Apple. IEEE 1394 — стан-
дарт, утвержденный IEEE для всех цифровых интерфейсов, обеспечивающих соединение между со-
бой не только компьютеров, но и бытовых устройств. Шина IEEE 1394 работает с более высокой
скоростью обмена, чем шина USB. К контроллеру IEEE 1394 (с 6- и 4-контактными гнездами) мож-
но подключить жесткий диск, DVD- и CD-привод, сканер, принтер, цифровые камеру и телевизор.
Основная сфера применения IEEE 1394 — видеомонтаж. — Примеч. ред.
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ВНИМАНИЕ
Оборудование с USB- и FireWire-разъемами можно подключать к компьютеру и отключать от
него прямо во время работы. Убедитесь сами: подсоедините к машине камеру, имеющую
разъем FireWire, и тут же скопируйте на компьютер все изображения. Должно получиться.

Модемы
Сейчас настолько значительная часть жизни каждого из нас связана с электрон-
ной почтой и так много вертится вокруг Интернета, что невозможно представить,
как это кто-то имеет собственный компьютер, но до сих пор не приобрел модем.
На сегодняшний день на рынке присутствуют модемы, обеспечивающие скорость
передачи данных 56 Кбит/с; на мой взгляд, покупка более медленного модема яв-
ляется не более чем потерей денег.

ПРИМЕЧАНИЕ
56 Кбит/с — это максимально возможная скорость обмена данными между сервером про-
вайдера и компьютером пользователя через стандартное телефонное соединение. Плохие
телефонные линии, старые коммутационные технологии, а иногда и «настроение» модема
значительно снижают скорость загрузки информации. Я обнаружил, что во время макси-
мальной нагрузки на телефонную сеть (днем и между 10 и И вечера) сложно дозвониться
до сервера и сильно падает скорость соединения. Но для полуночников вроде меня это не
является проблемой. Итак, помните, что наибольшая скорость загрузки, которой можно
достичь с помощью модема, равна всего лишь 33,6 Кбит/с1.

Не все модемы со скоростью передачи данных 56 Кбит/с равноценны. Некоторые
из них, обычно называемые Win-модемами, фактически вообще не являются
«настоящими», а всего лишь могут работать на компьютерах исключительно под
управлением операционной системы Windows. Если вам необходимо дозваниваться,
приобретайте полноценный модем, обеспечивающий скорость 56 Кбит/с. Он обой-
дется в два-три раза дороже, но эта разница через некоторое время будет возмеще-
на за счет производительности и меньшего количества доставляемых модемом
неприятностей.

ПРИМЕЧАНИЕ
Сейчас становятся популярными линии связи с широкой (высокой) полосой пропускания,
обеспечивающие действительно быстрый доступ к Интернету. Проверьте в собственной АТС,
предоставляет ли она такой вид сервиса. Телефонная служба, вероятно, предложит один из
вариантов DSL, который состоит в использовании уже имеющейся разводки телефонных
линий. Линия будет продолжать использоваться для обычной телефонной связи — голос
и данные будут передаваться по одному кабелю, но в разных частотных диапазонах, и поэтому
не помешают друг другу.

Согласно фундаментальному закону Клода Шеннона (1948 год), скорость передачи двоичных данных
по реальной физической среде зависит от ширины полосы частот, которые пропускает канал, и от
соотношения мощности полезного сигнала к мощности помехи. В обычной телефонной линии макси-
мальная скорость передачи 33 600 бит/с является стандартом, определенным организацией ITU-T.
Скорость 56 Кбит/с (получения данных, но не отправки) достигается только в цифровых каналах
в сочетании с цифровыми АТС клиента и провайдера. Эта модемная технология была предложена
в 1996 году в США, отличающихся высокой степенью оцифровки телефонных сетей общего пользова-
ния, потому пока более актуальна для этого государства. — Примеч. ред.
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Видеокарты
Большинство дешевых компьютеров оборудуется видеокартами, встроенными
в материнскую плату. Этого достаточно до тех пор, пока не понадобится увеличить
быстродействие обработки изображений. Обычно на материнской плате компьюте-
ра есть разъем для видеокарты, представляющей собой отдельную плату. При таком
подходе появляется возможность модернизации графических характеристик
компьютера без его полной замены.

Сейчас продается множество различных видеокарт; некоторые из них ориентированы
на работу с двумерными изображениями, другие способны аппаратно обрабатывать
трехмерную графику. ЗО-карты (З-Dimensional — трехмерный) значительно улучшают
производительность компьютера, когда дело доходит до SD-игр и приложений.

Размер видеопамяти (video RAM), которая встроена в видеокарту, определяет до-
ступное разрешение монитора и максимальную глубину цвета (на данный момент
глубиной цвета назовем количество цветов, отображаемое на экране монитора од-
новременно). Вряд ли кто-нибудь захочет сэкономить на таких вещах, поэтому не
стоит приобретать 2В-карту с объемом памяти меньше 8 Мбайт. Чем больше видео-
памяти содержит компьютер, тем более сложные текстуры и разнообразные цвета
можно создавать и тем выше будет скорость обработки и прорисовки изображений.

ПРИМЕЧАНИЕ
Если в самый быстрый в мире персональный компьютер встроить видеокарту-«черепаху»,
все преимущества в скорости теряются. Чем выше скорость видеокарты, тем скорее перери-
совывается экран, то есть быстрее становятся видны все изменения изображения.

Мониторы
Вопрос о приобретении монитора очень важен, поскольку его характеристики имеют
прямое отношение к качеству изображения, видимого на экране. Если невозможно
рассмотреть саму фотографию и ее детали, то ее редактирование будет представлять
собой непростую задачу. Но на рынке в настоящее время представлено так много
различных ЭЛТ-мониторов, что достаточно трудно выбрать конкретную модель.

Перед покупкой монитора неплохо разобраться в том, какие модели сейчас пользу-
ются спросом, а какие — нет. Поищите журналы, посвященные обзору компьютер-
ной техники, или посетите веб-сайты, на которых демонстрируются результаты
тестов и сравнивается различное оборудование. Подобные отчеты, несомненно,
упростят задачу выбора монитора из ряда моделей одинакового размера с похожи-
ми характеристиками.

ПРИМЕЧАНИЕ
Многие профессиональные фотографы, художники-иллюстраторы и дизайнеры создают для
своей работы систему из двух мониторов (рис. 5.2). На одном из них, подсоединенном
к встроенной в материнскую плату видеокарте, отображаются инструменты, палитры и меню
программ, обрабатывающих изображение, например цветовая палитра, — этот экран пред-
назначается для рабочих средств. Другой монитор обычно подключается к выходному разъему
отдельной, как правило, более мощной видеокарты, и на нем демонстрируется само изобра-
жение. При таком подходе изображение не перекрывает палитры инструментов, их не нуж-
но перемещать или закрывать, что очень удобно. Помните, что для каждого монитора нуж-
на своя видеокарта.
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Рис. 5.2. Система из двух мониторов, 21-дюймовый — для просмотра изображений
и 17-дюймовый — для инструментов

При покупке нового монитора следует обратить внимание на его размер. Под раз-
мером монитора понимается длина диагонали экрана (сам монитор несколько боль-
ше своего экрана). Большинство компьютерных систем продаются вместе с 15-
дюймовыми мониторами, которых недостаточно для работы с изображениями. Если
вы постоянно склоняетесь над экраном или утыкаетесь в него носом, значит, экран
слишком мал. Поэтому нужно попытаться приобрести компьютер без монитора, а
отдельно купить монитор более дорогой, чем стандартный. Можно выбрать мо-
дель с диагональю 17 дюймов, этот размер прекрасно подходит для редактирова-
ния большинства изображений. Такие мониторы должны стоить от примерно $ 150
до $500 (на стоимость влияют возможности управления, разрешение и частота
обновления экрана). Следом за 17-дюймовыми мониторами идут 19-дюймовые
модели, в пределах $250-900. И самые большие, скорее даже огромные, 21-дюй-
мовые мониторы, используемые преимущественно профессионалами, имеют цену
от $800.

Сейчас становятся популярными плоскопанельные жидкокристаллические мони-
торы (FP LCD — Flat Panel Liquid Crystal Display) из-за своей толщины и относи-
тельно маленькой площади подставки (рис. 5.3). Они также намного меньше ве-
сят, чем ЭЛТ-мониторы. Но, как происходит со всякой новой технологией, эти
модели пока достаточно дороги по сравнению с ЭЛТ-мониторами (стоимости сред-
них 15-дюймовых моделей различаются примерно на $200)'. Жидкокристалли-
ческие мониторы обычно обеспечивают большую четкость изображения, но их су-
щественным недостатком является фиксированное разрешение.

Последние годы характеризовались постоянным снижением цен на жидкокристаллические монито-
ры, сейчас на рынках Санкт-Петербурга ЖК-мониторы все увереннее теснят электронно-лучевые.
Предложения 15-дюймовых мониторов находятся в диапазоне $300-700, средняя типовая модель
стоит $361. По прогнозам аналитиков, к концу 2004 года цена на ЖК-телевизоры с диагональю от 28
до 32 дюймов может опуститься с примерно $5300 до $1600. Набирают силу новые технологии, на
мировом рынке появились первые модели, выполненные по технологии OLED (Organic Light Emitting
Diode, органический светоизлучающий диод). — Примеч. ред.
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Рис. 5.3. Превосходный плоскопанельный монитор с интересным дизайном от IBM

ПРИМЕЧАНИЕ
Если вы хотите сохранить здоровыми глаза, шею и спину, то при устройстве своего рабочего
места учитывайте положение, занимаемое телом. Клавиатура должна располагаться на сто-
ле или на специальной выдвижной полке и при этом находиться на уровне локтей. Следую-
щим важным параметром является высота монитора. Экран нужно разместить на уровне
глаз, когда вы сидите на стуле. Следует расположить его так, чтобы не требовалось смот-
реть вниз или вверх — это намного снизит напряжение шеи.

Если вам приходится щуриться при взгляде на экран, попробуйте уменьшить освещение
в комнате. Организуйте тень или выключите несколько ламп. Мне обычно достаточно неболь-
шой настольной лампы, которая освещает бумаги и клавиатуру. Мы, как правило, сидим
слишком близко к экрану монитора, и — это замечание относится в основном к тем, кто носит
очки — поэтому можно сделать себе очки, специально адаптированные к экрану. Также можно
просто немного сдвинуть очки на нос, чтобы таким образом изменить фокусировку глаз.

Периферийные устройства
Периферийными устройствами называются все дополнительные устройства, под-
соединяемые к компьютеру. Такие приспособления повышают стоимость компь-
ютера; ими заполнено множество полок в компьютерных магазинах, а их названия
занимают не один десяток страниц в каталогах. Некоторые из этих устройств, та-
кие как Zip-дисководы, очень удобны. В других же, например в держателе для ко-
фейной чашки, присоединяемом к монитору, нет реальной необходимости. Поэто-
му следует немного подумать и оценить, что вы покупаете и как это приспособление
стыкуется с остальной системой. Вы на самом деле хотите улучшить возможности
системы или всего лишь желаете благоустроить рабочее место?

Дисководы CD-R и CD-RW
Как говорилось ранее, иногда требуется копировать данные с жесткого диска для
их сохранения или передачи. Графические файлы занимают много места, поэтому
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имеет смысл хранить их вне компьютера. Очень удобно архивировать информацию
с помощью дисководов для записи компакт-дисков. Эти дисководы стоят от $40 за
простейшие модели до $200-300 за устройства, которые умеют записывать DVD-
диски. Дисководы, по своим свойствам промежуточные между этими крайними
моделями, также дешевы. Компакт-диск, не допускающий перезаписи, емкостью
650 или 700 Мбайт стоит около четверти доллара, то есть такие носители всем нам
по средствам. Я рекомендую приобрести дисковод CD-R, позволяющий записы-
вать данные на однократно записываемые компакт-диски (CD-R). Имея 12- или
24-скоростной дисковод, вы сможете создать собственный, целиком заполненный
компакт-диск за несколько минут. Дисководы CD-RW предназначаются для ра-
боты со специальными перезаписываемыми компакт-дисками (CD-RW), которые
весьма похожи по методу работы с ними на гибкие диски и стоят не намного доро-
же простых дисков CD-R. И конечно, CD-RW-диски можно записывать так же,
как и CD-R-диски.

Принтеры
Очень интересно сфотографировать что-нибудь и тотчас же увидеть фотографию
на жидкокристаллическом экране фотоаппарата. Еще лучше просмотреть изобра-
жения на новом большом 17-дюймовом мониторе (вы ведь купили 17-дюймовый
монитор, не так ли?). Но завершающим моментом, придающим особую прелесть
всему процессу, является печать изображений на собственном принтере. При этом
фотографии можно придать любой желаемый размер, сделать произвольное коли-
чество экземпляров, оплачивая всего лишь стоимость бумаги и краски. Принтер
может стать для вас столь же необходимым предметом, как и фотокамера, поэтому
несколько лишних долларов, потраченных на подходящую модель, несомненно,
оправдают себя.

Конечно, выбор правильного принтера потребует некоторых усилий. В компью-
терных магазинах предлагаются десятки моделей, предназначенных для домашне-
го использования; стоимость принтеров такого типа не превышает $200. Могут
встретиться принтеры от фирм Hewlett-Packard (HP), Epson, Minolta, Okidata,
Brother, Canon, Samsung, Lexmark и т. д. Все принтеры этого уровня являются
струйными. Фирмы Epson и HP разработали технологии, позволяющие получить
прекрасные четкие изображения, если их напечатать на специальной фотобумаге
с помощью простого струйного принтера.

Поскольку невозможно протестировать каждый принтер, в некоторых магази-
нах покупателям предлагаются демонстрационные картинки. Вы вправе взять
отпечатанные изображения, изучить и выбрать из них наиболее понравившийся.
В конце концов, следует приобрести наилучший принтер из тех, которые вписы-
ваются в ваш бюджет. Если вы в состоянии позволить себе цветной лазерный
принтер (самые дешевые модели стоят около $1000), обязательно купите имен-
но его. В противном случае рекомендуется остановиться на струйном принтере.
Мне, например, на редкость повезло с продукцией фирмы Epson. Кроме того,
всегда проверяйте, сумеете ли вы вернуть оборудование в случае, если оно не
работает.
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ПРИМЕЧАНИЕ
Не стоит «покупаться» на демонстрационные изображения, которые предоставляет произ-
водитель или автоматически печатает принтер. Эти картинки могут подбираться специаль-
но для того, чтобы подчеркнуть достоинства принтера или преувеличить его возможности,
например, часто эксплуатируется свойство принтера хорошо печатать отдельные цвета.
Кроме того, могут выбираться изображения с сильно детализированными темными или свет-
лыми областями.

Главным признаком, на котором основывается выбор принтера, должно быть
качество печати. Но также следует обратить внимание еще на несколько мо-
ментов.

Струйные принтеры
Струйные принтеры средней стоимости уже давно стали очень популярными. При
печати чернила из картриджа попадают на бумагу тоненькими струйками, выхо-
дящими через крошечные отверстия. Совсем просто, правда? В итоге, с помощью
струйных принтеров небольшой ценой можно добиться замечательных результа-
тов. Однако и у них существует несколько недостатков.

а Струйные принтеры работают очень медленно, поскольку каждый проход го-
ловки принтера по бумаге и распыление чернил занимает много времени. При
выборе принтера обратите внимание на скорость печати, выражающуюся в стра-
ницах в минуту (PPM — page per minute). Стоит немного переплатить за увели-
чение скорости печати. Вполне нормально, если принтер печатает около трех
страниц в минуту. Имейте в виду, что скорость варьируется от печати в черно-
вом монохромном режиме до качественной цветовой печати, и скорость отли-
чается в разах. Вместе с тем, производительность для фотопечати в 4-5 стра-
ниц в минуту уже стала нормой.

Q Некоторые принтеры, даже не являющиеся самыми дешевыми моделями, не
могут покрыть краской всю страницу — при печати целого листа бумаги по краям
остаются маленькие белые поля. Другие модели позволяют создавать изобра-
жения, не имеющие рамки, и, возможно, стоит заплатить за наличие этой ха-
рактеристики.

а Струйные принтеры обычно выполняют четырех- или шестицветную печать.
Первым цветом всегда является черный (ЫасК, обозначается буквой К). Следую-
щие три — голубой (Cyan), пурпурный (Magenta) и желтый (Yellow). Эта цве-
товая модель обозначается CMYK и составляет необходимый набор красок для
цветной печати. При шестицветной печати используются еще два специальных
цвета, обычно это добавочные светло-голубой и светло-пурпурный (пример
принтера, выполняющего шестицветную печать, изображен на рис. 5.4). В неко-
торых принтерах — как правило, это встречается в более дорогих моделях —
для каждого цвета предназначается отдельньш картридж, но в большинстве
принтеров все чернила объединены в одном картридже (это касается в основ-
ном фотопринтеров фирмы Epson). Я рекомендую приобретать шестицветный
принтер, если есть такая возможность.

Конечно, можно выполнять черновую печать изображений на оборотах старых
листов, но всегда следует помнить, что хорошая бумага, например высококаче-
ственная бумага для лазерного принтера, позволит намного улучшить результаты.
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И для получения самых качественных отпечатков нужно использовать бумагу, раз-
работанную специально для печати фотографий на струйном принтере. Некото-
рые производители принтеров, например Epson, выпускают фотобумагу, но также
в продаже встречается не уступающая по уровню продукция других фирм, которые
не занимаются производством оборудования, например Luminos. Те, кто печатали
фотографии традиционным способом, запираясь в темных лабораториях, знакомы
с бумагой фирмы Luminos. Чтобы определиться с фотобумагой, лучше всего купить
набор образцов в фотомагазине, напечатать различные изображения и текстуры
и выбрать самые лучшие из них. Я обычно на фотобумагу вывожу «окончатель-
ные» фотографии, а для рабочей печати использую более дешевые сорта.

Рис. 5.4. Первый, уже не выпускающийся шестицветный принтер компании Epson —
Epson 780 — также позволяет печатать изображения без белых рамок

Термодиффузионные принтеры
Термодиффузионные принтеры (иногда их также называют сублимационными)
обеспечивают качество отпечатков, наиболее приближенное к фотографиям. На
полученных с их помощью изображениях сохраняется чистота цветов и резкость,
характерная для фотографий, сделанных традиционным способом. Возможно,
я предвзято отношусь к моделям этого типа, но они являются моими любимыми
принтерами. В своей фотостудии я пользуюсь термодиффузионным принтером
фирмы Kodak для получения пробных отпечатков'.

Стоит отметить, что в 2002 году в продажу поступили (в том числе и в России по цене $160-170)
специализированные принтеры серии HP Photosmart (особенностью которых является печать не-
посредственно с карт флэш-памяти) под названием HP Photosmart 100. Этот термальный струйный
(термодиффузионный) принтер рассчитан на печать фотоснимков 10x15 (соответственно, Hewlett-
Packard постаралась уменьшить размеры корпуса до предела — 218x108x115 мм). Подробную ин-
формацию вы найдете на странице www.ixbt.com/peripheral/hp-pslOO.shtml. — Примеч. ред.
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ПРИМЕЧАНИЕ
Многие термодиффузионные принтеры работают следующим образом: выполняется печать
всего листа краской одного цвета, затем лист возвращается в принтер и накладывается
следующий цвет. Поскольку краски смешиваются друг с другом, они естественным образом
формируют нужный цвет. Но признаюсь — когда я увидел это в первый раз, я подумал, что
принтер сломался.

Термовосковые принтеры
В термовосковых принтерах, как вы уже догадались, вместо краски по поверхно-
сти бумаги распределяется цветной воск. Преимуществом такой печати является
то, что можно использовать незнакомую «любую старую бумагу», однако качество
печати оставляет желать лучшего.

ПРИМЕЧАНИЕ -
Фирма Fargo создала принтер Primera Pro, в котором объединены термодиффузионная и термо-
восковая печать. То есть он позволяет выполнять черновую печать с помощью воска и окон-
чательную печать с помощью сублимационной технологии. Это превосходный компромисс
технологий, качества и стоимости.

Термопринтеры
Термопринтеры (являющиеся прототипом термодиффузионных принтеров) ра-
ботают примерно так же, как термодиффузионные — чернила на смоляной основе
с помощью термопередачи переносятся с ленты на бумагу. Для такой печати мож-
но использовать старую бумагу, но, поскольку чернила попадают на бумагу в по-
чти высохшем состоянии, цвета смешиваются несколько хуже, чем при сублима-
ционной печати. По этой причине на отпечатках обычно видны точки и полоски
(последние чаще всего можно заметить в областях с плавным переходом цветов,
например «на небе»).

Цветные лазерные принтеры
Лазерные принтеры действуют с помощью магии. Нет, конечно, не на самом деле!
Внутри принтера лазер «облучает» барабан, а лазерный луч может производить
очень маленькие точки. В результате на барабане создается изображение из на-
электризованных точек. Эти точки притягивают красящий порошок, который по-
том переносится на бумагу при прокатывании барабана по листу. Путем термиче-
ской обработки краска закрепляется на бумаге, именно поэтому листы, выходящие
из принтера, обычно теплые на ощупь. Цветные лазерные принтеры потребляют
много электричества и сильно греются — в этом нет ничего опасного, но темпера-
тура в комнате будет повышаться.

Термоавтохромные принтеры
В термоавтохромных принтерах, которые стоят от $450 до $600, вообще не исполь-
зуются краска или чернила. Краситель уже «встроен» в многослойную бумагу
и «активизируется» при повышении температуры — похожий процесс происходит
в некоторых факсимильных аппаратах. Достоинство таких принтеров заключается
в том, что не требуется менять чернила или красящий порошок. Но необходимо
выполнять печать только на специально предназначенной для этого бумаге, а от-
печатки получаются достаточно приличного качества, но^не настолько хорошего,
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как при сублимационной печати. Кроме того, большинство принтеров данного типа
позволяют печатать изображения размером только 4x6 дюймов. Эта технология
не является широко используемой, однако фирмы Fargo, Fuji и Panasonic выпус-
кают подобные модели и все необходимые для печати составляющие.

Сканеры
Также часто рассматривается покупка еще одного устройства, докомплектовыва-
ющего цифровую лабораторию, — это сканер. С помощью сканера можно добавить
в свой цифровой архив все старые фотографии, скопировать или обработать уже
напечатанные изображения, как свои, так и чужие (например, моя мама постоянно
находит снимки, оставшиеся с незапамятных времен, которые нужно отсканиро-
вать и размножить).

Сканеры стоят примерно от менее $ 100 за простейшую модель до $1000 за модели,
позволяющие получать изображения с очень высоким разрешением. В продаже
представлено огромное количество различных марок сканеров; так произошло
потому, что сканеры являются предшественниками цифровых фотоаппаратов,
и они появились на рынке несколько раньше.

Рис. 5.5. Планшетный сканер фирмы Agfa

Существуют два типа сканеров1.

а Планшетные сканеры. Планшетные сканеры (рис. 5.5) главным образом предна-
значены для воспроизведения фотографий, изображений на бумаге и различных
документов. Эти сканеры имеют вид прямоугольной коробки с откидывающейся
крышкой, укрепленной на шарнирах; под крышкой находится стеклянная по-
верхность, на которую следует класть сканируемое изображение «лицом вниз».
Сканирующая головка и весь остальной механизм расположены под стеклянной
поверхностью. Крышку опускают для того, чтобы сканируемый документ был
плоским и не сдвигался, кроме того, не попадал свет и не происходило сканиро-
вания окружающей среды, а также чтобы стеклянная поверхность не загрязня-
лась, пока сканер не используется.

По способу перемещения считывающей головки и бумаги друг относительно друга сканеры можно
разбить на два основных типа: ручной (hand-held) и настольный (desktop). Существуют также ком-
бинированные устройства, которые сочетают в себе возможности обоих типов. Есть три разновидно-
сти настольных сканеров: планшетные, с полистовой подачей и проекционные. Последние внешне
напоминают фотоувеличитель — внизу сканируемый документ, а наверху — сканирующая головка. —
Примеч. ред.
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а Пленочные сканеры. Пленочные сканеры служат для сканирования 35-мил-
лиметровых негативов (или большего размера). Как правило, такие сканеры
стоят дороже планшетных. Это вызвано тем, что обычно в состав пленочных
сканеров входят оптические приборы и источники света, необходимые для
освещения кадра на пленке. Для сканирования чаще всего нужно вставить плен-
ку в специальную кассету, и остальную работу выполняет сканер. Некоторые
модели оснащаются механизмами, позволяющими автоматически перемещать
и сканировать несколько кадров подряд.

СОВЕТ
Такой показатель, как скорость сканирования, играет определенную роль в выборе скане-
ра. Несомненное преимущество имеют однопроходные модели. Сравнивая скорость, удо-
стоверьтесь, что тестирование проводится при одинаковом разрешении сканирования.

Многие планшетные сканеры предоставляют возможность сканирования слайдов
и негативов. Методы реализации различаются от производителя к производите-
лю, но все они нашли способ, позволяющий осветить кадр на пленке и отсканиро-
вать его. Достаточно экономично будет купить одну из подобных моделей вместо
приобретения двух устройств, предназначенных для разных целей, но тогда при
выборе сканера следует быть особенно внимательным. Технология сканирования
пленки практически всегда отставала в развитии от компьютерных технологий,
поэтому вполне вероятно встретить модель, не обеспечивающую приемлемого ка-
чества. Лучше всего получить возможность самостоятельного тестирования ска-
нера или же найти где-либо результаты исследований, проведенных независимой
третьей стороной.

СОВЕТ
При сканировании старайтесь получить изображение, максимально приближенное к желае-
мому. С одной стороны, это сокращает трудоемкость дальнейшей обработки — вам не пона-
добится тратить много времени на исправление всех мелочей в программе, предназначен-
ной для редактирования графики. С другой стороны, и это не менее важно, всякий раз,
когда происходит пересчет данных в файле изображения, это снижает его качество. Если
изменить картинку в размере, затем осветлить ее, а потом отрегулировать контрастность,
качество ухудшится.

Кроме того, нужно учитывать, что сканер не создаст ни одной точки без соответ-
ствующего программного обеспечения. Эти программы позволяют задать размер
изображения, контраст, белую и черную точки и настроить цвет, а также увели-
чить резкость.

Программное обеспечение, как независимые программы, так и дополнения, обыч-
но поставляется в комплекте со сканером. Функционально законченные приложе-
ния, как нетрудно догадаться, работают независимо от другого программного обес-
печения (конечно, это не относится к операционной системе). Дополнения, часто
называемые plug-ins, встраиваются в другие программы, например в приложения
для обработки фотографий или для создания иллюстраций. В некоторых случаях
предоставляется возможность управления процессом сканирования даже из про-
грамм — текстовых редакторов.

Итак, в представлении пользователя программное обеспечение для сканирования яв-
ляется неким «приобретаемым» модулем, позволяющим сканировать изображения,
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сохранять их в файлы на жесткий диск или просматривать их на экране компьютера.
Но это вовсе не означает, что все программы, предназначенные для сканирования,
одинаковы — они имеют различные характеристики. Так, например, подобное при-
ложение должно предоставлять возможность просмотра результата предваритель-
ного сканирования — быстрого сканирования с низким разрешением, дающего
представление о том, как будет выглядеть конечное изображение и правильно ли
настроен сканер. Также желательно иметь возможность выделения части изобра-
жения после предварительного прохода, если требуется отсканировать только ма-
ленькую область. Важнее всего, чтобы отображаемый на экране результат предва-
рительного сканирования имел максимально возможный размер, а не представлял
собой крошечную картинку, на которой нельзя рассмотреть никакие детали. Кроме
того, большой размер предварительного изображения необходим для выделения
«точек», используемых при настройке сканера: черной и белой, точек для опреде-
ления контраста, яркости и т. д.

Следует запомнить
Q Компьютеры на платформах Macintosh и PC одинаково хорошо подходят для

обработки фотографий.

Q Выбирайте монитор максимального размера.

Q Приобретите съемные устройства для хранения информации или найдите дру-
гой способ создать копии своих бесценных данных.

Q Перед покупкой принтера изучите предлагаемые модели.

Q Если вы решили приобрести сканер, выбирайте модель, обеспечивающую наи-
более разносторонние возможности.
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Программное обеспечение

Q Программы для обработки изображений

Q Корректировка композиции и улучшение качества изображений

Q Сохранение изображений
Q Использование инструментов, подобных IrfanView

Q Создание фотоальбома

Самой замечательной особенностью цифровых фотографий является возможность
редактирования полученных снимков. Для этого предназначаются многочисленные
программы — так называемые графические редакторы. Кроме того, существует
программное обеспечение, подобное фотоальбомам, которое позволяет хранить, сор-
тировать и просматривать изображения. А другие программы, работающие и на до-
машних компьютерах, помогут создать брошюру или информационный бюллетень.

Хотя передавать изображения с фотоаппарата на жесткий диск можно с помощью
инструментов самой камеры, чаще всего для этого используют специальные про-
граммы. Для просмотра снимков, полученных с камеры, также потребуются при-
ложения, работающие с изображениями.

Ниже представлен краткий обзор возможностей графических редакторов.

Корректировка композиции и улучшение
качества изображений
Существует множество приемов, позволяющих изменить композицию и повысить
качество снимков.

а Обрезание. Программы, предназначенные для обработки изображений, преж-
де всего должны помогать исправлять композицию кадра. Затратив минимум
усилий, можно обрезать изображение, смещая таким образом центр снимка или
меняя его пропорции.
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О Изменение размера. Возможно, вам понадобится отредактировать размер изоб-
ражения — увеличить снимок или уменьшить. Если же получилось так, что ка-
мера была направлена под углом к горизонту, и теперь горизонтальные линии
наклонились влево, не стоит расстраиваться — изображение можно повернуть.

D Настройка яркости и контрастности. Если снимок выглядит плоским, попро-
буйте увеличить его контрастность. А если фотография дома оказалась немно-
го затемнена, поскольку он находится в тени, это тоже исправимо — достаточно
просто увеличить яркость.

Q Редактирование цветов. Есть множество способов изменения параметров изоб-
ражения: настройка контрастности, осветление или затемнение снимка, увели-
чение или уменьшение насыщенности каждого цвета. Все это позволяют сде-
лать графические редакторы.

Р Копирование. Немного попрактиковавшись, вы научитесь вырезать части фото-
графий и вставлять их в другие изображения. Например, я недавно фотографиро-
вал букет ирисов. Мне было нужно, чтобы цветы заполняли весь снимок, и поэтому
я скопировал фрагмент с цветами и размножил его в несколько областей снимка.

Q Применение фильтров и специальных эффектов. Графические редакторы пре-
доставляют в распоряжение пользователя множество различных эффектов,
позволяющих изменить вид изображения. Фотографии можно придать вид на-
писанного красками полотна или добавить к фону текстуру. Кроме того, можно
применить фильтры — точно так же, как фильтры при фотосъемке. Например,
действие искривляющего фильтра заключается в придании изображению сфе-
рической формы и добавлении отражения — создается ощущение, что мы смот-
рим на изображение через стеклянный шар.

Как вы увидели, при обработке цифровых изображений не существует практиче-
ски никаких ограничений. Если что-то можно представить, найдется способ сде-
лать это. Следует помнить, что изменение снимка состоит в изменении его пиксе-
лов с помощью графического редактора. Также не нужно забывать о том, что фраза,
которую вы наверняка не раз слышали в течение своей жизни, — «фотографии не
лгут» — перестала быть правдивой. Если редактор журнала всего лишь придвинул
Египетские пирамиды друг к другу, чтобы уместить их на одной странице, он уже
обманул читателей — фотография изначально была другой.

ПРИМЕЧАНИЕ
Наиболее важным компонентом программного обеспечения, поставляемого вместе с фотоаппа-
ратом, являются программы, позволяющие улучшить качество изображения — такие как
Photoshop и Photoshop Elements. Следующее место занимают программы, позволяющие фор-
мировать каталоги или фотоальбомы. Также неплохо иметь программное обеспечение,
предназначенное для создания специальных эффектов, но оно не входит в обязательный
список. Кроме того, на диске, сопровождающем фотоаппарат, могут присутствовать програм-
мы для веб-дизайна. Однако не следует забывать, что некоторые из этих программ представляют
собой «облегченные» или демонстрационные версии и не всегда выполняют все свои функции.

Программы для работы с изображениями
Большинство фотоаппаратов сопровождается бесплатными программами (рис. 6.1).
Это удобно, поскольку после приобретения камеры не нужно срочно бежать
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в магазин и покупать программное обеспечение. Некоторые фотоаппараты постав-
ляются вместе с программами, разработанными производителем камеры, другие —
с приложениями сторонних фирм. Ниже мы рассмотрим обе категории.

Рис. 6.1. Примеры стандартного программного обеспечения. Если камера сопровождается
удобными в использовании, хорошими программами, будет очень легко заниматься

цифровой фотографией

Программное обеспечение фирм-
производителей фотоаппаратов
Иногда изготовители фотоаппаратов вместе с камерами продают собственное про-
граммное обеспечение. Как правило, такие фирменные пакеты программ способ-
ны более чем удовлетворить все основные нужды фотографов. Они предназна-
чаются для загрузки фотографий с камеры на компьютер, настройки цвета, яркости
и контрастности, а также выполнения большинства задач, связанных с улучшени-
ем качества изображения. Кроме того, они позволяют копировать части снимков,
обрезать фотографии, увеличивать их и ретушир'овать, дают возможность напеча-
тать изображение как отдельную фотографию или сгруппировать снимки, созда-
вая индекс-отпечаток. Иногда в этот же пакет входят программы, облегчающие
доступ в Интернет и отправку картинок по электронной почте. Итак, если вам тре-
буется только базовый набор операций, связанных с обработкой изображений, стан-
дартного фирменного пакета программ будет вполне достаточно.

Agfa PhotoWise
Одним из примеров подобного программного обеспечения является разработанная
компанией Agfa программа PhotoWise, которая поставляется вместе с некоторыми
из фотоаппаратов этой фирмы. Программа PhotoWise позволяет передавать фото-
графии с камеры на компьютер и создавать виртуальные фотоальбомы, в которых
удобно хранить снимки, а также дает возможность улучшать качество изображений,
настраивая цвета, контрастность, яркость и резкость. Кроме того, можно изменять раз-
меры фотографий, вращать и обрезать их. PhotoWise — это прекрасный инструмент,
предназначенный для выполнения основных операций по обработке изображений.
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Программное обеспечение сторонних фирм
Многие камеры сопровождаются программными средствами, разработанными
третьими фирмами — то есть программами от различных компаний, на распростра-
нение которых у производителей фотоаппаратов есть лицензии.

ВНИМАНИЕ
Иногда вместо программ от третьих фирм используются их «облегченные» варианты, кото-
рые способны выполнять ограниченный набор операций по сравнению с полнофункцио-
нальными версиями. Также могут встретиться программы, которые будут функционировать
только в течение короткого периода времени, а после этого вам придется заплатить за
полноценную работающую версию. Совсем редко, но все же попадаются демонстрационные
версии программ, позволяющие выполнить любые операции за исключением сохранения
или печати результатов, и это бывает особенно досадно.

Adobe Photoshop
Photoshop является мощнейшим графическим редактором и, более того, одной
из самых популярных на рынке программ. Ею пользуются практически все про-
фессионалы, работающие в области цифровых изображений: фотографы, худо-
жественные редакторы, дизайнеры, иллюстраторы и даже специалисты в области
компьютерной мультипликации. Photoshop также представляет собой основной
инструмент для подготовки изображений к печати — без него не может обойтись
ни одно издательство. Не будет преувеличением сказать, что многим в своей карь-
ере я обязан этой программе и рекомендую использовать Photoshop в качестве ос-
новного графического редактора.

ПРИМЕЧАНИЕ -
Компания Adobe System была основана в 1982 году, и ее можно назвать матерью всего
сегодняшнего программного обеспечения, связанного с графикой. Первый ее продукт —
программа Photoshop — стал основой для всех приложений, предназначенных для обработ-
ки фотографий и других изображений. Таким образом, Adobe создала все необходимое для
появления цифровой фотографии еще в те времена, когда цифровых фотоаппаратов не
было в свободной продаже. Было выпущено много программ, пытавшихся соперничать
с Photoshop, но последняя до сих пор остается эталоном для всех графических редакторов.
Кроме того, разделив понятия растровой и векторной графики, компания Adobe разработа-
ла программу Adobe Illustrator, специализирующуюся на обработке векторных рисунков
в отличие от Photoshop, предназначенного в основном для редактирования растровых изоб-
ражений1. Многие, если не все, профессиональные фотографы и иллюстраторы целиком
и полностью зависят от продукции компании Adobe. Это относится и ко мне!

С помощью Photoshop можно сформировать такие сложные изображения, как колг
лажи и многослойные картинки. В программе допускается комплексная коррек-
ция цвета и решена проблема цветоделения, которое необходимо выполнять при

В векторной графике все изображения описываются с помощью математических объектов — конту-
ров. Растровое же изображение представляет собой не совокупность объектов, а «мозаику» из пиксе-
лов. Характерным примером растровых изображений являются отсканированные картинки или фо-
тографии. Обрабатывается графика этих двух типов, как правило, в различных программах; в качестве
наиболее известных редакторов векторной графики можно назвать Adobe Illustrator или CorelDraw,
растровой — Adobe Photoshop. Обычно в векторных программах допускается использование растро-
вых объектов, но ограничены возможности их изменения. В редакторах растровой графики также
иногда встречаются векторные элементы. — Примеч. ред.
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предпечатной подготовке. Нетрудно заметить, что Photoshop имеет определенные
преимущества по сравнению с другими графическими редакторами. Правда, что-
бы свободно чувствовать себя при работе с этой программой, требуется немного
попрактиковаться. Если вы решили остановиться на Photoshop, который, кстати,
функционирует на обеих аппаратных платформах, вам необходимо иметь доволь-
но много оперативной памяти (по крайней мере, 128 Мбайт) и быстрый процес-
сор. Правда, для обработки фотографий иногда вполне достаточно более скромно-
го продукта Adobe, приложения Photoshop Elements.

Adobe Photoshop Elements
Одной из наиболее популярных программ такого рода, которая часто встречается
на дисках, сопровождающих фотоаппарат, является Photoshop Elements от компа-
нии Adobe. Программа Photoshop Elements, младшая сестра Adobe Photoshop, по-
зволяет выполнять все те же операции, что и программы фирм-производителей
фотоаппаратов, и даже несколько дополнительных. Можно, например, сохранить
выделенную область, чтобы потом воспользоваться ею как маской, а также приме-
нить к изображению фильтры и специальные эффекты. Часть примеров в данной
книге выполнена с помощью этой программы. Дешевую и демонстрационную ко-
пии программы можно загрузить с веб-сайта компании Adobe или приобрести вме-
сте с некоторыми из самых последних моделей фотоаппаратов.

LivePix
Также вместе с камерами распространяется другой известный графический редак-
тор — LivePix Deluxe от Live Picture. LivePix предназначена для выполнения всех
основных операций, связанных с обработкой изображений, и также позволяет объ-
единять изображения с шаблонами (предоставляемыми программой) с целью со-
здания календарей, визиток и бланков.

Программа Paint Shop
Преимущество'программы Paint Shop от Jasc Software заключается в том, что в ней
допускается одновременная работа как с растровой, так и с векторной графикой.
Это означает, что в одной программе можно редактировать фотографии и создавать
иллюстрации. В Paint Shop объединяется все лучшее из двух областей графики:
растровой и векторной, кроме того, предлагается несколько инструментов, ко-
торые предназначаются для веб-графики, включая средства для сжатия и нарезки
изображений.

Просмотр и сортировка изображений
Начав фотографировать и записывать файлы снимков на компьютер, вы скоро
обнаружите, что жесткий диск, который, казалось, не имеет пределов, теперь начи-
нает заполняться. Учитывая, что практически любой снимок можно исправить,
а издержки на это заключаются только в потраченном времени, вы будете снимать
все больше и больше фотографий. Если же камера имеет высокое разрешение, то
скорость заполнения диска сильно увеличится. Возникает проблема хранения фай-
лов изображений, которую можно решить с помощью компакт-дисков и устройств
для их записи или же других съемных носителей информации. Сейчас же мы рас-
смотрим процесс сортировки и упорядочивания изображений с помощью програм-
мы IrfanView, работающей в среде Windows.
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Использование программы IrfanView
Программу IrfanView написал боснийский программист, учащийся в Вене, — Ирфан
Скилян (Irfan Skiljan), и он регулярно обновляет свое творение. Последняя на дан-
ный момент версия приложения содержит все инструменты, необходимые для
управления разрастающимися коллекциями цифровых фотографий в операционной
системе Windows. Окно программы продемонстрировано на рис. 6.2. Для MacOS
нет подобного свободного распространяемого аналога.

gsMS

Рис. 6.2. IrfanView для Windows — это мощное, свободно распространяемое приложение,
которое помогает управлять большим количеством изображений

Эта программа хороша прежде всего тем, что с ее помощью можно прочесть
и отобразить на экране графические файлы практически любых когда-либо суще-
ствовавших форматов. Также она позволяет преобразовывать изображения из од-
ного формата в другой.
Конечно, программа предоставляет так необходимую возможность пакетной обра-
ботки файлов изображений и сама создает миниатюрные картинки — уменьшен-
ные копии изображения для просмотра. Пакетной обработкой называется автома-
тическое выполнение некоторого набора операций с большим количеством файлов.
Это очень удобно, если, например, вы уменьшили экспозицию, забыли вернуть ее
обратно и так и отсняли целую карту памяти — в результате получилось множе-
ство одинаково затемненных фотографий, и IrfanView поможет быстро справиться
с такой проблемой. Формирование миниатюр разрешает просматривать большое
количество изображений на одном экране и упорядочивать их.
Загрузка и установка программы IrfanView не должны занять много времени, даже если
вы работаете с модемом, обеспечивающим скорость всего лишь 33,6 Кбит/с. Програм-
ма распространяется свободно, и ее можно загрузить с сайта www.irfanview.com.
Попробуйте найти доступное «зеркало» (сайт, на котором находятся те же самые
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файлы, созданный для уменьшения нагрузки на основной сервер) и выберите
ссылку для загрузки саморазворачивающегося архивного файла. Его размер не пре-
вышает 1 Мбайт. Дважды щелкните на значке файла (его название должно быть
похоже на «iview380.exe») и следуйте указаниям по установке.

СОВЕТ
Во время установки программы появится вопрос о форматах файлов, которыми будет управ-
лять IfranView. Я обычно щелкаю на кнопке Select All (Выбрать все), но тогда сбиваются
предыдущие настройки, и в дальнейшем при щелчке на файле, который имеет формат,
поддерживаемый IfranView, открывается именно эта программа. Поэтому я советую про-
смотреть список форматов, установить флажки на неизвестных типах и сбросить флажки
там, где требуется, чтобы файлы данных типов открывались в других приложениях. Про-
грамма IrfanView способна отображать аудио- и видеофайлы, обычно сопоставляемые
с приложениями Windows Media (WMA, WMF, AVI), QuickTime (QT, MPG/MPEG, Mac PICT)
и RealPlayer (RAM, RA).

Как только просмотрщик IrfanView будет установлен, на рабочем столе появится
соответствующий значок. Проще всего просмотреть изображение, перетащив его
мышью на значок IrfanView — программа откроется автоматически и покажет изоб-
ражение. Если обнаруживаются ошибки или файл имеет неверное расширение,
Ifranview попытается их исправить, и обычно программе это удается. А когда мы
имеем дело с фотографиями, полученными с помощью цифровой камеры, возмож-
ность пакетной обработки приобретает особый вес. При съемке фотографий каме-
ра сама сохраняет изображения, используя некоторый алгоритм генерации имен
файлов (например, фотоаппарат SiPix SC-2100 нумерует файлы от PICT0001, и пол-
ный путь выглядит наподобие/DCIM/100NUCAM/PICT0001). Надо сказать, что такое
имя более понятно для большинства людей, чем, скажем, ECGxlOODF00234.

Чтобы изменить имена группы файлов с помощью IrfanView, выполните следующее.

1. Откройте IfranView, дважды щелкнув на значке с изображением красного кота,
распластавшегося на рабочем столе.

2. Откройте меню File (Файл) и выберите команду Batch Conversion/Rename (Пакетное
преобразование/переименование). Появится новое окно, изображенное на рис. 6.3.

3. В этом диалоговом окне в верхнем правом углу находится знакомый значок,
который обычно присутствует в диалоговых окнах, отвечающих за сохранение
и открытие файлов. Перейдите к папке, в которой хранятся нужные снимки.

4. Теперь следует создать список файлов, которые нужно переименовать. Если
это несколько файлов, выделите их и нажмите кнопку Add (Добавить). При этом
удержание клавиши Shift позволяет выделить несколько файлов подряд, а если
нажать Ctrl, то щелчками кнопки мыши можно выделить разрозненные файлы.
Если переименовываться будут все файлы из папки, щелкните на кнопке Add
all (Добавить все). Когда требуется обработать большинство файлов, удобно сна-
чала их все добавить в список, а потом удалить ненужные.

5. В поле Output directory (Папка результатов), находящемся справа в окне, следует
указать путь к папке, в которую будут записываться обработанные файлы.
Существует одно ограничение: IrfanView не позволяет здесь создавать папки,
поэтому это нужно сделать заранее. В крайнем случае, переключитесь в Про-
водник (Explorer) Windows, создайте папку и вернитесь назад — теперь ее можно
выбрать, щелкнув на кнопке Browse (Обзор).
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Рис. 6.3. Здесь продемонстрировано диалоговое окно программы IrfanView, предназначенное
для пакетного переименования файлов или преобразования в другой формат

6. В разделе Work As (Задание) установите переключатель в положение Batch rename
(Пакетное переименование). Другие параметры станут недоступны, но в актив-
ный режим перейдет кнопка Set rename options (Установка параметров переимено-
вания). Нажмите ее.

7. В диалоговом окне Batch rename settings (Настройки переименования файлов) в верх-
нем поле измените название файла. Оставьте переключатель второго раздела в поло-
жении Copy input files to output directory (recommended) (Копировать файлы в папку
результатов (рекомендуется)). Помните, что операционная система Windows позво-
ляет создавать имена файлов длиной до 255 символов. Получив желаемую форму
именования, нажмите кнопку О К, чтобы вернуться в основное диалоговое окно.

8. Еще раз проверьте все установленные вами параметры; убедитесь, что все на-
строено должным образом. И только после этого щелкните на кнопке Start
(Пуск), расположенной вверху справа от списка выбранных файлов. Появится
окно, показанное на рис. 6.4, сообщающее о результатах переименования.

Теперь, когда пакетная обработка закончена, можно посмотреть на полученные фай-
лы в режиме Thumbnails (Миниатюры). Выберите одноименную команду из меню File
(Файл) или просто нажмите клавишу Т, находясь в основном окне программы. Если
при вызове вида Thumbnails (Миниатюры) в основном окне открыто какое-либо изобра-
жение, то все файлы из его папки отобразятся в новом окне, представленном на рис. 6.5.

Как видно из рисунка, в окне Thumbnails (Миниатюры) помещается несколько малень-
ких копий изображений, по которым можно легко представить оригиналы. Чтобы
загрузить другой набор файлов, следует воспользоваться деревом папок, расположен-
ным в левой части окна. Здесь можно, как обычно, перемещать, переименовывать
и удалять файлы изображений. Также стоит познакомиться с командами меню File
(Файл) и Options (Параметры) окна Thumbnai ls (Миниатюры), чтобы научиться пользо-
ваться этим замечательным инструментом.
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Рис. 6.4. Программа IrfanView закончила обработку большого количества файлов. В этом
примере перед каждым именем добавлялось слово irfaned
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Рис. 6.5. Все изображения из папки отображаются в окне Thumbnails (Миниатюры)
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Виртуальные фотоальбомы

Во многие пакеты программ, предназначенных для обработки изображений, так-
же входят приложения, позволяющие создавать фотоальбомы, но в любом случае
всегда можно приобрести отдельную программу, такую как Picture Easy от Kodak,
Picture-It от Microsoft, Photo Explorer от Ulead, Extensis Portfolio и LivePix Album
от Live Picture.

Эти виртуальные фотоальбомы различаются по сложности и возможностям. К со-
жалению, мы не сможем обсудить здесь каждое приложение в отдельности, и од-
ной из причин является их постоянное совершенствование1. Если вы соберетесь
приобрести подобную программу, воспользуйтесь моим советом: попробуйте про-
тестировать несколько пакетов и/или просмотреть демонстрационные версии, за-
грузив их с веб-сайтов производителей.

Выбирая программу-фотоальбом, сравнивайте ее со своим каталогом, а также, хотя
это сложно выполнить, попытайтесь оценить, сколько фотографий вы собираетесь
хранить в альбоме. Сформулируем вопросы, на которые следует ответить при вы-
боре фотоальбома:

Q Каковы возможности программы?

О Сколько изображений допустимо поместить в альбом?

а Может ли программа работать с файлами, находящимися на разных дисках?

а Насколько хорошо выполняется возврат изображений из альбома?

О Существует ли простой поиск, например по ключевым словам, в именах или
описаниях файлов?

О Программа использует собственные форматы файлов или допускает стандарт-
ные расширения?

О Она сжимает файлы?

О Файлы изменяются?

Q Можно ли создать заново файл описания каталога, если исходный утерян или
поврежден?

Проще всего оценить любое программное обеспечение, читая рекламу. Из нее мож-
но почерпнуть очень многое о специальных приложениях, замечая, что говорят
и — еще важнее — что не говорят об этих программах.

В последнее время, помимо строго виртуальных, стали появляться цифровые фотоальбомы, представ-
ляющие из себя комбинацию из сменного (или встроенного) жесткого диска, жидкокристаллическо-
го дисплея, соединительного порта и источника питания в одном корпусе. Такие коробочки весят до
полукилограмма и стоят от $200. Размер дисплея составляет от 1,5 до 4 дюймов, в новинке 2003 года
Epson PhotoPC Player P-1000 объем жесткого диска равен 10 Гбайт, что позволяет вместить 7500
трехмегапиксельных фотографий (с поддержкой 260 000 цветов). Взаимодействие с внешними уст-
ройствами сводится к распечатке фотографий прямо на принтер или непосредственной записи на
компакт-диск. В будущем следует ожидать от таких устройств и различных интеллектуальных функ-
ций наподобие поиска по ключевым словам. — Примеч. ред.
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Следует запомнить
Q Программы, предназначенные для обработки и просмотра изображений, по-

могают копировать фотографии с камеры на компьютер.

Q С помощью графических редакторов можно улучшить качество изображений
или просто изменить их.

Q Такие программы разрабатываются как производителями фотоаппаратов, так
и сторонними фирмами.

Q Программы-фотоальбомы предназначаются для упорядоченного хранения изоб-
ражений.

Q Также мы рассмотрели пакетную обработку большого количества графических
файлов с помощью программы IrfanView.



Часть III

Фотосъемка
Достаточно легко поднять фотоаппарат и сфотографировать что-нибудь. Для это-
го требуется посмотреть в видоискатель, увидеть в нем объект и нажать на кнопку.
Но гораздо сложнее «создать» снимок.

Разница между этими понятиями определяется управлением процессом съемки.
Нет, это не означает, что приходится решать безумно сложные задачи или зани-
маться тяжелой работой. Чем больше удовольствия доставляет процесс создания
снимков, тем большее удовлетворение принесет результат творчества.

Я знаю, что ты хочешь сделать замечательный
портрет с хорошим освещением и прекрасной
композицией, но ты же снимаешь Джона —
фотография по определению получится плохой!



Глава 7

Экспозиция

а Диафрагменное число

а Скорость работы затвора
Q Светочувствительность пленки (матрицы)

а Творческое управление съемкой
Q Глубина резкости

Съемка фотографии, на которой появится видимый через видоискатель объект,
подразумевает корректное освещение пленки или матрицы светочувствительных
элементов. В результате слишком сильного освещения получатся «полинявшие»
изображения, а при недостатке света фотографии будут темными и мрачными.
Количественной мерой световой энергии, падающей на светочувствительный эле-
мент, является физическая величина, называемая экспозицией.

Объектив
Рассмотрим, каким образом свет попадает на пленку или светочувствительную
матрицу. При условии, что снята крышка с объектива и фотограф не закрывает
его рукой, свет проникает внутрь камеры через переднее стекло объектива. Затем
световые лучи проходят сквозь ряд линз, которые изменяют их направление и фо-
кусируют их на плоскости пленки (где находится пленка или матрица). Обычно
две или три линзы объединяются в группу, в которой они жестко соединены друг
с другом, и образуют оптическую систему. Объектив, в зависимости от его типа
и качества, как правило, содержит от двух до пяти оптических систем.

Внутри объектива, обычно где-нибудь между оптическими системами, располагает-
ся ирисовая диафрагма, которую также называют отверстием объектива (рис. 7.1).
С помощью диафрагмы регулируется количество света, проходящее сквозь объектив.
Для той же цели может использоваться рука или крышка объектива, но это вряд
ли позволит достичь желаемого результата.
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Рис. 7.1. Диафрагма состоит из тоненьких лепестков, которые могут сдвигаться
и таким образом регулировать размер отверстия

Затвор
Идем дальше. Обязательно должен существовать способ ограничить время осве-
щения плоскости пленки, и для этого применяется затвор. Он обычно находится
за объективом; на 35-миллиметровых зеркальных фотоаппаратах затвор, как пра-
вило, является частью корпуса камеры. Бывают шторные и центральные затворы.
Шторный затвор при работе выполняет два действия. Сначала металлическая или
резиновая шторка с помощью механизма затвора отодвигается в сторону, таким
образом позволяя свету проникать сквозь объектив на фокальную плоскость. Спу-
стя заданное количество времени другая шторка передвигается в противополож-
ном направлении, закрывая затвор и перекрывая доступ света. При перемотке кад-
ра затвор возвращается в исходное состояние (рис. 7.2).

•*-
Направление Затвор Направление
движения шторки, полностью открыт движения шторки,
затвор открывается затвор закрывается

Рис. 7.2. Работа шторного затвора

В некоторых фотоаппаратах затвор встроен в объектив, это осуществляется путем
объединения диафрагмы и затвора. Диафрагма остается закрытой вплоть до нажа-
тия кнопки затвора, затем она раскрывается, образуя отверстие заданного диамет-
ра. По прошествии нужного периода времени диафрагма закрывается.

Относительное отверстие объектива
и диафрагменное число
Данные величины описывают диаметр входного отверстия объектива, то есть диа-
фрагму, и, следовательно, количество света, проходящее сквозь объектив. Отно-
сительное отверстие объектива равно отношению диаметра входного «зрачка»
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объектива к его фокусному расстоянию. Для обозначения диафрагмы, тем не ме-
нее, используется так называемое диафрагменное число — величина, обратная от-
носительному отверстию. Ряд численных значений диафрагменного числа выби-
рается не самым логичным образом, что затрудняет понимание этой величины. Он
представляет собой геометрическую прогрессию со знаменателем, равным корню
квадратному из двух. Каждое последующее значение позволяет пропускать вдвое
меньше света, чем предшествующее. Чем больше диафрагменное число, тем мень-
ше диаметр диафрагмы. Прогрессия выглядит так: 1,4; 2; 2,8; 4; 5,6; 8; 11; 16; 22; 32;
45; 64; 901.

Если установить значение диафрагмы равным 8, то на пленку попадет в два раза
больше света, чем при значении 11, и в два раза меньше, чем при 5,6. Это может
показаться непонятным, но вспомните, что диафрагменное число на самом деле
является знаменателем в дроби, обозначающей относительное отверстие, и попро-
буйте провести сравнение с дробями. Одна шестнадцатая часть чего-либо меньше
одной восьмой.

Объективы характеризуются своим фокусным расстоянием, например величина-
ми 135 мм или 35 мм (фокусное расстояние будет рассматриваться в главе 8), но
обычно при описании объектива используется еще одна цифра, такая как 2,0 или
3,5. Это число имеет отношение к максимальному диаметру входного отверстия
объектива и характеризует параметр, называемый светосилой объектива. При мак-
симально открытой диафрагме объективы, имеющие минимальную диафрагму 2,8,
пропускают вдвое больше света, чем имеющие минимальную диафрагму 3,5. Если
эти объективы имеют одинаковое фокусное расстояние, то стоимость первых выше
стоимости вторых. В продаже можно встретить объективы с минимальными зна-
чениями 1,2,1,4 и 1,8; светосила таких объективов высока — по крайней мере, вдвое
больше, чем у объективов в обычных фотоаппаратах потребительского уровня,
обычно имеющих минимальное диафрагменное число 2,8.

Конечно, также можно устанавливать промежуточные значения диафрагменного
числа, что позволяет точно регулировать экспозицию.

Выдержка
Затвор фотоаппарата отвечает за время, в течение которого свет воздействует на
пленку, то есть за выдержку. Длительность выдержки измеряется в долях секунды,
причем каждое последующее значение означает сокращение времени освещения
вдвое. Если первое значение выдержки равно 1 с, вторым будет 1/2 с, третьим — 1/4 с.
После этого прогрессия сбивается, но сохраняется общий смысл. Следующие зна-
чения, как правило, равны 1/8, 1/15, 1/30, 1/60, 1/125, 1/250, 1/500, и последним
на вашем фотоаппарате (по моему предположению), но не менее важным будет
значение 1/1000. Этот ряд допустимых выдержек зависит от конкретной модели,
и некоторые действительно дорогие 35-миллиметровые камеры позволяют фото-
графировать даже с выдержкой 1/4000 с.

1 В англ, относительное отверстие обозначается f/stop, и значения диафрагмы принимают вид f/1,4;
f/2; f/2,8 и т. д. — Примеч. перев.
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Взаимосвязь между выдержкой
и диафрагмой
Вы могли заметить, что обе описанные выше величины увеличиваются или умень-
шаются пропорционально. Это удобно, поскольку сочетание значений выдержки
и диафрагменного числа позволяет достичь оптимального значения экспозиции.
(Вспомните, что экспозиция определяет количество света, попадающего на плен-
ку или светочувствительную матрицу, и для получения фотографии хорошего ка-
чества должна устанавливаться правильная экспозиция.)

Теперь на секунду забудем о выдержке и диафрагме. Представим игру в футбол.
В команде, скажем, восемь игроков, и они приехали на стадион в каком-то одном
автобусе. К началу игры все игроки должны оказаться на поле. Стоянка для автобу-
сов отгорожена от стадиона забором с воротами, которые в данный момент откры-
вают проход шириной в два фута. Соответственно, чтобы попасть на поле, игроки
должны выйти из автобуса и пройти через ворота. В результате они по очереди,
один за другим, медленно преодолевают ворота.

Тренер команды озабочен скоростью движения — он хочет, чтобы команда сдела-
ла это вдвое быстрее. Он возвращает команду в автобус и предлагает подумать над
решением такой простой задачи, но игроки не могут найти решения. И тут маль-
чик, моющий автобус, предлагает открыть ворота так, чтобы ширина прохода уве-
личилась до четырех футов. Тогда игроки смогут проходить парами, и попадут на
стадион вдвое быстрее. Какой находчивый мальчик!
Вернемся к фотографии. Из примера с воротами видно, что свет, попадающий на
пленку, то есть экспозиция (количество игроков), напрямую зависит от диафраг-
мы (ширины ворот) и от затвора (времени, в течение которого ворота открыты).
Чем шире открыта диафрагма, тем больше света проходит сквозь объектив, а при
постоянной диафрагме экспозицию можно регулировать с помощью выдержки за-
твора. Если по какой-либо причине (и такое бывает) требуется сделать маленькое
отверстие в объективе (то есть установить большое диафрагменное число), при-
дется увеличить выдержку. Но учтите, что чем дольше открыт затвор, тем больше
движений фиксируется на пленке — может получиться «смазанный» кадр.
Рассмотрим этот вопрос еще подробнее. Допустим, экспонометр показывает, что
для съемки футболиста на поле нужно установить диафрагменное число, равное
11, и выдержку — 1/125 с. Фотограф совершенно справедливо полагает, что футбо-
лист довольно быстро бегает по полю, и поэтому желательно сократить выдержку.
Установив диафрагменное число на 8, можно сфотографировать данный объект
с выдержкой 1/250 с. Если же требуется зафиксировать действие игрока крупным
планом, например движение ноги при ударе по мячу, снимать придется с выдержкой
1/500 с. Какое диафрагменное число при этом следует установить? Правильно — 5,6.

ПРИМЕЧАНИЕ
Установить экспозицию, соответствующую освещенности объекта съемки, помогает прибор,
называемый экспонометром. Современный экспонометр работает следующим образом: свет
попадает на находящийся в нем светочувствительный элемент, который называется фото-
элементом. На нем создается разность потенциалов, и ее регистрируют светодиоды.
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На рис. 7.3 проиллюстрирована взаимосвязь между выдержкой и диафрагмой.
Обратите внимание, что на горизонтальной оси штрихами отмечены значения ди-
афрагменного числа и выдержки (в этом примере мы зафиксировали их значения
в таком соотношении); ось экспозиции пересекает линия эффективной экспози-
ции. Сдвиг линии влево также позволяет достичь желаемой экспозиции, так как
при этом диафрагменное число увеличивается (отверстие в объективе уменьшается),
но затвор дольше остается открытым. Если отверстие сужается, на пленку попадает
меньше света, следовательно, требуется удлинить выдержку. При сдвиге по оси
вправо происходит увеличение диафрагмы и сокращение времени выдержки. Конеч-
но, эту взаимосвязь можно рассмотреть и с точки зрения работы затвора.

Светочувствительность
ISO 100

Диафрагменное число 1.4

Выдержка 1000 500

Рис. 7.3. Соотношение между диафрагменным числом и выдержкой, позволяющее получить
правильную экспозицию

В описанных выше примерах мы фиксировали соотношение между выдержкой
и диафрагмой, выбирая произвольную «правильную» экспозицию: диафрагменное
число 16 при выдержке 1/125 с или 16 при 1/60 с. Как же устанавливается это эф-
фективное значение?
Экспозиционное число, которое можно получить с помощью экспонометра, опре-
деляется освещенностью и светочувствительностью пленки. Чем оно больше, тем
больше освещенность объекта и допускается использование пленки с меньшей
светочувствительностью. В предыдущем примере соотношение между значения-
ми выдержки и диафрагмы задавалось исходя из оценки экспозиционного числа.
Определение этого параметра позволяет настроить экспозицию, то есть устано-
вить правильные значения выдержки и диафрагменного числа. В некоторые моде-
ли встраивается механизм, фиксирующий соотношение диафрагменного числа
и выдержки в соответствии с экспозиционным числом. К таким камерам относится
Hassleblad, в которой затвор является частью объектива, и при изменении диа-
фрагмы вручную автоматически настраивается выдержка.

Светочувствительность
Светочувствительность измеряется в единицах ISO (International Standards Orga-
nization — Международная организация стандартов) или ASA (American Standards
Association — Американская ассоциация стандартов). Количество единиц ISO



Светочувствительность 109

является характеристикой пленки или матрицы и описывает, насколько они чув-
ствительны к свету. Чем выше это число, тем больше светочувствительность плен-
ки. Если значение в единицах ISO пленки А в два раза меньше, чем пленки Б, зна-
чит, пленка типа Б вдвое светочувствительнее пленки А. Пленки, как правило,
обладают чувствительностью от ISO 50 до ISO 400 (позитивные пленки обычно
менее светочувствительные по сравнению с негативными). В цифровых камерах,
где чувствительность является свойством матрицы, можно встретить довольно вы-
сокие значения, например ISO 1600,

Высокочувствительные пленки имеют один недостаток: растет зернистость изоб-
ражения, которая проявляется в виде укрупнения точек растра. Этот эффект мо-
жет создавать текстуру и влиять на четкость изображения. Поэтому одно из основ-
ных правил фотографов гласит, что следует использовать пленку с минимальной
светочувствительностью, допускаемую освещением. На улице в солнечный день
вполне достаточно пленки с ISO 100, а в* помещении, к сожалению, придется сни-
мать на пленку с ISO 400, поскольку она более восприимчива к свету.

Одним из преимуществ цифровой фотографии является возможность изменения
светочувствительности матрицы. Обычно цифровые камеры настроены на опти-
мальное значение, которое определяется производителем, и при такой настройке
получаются наилучшие результаты. Но это значение можно изменить. Конечно,
как и в случае с пленкой, цифровые фотографии «страдают» от сильного увеличе-
ния светочувствительности. Если установить светочувствительность выше опти-
мальной, появится шум в виде синих и красных черточек; он обычно наиболее за-
метен в темных областях изображения.

Мы не говорим, что на фотографиях, которые сняты камерой, созданной для опти-
мальной работы при чувствительности ISO 400, шум будет выше, чем на изобра-
жениях с камеры, «правильная» светочувствительность которой равна ISO 100. Но
можно убедиться, что если чувствительность камеры, оптимальное значение кото-
рой составляет ISO 100, изменится до ISO 400, на фотографиях будет больше шума,
чем если бы они снимались камерой, у которой ISO 400 является оптимальным
значением. Поэтому если необходимо осуществить съемку при слабом освещении,
прежде всего попробуйте увеличить количество источников света или воспользо-
ваться лампой-вспышкой.

ВНИМАНИЕ
Восприятие света цифровыми камерами сложно сравнивать с чувствительностью пленоч-
ных фотоаппаратов; для получения хорошего изображения с их помощью обычно требуется
больше источников света, чем при съемке традиционным фотоаппаратом. Поэтому всегда
нужно предполагать, что понадобятся дополнительные источники света. К некоторым каме-
рам, таким как Olympus DL620, можно подключать вторую вспышку.

Вернемся к экспозиционным числам и рассмотрим рис. 7.4. Предположим, что ис-
ходное оптимальное значение светочувствительности равнялось ISO 100. Если
изменить настройку матрицы, подняв чувствительность до ISO 400, или восполь-
зоваться камерой с такой оптимальной чувствительностью, верхний и нижний па-
раметры разойдутся в противоположных направлениях (одно значение соответ-
ствует изменению чувствительности с ISO 100 до ISO 200, второе — с ISO 200
до ISO 400). Теперь, сохранив величину диафрагмы, можно сократить выдержку
или уменьшить диафрагму, не меняя выдержку.
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Светочувствительность
ISO 400

Диафрагменное число 1 .4

Выдержка 4000
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Рис. 7.4. Влияние светочувствительности на выдержку и диафрагму

Творческое управление съемкой
Наличие системы, позволяющей изменять экспозицию по своему усмотрению,
а также фокусировать объектив на любом объекте, дает больше возможностей для
творчества. У вас есть камера, вы «создаете» снимки и в состоянии управлять этим
процессом.

Выдержка
Прежде всего, такая система позволяет регулировать выдержку. Уменьшив ее,
можно сфотографировать движущийся объект, и он получится резким. При увели-
чении времени экспозиции снимки будут немного размытыми. (Но если требуется
показать, что автомобиль движется, проще всего допустить небольшую расплыв-
чатость.) Кроме того, увеличение выдержки позволяет увеличить диафрагменное
число, то есть уменьшить диафрагму.

Глубина резкости
Вторую возможность для творчества предоставляет оптическая система объекти-
ва — она позволяет регулировать глубину резкости. Эта величина отвечает за раз-
мер четко изображаемого пространства на фотографии. Если все объекты, распо-
ложенные перед объективом на расстоянии от двух до пяти футов, находятся
в фокусе, глубина резкости равна трем футам. При небольшой глубине резкости
можно, например, снимать портреты, тогда лицо человека будет в фокусе (или рез-
ким), а фон — не в фокусе (размытым). Когда глубина резкости велика, можно
сфотографировать группу людей на фоне гор, и резким получится весь снимок.
Это очень удобно!
На глубину резкости влияют два фактора, и ими можно управлять.
Q Чем ближе объект к объективу, тем меньше глубина резкости. Если попробо-

вать крупным планом снять первые весенние крокусы, то для этого, скорее всего,
придется встать на четвереньки, а затем, чтобы все цветы оказались в фокусе,
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потратить довольно много времени на наведение резкости. А при съемке груп-
пы людей, расположенной на расстоянии 15 футов от вас, можно быть уверен-
ным, что резким получится весь задний план, хотя объектив фокусируется на
людях. Итак, глубина резкости зависит от расстояния до объекта съемки.
Глубину резкости можно регулировать с помощью диафрагмы. И это гораздо
эффективней, нежели ползать вокруг крокусов, приближая и отдаляя их от
объектива; а также подводит к мысли о ценности систем, позволяющих изме-
нять экспозицию. Если не вдаваться в технические подробности, то описать этот
факт можно так: чем больше диафрагменное число и, соответственно, меньше
диаметр диафрагмы, тем резче будет изображение, что позволяет контролиро-
вать резкость объектов путем изменения диафрагмы (см. примеры на рис. 7.5
и 7.6). Естественно, можно комбинировать этот метод с изменением расстояния
до объекта. Однако не нужно забывать о том, что если для настройки глубины
резкости требуется установить новое диафрагменное число, то также необхо-
димо изменить выдержку.

Рис. 7.5. Уменьшение диафрагменного числа (увеличение диафрагмы) приводит
к снижению глубины резкости

Рис. 7.6. Большее диафрагменное число (сужение диафрагмы) приводит
к увеличению глубины резкости

Теперь попытаемся сфотографировать крокусы еще раз, но на этот раз целиком
всю группу цветов. Для этого придется немного отодвинуться назад. Пусть экспоно-
метр показывает, что нужно установить диафрагменное число, равное 8 (выдержку
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мы пока не рассматриваем). Итак, что же сейчас находится в фокусе? Вся группа
цветов, и это прекрасно. А трава на заднем плане тоже получается резкой?! Но мы
не хотели добиться этого эффекта. Ничего страшного, нужно просто открыть диа-
фрагму до 4 или еще больше, и тогда цветы станут резкими, а трава — нет.

Предположим, что участок с цветами имеет ширину в три фута. Также допустим,
что глубина резкости при диафрагменном числе 4 составляет три фута. Если сфо-
кусироваться на центре участка, все цветы будут строго очерчены, а трава позади
них станет размытой. Что же произойдет, если сделать упор, например, на перед-
ней границе участка с цветами, не меняя диафрагму? Резким останется все, что
расположено на расстоянии 1,5 фута перед границей, и все цветы на передней по-
ловине участка. Задняя половина участка и трава за ним окажутся размытыми.
Такой эффект применим при съемке художественных фотографий.

СОВЕТ
Не снимайте неинтересные фотографии. В описанном выше примере продемонстрировано,
каких изумительных эффектов можно добиться, изменяя глубину резкости и фокусировку.

Теперь предположим, что какой-то замечательный садовник выкопал всю траву
и посадил вместо нее множество самых разных цветов. Тогда, конечно, захочется,
чтобы они тоже получились резкими. Для этого требуется сфокусироваться на
центре группы растений и закрыть диафрагму до 22 (или даже больше).

Ручная или автоматическая установка
экспозиции
Теперь, после всех объяснений, вы можете решить, что не хотите затруднять себя
определением и настройкой экспозиции. Многие фотоаппараты, особенно деше-
вые (класса «увидел-снял»), оснащаются системой автоматической установки экс-
позиции и автоматической фокусировки. Они удобны в обращении, и до тех пор,
пока не потребуется особенное сочетание выдержки и диафрагмы, у вас будут по-
лучаться прекрасные фотографии.

Более дорогие камеры, как правило, предоставляют возможность относительно
свободного управления экспозицией. Иногда допускается ручная установка диа-
фрагмы, а выдержку фотоаппарат определяет самостоятельно. Такая схема назы-
вается режимом приоритета диафрагмы. В других фотоаппаратах, наоборот, раз-
решается ручная установка выдержки, а вычисляется диафрагма — это режим
приоритета выдержки. В некоторых камерах соседствуют оба режима, и фотограф
может работать в любом из них. Как вы уже видели, у каждой из схем есть свои
преимущества и недостатки. Но вы не встретите цифровую камеру с полностью
ручной настройкой до тех пор, пока не воспользуетесь полупрофессиональным или
профессиональным оборудованием.

В некоторых, наиболее дорогих цифровых фотоаппаратах встречаются центро-
взвешенные и матричные системы определения экспозиции. При центровзве-
шенном замере результат основывается на 90 процентов на центре изображения,
и тогда на экспозицию не оказывает неблагоприятного влияния разнообразный
задний план, например лампы подсветки. При матричном замере учитывается
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освещенность в разных областях кадра. Это удобно, когда, например, в солнечный
день фотографируется интерьер комнаты с открытым окном. Если бы экспозиция
определялась по среднему значению, то из-за яркого окна диафрагма бы закры-
лась, и комната получилась бы слишком темной. Но при матричном замере прини-
мается во внимание как светлое окно, так и темный интерьер. Система определяет,
что окно занимает лишь небольшую часть изображения, и в основном сосредото-
чивается на самой комнате, «осветляя» ее.

В цифровых фотоаппаратах вообще может отсутствовать диафрагма и затвор, это
очень часто характерно для дешевых камер. Роль затвора выполняет сама свето-
чувствительная матрица — она включается только на определенный промежуток
времени, на который открывался бы затвор. А диафрагма заменяется настройкой
чувствительности матрицы. Различные производители добиваются этого разны-
ми способами. Но не стоит сразу разочаровываться — можно не платить много де-
нег и, тем не менее, получать превосходные результаты.

СОВЕТ
Даже если система фотоаппарата не подразумевает ручной настройки выдержки или диа-
фрагмы, можно попытаться заставить ее «творчески подумать». Так, например, если изме-
нить светочувствительность матрицы, камере придется подстроить выдержку или диафраг-
му. Предположим, что фотоаппарат настроился на выдержку 1/60 с при чувствительности
ISO 100. Если усилить чувствительность в два раза, то есть установить ISO 400, выдержка
автоматически сократится до 1/250 с. Точно так же можно влиять на диафрагму. Характеристи-
ка, на которую воздействует изменение чувствительности, зависит от системы фотоаппарата.
Но помните, что чрезмерное увеличение чувствительности приводит к появлению шума.

Есть еще один способ «обмануть» камеру — надеть на объектив нейтральный светофильтр
(такие фильтры продаются в специализированных фотомагазинах). Нейтральный свето-
фильтр, также называемый нейтрально-серым, затемняет изображение, не изменяя цветов,
что вызывает раскрытие диафрагмы или увеличение выдержки в зависимости от устройства
камеры. Перед тем как воспользоваться нейтральным светофильтром, следует убедиться,
что камера определяет экспозицию по свету, прошедшему через объектив, а не по данным
из внешних источников. Если применяются внешние источники, их также можно закрыть
светофильтром.

Следует запомнить
О Важно понять основы определения экспозиции, чтобы получить возможность

творческого управления изменяемыми величинами.

Q Глубину резкости можно регулировать с помощью диафрагмы.

О Величина выдержки влияет на резкость отображения движущихся объектов.

Q Экспозицию можно устанавливать вручную или же воздействовать на значе-
ния, выбираемые камерой.
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Объективы

а Фокусировка
Q Широкоугольные объективы

Q Длиннофокусные объективы
а Объективы с переменным фокусным расстоянием

О Выбор объектива

В главе 7 мы упоминали понятие фокусировки по отношению к глубине резкости.
Но каким образом фотоаппарат «фокусируется»? В общих чертах, это происходит
следующим образом. Лучи света в прозрачных средах, таких как воздух, распрост-
раняются по прямой, но когда луч переходит из одной среды в другую, с отличаю-
щейся плотностью, например из воздуха в стекло, его направление изменяется.
Данное явление, наблюдаемое при прохождении света через границу двух сред,
называют преломлением света. Чтобы ввести все необходимые термины, нам придется
чуть подробнее рассмотреть строение линзы. Она образуется двумя сферическими
поверхностями (плоскую поверхность можно считать «бесконечной» сферой).
Прямая, проходящая через центры этих сферических поверхностей, называется
главной оптической осью линзы. Направив на выпуклую линзу пучок лучей, па-
раллельных главной оптической оси, мы увидим, что после преломления в линзе лучи
сойдутся в одной точке, находящейся на главной оптической оси. Эту точку называ-
ют главным фокусом линзы. Если через главный фокус (далее фокус) провести
плоскость, перпендикулярную главной оптической оси линзы, мы получим фокаль-
ную плоскость. В фотоаппарате в этой плоскости располагается пленка или светочув-
ствительная матрица, поэтому мы будем называть ее плоскостью пленки (рис. 8.1).
Если расстояние между объективом и плоскостью пленки не соответствует дис-
танции между фотографом и объектом съемки, фотография получится нерезкой
(рис. 8.2).
Обычно или объектив фокусируется автоматически, или фотограф должен настроить
системы линз объектива так, чтобы изображение стало резким. Вам когда-нибудь
приходилось держать в руках зеркальную камеру и поворачивать на объективе
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кольцо, отвечающее за фокусировку? При этом группы линз перемещаются,
и в результате изображение, создаваемое оптической системой объектива, фоку-
сируется на плоскости пленки.

Параллельные лучи сходятся,
или фокусируются,
в фокальной плоскости

Фокальная
плоскость

Рис. 8.1. Внимание! Снимаем...

Параллельные лучи
сходятся, или фокусируются,
в фокальной плоскости

Плоскость Фокальная
пленки плоскость

Рис. 8.2. Ошибка! Лучи света сошлись за плоскостью пленки, и изображение
получилось нерезким

Типы объективов
О Простейшие объективы характеризуются постоянным фокусным расстоянием

и не имеют системы фокусировки, то есть в них отсутствуют двигающиеся эле-
менты. При съемке такими объективами обычно получаются резкими предме-
ты, находящиеся на некотором среднем расстоянии от камеры — как правило,
где-нибудь между 12 футами и бесконечностью. Их можно встретить на деше-
вых камерах класса «увидел-снял», и с их помощью невозможно получить по-
настоящему качественные фотографии.

Q Более сложные объективы также имеют постоянное фокусное расстояние, но
могут фокусироваться. При повороте кольца фокусировки или при нажатии на
кнопку управления фокусировкой линзы начинают двигаться вдоль главной
оптической оси объектива, приближаясь к плоскости пленки или удаляясь от
нее, таким образом приводя к совмещению плоскость пленки с плоскостью, в ко-
торой изображение объекта получается резким. Подобные объективы можно
увидеть на полупрофессиональных и профессиональных камерах, для которых
почти всегда используются корпуса зеркальных фотоаппаратов.
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а В отдельную группу выделяются объективы с переменным фокусным расстоя-
нием. Они обычно содержат несколько оптических систем, которые объедине-
ны в группы, и их перемещение друг относительно друга позволяет изменять
фокусное расстояние объектива.

Некоторые производители цифровых камер встраивают в свои объективы пласт-
массовые оптические системы. Это сложилось исторически, потому что изначаль-
но матрицы ПЗС-элементов не могли обеспечить разрешение, которого было бы
достаточно для восприятия всех нюансов, предоставляемых стеклянной оптикой.
Сейчас разрешающие способности ПЗС-матриц значительно улучшились, и если
вам нужны четкие фотографии, то стоит приобрести камеру со стеклянной опти-
кой. Кроме того, качественные объективы на внешней линзе обычно имеют анти-
отражающее (ахроматическое) покрытие (синего или багряного цвета), которое
увеличивает контраст изображений и сглаживает блики. Такую оптику также на-
зывают просветленной.

Если даже очень хороший объектив загрязнен или поцарапан, вряд ли получатся
качественные фотографии. Ниже представлено несколько советов по хранению
объективов и уходу за ними.

Q Если на внешней линзе объектива осела пыль или соринки, прежде всего, нужно
попытаться аккуратно удалить их или сдуть с помощью какого-нибудь приспо-
собления. Для этого лучше всего подойдет клизма, предназначенная для выса-
сывания слизистых выделений из носа ребенка (на самом деле!). Также можно
попробовать легонько протереть объектив мягкой тряпочкой. Никогда не дуйте
на объектив — когда-нибудь вы обязательно на него плюнете.

О Если на стекле объектива появилось грязное пятно, то, чтобы удалить его, при-
дется немного потрудиться. Существует специальная жидкость, предназначен-
ная для очистки объективов. Нужно капнуть несколько капель этой жидкости
на мягкую ткань и аккуратно протереть ею объектив. Также встречаются сал-
фетки для протирки оптики, уже пропитанные специальными жидкостями.
После удаления пятна можно попытаться отполировать стекло объектива сухой
тряпочкой из мягкой ткани. Ни в коем случае не следует капать очищающую
жидкость прямо на объектив — она может просочиться через щели внутрь.

а Наилучшим способом сохранения внешней линзы объектива в чистом состоя-
нии и предохранения от повреждений является использование прозрачного
фильтра. Если на переднем цилиндре объектива есть винтовая резьба, значит,
на него можно надеть фильтр. Лучше всего для нашей цели подходят ультра-
фиолетовые светофильтры — они прозрачные и, кроме того, уменьшают дымку,
создаваемую ультрафиолетовым излучением. Такие фильтры обычно дешевы,
поэтому их несложно заменить.

ПРИМЕЧАНИЕ
Отпечатки носа, пальцев, а также другая смешанная грязь и пыль — это не самое лучшее
покрытие для оптических приборов. Любой фотограф должен постоянно носить с собой
набор для очистки объектива. В него входит салфетка или кусок мягкой ткани (они должны
быть чистыми!) для очистки, очищающая жидкость и мягкая ткань или щеточка для поли-
ровки. Все это можно купить в магазинах.
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Объективы с автоматической фокусировкой
Если объектив фотоаппарата допускает фокусировку, вполне возможно, что в нем
используется система автоматической фокусировки, в обиходе его называют авто-
фокусом. Автофокусирующиеся объективы лучше объективов без системы фокуси-
ровки, поскольку они способны точно определять расстояние между объектом и каме-
рой и самостоятельно фокусироваться на объекте. Фотографии при этом получаются
намного резче. Существует несколько разных типов систем автофокусировки.
Q Во многих фотоаппаратах с системой автофокусировки расстояние между объекти-

вом и предметом съемки определяется с помощью инфракрасного либо ультразву-
кового дальномера — на объект съемки посылается импульс (инфракрасный
либо ультразвуковой, в последних моделях Sony используется лазерный принцип)
и, отраженный от объекта, он попадает на специальный датчик фотоаппарата.
Измеряется интервал времени, прошедший между моментами посылки импульса
и приема отраженного сигнала (рис. 8.3). По нему определяется расстояние до
объекта, и настраиваются линзы объектива. Такая система называется активной.

Время, за которое импульс
шел до объекта и вернул

Скорость импульса х 2

дошел до объекта и вернулся
Расстояние = —

Звуковой или
инфракрасный

импульс

Дальномер

Рис. 8.3. В некоторых камерах с системой автофокусировки расстояние до объекта
определяется с помощью звука или инфракрасного излучения

а В пассивных автофокусирующих системах, которые можно встретить в доро-
гих фотоаппаратах, объектив самонастраивается исходя из оценки контрастно-
сти объекта съемки. Если сравнить четкое и размытое изображения, то можно
заметить, что резкое также является более контрастным.

Системы автоматической фокусировки имеют несколько недостатков.
а если между фотоаппаратом и объектом съемки находится какое-то препятствие,

например забор, то камера может сфокусироваться именно на заборе, и объект
получится нерезким;

а если объект съемки расположен рядом с большим предметом, то этот предмет
может отразить импульс, посланный дальномером, и тогда расстояние до объекта
будет определено неточно;

Q при съемке группы людей, находящихся на разных расстояниях от объектива,
вероятны проблемы с определением правильного расстояния и фокуса.



118 Глава 8. Объективы

Системы автофокусировки с блокировкой
Все перечисленные проблемы позволяет решить автоматическая фокусировка
с блокировкой. В этом режиме фотограф направляет камеру на объект, который
должен оказаться в фокусе, и наполовину нажимает кнопку спуска затвора. В резуль-
тате происходит обсчет экспозиции и дистанции съемки. Затем фотограф может
окончательно скомпоновать кадр. Предположим, что требуется сфотографировать
ребенка, стоящего на скале, на фоне голубого неба, но желательно сделать так, чтобы
ребенок находился не по центру кадра. Если просто сфотографировать его авто-
фокусирующейся камерой с автофокусом, объектив настроится на бесконечность
вместо дистанции до ребенка, поскольку обычно система автоматической фокуси-
ровки вычисляет расстояние до объектов, расположенных именно посередине
кадра. Исправляется это следующим образом.

1. Направьте фотоаппарат так, чтобы ребенок оказался в центре кадра.

2. Нажмите до половины кнопку затвора — камера сфокусируется.

3. Заблокируйте это состояние.

4. Измените направление камеры, чтобы получить желаемую композицию.

5. Сфотографируйте.

ПРИМЕЧАНИЕ
Если фотоаппарат фокусируется достаточно медленно, объект съемки может заметить на-
веденный на него объектив, и фотография получится неестественной. В такой ситуации
очень поможет автофокус с блокировкой: нужно направить камеру на другой объект, нахо-
дящийся на том же расстоянии, что и настоящий, сфокусироваться, а затем перевести каме-
ру и сфотографировать.

При съемке широкоугольным объективом можно не затруднять себя блокировкой фокуса и
даже не смотреть в видоискатель. Такой техникой в совершенстве владеет большинство
профессиональных фотографов, особенно фотожурналисты, снимающие для спортивных
и новостных изданий.

Макросъемка
При съемке объектов, находящихся близко к объективу, начинают искажаться их
пропорции. Если рассмотреть хороший объектив для 35-миллиметрового фотоаппа-
рата, можно заметить, что он выдвигается вперед при съемке мелких объектов крупным
планом. Во многих камерах с системой автофокусировки есть режим макросъемки,
в котором объектив перестраивается под размеры мелких объектов. Иногда это реали-
зуется с помощью оптической системы самого объектива, но подчас для макросъем-
ки требуется подсоединение специальных приспособлений, называемых конвертер-
ными насадками. Снимая что-либо крупным планом, старайтесь работать в режиме
макросъемки, это поможет точнее сфокусироваться на объекте съемки.

Фокусное расстояние
Фокусное расстояние объектива является важной величиной, поскольку оно
напрямую связано с размером изображения в плоскости пленки. Также оно влия-
ет на угол зрения объектива (эти понятия рассматриваются далее). Фокусным
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расстоянием объектива называют измеряемую в миллиметрах длину отрезка меж-
ду оптическим центром и главным фокусом объектива, то есть точкой, в которой
сходятся параллельные главной оптической оси лучи света. Это расстояние явля-
ется характеристикой объектива, определяемой его производителем.

Угол зрения, поле изображения и размер
объектов в кадре
Область перед объективом, которую мы фотографируем, называется пространством
объектов, область за объективом, в которой находится пленка или матрица, на-
зывается пространством изображений. Рассмотрим важные понятия, связанные
с объективами.

Q Прежде всего, следует обратить внимание на угол зрения объектива. Эта вели-
чина показывает, как много объектов может попасть в кадр, иногда ее также
называют просто полем зрения. На рис. 8.4 через длиннофокусный объектив
видна небольшая часть изображения, потому что его угол зрения острый, в то
время как в зону обзора широкоугольного объектива попадают области, нахо-
дящиеся под большим углом относительно центральной оси объектива. Типы
объективов мы рассмотрим далее.

О Не менее важен для фотографа размер объектов в кадре. Он напрямую связан
с фокусным расстоянием объектива: чем больше фокусное расстояние, тем боль-
ше объектив приближает предметы, то есть у фотографа появляется возмож-
ность снимать удаленные предметы крупным планом, как показано на рис. 8.4.
Объектив с широким углом зрения (короткофокусный) удаляет объекты, что
позволяет снимать крупные предметы, например деревья или здания в городе,
не отходя от них далеко.

Объект
съемки

Угол зрения
объектива

Длиннофокусный
объектив

Матрица или
фотопленка Фотография

Рис. 8.4. Угол зрения определяет размер области, видимой через объектив;
от фокусного расстояния объектива зависит размер объектов в кадре

Q Еще одна характеристика объектива называется полем изображения — это об-
ласть, занимаемая на плоскости пленки изображением, которое видно через
объектив. Поскольку для объектива характерна круглая форма, поле изображе-
ния также имеет форму круга. Его диаметр зависит от фокусного расстояния



120 Глава 8. Объективы

объектива. Круг, диаметром которого является диагональ кадра пленки или
матрицы, называется используемым полем изображения. Величина используе-
мого поля изображения зависит от размеров кадра пленки или светочувстви-
тельной матрицы.

Угол зрения, поле изображения и размер объектов в плоскости пленки объектива
связаны друг с другом. На практике встречаются объективы с различным соотно-
шением данных параметров, это зависит от конструкции их оптических систем.

Угол обзора обычного объектива приближен к углу зрения человека (области, ко-
торую видит человек, не поворачивая головы), а диаметр поля изображения стан-
дартного объектива цифрового фотоаппарата примерно равен длине диагонали
светочувствительной матрицы (рис. 8.5) (то есть используется все поле изоб-
ражения).

-̂ -̂
Рис. 8.5. Длина диагонали матрицы приблизительно совпадает с диаметром поля

изображения объектива

Производители объективов всегда указывают на своей продукции фокусное рас-
стояние объектива, величина которого обратно пропорциональна углу зрения,
иногда также указывают и угол зрения. Для 35-миллиметровых фотоаппаратов счи-
таются нормальными объективы с фокусным расстоянием 55 мм — при этом их
угол зрения примерно совпадает с человеческим углом зрения. В обычных цифро-
вых камерах длина стороны светочувствительной матрицы намного меньше 35 мм,
поэтому укорочен и объектив. Поскольку для размера матрицы не существует еди-
ного стандарта, объективы различаются в зависимости от производителя. Кроме
того, матрицы постоянно совершенствуются, на данный момент новыми являются
5-7-мегапиксельные, но никому не известно, как изменится ситуация даже в сле-
дующем месяце. Как правило, стандартные объективы цифровых фотоаппаратов
имеют фокусное расстояние в пределах от 4,5 мм до 7 мм.

ПРИМЕЧАНИЕ
Многие производители указывают на своих объективах фокусное расстояние в эквиваленте
35-миллиметрового фотоаппарата. Как-то я осматривал камеру, объектив которой имел пе-
ременное фокусное расстояние от 9,2 мм до 28 мм, что соответствует так называемому «ры-
бьему глазу» на 35-миллиметровой камере. На объективе указывалось, что это его факти-
ческие размеры, Фокусное расстояние другого объектива, похожего на первый, изменялось
в диапазоне от 28 мм до НО мм. Откуда получились такие цифры? Просто производитель
пересчитал фокусное расстояние в эквиваленте 35-миллиметрового фотоаппарата.
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ПРИМЕЧАНИЕ
Мне кажется, что для фотографа удобно, когда фокусное расстояние объектива задается
в эквиваленте 35-миллиметровой камеры. Как я уже говорил, размер светочувствительной
матрицы зависит от модели фотоаппарата, и если он не известен, также не ясно, какой
объектив подойдет к данной камере. Кроме того, большинство из нас знакомы с 35-миллиметро-
выми камерами и привыкли' пользоваться их маркировкой. В любом случае нужно знать,
какая система измерений взята за основу, и не пытаться сравнивать килограммы с метрами.

Длиннофокусные объективы
Для длиннофокусных объективов характерно большое фокусное расстояние —
именно поэтому они получили такое название. К этому же виду относятся теле-
объективы, они имеют еще большее фокусное расстояние, чем длиннофокусные.
У объективов этого типа довольно маленький угол зрения, и они визуально при-
ближают объекты съемки, то есть объект в кадре получается крупнее, чем вы его
видите на самом деле. При съемке длиннофокусными объективами появляются
телезффект (его также называют «подушкообразным») и аберрации. Аберрациями
называются искажения изображения, формируемые оптической системой. Они
возникают по краям фотографий и проявляются в понижении резкости изображе-
ния, нарушении подобия между объектом и его изображением (геометрические
аберрации) либо окрашивании контуров изображения (хроматические аберрации).
Производители фотоаппаратов стараются уменьшить эти искажения за счет кон-
струкции объективов, например, помещая в кадр только центральную часть поля
изображения. Это реализуется и в обычных цифровых фотоаппаратах — в них абер-
рации минимальны, поскольку матрица, как правило, существенно меньше поля
изображения, но располагается по его центру.

Длиннофокусные объективы чаще всего используются для съемки удаленных
объектов — они визуально уменьшают расстояние. Но их маленький угол обзора
позволяет также фотографировать фрагменты приближенных объектов, например,
лицо человека, стоящего в группе людей, или цветок на клумбе. Длиннофокусные
объективы с относительно небольшим фокусным расстоянием прекрасно подходят
для портретной съемки; с их помощью можно сфотографировать опасный объект,
например тигра, из окна автомобиля, на безопасном расстоянии.

Одним из свойств длиннофокусных объективов является так называемое визуаль-
ное сжатие, сказывающееся на перспективе снимка. То есть если в кадре одновре-
менно присутствуют объекты, расположенные на разных расстояниях от фотогра-
фа, они как бы приближаются друг к другу. Помимо этого нужно помнить, что
близко расположенные к камере объекты получаются в кадре очень крупными.

Мы постоянно сталкиваемся с явлением визуального сжатия, когда смотрим теле-
визор, например игру в бейсбол. Центральная камера часто показывает следую-
щую картину: подающий бросает мяч в игрока с битой. Обратите внимание, на-
сколько подающий игрок выглядит крупнее отбивающего, кроме того, кажется, что
они стоят прямо друг за другом. Можно удивиться тому, как много энергии затра-
чивает подающий, чтобы бросить мяч на такое короткое расстояние! На рис. 8.6
также представлен хороший пример видеокомпрессии — здания выглядят сдав-
ленными, и кажется, что архитектор нисколько не озаботился вопросами детских
площадок, спортивных полей и мест парковки автомобилей.
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Рис. 8.6. Объектив с большим фокусным расстоянием приближает объекты, а также

Так как длиннофокусные объективы часто применяются для съемки группы объек-
тов, находящихся на разных дистанциях от фотографа, нужно внимательно сле-
дить за глубиной резкости и тщательно фокусировать объектив. В общем случае
(при одинаковых диафрагме и расстоянии до точки, по которой объектив фокуси-
руют) глубина резкости у длиннофокусных объективов меньше, чем у короткофо-
кусных. Иногда, правда, глубину резкости специально уменьшают для создания
интересных художественных эффектов. Также, поскольку объектив визуально
приближает объекты съемки, любая встряска фотоаппарата заметно повлияет на
качество кадра. Поэтому при работе с длиннофокусными объективами, особенно
в ситуации со слабым освещением и при отсутствии штатива и тросика, фотограф
имеет минимальное право на ошибку — любая, даже самая маленькая, оплошность
может привести к существенному снижению качества снимка. Иногда фотографы
находят удобные для опоры места и пользуются ими, например камнями для съемки
в горах.

Широкоугольные объективы
Широкоугольные объективы по своим свойствам противоположны длиннофокус-
ным: они имеют короткое фокусное расстояние и большой угол зрения, они визу-
ально удаляют объекты, и в кадр пленки или на светочувствительную матрицу по-
падает почти все пространство, видимое объективом.

Широкоугольные объективы, как правило, используются там, где нужно, чтобы
в кадре уместилось как можно больше объектов, например для пейзажной съемки,
особенно если у фотографа нет возможности отойти на достаточное расстояние.
Так, если бы некоторые из самых прекрасных панорам и горных видов пришлось
снимать обычным объективом, понадобилось бы отойти на несколько километров!
Широкоугольные объективы имеют большую глубину резкости, то есть сохраняются
четкими как относительно близкие объекты, так и находящиеся на заднем плане —
как на следующем рисунке (рис. 8.7). Правда, при съемке широкоугольным объек-
тивом существует один недостаток — возникает явление дисторсии. Дисторсией
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называется один из видов геометрической аберрации, который выражается в том,
что линия горизонта изгибается по краям изображения (так называемый «бочко-
образный» эффект). Однако ей также можно найти применение для создания ин-
тересных эффектов.

Рис. 8.7. При съемке широкоугольным объективом в кадр попадает больше объектов

Объективы с переменным фокусным
расстоянием
В объективах с переменным фокусным расстоянием, как и следует из их названия,
фокусное расстояние может изменяться (их также называют вариообъективами,
а в английском языке для их обозначения используется термин «zoom»). Это очень
удобно — особенно если конструкция фотоаппарата не подразумевает смены объек-
тива. Переменное фокусное расстояние обеспечивается за счет наличия несколь-
ких групп линз, которые могут передвигаться друг относительно друга.
Хороший вариообъектив не перекрывает весь диапазон от широкоугольного объек-
тива с очень маленьким фокусным расстоянием до длиннофокусного с очень боль-
шим фокусным расстоянием. Обычно фокусное расстояние вариообъектива изме-
няется в некоторых средних, хотя и достаточно широких пределах. Например,
замечательно, если в эквиваленте 35-миллиметровой камеры фокусное расстояние
объектива варьируется в диапазоне от 35 мм до 100 мм.
Поскольку элементы вариообъектива должны двигаться на большие расстояния,
он обычно не обеспечивает такую проработку деталей, как соответствующие спе-
циальные объективы с постоянным фокусным расстоянием. По этой же причине
на настройку вариообъектива обычно требуется больше времени. После измене-
ния состояния такого объектива всегда следует проверять его на резкость будуще-
го кадра. Очень удобно, когда фотоаппарат с вариообъективом имеет систему ав-
тофокусировки, тогда объектив автоматически перенастроится после или при
изменении фокусного расстояния.
В общем, если вы не пользуетесь профессиональной камерой со сменными объек-
тивами, то лучше всего будет приобрести фотоаппарат с объективом, имеющим
переменное фокусное расстояние.
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СОВЕТ
Вы когда-нибудь в солнечный день прикрывали глаза рукой, чтобы они оказались в тени?
И замечали, что при этом становится лучше видно окружающий мир? Вы догадываетесь,
почему? Если сделать то же самое с объективом, качество изображения также улучшится.
Всегда при съемке на улице или при возможности попадания в объектив ярких прямых
лучей света старайтесь затенить его. Это первое, что можно сделать для улучшения каче-
ства фотографий.

Кратность объективов с переменным фокусным расстоянием
Многие производители указывают на своих вариообъективах так называемую крат-
ность увеличения фокусного расстояния — отношение максимального фокусного
расстояния к минимальному. Например, фокусное расстояние трехкратного варио-
объектива (обозначается как Зх) может изменяться от 25 мм до 75 мм. Но если
объектив с переменным фокусным расстоянием имеет маркировку Зх/2х, что это
означает? Смысл данных цифр заключается в следующем: трехкратное увеличе-
ние достигается с помощью оптической системы фотоаппарата, а еще двухкрат-
ное — светочувствительной матрицей, с помощью вычислений.
Дополнительное увеличение получается за счет интерполяции, которую выпол-
няет камера, и, следовательно, фотоаппарат создает изображение на основе не только
орининальных, но и расчетных данных. Не стоит пользоваться данной возможно-
стью, за исключением тех случаев, когда это действительно необходимо, так как
при подобном увеличении изображения усиливаются искажения и множатся ошиб-
ки в цветопередаче. В принципе, я не советую покупать фотоаппараты с дополни-
тельным электронным масштабированием, поскольку все то же самое можно сде-
лать на компьютере с помощью графических редакторов.

Следует запомнить
Фокусом объектива или линзы называется точка, в которой собираются лучи
света, параллельные главной оптической оси линзы или объектива. Плоскость
пленки располагается в фокальной плоскости, которая проходит через фокус.
Некоторые фотоаппараты оснащаются системой автофокусировки, другие нуж-
но наводить на резкость вручную.

Широкоугольные объективы имеют большой угол обзора, и на фотографию
попадает много объектов.

При съемке длиннофокусным объективом объектов в кадр попадает меньше,
но их размер визуально увеличивается.

Угол зрения вариообъектива изменяется при уменьшении-увеличении фокус-
ного расстояния.
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Композиция кадра

Q Равновесие композиции

Q Создание интересных кадров

а Точка зрения

а Использование цвета

Q Текстура и узоры

Даже при наличии всех возможных инструментов будут получаться плохие и не-
интересные фотографии, если не следить за композицией кадра. Под композицией
мы подразумеваем расположение объектов на снимке. Взгляните на фотографии,
представленные в книгах и журналах. Что делает их интересными и живыми? В чем
«изюминка» каждой из них? На фотографии попадают лишь мгновения, которые
можно сопровождать целыми историями, но их обычно никто не рассказывает.
Фотограф должен сделать так, чтобы человек, просматривающий его снимки, мог
представить все происходящее на фотографии и за кадром. Взобравшись на гору,
не нужно снимать свое семейство на самой вершине — гораздо лучше расположить
родственников около знака, указывающего высоту горы. Теперь любой, кто по-
смотрит на фотографию, поймет, сколь многого вы достигли.

Если снимок заслуживает тысячи слов, пусть он сам говорит за себя. Перед тем
как сфотографировать что-либо, подумайте, почему вы хотите сделать это. Что вы
пытаетесь сказать? Каково описание сюжета? Что вы чувствуете, глядя на объект
съемки, и будут ли чувствовать то же самое люди, которые увидят фотографию?
Задайтесь вопросом: «Каким образом я могу улучшить фотографию?».

Старайтесь снимать интересные фотографии. Для этого недостаточно искать объекты,
глядя через видоискатель, — хороший фотограф сначала видит кадр глазами и пред-
ставляет, каким он получится на бумаге, и только затем фотографирует. Не нужно
торопиться, стоит внимательно рассмотреть будущую фотографию, а для съемки
движущихся объектов выбрать подходящий момент.
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Отсутствие симметрии
Самой интересной частью фотографического снимка обычно является объект,
и снимок должен рассказывать о нем историю, а все художественные элементы —
дополнять объект. Фотография должна притягивать внимание наблюдателя.

Чтобы привлечь зрителей, следует «провести» их взгляд через фотографию, дру-
гими словами, человек, взглянув на какую-нибудь точку снимка, должен затем рас-
смотреть его целиком. Представьте фотографию чего-то ожидающей группы людей,
выстроившихся в очередь, в конце которой клоун надувает для ребенка воздуш-
ный шар. Если посмотреть на этот снимок, взгляд проскользнет по очереди, пока
не наткнется на ребенка с клоуном. Таким образом, вы не только добьетесь того,
что любой наблюдатель обязательно рассмотрит всю фотографию, но и поведаете
свою историю.

Чем дольше смотришь на хорошую фотографию, тем интереснее она становится.
Можно прельстить зрителей с помощью нестандартной цветовой гаммы, удиви-
тельных форм или различных объектов. Необходимо удерживать взгляд зрителя
и контролировать его перемещение. Если объект съемки занимает центр фотогра-
фии, снимок сразу станет неинтересен — любой посмотрит на него, увидит объект,
находящийся прямо в центре, и тут же перейдет к следующему снимку.

Итак, где же расположить объект съемки? Давайте рассмотрим рис. 9.1, на кото-
ром представлена схема классической композиции. Для начала разделим кадр на
части, как для игры в крестики-нолики; точки пересечения линий назовем горячи-
ми. Попробуем разместить объект изображения в одной из этих точек.

«Горячая» точка.

«Горячая» точка-

, «Горячая» точка

Горизонтальная
«мертвая» линия

«Горячая» точка

Вертикальная
«мертвая» линия

Рис. 9.1. Композиционная схема помогает расположить объект съемки в кадре
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Фотографии, продемонстрированные на следующих двух рисунках, иллюстриру-
ют разницу между расположением основного объекта прямо в центре фотографии
и сдвигом его в сторону. Не правда ли, второй снимок (рис. 9.3) намного привлека-
тельнее, чем первый (рис. 9.2)? Обратите внимание, что объект находится в ниж-
ней правой «горячей» точке.

Горизонтальная
«мертвая» линия

Вертикальная
«мертвая» линия

Рис. 9.2. На следующей фотографии композиция значительно улучшилась

Это, конечно, не означает, что нужно оставлять пустое пространство посередине
фотографии. Представьте, что вы фотографируете парусную шлюпку в гавани.
На воду светит солнце, а в небе парят птицы. Где в таком случае должен белеть
парус? Можно оставить шлюпку на горизонтальной «мертвой» линии, но немного
сдвинуть вправо, и получится превосходная фотография. Теперь попробуйте раз-
местить шлюпку в нижней правой «горячей» точке. Композиция не улучшилась?
Может быть, тогда стоит попытаться улучить момент, когда через верхний правый
угол кадра будут пролетать птицы, или расположиться так, чтобы в кадре оказа-
лись пушистые облака или солнце.

Теперь представим другой снимок. Объектами съемки будут ваша любимая дочка
и кот, сидящий у нее на коленях. Направьте фотоаппарат так, чтобы лицо девочки
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оказалось в верхнем левом углу кадра, а кот — в нижнем правом. Получилась заме-
чательная фотография, как на рис. 9.4. Сделав композицию именно такой, вы за-
интересуете зрителя, и его взгляд будет переходить от лица вашей дочки к коту
и обратно.

«Горячая» точка

Рис. 9.3. Это изображение гораздо привлекательнее предыдущего

Рис. 9.4. Кот зрительно уравновешивает лицо девочки
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Баланс композиции
Хорошие фотографии всегда сбалансированы, то есть объекты не перегружают ни
одну часть изображения. Так, например, на рис. 9.4 кот уравновешивает лицо де-
вочки, а на фотографии шлюпки, которую мы представляли себе, такими объекта-
ми были птицы, облака или солнце.

Уравновешивающий элемент и объект съемки не обязательно должны иметь оди-
наковый размер; маленький предмет вполне может компенсировать большой. Идея
состоит в том, что при просмотре снимка взгляд переходит от объекта съемки
к уравновешивающему элементу и обратно.

Представим себе еще несколько фотографий. Пусть на снимке изображен боль-
шой прекрасный цветок, но он сдвинут немного вправо. Тогда слева к нему может
подлетать симпатичный шмель. Цветок и шмель имеют разные размеры, но пре-
восходно уравновешивают друг друга.

Еще один снимок: ваш двухлетний сынишка построил свою первую башню из де-
ревянных кубиков. Он гордится собой, и его улыбка растянулась до ушей. И тут
в кадр вбегает щенок, направляясь прямо на башню. Щелкайте! Получится заме-
чательная фотография — вы рассказываете свою историю, и композиция уравно-
вешена.

Для баланса композиции не обязательно использовать два предмета. Предположим,
что вы испекли яблочный пирог и хотите его сфотографировать. Что же поместить
в кадр? Отрежьте клинообразный кусок пирога, чтобы показать его начинку, а также
придать пирогу объем, и свободное пространство, оставшееся после вырезания
куска, уравновесит оставшуюся часть пирога. Расположите пирог так, чтобы кадр
не был симметричным, например поверните пирог вырезанным куском от себя —
пустое пространство окажется немного выше центральной линии, а снимок будет
сбалансированным.

Линия горизонта
Линия горизонта оказывает значительное влияние на формирование композиции
(рис. 9.5). Небо, кромку воды, крыши зданий, висящее на веревке белье, забор, вер-
хушки и подножья деревьев — все это можно использовать в качестве горизон-
тальных элементов изображения. Как правило, не нужно, чтобы горизонт или дру-
гая горизонтальная линия делили снимок на две равные половины; фотографии,
половину которых занимает небо, а другую — вода, банальны и скучны.

Еще раз посмотрите на схему, представленную на рис. 9.1, и обратите внимание на
горизонтальные линии, проходящие через «горячие» точки. Они делят кадр на три
части. Возможно, неплохо будет сформировать кадр так, чтобы линия горизонта
примерно совпадала с одной из этих линий. Есть еще одно правило, которого все-
гда следует придерживаться: линия горизонта должна быть параллельна нижнему
краю кадра. Не нужно торопиться, вместо этого стоит внимательно выровнять ли-
нию горизонта в видоискателе. Нет ничего хуже, чем лодка, плывущая по наклон-
ной поверхности.
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Рис. 9.5. Бостонская гавань

Количество и размер объектов в кадре
На фотографии должен появиться только объект съемки и уравновешивающий
его элемент. Не следует допускать небрежности в этом вопросе. Если не отследить
попадание в кадр второстепенных предметов или людей, получится «разбавлен-
ное^ изображение, и зритель не поймет, что же является объектом съемки. Все ли
предметы на фотографии одинаково важны? Если вы фотографируете живопис-
ный вид, например панораму, стоит ограничиться только самым необходимым
и не перегружать кадр. Кроме того, следует помнить о разрешении снимка — это
особенно касается фотографий, снятых на цифровую камеру. Обрезание изобра-
жения в графическом редакторе окажет влияние на его оптимальное разрешение.
Будьте скромными; компонуйте кадр так, чтобы в нем помещались все желаемые
объекты и ничего более.

Сменные объективы позволяют добиться интересных эффектов и сформировать
различные композиции, кроме того, можно творчески воспользоваться явлениями
сжатия и дисторсии. Если требуется немного приблизить объект съемки, сделайте
это с помощью длиннофокусного объектива. Если же, наоборот, нужно, чтобы
в кадр попало как можно большее пространство, вам пригодится широкоугольный
объектив.

Снимок может быть как горизонтальным, так и вертикальным. Ниже представле-
но несколько советов, которые помогут выбрать направление кадра.

О Различные панорамные виды следует снимать, располагая кадр горизонтально.
Это же направление подходит для групповых снимков и фотографий различ-
ных сцен — оно акцентирует внимание на широте и размахе фотографии.

Q Вертикальные снимки, напротив, подчеркивают высоту объекта съемки. Такое
направление кадра прекрасно подходит для портретов. Также оно удобно, если
нужно сопоставить маленький и высокий объекты.

а Фотографируя для газеты или журнала, всегда старайтесь делать два снимка:
вертикальный и горизонтальный. Часто случается так, что в макет печатного
издания можно вставить изображение строго определенного размера. При этом
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всегда есть шанс, что вы не будете знать об этом заранее и предоставите фото-
графию в неверном формате. (Это один из так называемых «законов Мерфи»
для фотографов.)

Итак, стоит уделить некоторое время компоновке кадра (рис. 9.6 и 9.7) и убедить-
ся в том, что каждый оставленный пиксел имеет значение.

Рис. 9.6. Пример фотографии, края которой желательно обрезать

Рис. 9.7. Пример чересчур обрезанной фотографии

Цвет
С помощью цвета также можно улучшить композицию. Интересным станет сни-
мок яркой, цветастой клумбы с тюльпанами, а старый, выцветший красный амбар
расскажет свою замечательную повесть. Сформируйте кадр так, чтобы амбар за-
нял основное положение — тогда его чудесный цвет привлечет внимание к снимку.
Конечно, и в этом деле важно не переборщить, поэтому не слишком увлекайтесь
цветами. Мало кто из нас захочет надеть зелено-сине-оранжевый костюм с белым
в красную крапинку галстуком — точно так же стоит попытаться избежать подобного
разнообразия цветов на фотографиях. Например, хорошим получится снимок,



132 Глава 9. Композиция кадра

в котором много красного и немного других цветов, потому что красный создает
композицию, а остальные цвета его уравновешивают.

Для выделения объекта съемки можно использовать насыщенные цвета. Еще одно
правило: хорошо сочетаются контрастные цвета, они подчеркивают друг друга.
Например, вместо того чтобы снимать красную розу на фоне бледно-голубого неба,
лучше попробовать расположить ее среди зеленых листьев. Противопоставление
красного и зеленого цветов сделает фотографию «яркой». Также превосходно соче-
таются близкие по тону цвета, и даже одноцветные фотографии могут быть весьма
интересны. Хорошими примерами являются группа зеленых деревьев в лесу или
пруд с голубой водой, в котором на камере от автомобильного колеса плавает ребе-
нок. А если сфотографировать разбегающиеся в стороны песчаные дюны, все оди-
накового цвета и похожей формы, получится очень красивая композиция.

Цвет помогает придать фотографии определенное настроение. Если на снимке за-
печатлен рассвет или сумерки, нежные цвета позволят фотографу передать свои
эмоции и ощущения зрителям. Фотографии ярко-красных объектов излучают
энергию и вызывают тревогу, изображения же в пастельных голубых и зеленых
тонах излучают спокойствие и безмятежность. Как ни удивительно, недостаток
цвета тоже может способствовать улучшению композиции. Попробуйте предста-
вить гавань в тумане — в этой картине отсутствуют все цвета, их приглушает и
скрадывает бледно-серая мгла. Но в доке стоит одинокая красная парусная лодка.
Она сделает фотографию более интересной, оживит снимок. Еще один хороший
пример: белое снежное поле, на котором единственным цветным пятном гуляет
ребенок в яркой зимней одежде.

Контраст
Существует несколько способов повышения контрастности изображения — уси-
лить ее можно с помощью цвета или освещения. Снимок, в котором глубокие тени
граничат с хорошо освещенными областями, будет замечательно контрастным
(рис. 9.8). Также контрастным получится изображение объекта, имеющего ярко
выраженную текстуру, на фоне однородного заднего плана, например срез тек-
стурной коры дерева на мягком размытом фоне.

Рис. 9.8. Яркий свет и тени могут создать интересный эффект
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Негативное и позитивное пространства
Пространство, занимаемое на фотографии объектом съемки, мы назовем позитив-
ным, а все остальное, не использующееся пространство, например фон, назовем
негативным. На снимке эти пространства взаимодействуют между собой и усили-
вают друг друга. Представьте фотографию зеленой ветки дерева на фоне голубого
неба — небо активно участвует в формировании узора, образованного сплетающи-
мися зелеными ветками, и, таким образом, является важной частью композиции.

На рис. 9.9 представлен снимок лампы, на котором области между деталями лампы
(то есть негативное пространство), покрашенные в два разных цвета, начинают
формировать собственное изображение. Эти контрастные цвета делают фотографию
интересной; негативное и позитивное пространства являются неотъемлемыми эле-
ментами композиции.

Рис. 9.9. Цветной фон помогает выделить части лампы

Движение
Современные фотоаппараты позволяют снять практически любую сцену, но од-
ним из самых важных моментов является то, что теперь можно снимать движущи-
еся объекты, и фотографии при этом получаются резкими. Камеры дают возмож-
ность «остановить мгновение» — сфотографируйте несущуюся машину, едущего
на велосипеде ребенка или парящего в небе коршуна. Снимки такого типа зачас-
тую получаются более интересными для наблюдателя, чем изображения непо-
движных объектов.

ПРИМЕЧАНИЕ
Ранние фотографии Эдварда Мойбриджа были посвящены изучению движения, Он снимал
целые серии фотографий прыгающих людей и животных, используя камеру, которая обеспе-
чивала на тот момент самую высокую скорость съемки. Его фотографии бегущей лошади
помогли доказать факт, что во время галопа животное в некоторый момент отрывает от земли
все четыре ноги. Намного позже доктор Гарольд Эджертон из Массачусетского технологиче-
ского института (бостонцы зовут его MIT) исследовал высокоскоростные движения; на одной
из наиболее знаменитых его фотографий изображена пуля, пробивающая игральную карту.
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Чаще получается, что небольшая нерезкость контуров объекта гораздо эффектив-
нее создает иллюзию движения, чем фотография объектов с четкими контурами.
Для получения размытости следует немного увеличить выдержку. Если фотоап-
парат автоматически определяет выдержку и диафрагму, его можно обхитрить,
воспользовавшись нейтральным светофильтром. Есть еще один хороший способ
показать на снимке скорость движения, я его называю «панорамой действия»
(рис. 9.10).

Рис. 9.10. Панорамирование позволяет создать иллюзию движения

СОВЕТ
Для так называемого «панорамирования движения» нужно установить выдержку примерно
1/30 с. При этом не очень важна скорость перемещения объекта съемки, но она повлияет на
результирующее изображение. Усилить эффект позволяет длиннофокусный объектив, мож-
но взять даже телеобъектив. Обычно для такой съемки используется горизонтальное на-
правление кадра.

Итак, пусть объектом съемки является спортивный автомобиль. Как только он попал в кадр,
попробуйте нажать кнопку затвора и переместить фотоаппарат в направлении движения
машины. Получится снимок (или несколько, если нажать на кнопку не один раз), на котором
будут сочетаться остановка и размытие движения. Почти полностью размытым окажется
фон, так как камера двигалась в момент съемки. Автомобиль же, напротив, получится отно-
сительно резким, поскольку он оставался в одном и том же месте кадра. Конечно, добиться
его полной резкости вряд ли получится, но это и не требуется.

Точка съемки и ракурс
Точкой съемки называется место, где находится фотограф по отношению к види-
мым и изображаемым предметам. Удачно выбранный ракурс может сыграть реша-
ющую роль в построении композиции и сделать снимок привлекательным. Здесь
основным правилом является следующее: если возможно, старайтесь избегать
фронтальной съемки, такие фотографии обычно получаются нудными. Вместо это-
го посмотрите на объект под разными углами. Может быть, стоит сдвинуться чуть-
чуть в сторону или вообще сфотографировать объект сбоку, взглянуть на него сни-
зу или, наоборот, сверху. При съемке пейзажа нужно решить, где расположить
линию горизонта. Кроме того, с помощью широкоугольного объектива можно со-
здать интересные эффекты, вызванные дисторсией.
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Конечно, здесь, как и во всяком деле, важно чувство меры. Если выбор точки
съемки приводит к отвлечению внимания от основного объекта, это плохо — фо-
тография теряет свое значение. Поэтому не слишком увлекайтесь. Нужно всегда
помнить о той причине, которая побудила вас сфотографировать именно этот
объект.

В принципе/относительно выбора ракурса не существует никаких жестких пра-
вил, только постарайтесь не забывать об общей композиции и расположить объект
в одной из «горячих» точек (рис. 9.11).

Рис. 9.11. Стоит посмотреть на объект с разных точек съемки, чтобы выбрать
наиболее интересный ракурс

ВНИМАНИЕ
Делая фотографии, не нужно забывать и о собственной безопасности. Как-то раз со мной
произошел один печальный случай. Я фотографировал игру в баскетбол в одной школе
и внимательно следил за развитием игровых действий в видоискатель. Вдруг мяч стал расти
на глазах, но я возбужденно думал только о том, какой замечательный получится снимок.
Наконец, удар мячом вернул меня к реальности. Ничто не сравнимо с ощущениями, испыты-
ваемыми, когда ваш фотоаппарат разбивается о ваше же лицо.
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ВНИМАНИЕ
Поэтому следует быть внимательным при фотосъемке. Не нужно прятаться за камеру — она
вряд ли защитит вас в трудную минуту. Многие профессиональные журналисты получали
ранения или даже погибали из-за того, что забывали о своей смертности. Также нужно
смотреть, куда вы идете, когда снимаете фотографии: можно случайно упасть с обрыва или
удариться головой о сук ради «великолепного» кадра. Помните об окружающем мире.

Перспектива
Многие фотографии страдают от недостатка размерности — они выглядят плоскими
и нереалистичными. Иногда помогает решить данную проблему добавление эле-
ментов, создающих перспективу, например двух разных линий, которые сходятся
в одну точку в каком-то месте фотографии (такое место называют центром перс-
пективы). Это зрительно увеличивает перспективу и создает иллюзию глубины.
Люди знают, что когда две параллельные линии встречаются в одной точке, эта
точка находится на некотором расстоянии от них. Прекрасным примером (рис. 9.12)
является железнодорожное полотно — рельсы, убегающие вдаль, но с этой же целью
можно воспользоваться границей крыш, заборами и даже линиями электропередач.

Рис. 9.12. Перспектива, созданная удаляющимися линиями рельсов, придает снимку объем

Сходящиеся линии
создают ощущение глубины

Рис. 9.13. Линии, формируемые боковой стороной коробки и шахматными фигурами,
создают перспективу кадра
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Если же сюжет кадра не предполагает наличия рельсов или автомобильных дорог,
можно создать перспективу, немного повернув объект и сняв его не фронтально,
а чуть-чуть со стороны. На фотографии (рис. 9.13) показаны не только размер
и форма объектов, но и возникает ощущение глубины кадра — изображение как
бы «понижается» по направлению к заднему плану.

Передний и задний планы
Ощущение глубины кадра можно также создать с помощью объектов, расположен-
ных на переднем и заднем планах. Например, если на фотографии присутствуют
двое взрослых людей, тогда человек, находящийся ближе к камере, на снимке будет
выглядеть больше другого человека, стоящего дальше от фотографа. Каждый знает
об этом эффекте, и изображение не покажется плоским.

Наложение объектов друг на друга тоже дает возможность создать перспективу
(рис. 9.14). Скажем, вы фотографируете кошку, а за ее спиной на некотором рас-
стоянии находится диван. На фотографии диван получится меньше кошки. Вряд
ли кто-нибудь удивится этому, поскольку знает, что кошка никак не может быть
больше дивана. Тогда соотношение размеров, как и требовалось, будет проассоци-
ировано с расстоянием между кошкой и диваном. Правда, я в своей жизни видел
несколько котов размером с целое кресло!

Рис. 9.14. Кадру придают объемность поле и футбольные ворота

Линии реальные и воображаемые
Объект или несколько объектов могут располагаться друг за другом, создавая некую
визуальную линию, пересекающую фотографию. Это поможет привлечь к снимку
внимание и высказать то, что задумывал фотограф. К появлению интересных эф-
фектов и улучшению композиции способно привести формирование воображае-
мой линии. Как я уже говорил, иногда второстепенные детали фотографии стоит
располагать так, чтобы направлять взгляд зрителя к объекту съемки. В качестве
линий подходят самые обыкновенные предметы — например на рис. 9.15 для этого
применяется трубопровод.
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Линия как элемент дизайна
Рис. 9.15. Старый трубопровод создает направление и переводит взгляд наблюдателя

к зданиям на заднем плане

Попробуем представить еще несколько примеров. Пусть на фотографии изобра-
жен ребенок, который плачет и показывает пальцем на все дальше улетающий
в небо воздушный шарик. Фотограф хотел сказать вам, что ребенок очень расстраи-
вается из-за потери шарика, но при этом создал интересный эффект — взгляд про-
следует по воображаемой линии вслед за протянутой рукой ребенка, и вы обнару-
жите шарик. Это очень удачная фотография.

Приведем еще один пример. На снимке пес пристально вглядывается в яркое пят-
нышко на полу — крошечную точку, расположенную прямо перед носом собаки.
Может быть, это муравей или малюсенький кусочек пищи? В любом случае, взгляд
наблюдателя будет переходить с собачьего носа на пятнышко и обратно.

Старайтесь делать так, чтобы воображаемая линия, а точнее, ее «конечная точка»
не выходила за пределы композиции и, соответственно, снимка. Если собака будет
внимательно смотреть на что-то, находящееся за рамкой фотографии, взгляд на-
блюдателя проследует туда же и вряд ли вернется обратно.

Фон
На фотографии всегда найдется место для объектов, рассеивающих внимание, но
это не должно давать вам никакого права терять бдительность. Не увлекайтесь
объектом съемки настолько, чтобы забыть посмотреть, что же еще попадает в кадр.
Самый простой способ испортить фотографию — сделать отвлекающий фон.
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Рис. 9.16. Заваленный бумагами стол свидетельствует о выдающихся умственных способностях

Иногда появление отвлекающих объектов неизбежно — вы далеко не всегда може-
те гарантировать, что никто внезапно не появится в кадре. Или все-таки можете?
Когда мы с другом гуляем в местах, где бывает много народа, я прошу его защитить
от людей пространство между мной и объектом, пока сам фотографирую.

Также стоит осмотреть пространство, которое вы собираетесь сфотографировать,
и убрать все случайно попадающие в кадр листы бумаги и мусор — белые кусочки
бумаги отвлекут внимание наблюдателя. Не стоит фотографировать сотрудника
фирмы на фоне доски с объявлениями, и, несомненно, нужно убрать с заднего пла-
на кофейные чашки и тарелки, оставшиеся после обеда. Вы в силах сами контро-
лировать фон снимка, поэтому следует внимательно взглянуть на будущий кадр,
прежде чем нажать кнопку спуска затвора.

Одной из наихудших ошибок является фотография, на которой изображен чело-
век на фоне каких-нибудь предметов, где создается впечатление, что из его головы
что-то растет. Это еще одна причина, по которой нужно внимательно проверять не
только положение объекта съемки, но и задний план: деревья, столбы, книжные
полки, дверные проемы и т. д.

На улице желательно отслеживать положение линий электропередач. Иногда все
же есть возможность изменить точку съемки так, что провода не попадут в кадр.
Конечно, цифровая фотография позволяет впоследствии удалить провода из изоб-
ражения, но это требует времени и определенных навыков работы в графическом
редакторе.

Текстура
Текстура оказывает неоценимую помощь в создании композиции. Может быть
прекрасным изображение какого-нибудь сильно текстурированного объекта, на-
пример кусочка старого дерева. Конечно, скорее всего, потребуется уравновесить
объект с текстурой какой-нибудь другой однородной частью снимка. Потратьте
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некоторое время на изучение рисунков, создаваемых деревом, камнем, бумагой
и даже водой, — это, кроме всего прочего, поможет вам понять себя и свое видение
окружающего мира.

Также текстуру можно создать с помощью различных узоров, таким примером
является плетение и рисунок ткани. Легкая рябь на поверхности заводи, ячейки
медовых сот и даже парящие в небе облака образуют замечательные текстуры.

Часто текстуру формируют замысловатые переплетения цветов (рис. 9.17), или,
например, изысканный пурпурный и яркий желтый цвета дикого осеннего луга
создают великолепное цветное покрытие. Взгляните внимательнее на кусок ста-
рого, покрытого краской дерева. Найдите участок, который в течение многих лет
несколько раз красили разными красками, и вы обнаружите превосходный компо-
нент снимка.

Рис. 9.17. Разноцветные цветы создают прекрасную повторяющуюся текстуру

Текстуру можно использовать в качестве фона или же располагать на переднем
плане: например, потрясающий старый пень является объектом съемки и занима-
ет на фотографии центральную часть, или же основную часть кадра занимает ку-
сок мятой газеты, но в центре выделяется изысканный цветок или керамическая
вазочка.

Масштаб
В портрете или даже пейзаже не очень важен масштаб объектов. Все знают сред-
ние размеры человека, а оценить параметры пейзажа поможет любой из относи-
тельно стандартных предметов, например дерево.

Но многие фотонатюрморты неважно выглядят оттого, что невозможно оценить
размеры изображенных на них предметов. На них нет ни одного известного объек-
та, который помог бы представить масштабы снимка, и это может запутать наблю-
дателя. Например, на следующей фотографии (рис. 9.18) сохранено для истории
несколько болтов и гаек, но мы бы не смогли оценить их размер, если бы среди них
не лежала шариковая ручка. А если бы там находилась отвертка или гаечный ключ,
нам бы все равно пришлось догадываться о масштабе снимка.
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Рис. 9.18. Шариковая ручка помогает оценить размеры болтов

Следует запомнить
Q Нужно создавать композиционный сюжет и удерживать внимание наблюдателя.

Q Объекты на снимке должны быть уравновешены.

Q He стоит располагать объект съемки прямо в центре кадра.

Q Направляйте взгляд наблюдателя с помощью «линий» и перспектив.

Q Значительную роль в создании композиции играют также цвет и текстура.



Глава 10

Роль освещения в формировании
снимка

Q Естественное освещение

а Освещение с помощью вспышки
Q Настройка освещения

Теперь, когда мы рассказали о композиции изображения, а вы научились компо-
новать кадры, пришла пора подумать об освещении, которое также играет боль-
шую роль при создании фотографий. Оно создает определенное настроение, дела-
ет снимок более глубоким и подчеркивает форму объектов.

Естественное освещение
Проще всего фотографировать при естественном освещении, например при сол-
нечном свете. При этом угол падения световых лучей зависит от времени. Рано
утром и перед закатом солнце располагается низко к линии горизонта и создает
мягкий, рассеянный свет; ближе к полудню слишком яркое освещение приводит
к появлению коротких, но резких теней. По мере продвижения солнца по небу вид
теней меняется.

Цвет света также зависит как от времени суток, так в некоторой степени и от вре-
мени года. Большую часть дня, когда солнце находится высоко в небе, его свет не
имеет четко выраженного окраса. Но ближе к закату, особенно в летние месяцы,
солнце начинает окрашивать освещаемые объекты в теплые желтоватые тона, что
позволяет получить впечатляющие снимки.

Кроме того, освещенность зависит от погодных условий. Прозрачный, интенсив-
ный свет ясного дня сменяется мягким, рассеянным освещением при появлении
на небе облаков. В некоторых ситуациях это помогает получить хороший снимок,
но иногда уменьшение четкости теней делает снимок плоским.
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СОВЕТ
Нет ничего хуже, чем обнаружить, что здание, которое вы собираетесь снимать, полностью
находится в тени. Чтобы не попадать в подобные ситуации, фотографы, специализирующи-
еся на снимках архитектуры, носят с собой компас. Все мы знаем, что солнце встает на
востоке и садится на западе. Обращая внимание на такие детали, как направление камеры
и время снимка, можно примерно представить положение солнца на небе и освещенность
здания. Если вы не смогли сделать фотографию из-за неудачного освещения, остается толь-
ко вернуться в более подходящее время.

Освещение объектов сзади
Снимая при солнечном свете, принято располагаться так, чтобы солнце находи-
лось за плечом фотографа и освещало передний план объекта. Разумеется, солнце
не всегда оказывается в нужном месте. Иногда получается так, что оно освещает
объект сзади, при этом сам объект находится в тени.

ВНИМАНИЕ
Если поместить объект на фоне яркой области, например белой стены, это тоже приведет
к освещению сзади. Следует помнить о таких дополнительных «источниках света».

В задачу «умного» экспонометра входит поиск ярко освещенных и затененных
областей кадра. При этом предполагается, что суммарное освещение сцены будет
равномерно серым. Поэтому, когда экспонометр обнаруживает за объектом ярко
освещенную область, то чтобы получить среднюю освещенность, он, компенсируя
увеличение света, уменьшает диафрагму. К сожалению, в результате передний план
объекта выглядит слишком затененным. Что же делать в подобном случае?

Если камера допускает ручное управление, достаточно открыть диафрагму или же
увеличить выдержку. Объектив пропустит большее количество света, и сцена будет
освещена корректно. Сейчас многие любительские фотоаппараты имеют функцию
определения заднего освещения. В качестве альтернативного метода некоторые каме-
ры предлагают возможность точечного замера освещенности с последующей блоки-
ровкой положения диафрагмы. Например, замерив освещенность в тени, можно
задать это значение для всего изображения. В результате камера автоматически
открывает диафрагму на нужную величину, игнорируя освещение заднего плана.

ПРИМЕЧАНИЕ
Единственным недостатком замера экспозиции по теневым участкам является слишком яр-
кое освещение заднего плана на фотографии. В таких случаях говорят, что изображение
передержано. Этого можно избежать, осветив теневые участки отраженным светом, вос-
пользовавшись, например, белой простыней или листом бумаги.

Другим способом избавиться от передержанных участков изображения является заполняю-
щая вспышка. Но об этом мы поговорим позднее.

Темная ночь
На сегодняшний день ночная фотосъемка перестала быть таким сложным делом,
как раньше. С помощью жидкокристаллического экрана предварительного про-
смотра легко составить представление об освещенности будущего снимка. При этом
вам обязательно понадобится штатив. Кроме того, желательно воспользоваться
спусковым тросиком или автоспуском.
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Фотографируя ночью, попытайтесь сделать несколько кадров с различной выдерж-
кой. Например, уменьшив выдержку, можно получить потрясающий эффект све-
товых полос от задних фар автомобиля. Изменение выдержки при съемке фейер-
верка создает световые вспышки различной формы. Некоторые камеры позволяют
держать затвор открытым произвольное время, что незаменимо, например, при
съемке звездного неба. Хотя не стоит забывать о том, что любой фейерверк или
звезды на небе всегда можно сотворить с помощью графических редакторов.

Вспышка
Прошли времена магния в лотке и ламп-вспышек. Теперь камеры любительского
класса, как цифровые, так и пленочные, имеют встроенную вспышку, которая обес-
печивает хорошую освещенность при съемке в помещении при условии, что объект
находится на расстоянии 10-12 футов от камеры. Вспышка позволяет осуществ-
лять съемку при недостатке света, но не может воспроизвести эффект естествен-
ного освещения.

Не стоит ожидать, что маленькая вспышка осветит всю комнату. Ее мощности для
этого недостаточно. Кроме того, не надейтесь, что вспышка изменит вид объекта,
расположенного на расстоянии более 20 футов. Мне всегда смешно наблюдать за
вспышками камер при съемках на стадионе, ведь свет от них даже не достигнет
поля!

Итак, перечислим основные правила работы со вспышкой:

а объект должен располагаться на расстоянии не более 15 футов от камеры;

Q свет от вспышки не очень хорошо рассеивается, поэтому желательно, чтобы по
ширине объект не превосходил 6-8 футов;

Q вспышка должна располагаться над объективом;

Q старайтесь избежать приобретения фотоаппарата с маломощной вспышкой,
а также камеры, у которой вспышка расположена слишком близко к объективу.

ПРИМЕЧАНИЕ
Легко заметить, что вспышка дает прохладный светло-голубой свет. Это связано с тем, что
ее цветовая температура — примерно 6500 К. Профессиональные фотографы иногда наде-
вают поверх вспышки желтоватый фильтр, чтобы сделать ее свет более теплым и есте-
ственным.

Заполняющая вспышка
Некоторые камеры имеют возможность настройки заполняющей вспышки, что
позволяет освещать сцену, не меняя настройки диафрагмы и выдержки. Это связано
с тем, что при измерении экспозиции учитываются только существующие источни-
ки света, к которым не относится вспышка. Заполняющая вспышка просто делает
затененные области более светлыми. Ее можно использовать и на улице в солнеч-
ный день, чтобы сделать тени от объектов менее резкими, как показано на рис. 10.1.

Не стоит удивляться, обнаружив, что освещенный заполняющей вспышкой объект
слегка выступил на передний план. Это происходит потому, что свет вспышки
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увеличивает освещенность объекта. Разумеется, объект должен находиться на ра-
зумном расстоянии от фотографа.

Без вспышки Со вспышкой
Рис. 10.1. Заполняющая вспышка помогает избежать передержки слишком ярко

освещенного заднего плана

ПРИМЕЧАНИЕ
Я почти всегда использую вспышку при уличных съемках, особенно если фотографирую
людей. Однако следует помнить, что это требует дополнительных затрат энергии, соответ-
ственно, желательно иметь при себе запасные батарейки.

Рассеянный свет вспышки
Часто использование встроенной вспышки приводит к резкому выделению объек-
тов на фоне («олень в свете фар»). С этим можно бороться, направив свет вспыш-
ки на стену или в потолок (что не позволяет сделать большинство дешевых ка-
мер). При этом объект освещается преимущественно рассеянным светом, и влияние
вспышки сглаживается. Однако следует помнить, что, направляя вспышку на сте-
ну или на потолок, вы отправляете свет в долгое путешествие, что приводит к умень-
шению результирующей освещенности объекта.

Дополнительная вспышка
Еще одним способом изменить освещенность сцены является дополнительная
вспышка. Автономные переносные вспышки стоят недорого. Может быть, у вас
уже есть одна из них, как наследие от старого пленочного фотоаппарата. Дополни-
тельную вспышку можно нацелить как на объект съемки, так и на потолок или
стену. В последнем случае получится рассеянный мягкий свет.
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Автономная вспышка должна быть оснащена синхроконтактом (slave eye), благода-
ря которому она сверкает в нужный момент. Синхроконтакт следит за состоянием
встроенной в камеру вспышки и соответствующим образом настраивает автономную
вспышку. В качестве альтернативы многие профессиональные фотографы пред-
почитают управление с помощью радиосигнала. Это позволяет гарантировать, что
автономная вспышка не сработает, когда в помещении фотографирует кто-то кроме
вас. При отсутствии встроенного синхроконтакта его можно приобрести отдельно.

Следует строго отслеживать расположение дополнительных вспышек и их направ-
ление. Вряд ли кому-то захочется сфотографировать вспышку в работе, особенно
если она направлена прямо в объектив. Также существует распространенное за-
блуждение, что вторая вспышка должна находиться недалеко от камеры. Во время
съемки семейных торжеств и вечеринок я обычно подвешиваю вторую вспышку
высоко на стене.

Кронштейн для вспышки
Чтобы избежать эффекта красных глаз и уменьшить резкость теней, желательно
разместить вспышку как можно дальше от объектива. Для этого многие фотогра-
фы устанавливают вторую вспышку на присоединяемый к камере кронштейн, ко-
торый обычно имеет форму буквы L, как показано на рис. 10.2.

Рис. 10.2. Специальный кронштейн помогает держать вспышку на некотором расстоянии
от объектива. При этом у вас есть возможность менять направление распространения света

Кронштейн позволяет направить вспышку в потолок для освещения сцены рассе-
янным светом или же нацелить ее непосредственно на объект съемки. При нали-
чии у камеры разъема под соединительный шнур можно закрыть непрозрачной
лентой встроенную вспышку и в качестве источника света использовать дополни-
тельную вспышку на кронштейне.

К фотоаппарату вспышку подключают с помощью специального шнура, соединя-
ющегося с разъемами. Тогда она будет работать синхронно с затвором. Лучше не
полагаться на синхроконтакт, так как чувствительный элемент может оказаться за
встроенной вспышкой или выше нее и просто будет не способен отслеживать ее
состояние.
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СОВЕТ
Так как в большинстве случаев дополнительная вспышка значительно превосходит по мощ-
ности встроенную, имеет смысл положить на нее рассеивающий объект, например неболь-
шой белый платок. В качестве альтернативы можно приобрести небольшой кусок пластика,
фильтры или гели.

Дополнительные источники света
Если вас не привлекает необходимость отслеживать работу всех дополнительных
вспышек, развешанных по комнате, существует более простой способ влиять на
освещенность сцены. Достаточно включить дополнительные источники света.
Можно как добавить несколько новых осветителей, так и увеличить яркость уже
имеющихся. Для концентрации и фокусировки света используются отражатели,
обычно представляющие собой металлические чаши. Их форма и размер опреде-
ляют область распространения светового луча и его интенсивность.

СОВЕТ
Для получения ровного рассеянного света профессиональные фотографы часто прибегают
к специальному приспособлению в виде коробки из теплоустойчивого, облегченного мате-
риала, передняя сторона которой полупрозрачна. Источник света помещается внутрь такой
коробки.

Если вы не хотите покупать подобное приспособление (тем более что они могут стоить
довольно дорого), можно сделать его аналог. Для этого нужно всего лишь повесить перед
нацеленным на объект источником света белую ткань. Хотя в результате количество про-
пускаемого света будет меньше по сравнению с тем, что можно получить при помощи спе-
циального оборудования, он будет мягким и рассеянным.

При работе с тканью следует постоянно следить за тем, чтобы материал не воспламенился.
Для этого держите источник света на безопасной дистанции.

Цвет света
Все слышали выражения «раскаленный добела» или «раскаленный докрасна»,
и все знают, что нагретый металл испускает свет. Много лет назад была разработана
система, определяющая цвет света. Кусок металла нагревался в полдень при дневном
свете, и по мере того, как он менял свой цвет, регистрировалась его температура.
Оказалось, что чем больше нагревался металл, тем ближе его цвет становился к бело-
му. Температура раскаленного добела металла составляет 5500 К. Что интересно,
именно так оценивается среднее дневное освещение в полдень. В настоящее время
шкала Кельвина используется для указания цветовой температуры (табл. 10.1).

Таблица 10.1. Цветовая температура различных источников света

Источник света Цветовая температура

Свеча 1950 К (романтическое освещение)

Солнце на закате 2000 К (еще одна разновидность романтического
освещения)

Обычная лампа накаливания 2800 К

Лампа дневного света 3000 К (омерзительный цвет!)

продолжение &
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Таблица 10.1 (продолжение)

Источник света Цветовая температура

Лампа накаливания, применяемая 3400 К
в фотографии

Солнечный свет в полдень От 5000 до 5500 К

Солнечный свет при небольшой 6500 К
облачности

Свет безоблачного северного неба От И 000 до 18 000 К

Если внимательно посмотреть на различные источники света, вы обнаружите, что
они имеют различный цвет. Например, излучение обычной лампочки, встречаю-
щейся в каждом доме, видимо при температуре от 2700 до 2900 К и дает свет жел-
товатого оттенка. Осветители с вольфрамовой нитью, применяемые в фотографии,
«загораются» при температуре 3400 К. Фотографические лампы дневного света
имеют цветовую температуру 5500 К.
Фотоаппарат должен распознавать цвет падающего на объект света. Большинство
камер (или их программное обеспечение) автоматически настраивается на пра-
вильную цветовую температуру. Это называется цветовым балансом. Без подобной
настройки изображение будет иметь оттенок, присущий источнику света. Только
представьте, что ваша камера настроена на единственную цветовую температуру —
5500 К. Сфотографируйте сцену в интерьере, которая освещена обычной лампой
накаливания, и вы обнаружите неприятный желтый оттенок на всех снимках.
И наоборот, если ваша камера настроена на цвет вольфрамовой лампы, все сделан-
ные на улице фотографии будут синеватыми. Итак, для нейтральной или естествен-
ной цветовой гаммы снимков необходимо, чтобы фотоаппарат правильно опреде-
лял цветовую температуру основного источника света.
Разумеется, бывают ситуации, когда не требуется корректировать цветовую тем-
пературу. Например, при съемке сцены, освещенной свечами, грешно заменять их
теплый свет нейтральными цветами. В этом случае следует отключить корректи-
ровку цветового баланса. Словом, экспериментируйте и дерзайте! Помните, что
вы снимаете не на пленку и, сделав лишний кадр, ничего не потеряете.

ВНИМАНИЕ
Следует быть крайне осторожным с дополнительным освещением объекта и использовать
для этого однотипные источники света в одной и той же среде. Например, применив вспыш-
ку (5500 К) для сцены, освещенной вольфрамовой лампой, вы получите фотографии стран-
ного оттенка, поскольку камера настраивается только по одному из источников света.

Расстановка осветителей
При съемке портретов и объектов контролировать освещенность достаточно лег-
ко. Для начала требуется выделить важную часть будущей фотографии, а затем
решить, как она будет освещаться. Попробуйте действовать следующим методом.
1. Установите источник, дающий основное освещение. Он должен быть самым яр-

ким, и обычно его располагают перед объектом съемки. Но, поместив его сбоку,
вы сделаете снимок более объемным. Как показано на рис. 10.3, основной ис-
точник света приводит к появлению резко очерченных теней.
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Основное освещение

Рис. 10.3. Основное освещение приводит к появлению насыщенных теней с резко очерченными
границами

2. Не торопитесь добавлять следующий источник света. Для начала поместим бе-
лый лист бумаги за объектом, но напротив основного осветителя. Отраженный
таким способом свет упадет обратно на объект и сделает тень менее контраст-
ной, как показано на рис. 10.4.

Отраженный
свет

Основное
освещение

Рис. 10.4. С помощью белого листа бумаги можно сделать тени более светлыми

3. Если желательно получить еще менее контрастные тени, стоит заменить лист
бумаги еще одним осветителем, я называю его заполняющим источником света.
Он должен быть более тусклым, чем основной свет, чтобы затененные участки
исходного изображения сохранялись более темными. Если имеющиеся источ-
ники света имеют одинаковую интенсивность, заполняющий осветитель
можно поместить на большем расстоянии от объекта или сделать его свет рас-
сеянным с помощью белой ткани. Обратите внимание на вторую тень от объекта
на рис. 10.5.
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Заполняющее
освещение

Основное
освещение

I
Рис. 10.5. Заполняющий источник света может приводить к появлению второй тени,

что в некоторых случаях делает изображение неестественным

4. При съемке объектов иногда требуется еще один источник света, помещаемый
сверху. В зависимости от эффекта, который вы хотите получить, его следует
подвесить перед объектом или за ним. Его свет также должен быть рассеянным,
так как появление дополнительной резкой тени от объекта крайне нежелатель-
но. При съемке людей или текстурированных объектов (подобных показанно-
му на рисунке) можно получить впечатляющий эффект с помощью верхнего
источника света. Расположив его сзади, вы подчеркнёте структуру волос и по-
лучите блики на их поверхности. При этом нужно следить за тем, чтобы свет от
осветителя не оказался направлен прямо в объектив (рис. 10.6).

Верхнее освещение

Заполняющее _
освещение"

_Контурная
"подсветка

_ Основное
освещение

Рис. 10.6. Дополнительные источники света, один из которых расположен сверху, а другой —
немного сзади, позволили увеличить освещенность сцены
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Практикуйтесь в освещении объектов. Пробуйте пользоваться различными источ-
никами света и экспериментировать с их местоположением. Можно получить про-
сто фантастические снимки с помощью цветных осветителей. Красный свет при-
вносит в сцену ощущение напряженности, а голубой дает ощущение спокойствия
и прохлады. Цветные источники света помогут вам создать нужное настроение.

Меры предосторожности
Перечислим меры предосторожности, которые следует принимать при настройке
освещения.

Q Не перегружайте сеть слишком большим количеством осветителей.
Q Используйте тяжелые удлинители.
а Аккуратно прокладывайте электрические шнуры.
Q Чтобы осветители не опрокидывались, утяжеляйте их подставки. Дешевый утя-

желитель можно сделать, наполнив песком пластиковую бутылку.
Q Помните, что лампы нагревают расположенные перед ними предметы.
Q Не трогайте руками лампочки. Они действительно сильно нагреваются и оста-

ются горячими даже в течение некоторого времени после выключения.
а Наносить окрашенные гели на лампы следует крайне аккуратно. Они расплав-

ляются при слишком сильном нагревании. Кроме того, крайне желательно при-
обретать только специальные, предназначенные для фотографии гели, так как
они устойчивы к высокой температуре.

Q Не перемещайте включенные источники света. После нагревания лампочки
становятся очень хрупкими и могут разбиться или взорваться.

Работа со штативом
При съемке с выдержкой менее 1/60 с вам обязательно потребуется штатив, по-
скольку при этом даже совсем небольшие перемещения камеры сказываются на
качестве изображения.
Штатив должен быть как можно более прочным. Опоры самых лучших штативов
покрыты материалом, похожим на тефлон, который облегчает их перемещение. Чем
выше штатив и чем более компактные размеры он имеет в сложенном состоянии,
тем дороже он стоит. Особое внимание обращайте на подставку, к которой присо-
единяется камера. Она должна быть твердой и двигаться без толчков.
Большинство профессиональных камер имеют гнездо для спускового тросика.
Тросик представляет собой длинный подпружиненный кабель, который позволя-
ет спускать затвор без сотрясения камеры. Если же гнездо для тросика отсутству-
ет, воспользуйтесь автоспуском.

СОВЕТ
Если вам понадобился штатив, но вы не взяли его с собой на съемку, можно все равно
попробовать сделать снимок. Поднесите фотоаппарат к глазам и расслабьте руки и тело.
Расслабление снимает напряжение, которое вызывает встряску камеры. Сделайте несколь-
ко глубоких вдохов и выдохов, а затем, медленно выдыхая, нажмите кнопку затвора. Это
упражнение не только поможет уменьшить дрожание фотоаппарата, но и успокоит вас.
А если вы сумели таким образом снять хорошую фотографию, может быть, вам стоит запи-
саться на курсы йоги?
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Следует запомнить
Q Используйте для основной экспозиции доступные источники света.

а Иногда экспонометр замеряет освещенность по слишком светлому или по слиш-
ком темному фону.

а Дополнительно осветить объекты можно с помощью вспышки.

а Ее также допустимо использовать и в качестве непрямого источника света.

Q Отраженный свет делает тени менее контрастными и насыщенными.

а Дополнительные источники света позволяют создавать интересные эффекты.

Q Любой источник света имеет цвет.



Глава 11

Разрешение

а Что мы видим и что получаем

а Печать фотографий

а Разница между снимками, отпечатанными с помощью лазерного и струй-
ного принтеров

Вы помните героиню сказки про трех медведей? Одна кровать была для нее слишком
мягкой, вторая — слишком жесткой, а вот третья оказалась достаточно удобной.
Примерно так же можно описать ситуацию с разрешением снимков. Слишком низкое
разрешение приводит к недостаточной проработке деталей кадра, а слишком вы-
сокое перегружает компьютер и принтер и значительно снижает скорость работы.
Соответственно, в задачу фотографа входит поиск оптимального разрешения.

Разрешение изображения и монитора
Фотоаппараты могут создавать изображения с различным разрешением. В общем
случае, чем больше размер выходного файла, тем больше остается возможно-
стей для его редактирования. Из слишком маленького файла невозможно напеча-
тать большую фотографию, сохранив все детали. Чересчур большие файлы имеют
другой недостаток — они занимают много места на устройствах хранения ин-
формации.

Разрешение монитора, как и разрешение фотографий, измеряется в пикселах. Изме-
нение настроек монитора приводит к изменению вида снимка на экране, но не влияет
на разрешение изображения.

Настройка разрешения изображения и монитора
На вид фотографии на экране компьютера помимо разрешения самого изображе-
ния влияет разрешение монитора. Если вы не верите мне на слово, убедитесь сами,
выполнив следующие действия.
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1. Выберите в меню Start (Пуск) команду Settings > Control Panel (Настройки > Панель
управления).

2. Дважды щелкните на значке Display (Экран). На компьютерах Macintosh это
значок Monitor and Sound СР.

3. Перейдите на вкладку Settings (Настройка) и обратите внимание на регулятор
Screen Area (Область экрана) в нижней части диалогового окна. Выберите разре-
шение 640 х 480 точек, как показано на рис. 11.1. Результат изменений будет
показан в окне предварительного просмотра. Если вы решили нажать кнопку
Apply (Применить), запомните текущие настройки, чтобы иметь возможность вер-
нуться к ним впоследствии.

5.
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Рис. 11.1. Изменение разрешения экрана меняет вид изображений

Откройте любой графический редактор. Я здесь пользуюсь приложением Photo-
Deluxe, но и в более, возможно, знакомой для вас программе Photoshop следует
выполнить точно такие же действия. В меню File (Файл) выберите вариант
New (Создать). Тот же самый результат можно получить, нажав комбинацию
клавиш Ctrl+N. На Macintosh это будет комбинация клавиш Command+N.

В диалоговом окне New (Создать), показанном на рис. 11.2, введите в поле Width
(Ширина) значение 8,9, а в поле Resolution (Разрешение) — значение 72. Значе-
ние поля Height (Высота) появится автоматически. Скоро вы поймете, почему
требуется указать именно эти значения. Убедитесь, что в качестве единиц из-
мерения длины и ширины выбраны дюймы (inches), а разрешение измеряется
в пикселах на дюйм (pixels/inch). Нажмите кнопку ОК.

СОВЕТ
Чтобы не усложнять себе жизнь, помните, что имеет смысл беспокоиться только о ширине
изображения и соответственно о ширине экрана. Высота фотографий устанавливается ав-
томатически.
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Рис. 11.2. Выберите ширину изображения и его разрешение в диалоговом окне New (Создать)

Только взгляните! По ширине изображение в масштабе 100% заполнило весь экран.
Но откудая знал, какое число следует ввести в поле Width (Ширина) для получения
такого результата? Все очень просто. Монитор настроен таким образом, чтобы по-
казывать изображения с разрешением 72 ppi (pixels per inch — пикселов на дюйм).
Мы выбрали разрешение монитора 640 х 480, то есть ширина его рабочей области
равна 640 пикселам. Остается разделить 640 на 72, и получится 8,9!

А что произойдет, если взять изображение шириной 8,9 дюйма с разрешением
100 ppi? Оно просто не поместится на экране. Его можно посмотреть целиком
с помощью полосы прокрутки, или изменив разрешение экрана на 1024 х768.
В последнем случае ширина экрана будет равна 1024, а ширина изображения
в масштабе 100% - 8,9 х 100 - 890 пикселам.

Если же нужно сделать видимым все изображение, не меняя разрешения экрана,
вспомните о возможности изменения масштаба. Можно настроить программу таким
образом, что на экран будут выводиться не все пикселы изображения. Например,
если задать величину 25%, будет виден только каждый четвертый пиксел фотографии.
При этом детализация снимка, конечно, снизится, зато вам не придется пользо-
ваться полосой прокрутки.

ПРИМЕЧАНИЕ
Кстати, изображение, открываемое с помощью приложения PhotoDeluxe, по умолчанию имеет
масштаб 100%.

Рис. 11.3. Можно увеличивать и уменьшать масштаб изображения, чтобы рассмотреть его
во всех подробностях
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Обычно графические программы позволяют не только уменьшать, но и увеличи-
вать масштаб изображения, например, чтобы рассмотреть дополнительные дета-
ли, как показано на рис. 11.3.

Разрешение принтера
Как правило, принтеры имеют фиксированное разрешение, при котором они печа-
тают фотографии с наилучшим качеством. Стандартное разрешение лазерных
и термодиффузионных принтеров равно 300 dpi (dots per inch — точек на дюйм).
Разрешение фотографий, как мы уже говорили, измеряется в пикселах на дюйм.
Как же сопоставляются эти величины? Принтеры не печатают пикселы — они на-
носят небольшие капли чернил или краски. Желательно, чтобы одна капля соот-
ветствовала одному пикселу.

Для наилучшего воспроизведения изображения с помощью принтера требуется
сохранить его максимальный размер. Кроме того, разрешения изображения и прин-
тера должны совпадать. Для принтера с разрешением 300 dpi следует подготовить
фотографию с разрешением 300 ppi. Имейте в виду, что эти цифры не имеют ника-
кого отношения к разрешению монитора, то есть размер напечатанного изображе-
ния не будет совпадать с его размером на экране.

Если изображение имеет слишком маленький размер или его разрешение меньше
разрешения принтера, вы можете столкнуться с двумя вариантами развития ситуации:

Q принтер оставляет пустое пространство между точками, что приводит к снижению
качества проработки мелких деталей и уменьшению резкости изображения;

а принтер заполняет пространство между точками с помощью процедуры интер-
поляции. Но, как вы уже знаете, этот метод восстановления информации дале-
ко не совершенен, поэтому, скорее всего, все равно получится нерезкое изобра-
жение с недостаточно достоверными деталями.

Мораль этой истории проста. Для получения отпечатков приемлемого качества
исходное изображение должно иметь достаточный размер.

Струйные принтеры
Наверное, вам приходилось видеть на коробках со струйными принтерами надпи-
си, сообщающие о том, что разрешение этого принтера может достигать 1200 dpi.
Нужно ли срочно бежать в магазин, чтобы приобрести такой принтер? Ведь его
разрешение намного превосходит 300 dpi вашего лазерного принтера.

Не торопитесь! Сначала поговорим об одной маленькой детали.

Струйный принтер способен наносить на бумагу точки намного меньшего разме-
ра, чем лазерный или термодиффузионный принтеры. Кроме того, сопла струйно-
го принтера способны перемещаться на очень маленькие расстояния, в результате
чего в процессе печати на бумагу можно нанести очень много точек. Если у лазер-
ного принтера одному пикселу соответствует одна точка, то струйный принтер
напечатает две, три и даже четыре точки! Это значит, что файл с разрешением
300 ppi можно напечатать с разрешением 1200 dpi, так как одному пикселу будут
соответствовать целых четыре точки, и в итоге получится изображение со всеми
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сохраненными деталями и более плавными цветовыми переходами. Однако не сто-
ит обманывать себя. Принтер не создает дополнительную информацию между от-
сутствующими пикселами, он просто повторяет уже имеющиеся сведения. То есть
печать происходит с тем же самым разрешением 300 dpi, просто для этого исполь-
зуется большее количество точек.

Высококачественный лазерный принтер с разрешением 300 dpi печатает изобра-
жения такого же качества, как и струйный принтер с разрешением 1200 dpi. Лазер
может наносить очень маленькие точки, но их размер кажется большим, так как
тонер распространяется по бумаге. Из-за этого точки перекрываются друг с другом,
и их цвета смешиваются, что приводит к более натуральным цветам изображения.

Чтобы решить, какой из принтеров печатает лучше, просто сравните два отпечатка.
Ведь каждый принтер имеет свои сильные и слабые стороны, и нельзя наверняка
сказать, что качество печати струйного принтера с разрешением 1200 dpi будет
лучше качества печати лазерного принтера с разрешением 300 dpi.

В любом случае, если вы собираетесь печатать фотографии с высоким разрешением,
используйте качественную бумагу. Также помните о том, что процесс печати зани-
мает значительное время. В некоторых случаях сначала имеет смысл посмотреть
на результат работы принтера при выводе изображений с низким разрешением,
а потом уже переходить к производству высококачественных отпечатков.

Размер файла
У владельцев небольших, дешевых цифровых камер вряд ли когда-нибудь возник-
нут проблемы со слишком большим размером файла. Кроме того, напоминаю, что
каков бы ни был размер отпечатка, его разрешение должно соответствовать разре-
шению принтера.

При попытке отпечатать слишком большое изображение часть информации о нем
будет выброшена. Это явление называется обратной интерполяцией, или умень-
шением размеров. Поэтому перед тем, как отправить изображение на печать, же-
лательно уменьшить его размер. Рекомендуем проделать это с копией, сохранив
исходные размеры оригинала, ведь вам может потребоваться распечатать несколь-
ко версий снимка разных размеров в зависимости от принтера и типа бумаги".

Не стоит пугаться, если в сопроводительной документации на принтер указано раз-
решение в единицах Ipi (lines per inch — линий на дюйм). Чтобы определить требу-
емое разрешение, достаточно умножить это число на два. Например, если принтер
имеет разрешение 133 Ipi, разрешение изображения должно быть равным 266 ppi.

Также важное значение имеет линейный растр принтера. Этот термин относится
к маске, используемой принтером для экспонирования негатива, которая, в свою
очередь, применяется для создания печатной формы. Чем ниже линейный растр,
тем грубее будет выглядеть результирующее изображение. Кроме того, растр опре-
деляется выбранным типом бумаги. Например, газетная бумага не в состоянии
сохранить большое количество деталей. Поэтому на ней следует печатать с низ-
ким линейным растром, чтобы детали не сливались друг с другом при смачивании
чернилами пористой бумаги. Глянцевая бумага намного лучше удерживает детали
изображения, так как чернила впитываются в нее не так быстро.
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Следует запомнить
Q Мониторы показывают изображения с разрешением 72 dpi. Если ширина изобра-

жения не превышает ширину монитора, оно демонстрируется в масштабе 100%.

Q Для получения отпечатков приемлемого качества требуется достаточное раз-
решение изображения. Помните, что разрешение принтера превышает разре-
шение монитора.

Q Размер изображения на экране зависит от выставленного разрешения монитора
и может отличаться от размеров отпечатка.

Q Чем больше размер изображения, тем лучше будет качество его печатной копии.
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Способы сжатия изображения

Q Уменьшение разрешения и снижение качества
О Различные варианты сжатия
О Знакомство с различными типами файлов

Сжатие изображений позволяет уменьшить занимаемое ими место на носителе
камеры или на жестком диске. К сожалению, при этом иногда ухудшается каче-
ство снимка.

Получение качественных фотографий
Изображения самого лучшего качества получаются при распечатке несжатых ис-
ходных изображений. Если качество для вас стоит на первом месте, попробуйте
найти способ передачи данных с камеры без сжатия. К сожалению, это недостижимо
при работе с подавляющим большинством любительских фотоаппаратов и с частью
полупрофессиональных. Как же в таких условиях добиться изображений наилучше-
го качества?
Это не так-то просто. Оценить качество изображения можно только при знании
его размера, разрешения и степени сжатия. При этом производители камер описы-
вают данные параметры по-разному.
Q Размер и разрешение изображения. Некоторые камеры позволяют формиро-

вать изображения от двух до пяти разных размеров. Обычно они измеряются
в пикселах, например 1152 х 864 пиксела, 640 х 480 пикселов и т. п. Чем меньше
разрешение, тем меньше размер файла и, как следствие, требуется меньшее сжа-
тие. При подготовке иллюстраций для веб-сайта не нужно большое разреше-
ние, но если вы собираетесь распечатывать фотографии, выберите максималь-
ное значение из возможных.

Q Сжатие. Пользователи полагают (и я в их числе), что качество изображения
зависит от количества сохраняемой информации, но производители оценивают
его по-другому. Качество фотографии измеряется степенью ее сжатия. Чем она
выше, тем больше информации о снимке потеряно.



160 Глава 12. Способы сжатия изображения

У некоторых камер отсутствует возможность выбирать разрешение и степень сжа-
тия. Имеются только параметры вида: «Хорошее», «Плохое» и «Безобразное», од-
новременно характеризующие разрешение и сжатие. В этом случае, если камера
снимает с низким разрешением, снимок сжимается меньше, а по мере увеличения
разрешения растет и степень уплотнения. Вы сможете понять, что же при этом
происходит, только посмотрев на итоговый размер изображения. Например, если,
сделав два снимка с качеством «Хорошее» и «Плохое», вы обнаруживаете, что их
размер одинаков, значит, они различаются только степенью сжатия. Если же снимки
получатся разного размера, значит, изменению подвергается разрешение. Очевид-
но, такое слепое управление качеством фотографий не очень желательно.

ПРИМЕЧАНИЕ
Создается впечатление, что слегка сжатые снимки с низким разрешением дают в итоге
изображение лучшего качества, чем снимки с высоким разрешением после сильного сжатия.
На самом деле это не так. Проблема в том, что снимки с низким разрешением с самого нача-
ла сохраняют не все детали. Запакованный с высоким разрешением и потом открытый снимок
сохранит детализацию, правда, качество изображения может пострадать от интерполяции.

Различные способы сжатия
Существуют два способа сжатия снимков.

а Сжатие без потерь. Схема сжатия, при которой не происходит ухудшения ка-
чества рисунка. Также его иногда называют кодированием с переменной длиной
(RLE, run-length encoding).

Q Сжатие с потерями. Схема сжатия, при которой часть информации теряется
или выбрасывается, и за счет этого происходит уменьшение размеров файла.
При этом предполагается, что недостающие фрагменты восстановленного файла
будут заполнены с вашей помощью (на самом деле они интерполируются).

Сжатие без потерь
Вместо того чтобы сохранять информацию об изображении пиксел за пикселом
(понятно, что при этом никакое сжатие невозможно), происходит отслеживание
положения и цвета пикселов. Например, в процессе уплотнения отслеживается
положение зеленых пикселов. В итоге вместо 1000 пикселов сохраняется только
один, а также информация о местах его расположения на фотографии. Процесс
восстановления файла происходит в обратном порядке. Изображение складыва-
ется как мозаика в соответствии с сохраненными цветами и информацией о месте
их расположения. При этом между исходным и восстановленным файлами теоре-
тически не должно быть никаких различий, но из-за несовершенства процесса за-
писи информации точно восстановить изображение невозможно.

Сжатие без потерь является безопасным методом сохранения изображений, но при
этом размер выходных файлов будет не намного меньше размера оригиналов.

Сжатие с потерями
Посмотрите на снимок двух расположенных близко друг к другу объектов, например
на блестящий красный автомобиль на фоне голубого неба, и обратите внимание
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на границу между этими элементами. Вы заметили, как цвет пикселов постепенно
переходит от красного к голубому? При сжатии с потерями информация о таких
переходах частично теряется. Предполагается, что человеческий мозг самостоя-
тельно добавит все недостающие оттенки. Вторым недостатком подобного способа
сжатия является дополнительная потеря информации при повторении процедуры.

Зато сжатие с потерями позволяет достичь крайне небольших размеров файла. Это
особенно важно при рассылке фотографий по электронной почте или при разме-
щении их в Интернете. В конце концов, фотографии на веб-страницах обычно име-
ют настолько скромные размеры, что большинство деталей все равно разглядеть
невозможно. А чем меньше размер файла, тем быстрее он появится на экране при
загрузке веб-страницы.

Архиваторы
С течением времени любой пользователь накапливает на своем жестком диске
сотни фотографий, стереть которые не поднимается рука. В этом случае можно
перенести их на сменный носитель, например на компакт-диск или гибкий диск.
Проще всего, конечно, скопировать файлы с жесткого диска на гибкие диски, но
количество таковых при этом будет просто огромным.

Для решения подобных проблем и были изобретены архиваторы, то есть програм-
мы, которые сжимают файлы без потери данных. Кроме того, они помогают отсле-
живать положение файлов, сохраняя информацию об их положении в папках. Не-
которые архиваторы просто сжимают данные и помещают их в соответствующий
файл, а другие создают также регистрационный файл, что позволяет отслеживать
историю работы с архивом.

Архиваторы PKZip/WinZip
Приложения PKZip (обычно используется в DOS) и WinZip (соответственно, для
Windows) обеспечивают сжатие без потерь и доступны как в коммерческой, так
и в условно бесплатных версиях. Вы можете найти их на сайте http://www.winzip.com.
Реально процент уплотнения этими архиваторами может быть от самого низкого
(для формата JPEG, который описывается далее) до самого высокого для различ-
ных графических файлов. Степень сжатия текстовых файлов (например, докумен-
тов Word) может достигать 95%.

ПРИМЕЧАНИЕ -
Условно бесплатные версии программ создаются частными лицами и небольшими компани-
ями для заполнения пробелов, оставляемых крупными производителями программного обес-
печения. Подобные программы предлагаются по крайне низкой цене или даже бесплатно,
и обычно их можно загрузить из Интернета. Вырученные деньги (как правило, небольшие —
от $25 до 50) поступают к программисту в качестве оплаты за написание программного
кода, а также предназначаются для поддержки сайта.

Приложения PKZip и WinZip могут не только сжимать отдельные файлы, но и упако-
вывать наборы изображений в единый файл с расширением ZIP, как показано
на рис. 12.1.
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Рис. 12.1. Приложение WinZip сжало эти файлы приблизительно на 35 процентов

Восстановить файлы из такого архива можно с помощью WinZip, приложения
UnZip и ему подобных. Обычно этот процесс требует простых дополнительных
действий, отличных от перетаскивания файлов на значок архивирующей програм-
мы. Кроме того, упомянутые приложения позволяют создавать самораспаковыва-
ющиеся архивы, для восстановления файлов из которых не нужно пользоваться
специальной программой. Как правило, они имеют несколько больший размер, чем
ZIP-файлы, так как в них входит и небольшой программный код, без которого не-
возможно автоматическое извлечение файлов из архива. Подобные архивы полез-
ны, если вы не знаете, присутствует ли на компьютере человека, которому вы от-
правляете фотографии, программа для извлечения файлов из ZIP-архива.

Архиватор Stuff It
Приложение Stufflt, которое производит и продает компания Aladdin (http://
www.aladdinsys.com),'также обеспечивает сжатие без потерь. Однако оно было раз-
работано специально для компьютеров Macintosh, хотя существует и расширен-
ная версия под Windows. Принцип действия этого приложения отличается от опи-
санного в предыдущем разделе только расширением получаемого в итоге архива —
SIT. Степень сжатия графических файлов также сильно различается в зависимо-
сти от формата. И опять же у вас есть возможность поместить набор файлов в один
архив, как показано на рис. 12.2.

5/12/99 1.6ОЖ 1,461K «09

3/12/99 X.B3W 2(42SK Х7Я

3/12/» 3.610K 2,249»: 58*

3/12/» J,«XJK 2,406»:

Рис. 12.2. Приложение Stufflt уменьшило суммарный размер этих файлов на 43%

Stufflt также поддерживает возможность создания самораспаковывающихся архи-
вов, размер которых слегка превышает размер обычного файла .SIT из-за наличия
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небольшого программного кода, отвечающего за автоматическую распаковку.
Но имейте в виду, что они работают только на компьютерах Macintosh, поэтому
лучше сохранять файлы в стандартном SIT-архиве, который читается в любой
системе.

Форматы файлов , i
В существующем многообразии форматов файлов легко запутаться. Некоторые из
них относятся к определенной программе или производителю, в то время как дру-
гие являются промышленными стандартами. В этом разделе мы рассмотрим толь-
ко те форматы, которые относятся к растровым изображениям.

Существуют форматы, позволяющие сжимать изображения, другие уменьша-
ют цветовую информацию, а многие из них разработаны специально для исполь-
зования в Интернете. Некоторые форматы читаются только на компьютерах
Macintosh, а некоторые предназначены исключительно для PC. Поговорим о них
более детально.

Формат JPEG
Сжатие файлов алгоритмом JPEG (Joint Photographic Experts Group — объеди-
ненная группа экспертов в области фотографии) сопровождается потерями каче-
ства. Но их можно прочитать на любом компьютере. Кроме того, эти файлы имеют
небольшой размер, практически не сжимаются программами-архиваторами и вслед-
ствие своей компактности идеально подходят для размещения в Интернете.

В программах для редактирования изображений имеется возможность сохране-
ния файлов в формате JPEG. На рис.12.3 показано окно сохранения в этом форма-
те в программе Photoshop. Обычно при этом на экране появляется диалоговое окно,
запрашивающее степень сжатия изображения. Определить нужную степень сжа-
тия можно только экспериментально, но при максимальном значении коэффици-
ента будет произведено сжатие без потерь. При повторном открытии файла лю-
бым приложением изображение будет автоматически восстановлено.

:рет>
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Рис. 12.3. Основным форматом сжатия с потерями является JPEG
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ПРИМЕЧАНИЕ
Если вы хотите знать, кто, где, когда и как снял фотографию, вам повезло. Подобная ин-
формация (так называемые метаданные) сохраняется в формате JPEG EXIF (Exchangeable
Image Format) вместе с данными самого изображения. Многие потребительские камеры
высокого класса, а также профессиональные камеры в состоянии сохранять снимки в дан-
ном формате. Стандарт EXIF поддерживается ISO, Microsoft и более чем десятком произво-
дителей камер.

Если ваша камера поддерживает этот формат, скорее всего, в комплекте с ней продается
программное обеспечение для извлечения всех сопутствующих фотографии сведений. Кро-
ме того, такие программы можно найти в Интернете.

Метаинформация поможет вам понять, как камера определяет экспозицию, и запомнить,
когда были сделаны снимки.

Минимизация потери качества
Однажды во время прогулки с собакой ко мне подошла знакомая и спросила, почему
отправленные по электронной почте фотографии выглядят зернистыми, а мелкие
детали сливаются между собой? Для начала я узнал у нее, как она открывает, ре-
дактирует и сохраняет свои фотографии.

Оказалось, что ее камера сохраняет изображения с потерями, которые невозмож-
но контролировать. Затем в процессе редактирования и сохранения фотографии
снова подвергаются сжатию. Кроме того, программа для работы с электронной
почтой еще раз сжимает снимки. Это просто чудо, что при таких условиях какие-
то пикселы исходного изображения все же попадали к адресату!

Так как в данной ситуации возможность контролировать сжатие с помощью камеры
отсутствовала (имейте в виду, что покупать подобные камеры не стоит!), я предло-
жил передавать изображения непосредственно с носителя, открывать их в приложе-
нии PhotoDeluxe и сохранять в формате TIFF или PDD. Эти форматы обеспечи-
вают сжатие без потерь. После завершения редактирования можно сохранить файл
в формате JPEG с минимальным сжатием. Кроме того, я порекомендовал отклю-
чить сжатие изображений в программе для работы с электронной почтой.

В результате моей знакомой пришлось выполнять ряд дополнительных действий,
но качество снимков значительно возросло.

Формат TIFF
Одним из наиболее универсальных форматов растровых изображений является
формат TIFF (Tagged Image File Format — самодокументируемый формат файлов
изображений). Изображения в этом формате можно открывать как на компьютерах
Macintosh, так и на PC. Для размещения в Интернете они не подходят из-за слишком
большого размера. Для этих файлов используется схема сжатия без потерь, но не
с максимальным коэффициентом, поэтому уже сжатые изображения можно допол-
нительно уплотнить с помощью архиваторов.

На рис. 12.4 показано окно сохранения файла в формате TIFF в программе
Photoshop 7. Начиная с этой версии в формате TIFF можно запоминать такие важ-
ные элементы программы, как слои. Редактирование изображений в Photoshop 7
рассматривается в главах 14-21, и глава 20 целиком посвящена слоям.
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Рис. 12.4. При сохранении файлов в формате TIFF в числе других параметров требуется
указывать платформу, на которой вы собираетесь их открывать

ПРИМЕЧАНИЕ
Способы записи данных на платформах Macintosh и IBM PC отличаются друг от друга поряд-
ком следования байтов. Поэтому при сохранении желательно указывать платформу, на ко-
торой вы работаете.

При сохранении файлов в данном формате можно применить сжатие данных по
методу Лемпеля-Зива-Уэлша (LZW). Однако большинство пользователей пред-
почитает пренебрегать этой возможностью, так как степень сжатия при этом ми-
нимальна.

-

Формат GIF
Формат GIF (Graphics Interchange Format — формат графического обмена) был
разработан компанией CompuServe и до сих пор широко используется в сети Интер-
нет. Алгоритм сжатия LZW, который используется в файлах формата GIF, пред-
назначен преимущественно для текстовых файлов. Он позволяет эффективно сжи-
мать файлы, в которых имеется много однородных заливок. При этом изображения
с последовательностями пикселов одинаковых цветов по горизонтали (аналог
текста) сжимаются намного лучше рисунков с вертикальной ориентацией линий.
Формат GIF поддерживает только 8-разрядный цвет и лучше всего подходит для
значков, текста и линий.
Файлы формата GIF поддерживают чересстрочный формат графического обмена,
при котором изображение развертывается в окне браузера постепенно, с большей
детализацией. Например, сначала показывается каждая восьмая строчка изобра-
жения, а затем постепенно появляются все остальные. Это позволяет быстро со-
ставить представление о том, как выглядит изображение, хотя рассмотреть все де-
тали удается только после его полной загрузки. Кроме того, вы можете использовать
анимационный GIF, который представляет собой набор изображений в формате
GIF, создающих при быстром последовательном показе эффект движения.
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Формат EPS
Файлы формата EPS (Encapsulated PostScript — встроенный PostScript) могут
иметь большой размер, так как кроме изображения они содержат элементы для
установки принтера языка PostScript, который был разработан компанией Adobe
для описания файлов, направляемых на печать. Если принтер поддерживает дан-
ный язык, ему можно указать размер файла, используемые шрифты и другую ин-
формацию. Это позволяет принтеру напечатать файл должным образом.

Файлы формата EPS содержат описательную информацию в заголовке, что позво-
ляет вставлять изображение в текстовые и прочие документы. Файлы данного
формата можно легко переносить с одной машины на другую, но это же свойство
делает их слишком большими и замедляет процесс работы с ними. Ведь графический
редактор должен обработать не только сам снимок, но и инструкцию PostScript.
Очевидно, что файлы в данном формате не подходят для размещения в Интернете1.

Формат PDF
Можно сказать, что формат PDF (Portable Document Format — платформно-неза-
висимый формат документов) является современной версией формата EPS. Он
также содержит инструкции для принтера, а именно информацию о шрифтах, раз-
мере документа и используемых цветах, и может вмещать текстовые и графиче-
ские элементы, видео, звук, внедренные шрифты, элементы, обеспечивающие по-
иск и просмотр других элементов и документов (гиперссылки и оглавление). То есть
в формате PDF можно записывать не просто картинки, а целый документ с описа-
нием макета страницы, изображения и цветов.

Этот формат, хотя и не является чисто графическим, замечательно подходит для
распространения больших документов — графики с сопровождающим текстом,
особенно с помощыаИнтернета. Так как приложения для чтения файлов PDF бес-
платно распространяются компанией Adobe и другими фирмами, многие программ-
ные продукты снабжаются описанием в формате PDF вместо напечатанной инст-
рукции. Это позволяет производителям программного обеспечения сэкономить
значительные суммы на печати сопроводительной документации.

Многие правительственные организации, корпорации и даже небольшие фирмы
все чаще используют данный формат для передачи различной документации как
внутри предприятий, так и при связи с внешним миром, с

Для создания файлов в формате PDF требуется такое приложение, как Adobe
Acrobat, включающее в себя Acrobat Distiller. Документ^ в формате PDF имеют
небольшие размеры, так как это всего лишь код, содержащий описание макета и спе-
цификаций типов, вместо самого файла.

Формат FlashPix
Формат FlashPIX разработан группой компаний, производящих программное обес-
печение для обработки изображений (Kodak, Hewlett-Packard, Live Picture, Inc.
и Microsoft), и является вторым современным форматом, подходящим для размещения

Файлы EPS применяются в основном в полиграфии для внедрения иллюстраций в верстаемый текст.
Эталоном для создания файлов EPS являются продукты Adobe. — Примеч. ред.
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файлов в Интернете. Он использует сжатие с потерями для сохранения всего изоб-
ражения и многочисленных версий файла с более низким разрешением.

Соответственно, пользователь может выбрать для просмотра снимок с определен-
ным качеством. Помните, что при увеличении снимок будет разворачиваться на
весь экран, при этом в оперативной памяти находится только показанное на экра-
не изображение, а остальные располагаются в файле подкачки. Это позволяет бы-
стро менять разрешение по запросу пользователя. Кроме того, поскольку в опера-
тивной памяти находятся данные, необходимые для демонстрации изображения
только с одним разрешением, большее количество памяти освобождается для дру-
гих задач. Например, вместо загрузки 20 Мбайт информации для отображения
снимка размером 100 Кбайт в данном случае потребуется всего 100 Кбайт.

Также можно настроить размещенное на веб-странице изображение в формате
FlashPIX таким образом, что сначала будет загружаться версия с низким разреше-
нием, в то время как более детализированная версия будет ожидать своей очереди
в оперативной памяти. Это уменьшает время загрузки изображения и позволяет
размещать на веб-страницах изображения более высокого качества1.

Формат BMP
Формат BMP является стандартным форматом растровых изображений в Windows.
Соответственно, файлы в данном формате ассоциированы с различными приложе-
ниями этой операционной системы. Не стоит использовать данный формат без
крайней необходимости.

Формат PICT
Файлы в формате PICT напоминают файлы в формате TIFF, но предназначены
в основном для приложений Macintosh. В Windows их также позволяет читать
и сохранять в другом формате описываемая ранее программа IrfanView и некоторые
другие. Данный формат обеспечивает сжатие без потерь и обрабатывается программой
Stufflt. PICT-файлы состоят из отдельных графических объектов (линий, дуг, овалов
или прямоугольников), которые можно независимо редактировать и масштабиро-
вать. В PICT-файлах могут также храниться растровые изображения.

Многообразие выбора
При наличии ограничений на место для хранения фотографий сохраняйте их
в формате JPEG. Сделайте копию исходного снимка и попробуйте записать ее
с различной степенью сжатия, чтобы подобрать оптимальное соответствие размера
файла и качества изображения. К сожалению, без подобных экспериментов пред-
сказать размер файла почти невозможно.

Предшественником формата FlashPIX был формат PhotoCD от Eatman Kodak. Файл FlashPix со-
держит не только изображение, но и управляющую информацию (сценарий обработки) о требуемых
изменениях при просмотре. Тем не менее, формат не приобрел должной популярности, отнюдь не
все программы умеют с ним работать, и сегодня единственным производителем цифровой техники,
поддерживающим FlashPIX, является Kodak. На данный момент в качестве наиболее подходящего
для Интернета и альтернативы устаревшему формату GIF выдвигается формат PNG (Portable Network
Graphics). — Примеч. ред.
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Если на жестком диске вашего компьютера достаточно места, старайтесь записывать
изображения без сжатия, а затем запаковывать их с помощью программ, выполня-
ющих сжатие без потерь, например Stufflt, PKZip или WinZip. Для сохранения
большого числа фотографий можно приобрести дисковод для записи компакт-
дисков (CD-R или CD-RW) и хранить информацию на этих недорогих носителях.

Форматы TIFF и PICT замечательно подходят для хранения изображений, которые
в дальнейшем будут редактироваться. При этом данные сохраняются без потерь,
так как это несжимаемые форматы. (Вообще говоря, по требованию сжимаются,
но не так существенно, как для формата JPEG. Схема RLE-сжатия, используемая
в PICT-файлах, способна даже увеличить размер файла, поэтому чаще всего сжатие
для данных типов файлов не применяется.) Для долгосрочного хранения их можно
сжать с помощью приложения Stufflt или PKZip. Выбор зависит от операционной
системы, в которой вы работаете. Формат TIFF является более универсальным,
так как читается и на компьютерах Macintosh, и на компьютерах PC.

ПРИМЕЧАНИЕ
Не стоит пугаться, обнаружив файл в «формате» TIF вместо TIFF. Просто раньше, до появ-
ления операционных систем семейства Windows, файлы имели исключительно трехбуквен-
ные расширения, например TIF, DOC или LET.

Для размещения в Интернете лучше всего подходят изображения в формате JPEG.
То же самое можно сказать и о файлах, отправляемых по электронной почте. Это
связано как с небольшими размерами данных файлов, так и с возможностью че-
ресстрочного вывода (для этого при сохранении нужно выбрать вариант Progressive
JPEG). To есть файл на веб-странице сначала открывается с небольшим разрешени-
ем, а потом оно постепенно увеличивается по мере загрузки остальной информа-
ции. При этом посетитель страницы сможет быстро составить впечатление о том,
что же изображено на фотографии, вместо того чтобы с раздражением ждать, ког-
да же загрузится весь файл. Если снимок окажется неинтересным, всегда можно
перейти к чему-то другому, что увеличивает скорость работы в Интернете.
Файлы формата GIF лучше всего подходят для логотипов, штриховых рисунков
и одноцветных изображений. Они быстро загружаются, допускают сжатие и черес-
строчную развертку. Но этот формат не стоит использовать для сохранения фото-
графий, которые не являются частью логотипов.

Следует запомнить
Q Для экономии места на диске имеет смысл сжать файл.
а Сжатие без потерь не влияет на качество изображения, в то время как при сжа-

тии с потерями часть информации уходит в никуда, и вид снимка ухудшается.
Q Существует множество различных форматов графических файлов, некоторые

из них связаны с определенной платформой.

Q Запись изображения в «правильном» формате не только позволяет сохранить
фотографии, но делает их доступными для просмотра другими пользователями.



Часть IV

Методы обработки изображений
Еще на этапе съемки можно привлечь внимание к объекту и добавить фотографии
выразительности установкой соответствующих диафрагмы, выдержки и фокусно-
го расстояния. Также, с точки зрения композиции, важно расположение объекта
по отношению к фотографу, а игра с освещением создает желаемое настроение
и позволяет выделить нужные детали. Но если скопировать фотографии с камеры
на компьютер, перед вами откроется несоизмеримо больший круг возможностей
по улучшению и обработке изображений.
С помощью графического редактора можно удалить царапины и совершенно не-
нужные на снимке провода или, например, вставить выпавший зуб. Программы
позволяют управлять перспективой кадра, улучшать цветовую гамму, повышать
резкость или, наоборот, размывать некоторые части изображения. Вы можете даже
создавать новые прекрасные картины, комбинируя фрагменты нескольких фотогра-
фий, и воплощать в реальности то, что раньше существовало только в вашем вообра-
жении. А затем печатать изображения или просматривать их на экране монитора.

Я хотел улучшить цифровые фотографии,
на которых изображена моя бывшая жена, -

но случайно нажал клавишу Delete и
удалил их.
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Q Загрузка изображений с помощью программного обеспечения произво-
дителя камеры

а Загрузка изображений с помощью программы Photoshop Elements

Q Быстрее всего: загрузка изображений прямо с карт памяти

а Копирование файлов с компакт-дисков

Итак, вы фотографировали весь день, бегая по городу, и теперь ваши карманы за-
биты картами памяти, заполненными замечательными снимками. Друзья замучи-
ли вас вопросами о том, почему до сих пор нет фотографий. И вот, наконец-то, вы
готовы заняться полученными изображениями.

Практически невозможно — не говоря о том, что это попросту скучно и неинтерес-
но — подробно рассказать об использовании каждой модели камеры, представлен-
ной в продаже, и сопровождающего ее пакета программ. Но в работе большинства
камер и программ прослеживаются определенные закономерности; многие графи-
ческие редакторы функционируют одинаково, несмотря на различный интерфейс.

Если случится так, что тип вашего фотоаппарата и используемая вами программа
совпадут с примерами, описываемыми в этой книге, вам, несомненно, повезло.
В противном случае попытайтесь понять основы работы с графическими редакто-
рами и применить их в своей ситуации. Если это ни к чему не привело, попробуйте
почитать инструкцию к камере — представьте себе, там иногда содержатся дей-
ствительно полезные советы, которые помогут в работе. И, конечно, не бойтесь
делать ошибки — иначе вы никогда ничему не научитесь.

ВНИМАНИЕ
Приведенные ниже примеры не являются отражением свойств какого-либо определенного
продукта. Я попытался выделить общие черты, характерные для программного обеспече-
ния, которое, надеюсь, легко доступно и имеет похожие интерфейс и рабочие функции.
Также в свой краткий обзор я включил забавные программы, использование которых доба-
вит удовольствия от процесса и создаст дополнительные перспективы для творчества. Но,
как всегда, я советую вам выйти за рамки данной книги и поэкспериментировать.
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Подключение камеры
Перед тем как загрузить изображения с фотоаппарата на компьютер, независимо
от используемого программного обеспечения, нужно соединить эти два устройства.
Рассмотрим основные моменты процедуры подключения камеры. Скорее всего,
эти же действия следует выполнить и для вашего фотоаппарата, поскольку боль-
шинство камер и кабелей работают исходя из одинаковых принципов.

Перед подключением фотоаппарата следует прочитать сопровождающую его ин-
струкцию, но в целом руководствуйтесь следующим.

1. Как USB-интерфейс, так и интерфейс Fire Wire (IEEE-1394) допускает соеди-
нение работающих устройств между собой. Конечно, для большей безопасно-
сти можно перед подсоединением выключить и камеру, и компьютер, но для
экономии времени и профилактики проблем достаточно будет просто перезагру-
зить компьютер после подключения нового устройства.

2. На старых IBM PC может отсутствовать USB-порт, тогда следует найти после-
довательный порт на задней панели компьютера. Последовательных портов
может быть один или два, они помечаются СОМ 1 (первый порт) и СОМ 2
(второй порт). Возьмите соответствующий кабель, вставьте его в разъем после-
довательного порта СОМ 1 и завинтите винты на разъеме (рис. 13.1).

Рис. 13.1. Кабель легко подсоединяется к компьютеру под управлением Windows

На самом деле, если на вашем компьютере есть место для еще одного порта,
стоит подумать о покупке USB-карты. Попробуйте найти на задней панели
компьютера дырку для разъема, еще прикрытую заглушкой, — если таковая имеет-
ся, возможно, в вашем компьютере предполагается присоединение USB-карты.
В более новых IBM PC, как правило, есть USB-порт, к которому и следует при-
соединять кабель от фотоаппарата. Если все USB-порты уже заняты и ведется
работа с несколькими USB-устройствами, стоит приобрести USB-концентра-
тор. Эти устройства обычно достаточно дешевы, но очень полезны.
Если вы работаете на PowerMac или компьютере Macintosh серии 68К, для под-
соединения фотоаппарата можно использовать по своему выбору или модемный
порт, или порт для принтера (рис. 13.2)'. Соответствующие разъемы находятся
на задней панели компьютера. К компьютерам G3, G4 или Шас камеру можно

1 Модемный порт — последовательный порт, а портом принтера называют параллельный порт, кото-
рый имеется также на каждом компьютере IBM PC. — Примеч. ред.
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подключать через любые USB-порты компьютера и камеры. Оборудование
с интерфейсом FireWire соединяется аналогично.

Macintosh
cable

Рис. 13.2. Подключение к компьютеру на платформе Macintosh еще проще

СОВЕТ
Не нужно силой засовывать разъем кабеля в разъем порта — они должны легко соединять-
ся. В противном случае следует проверить соответствие кабеля используемому порту. Так-
же стоит взглянуть на сами разъемы и вычистить всю попавшую в них пыль и мусор.

Как это ни удивительно, причиной проблем, связанных с оборудованием компьютера, очень
часто являются поселившиеся в машине насекомые.

3. Возьмите другой конец кабеля. Сравните форму разъема кабеля с формой гнез-
да в камере, поверните кабель так, чтобы штырьки совпали с дырочками, и ак-
куратно вставьте кабель в разъем последовательного порта камеры.

Передача снимков программами
производителя фотоаппарата
Существует множество способов передачи изображений с камеры на компьютер
или получения доступа к файлам, находящимся на носителе фотоаппарата. Про-
изводители обычно продают свои фотоаппараты вместе с пакетами программ, в
них часто входят приложения, разработанные самим производителем, или версии
общедоступных программ, специально адаптированные для конкретных моделей
камер. Такое программное обеспечение называется OEM software (OEM, original
equipment manufacturer — изготовитель комплектного оборудования). К этому типу
нельзя отнести программы, авторами которых являются сторонние фирмы, напри-
мер продукты компании Adobe — Adobe Photoshop Elements или Photoshop, хотя
подобные приложения также могут находиться на диске, сопровождающем камеру.

Перед началом работы следует убедиться, что версии программ соответствуют
вашей операционной системе. Что может быть хуже попытки вставить квадрат-
ную втулку в круглое отверстие?! Кроме того, и это действительно важно, обяза-
тельно создайте резервную копию содержимого вашего жесткого диска. Она ока-
жется бесценной в случае возникновения повреждений в процессе установки новых
программ. Сделав копию, перезагрузите компьютер. После этого можно присту-
пать к установке программного обеспечения, сопровождающего фотоаппарат. При
необходимости обращайтесь к документации на камеру.
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ВНИМАНИЕ
Часто случается, что камера и другое периферийное оборудование не подсоединяется
к компьютеру так, как это описано в руководстве, или не распознается им. Вам повезет,
если вы не первым столкнетесь с подобной проблемой — тогда ответы на свои вопросы
можно будет обнаружить в форумах в Интернете. В любом случае зайдите на веб-сайт про-
изводителя фотоаппарата, загрузите обновленную версию драйвера, установите ее и по-
пробуйте вновь подключить камеру.

ПРИМЕЧАНИЕ
Как правило, вместе с камерами поставляются программы, работающие в обеих системах:
Macintosh и IBM PC. Я предпочитаю пользоваться программами, совместимыми с обеими
платформами, с минимально разнящимся интерфейсом. Если в описываемых далее про-
граммах будут встречаться существенные различия, я обязательно буду упоминать об этом.

Я пользуюсь программой Image Expert, которую приобрел вместе с фотоаппара-
том Epson Photo PC 750Z. Image Expert позволяет просматривать изображения,
находящиеся на носителе камеры, дает возможность индивидуального копирова-
ния файлов на компьютер и/или одновременной загрузки пакета изображений.
Фотографии при этом можно сохранить в фотоальбоме и выполнить простейшие
операции по их редактированию: настроить цвет, яркость и контраст.

После подключения фотоаппарата к компьютеру можно начинать передачу изоб-
ражений (при этом предполагается, что все необходимые программы уже установ-
лены). Выполните следующие действия.

1. В операционных системах Windows 95, 98, ME или 2000 щелкните на кнопке
Пуск (Start), выберите пункт Программы (Programms) и команду Photo PC750Z >
Image Expert. В Windows ХР щелкните на кнопке Пуск (Start), выберите пункт
Программы (More Programms) и команду Photo PC750Z * Image Expert.

Второй метод вызова программы больше подходит для систем Macintosh: най-
дите на жестком диске папку Photo PC750Z, в ней дважды щелкните на названии
Image Expert, чтобы открыть соответствующую папку, и затем дважды щелкните
на значке Image Expert.

2. На экране появится диалоговое окно, изображенное на рис. 13.3. Щелкните на
кнопке View Pictures in the Camera (Просмотр изображений в камере).

*t View Pictures from an Existing Albui

• r^iirii View Pictures In the Camera
i **4™

View Pictures In PC Card Slot

. Tip of the Day : :

d you know»

inds in the View menu.

Show at startup

Рис. 13.3. Чтобы начать процесс загрузки фотографий, щелкните на одной из кнопок View
Pictures (Просмотр изображений)
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3. Откроется показанное на рис. 13.4 диалоговое окно, в котором демонстрируются
кадры пленки. Чтобы переписать все фотографии на жесткий диск компьюте-
ра, нажмите на кнопку Get All (Получить все). Чтобы скопировать отдельные изоб-
ражения, щелчками выделите их и нажмите кнопку Get Selected (Получить выде-
ленные), в которую трансформируется кнопка Get All после выделения снимков.

I

Рис. 13.4. Можно переписать все изображения или толькб часть из них; во втором случае
фотографии нужно предварительно выделить

4. При записи снимков с камеры на жесткий диск компьютера программа Image
Expert автоматически создает для них альбом (папку), присваивая ей в каче-
стве названия текущую дату. Впоследствии в этот альбом можно будет добав-
лять изображения, выбирая его в диалоговом окне, а название папки изменить.

Select Album;
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Рис. 13.5. Выбрав изображения, нажмите кнопку OK, чтобы начать их копирование

5. Чтобы начать передачу фотографий, щелкните на кнопке Open (Открыть) (ОК
в системе Macintosh — рис. 13.5). Откроется окно, в котором будет отображаться
процесс копирования файлов (рис. 13.6). Эта процедура может занять довольно
много времени, поэтому вы вполне успеете выпить чашечку кофе или пооб-
щаться с семейством.

6. По окончании передачи файлов закройте диалоговое окно с кадрами.

7. На экране появится вопрос о том, нужно ли удалить изображения с носителя
камеры. Если вы хотите освободить место для будущих снимков, удалите пе-
реписанные фотографии, нажав на кнопку Yes (Да). Если же вы опасаетесь
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всяческих неприятностей и подвохов, не удаляйте снимки до тех пор, пока не
проверите, что они действительно переписаны на компьютер (рис. 13.7).

Рис. 13.6. Индикатор состояния подскажет вам, сколько времени потребуется
для записи фотографий

Ж l'""a"J.Sri_ ' :

: Delete All pictures from the removable media In the
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Рис. 13.7. Перед удалением изображений с носителя камеры проверьте,
нормально ли они переписались на компьютер

8. Это легко сделать, если не выходить из программы и открыть нужную папку.
Здесь, чтобы отобразить конкретное изображение, следует дважды щелкнуть
на нем (рис. 13.8).

Рис. 13.8. Чтобы вывести на экран фотографию из альбома, требуется дважды щелкнуть на ней
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9. Я советую перед тем, как начать заниматься редактированием изображений,
делать их копии, меняя при этом названия (рис. 13.9). В таком случае вы всегда
сможете вернуться к исходным фотографиям. Можно даже создать для копий
отдельную папку. Чтобы сохранить снимок из программы Image Expert, нужно
щелкнуть на кнопке Save (Сохранить), а для создания копии изображения следу-
ет выбрать меню File (Файл), команду Save as (Сохранить как) и в открывшемся
диалоговом окне выбрать нужную папку и ввести другое название, например
Имяфайлакопия-tif или Имяфайла2.Ь'т.

Рис. 13.9. Перед тем как начинать изменять фотографию, лучше создать ее копию

10. Если фотография снималась «вертикально», вам потребуется развернуть ее. Это
можно сделать с помощью команды раскрывающегося меню или кнопки Rotate
(Повернуть).

11. Выделенное изображение можно отредактировать. Для этого щелкните на пун-
кте меню Image (Изображение) и выберите команду Corrections (Исправления).
На экране появится диалоговое окно, предназначенное для корректировки кон-
траста, цвета и т. п. В правой части диалогового окна демонстрируется резуль-
тат изменения настроек (рис. 13.10). Правда, я обычно не редактирую снимки
в этой программе.

Contrast/Brightness f Color |Hue/Saturation^ Sharpness [Equalization ]

!:.' .;, . ' Original • • • . - . . • • • ' :

: . • ' ' • ' 'v.: ".New
I Contrail

High

Light

ц

Рис. 13.10. Диалоговое окно Image Corrections позволяет легко откорректировать цвет
и улучшить изображение
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Передача снимков с помощью
графических редакторов
Как я упоминал ранее, многие камеры поставляются в комплекте с собственным
программным обеспечением. В принципе, этих программ достаточно для получения
приличных изображений, с их помощью можно откорректировать цветовую гамму,
изменить размер снимка, обрезать его и т. д. Но обычно на этом возможности по ре-
дактированию фотографий заканчиваются, и если вы чувствуете в себе силы для
творчества, вам придется обратиться к различным приложениям, предназначенным
для просмотра и обработки изображений. Их называют графическими редакторами.

ПРИМЕЧАНИЕ
Драйверы TWAIN позволяют программному обеспечению напрямую соединяться с фотоап-
паратами и сканерами; особенно это касается графических редакторов. Многие производи-
тели камер и сканеров распространяют эти драйверы вместе со своей продукцией. Драйвер
TWAIN встраивается в связанные с графикой приложения при установке на компьютер про-
граммного обеспечения камеры. Он может работать на большинстве платформ и практиче-
ски во всех операционных системах. Доступ к этому драйверу из графической программы
почти всегда осуществляется через меню File (Файл); далее для загрузки изображения в зави-
симости от конкретного приложения требуется выбрать команду Acquire (Получить) или
Import (Импорт). Также вас, возможно, предварительно попросят определить TWAIN-
устройство. В принципе, вы можете даже не подозревать о том, что пользуетесь драйвером
TWAIN, настолько незаметно он встраивается в программы.

Помните о том, что все TWAIN-драйверы отличаются друг от друга, поскольку производите-
ли создают драйверы специально для своего оборудования. Невозможно описать использо-
вание драйверов для каждой отдельной модели фотоаппарата — это бы заняло сотни стра-
ниц. При работе с драйвером требуется выполнить всего несколько основных операций и не
нужно расстраиваться, если ваша программа не совсем похожа на примеры из книги. Поста-
райтесь найти кнопки и команды меню, отвечающие за выполнение задач, о которых рас-
сказывается в тексте. Для этого стоит обратить внимание на значки на кнопках. Руковод-
ствуйтесь интуицией, выделяйте главное, экспериментируйте и не волнуйтесь, если что-то
не получается. Если делать копии, вы не повредите файлы и систему.

Adobe Photoshop и Adobe Photoshop Elements — это графические редакторы, со-
зданные для всех пользователей, а не только для профессиональных фотографов.
С их помощью можно выполнить все основные операции по преобразованию изобра-
жений, а также наложить специальные эффекты и т. д. Программа Adobe Photoshop
Elements широко распространена и бесплатно продается в комплекте со многими
фотоаппаратами. Она очень похожа на своего старшего брата, Adobe Photoshop,
как интерфейсом, так и функциональностью. В дальнейшем я часто буду исполь-
зовать одну из этих программ для демонстрации своих примеров.
Прежде чем копировать снимки с камеры на компьютер с помощью Photoshop или
Photoshop Elements, следует установить саму программу. Внимательно прочтите
инструкцию по установке и, как всегда, сделайте копию содержимого жесткого
диска. Если что-то случится, вы об этом не пожалеете. Затем можно приступать
к загрузке фотографий. Этот процесс мы рассмотрим на примере Photoshop Elements.

1. Запустите программу. Для этого в системе Windows щелкните на кнопке Пуск
(Start) и выберите команду Programs > Adobe Photoshop Elements 2.0 (Программы >
Adobe Photoshop Elements 2.0) или же щелкните на значке программы, появив-
шемся на рабочем столе в процессе ее установки.



178 Глава 13. Передача фотографий на компьютер

На Macintosh найдите папку Adobe Photoshop Elements, откройте ее и щелкните
на значке Adobe Photoshop Elements.

2. Убедитесь в том, что фотоаппарат подсоединен к компьютеру и включен. Затем
щелкните на кнопке Connect to Camera or Scanner (Соединиться с камерой или ска-
нером) в появившемся диалоговом окне (рис. 13.11).

3. На экране появится диалоговое окно Select Import Source (Выбор источника им-
порта). Выберите в списке драйвер вашей камеры.

Рис. 13.11. Чтобы открыть фотографию на экране компьютера,
щелкните на кнопке Connect to Camera or Scanner

Рис. 13.12. TWAIN-драйвер Pretec предназначен для соединения
с цифровым фотоаппаратом Pretec DC620
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4. Когда будет нажата кнопка ОК, TWAIN-драйвер устройства (рис. 13.12) запустится
и создаст соединение с фотоаппаратом.

5. На экране откроется диалоговое окно драйвера камеры, похожее на представ-
ленное на рис. 13.13. Программа просмотрит изображения, находящиеся на но-
сителе фотоаппарата, и на экран будут выведены миниатюрные копии этих
фотографий.

ПРИМЕЧАНИЕ
Интерфейс драйвера, позволяющего скопировать фотографии с носителя камеры, обычно
предоставляет доступ к некоторым функциям самого фотоаппарата. Иногда с его помощью
можно изменить установки камеры и параметры, используемые ею по умолчанию. Драйвер
Pretec сам по себе очень простой и не предлагает многого с этой точки зрения.

6. Нажмите кнопку Select All (Выделить все) или выделите отдельные снимки, за-
тем щелкните на кнопке Save to Folder (Сохранить в папку).

7. Укажите папку, в которую следует записать файлы изображений, при этом обыч-
но разрешается создать новую папку или воспользоваться существующей.

Рис. 13.13. Записать фотографию на компьютер можно, выделив щелчком конкретное
изображение или нажав кнопку Select All

8. Программа начнет копировать файлы, и этот процесс может занять некоторое
время. Фотоаппарат Pretec DC620 можно подключать к компьютеру через стан-
дартный последовательный порт или через порт USB. USB-соединение обеспе-
чивает большую скорость передачи информации, но для этой камеры требует-
ся специальный кабель, найти который не очень легко.

9. Когда копирование файлов завершится, щелкните на кнопке Close (Закрыть),
чтобы выйти из диалогового окна драйвера и вернуться ;к окну Photoshop
Elements.
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Процесс копирования изображений с камеры на компьютер с помощью программы
Photoshop осуществляется точно так же, только вместо шагов 2 и 3 нужно открыть
меню File > Import (Файл > Импорт) и выбрать команду, соответствующую драйверу
камеры. Это приведет к загрузке окна драйвера камеры, и дальше следует действо-
вать по описанному алгоритму.

Самый быстрый способ: загрузка с карты
памяти
В принципе, не обязательно копировать фотографии прямо с камеры, когда у вас
есть заполненные снимками карты памяти или другие носители, подключаемые
к фотоаппаратам. Для подсоединения их к компьютеру используются адаптеры,
такие как, например, адаптеры для дисководов гибких дисков или устройства, по-
зволяющие подключать внешние миниатюрные жесткие диски. Такой способ по-
зволяет копировать снимки на компьютер, не теряя возможности пользоваться
камерой. (Правда, для этого у вас должно быть по крайней мере две карты памя-
ти.) Это самый быстрый способ загрузки отснятых фотографий на компьютер.

Для каждого типа съемной памяти подходит много моделей адаптеров. Их можно
купить в магазинах, торгующих компьютерами и цифровыми фотоаппаратами.
Некоторые адаптеры выпускаются производителями камер, другие — сторонними
фирмами. Покупая адаптер, убедитесь в том, что он будет работать в вашей системе.
Для своего Macintosh я приобрел считывающее устройство Iread фирмы Ariston.
Оно годится для чтения карт PCMCIA, а также карт SmartMedia и CompactFlash.
Кроме того, в продаже встречаются устройства для чтения карт PCMCIA, которые
прекрасно подойдут всем владельцам портативных компьютеров.

В следующем примере использован адаптер FlashPath1 для гибких дисков, который
я купил в комплекте с фотоаппаратом Olympus 620. Он предназначен для подсоеди-
нения карт SmartMedia к компьютеру. Выполните перечисленные ниже действия.

1. Подключите адаптер в соответствии с инструкциями производителя. Также,
следуя указаниям, установите драйвер адаптера, который обычно продается
в комплекте с устройством. В нашем примере программа-драйвер называется Read
FlashPath (Прочитать из FlashPath) — просто и понятно. Помните, что в при-
мере использованы настройки и платформа моего компьютера, а также кон-
кретная версия драйвера. Ваши результаты могут отличаться от представлен-
ных здесь, но общий смысл всех действий сохранится.

2. Запустите программу-драйвер (щелкните на кнопке Пуск (Start), выберите пункт
Программы (Programs) и затем название программы).

3. Откройте меню File (Файл) и выберите команду Import from FlashPath (Получить от
FlashPath).

Адаптер FlashPath представляет собой электронное устройство в форме 3,5-дюймовой дискеты, име-
ющее разъем для вставки карт SmartMedia (иначе Solid State Floppy Disk Card, SSFDC). В основном
производителем карт SmartMedia и адаптеров FlashPath является компания Toshiba. Цены на адап-
тер на российском рынке не отличаются от мировых — $70-75. Подробную информацию смотрите
на http://www.ixbt.com/storage/flashpath.htm. — Примеч. ред.
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4. Далее программа попросит вставить адаптер в дисковод для гибких дисков
(рис. 13.14). Проверьте еще раз, находится ли в адаптере карта памяти, и за-
двиньте его в дисковод.

Please insertyour
FlnshPath into the internal
floppy drive.

Рис. 13.14. Вставлять FlashPath в дисковод для гибких дисков
следует только по запросу программы!

5. Откроется диалоговое окно, содержащее имя карты, которая находится в адап-
тере (рис. 13.15). (Не нужно удивляться, если здесь появится бестолковое на-
звание, к которому вы не имеете никакого отношения. Имена картам и дискам
присваиваются в процессе форматирования, при этом не всегда пользователю
дается возможность выбора названий.) Нажмите кнопку Open (Открыть).

Рис. 13.15. Карта памяти может иметь довольно бессмысленное имя

6. Здесь вы должны увидеть корневую папку, в которой находятся все изобра-
жения, записанные на карту (рис. 13.16). Если требуется выделить только
один файл (или несколько), выделите название (или названия) и щелкните
на кнопке Open (Открыть). В противном случае нажмите кнопку Select A l l
(Выделить все).
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Рис. 13.16. Откройте папку, в которой находятся все фотографии с карты.

Обратите внимание — они имеют формат JPEG (расширение JPG)

7. Программа спросит, куда следует сохранить копируемые файлы. Вы можете
выбрать существующую на жестком диске папку или создать новую. Определив
место назначения, щелкните на кнопке Select «FlashPath» (Выбрать «FlashPath»),
расположенной внизу окна (рис. 13.17).

8. Начнется процесс копирования снимков, который занимает разное количество
времени в зависимости от выбранного числа файлов.
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Рис. 13.17. Для хранения своих фотографий я выбрал папку FlashPath. При желании вы можете
указать другую папку

9. По окончании записи дисковод отщелкнется и адаптер автоматически выско-
чит наружу. Теперь стоит проверить, появились ли нужные изображения там,
куда вы хотели их записать. Если да, примите мои поздравления!

Следует запомнить
О Фотографии можно переписать с камеры на компьютер посредством программ-

ного обеспечения, разработанного ее производителем.

Q Сделать это также позволяют различные графические редакторы в сочетании
с драйвером TWAIN.

а Самый быстрый способ передачи снимков: вынуть карту памяти из* камеры
и переписать файлы с помощью внешнего устройства для чтения карт.

Q Адаптер FlashPath великолепно подходит для старых PC, которые не поддер-
живают USB-интерфейс.

Q После записи снимков на компьютер драйвер камеры, как правило, позволяет
очистить карту памяти.
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Улучшение качества изображений

а Подготовка к работе
Q Изменение формы снимка

а Изменение размера изображения

Q Изменение его ориентации

Q Корректировка перспективы
Q Яркость и контраст

Одной из основных причин, побуждающих снимать фотографии с помощью циф-
ровых камер, является простота редактирования изображений. Теперь вам не при-
дется довольствоваться снимками плохого качества — графические редакторы по-
могут настроить или исправить цветовую гамму, контраст, размер и даже резкость
фотографии. Конечно, в реальной жизни не все снимки можно довести до совер-
шенства, но при наличии цифрового изображения намного проще попытаться сде-
лать это.

Подготовка к работе
Перед тем как заняться улучшением фотографий, несомненно, следует запустить
графический редактор. Мы будем рассматривать выполнение операций на примере
программы Adobe Photoshop 7.0, но в более простом приложении Adobe Photoshop
Elements, а также в предыдущих версиях Photoshop все выполняется аналогично,
хотя и существуют некоторые различия. В основном они заключаются в располо-
жении инструментов и пунктов меню.
Запустите программу Photoshop аналогично Photoshop Elements — этот процесс
рассматривался в главе 13. Откройте в окне программы одну из фотографий. Для
этого можно воспользоваться командой Open (Открыть) меню File (Файл) и в появив-
шемся на экране диалоговом окне указать один из файлов изображений. Я буду
проводить демонстрации на примере собственных снимков.
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ВНИМАНИЕ
Как правило, команды меню и инструменты программы Photoshop одинаковы для систем
Macintosh и Windows. Но в этих системах приняты разные клавиатурные сочетания, и об
этом не стоит забывать. Например там, где в Windows используется клавиша Ctrl, на компь-
ютере Macintosh нужно будет нажать клавишу Command, а клавиша Enter на PC действует
аналогично клавише Return.

Познакомимся с тремя основными рабочими элементами окна программы Photoshop,
представленного на рис. 14.1.

Q Строка меню. Представляет собой полосу со словами, расположенную в самом
верху окна программы, как показано на рис. 14.1. Каждое слово является назва-
нием меню, содержащего определенный набор команд, которые служат для на-
стройки окна программы, улучшения изображений и добавления различных
эффектов. К последним двум типам относятся меню Image (Изображение), Layer
(Слой) и Filter (Фильтр). Скрыть строку меню позволяет только полноэкранный
режим, перейти в который можно нажатием клавиши F или щелчком на кнопке
Full Screen Mode (Полноэкранный режим), находящейся на панели инструментов.

Панель
инструментов Главное меню

Название файла
Панель настройки
инструментов

Палитры

Область палитр

Рис. 14.1. Окно программы Photoshop

Панель инструментов. В ней располагаются инструменты, предназначенные
для создания и редактирования изображений. По умолчанию панель находится
в левой части рабочей области окна Photoshop. Если этой панели нет на экране,
выберите команду Tools (Инструменты) меню Window (Окно).

Панель настройки и область палитр. Панель настройки инструментов находится
прямо под строкой меню, как продемонстрировано на рис. 14.1, и предназначается
для изменения параметров активного инструмента. Областью палитр называется
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небольшая, по умолчанию расположенная в правой части панели настройки
область, в которой можно хранить не используемые в данный момент палитры.
Если панель настройки отсутствует на экране, выберите команду Window >
Options (Окно > Параметры).

Q Палитры. В программе Photoshop используется большое число различных па-
литр. С их помощью можно узнавать текущий масштаб изображения, выбирать
цвета для рисования, отменять или запоминать последовательность действий,
управлять такими элементами, как слои, контуры и каналы. Поскольку палитр
так много, они группируются в одном окне, а переключение с одной палитры на
другую осуществляется щелчком на нужной вкладке. Окна с палитрами по умол-
чанию располагаются в правой части рабочего окна программы, как показано
на рис. 14.1. Если нужной палитры нет на экране, выберите ее название из меню
Window (Окно).

Чтобы получить подробную информацию о составляющих окна программы, выбе-
рите команду Help > Photoshop Help (Справка > Справка Photoshop) или нажмите кла-
вишу F1 — откроется справочная страница — и затем щелкните на пункте Looking
at the Work Area (Просмотр рабочей области). Здесь, если щелкнуть на ссылке с назва-
нием интересующего вас элемента экрана, появится текст с инструкциями по его
использованию, во многих случаях сопровождаемый рисунком, на котором пока-
зывается положение элемента в рабочем окне программы.

Сохранение изображений
Прежде чем начать редактировать изображения в программе Photoshop, имеет
смысл научиться сохранять результаты своей работы. Для записи изображений
используется команда File > Save (Файл > Сохранить) или File > Save As (Файл > Сохра-
нить как). В открывшемся диалоговом окне следует ввести имя файла, указать гра-
фический формат (форматы подробно рассматривались в главе 12) и определить
элементы для записи. Дальше в зависимости от выбранного формата может по-
явиться еще одно окно, в котором нужно определить дополнительные параметры.

При сохранении открытого файла изображения в Photoshop командой File > Save
(Файл > Сохранить) его исходный формат обычно не меняется, однако в некоторых
ситуациях, когда формат не поддерживает выполненные над изображением пре-
образования, программа выводит диалоговое окно Save As (Сохранить как) и пред-
лагает выбрать другой формат.

Форматы PSD и PDD являются родными (собственными) форматами программ
Photoshop и Photoshop Elements (большинство графических редакторов имеют свои
собственные форматы, в которых без потерь сохраняется вся дополнительная инфор-
мация и вспомогательные элементы, такие как слои). Я советую всегда после откры-
тия файла в программе Photoshop сохранять его с помощью команды Save As (Сохра-
нить как) в формате PSD, а потом уже начинать редактирование. При этом исходный
файл остается нетронутым, а все изменения применяются к его копии в формате PSD.

Вот еще несколько полезных советов.

D После выполнения некоторого количества операций по преобразованию изоб-
ражения файл следует сохранить. При этом не стоит записывать измененный
снимок поверх оригинала, лучше создать копию.
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а Если работа с файлом в программе Photoshop не закончена, оставьте его в фор-
мате PSD. Многократное сохранение изображения со сжатием, например
в формате JPEG, ухудшает его качество, поэтому редактировать снимок лучше
в собственном формате программы, а в общедоступном графическом формате
сохранять только окончательный результат.

Q Если планируется открывать изображение в программе, отличной от Photoshop
и Photoshop Elements, используйте какой-нибудь стандартный графический
формат, например TIFF. Если же требуется уменьшить размер файла, можно
выбрать максимальный коэффициент для формата JPEG, который обеспечи-
вает сжатие практически без потерь, или упаковать файл с помощью архивато-
ра WinZip или Stufflt.

Еще раз обратите внимание на то, что если нужно сохранить изображение в дру-
гом формате, использование команды Save (Сохранить) не приведет к желаемому
результату — следует выполнить команду Save As (Сохранить как) или Save for Web
(Сохранить для Web) меню File (Файл). В этом случае откроется диалоговое окно,
позволяющее изменить название файла и указать другой формат хранения.

Изменение формы и размера изображений
Изображения хорошего качества можно увеличивать в размере, но только в разум-
ных пределах и только в тех случаях, когда без этого не обойтись. Если слишком
растянуть снимок, его качество заметно ухудшится. В большинстве случаев допу-
стимо увеличение размеров на 150-200%, при этом уровень детализации искажа-
ется не сильно.

Но по какой причине вам может понадобиться увеличить изображение? Напри-
мер, снимая объект, вы не смогли подойти к нему на достаточное расстояние, или
фотография была обрезана с целью улучшения композиции. Теперь требуется уве-
личить изображение, чтобы стали видны все детали. Или, может быть, вам подари-
ли несколько рамок размером 8x10 дюймов, в которые теперь нужно вставить са-
мые хорошие фотографии.
Существует несколько методов изменения размера изображения, которые мы об-
судим дальше. Но важно помнить об одном правиле, относящемся к программам
Photoshop Elements и Photoshop: чаще всего достичь одинаковых результатов мож-
но разными способами. Также не стоит забывать о том, что желательно сохранить
файл перед выполнением важных изменений, хотя в обеих программах допускает-
ся отмена всех действий, записанных в палитре History (История). По умолчанию
это 20 последних операций.

Размер фотографии
Диалоговое окно, показанное на рис. 14.2, позволяет точно установить размеры
изображения или изменить их. Вызывается оно командой Image > Image Size
(Изображение > Размер изображения).
При изменении размера изображения можно сохранить или переопределить его
пропорции (так называемое свободное изменение размеров). Когда в диалоговом
окне установлен флажок Constrain Proportions (Сохранять пропорции), при увеличении
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или уменьшении одной из сторон изображения корректируется и вторая — таким
образом, пропорции остаются теми же. Обратите внимание, что при этом поля Width
(Ширина) и Height (Высота) соединены справа перемычкой. Если снять флажок
Resample Image (Пересчитать изображение), становятся связанными друг с другом
величины в разделе Document Size (Размеры документа): ширина и высота отпечатка
изображения и разрешение. Тогда изменение одного из физических размеров приве-
дет к пропорциональному изменению другого размера и разрешения (ppi), а коли-
чество пикселов в изображении и, соответственно, размер файла останутся прежни-
ми. Подробнее о разрешении и размерах изображений рассказано в главах 11,23 и 24.

Рис. 14.2. В диалоговом окне Image Size (Размер изображения)
выводятся точные размеры снимка

Если вы решили, пользуясь диалоговым окном Image Size (Размер изображения),
увеличить изображение, то снимок может выйти за пределы своего окна, при этом
на правой и нижней границах окна появляются полосы прокрутки. Я часто стал-
кивался с подобной ситуацией, работая на маленьких 14- или 15-дюймовых мони-
торах. В этом случае для просмотра изображения целиком нужно уменьшить раз-
мер снимка на экране, то есть уменьшить масштаб его отображения, что не вызывает
фактического изменения размеров снимка. При этом вы чем-то становитесь похо-
жи на художника, отходящего на шаг от своей картины, чтобы лучше ее видеть
в целом. Щелкните на инструменте Zoom (Масштаб), расположенном на панели ин-
струментов (значок с лупой), или нажмите клавишу Z, наведите указатель мыши
на изображение, затем нажмите клавишу Alt и, не отпуская ее, щелкните кнопкой
мыши. Обратите внимание на то, что при включении инструмента указатель мыши
принял вид лупы со значком «+», а при нажатии клавиши Alt вместо него появился
значок «-». Если щелкнуть на изображении, отпустив клавишу Alt, его размер на
экране увеличится. Можно уменьшить масштаб изображения, не включая инстру-
мент Zoom (Масштаб) —для этого требуется выбрать команду View > Zoom out (Вид >
Уменьшить) или нажать комбинацию клавиш Ctrl+-. Чтобы добиться противопо-
ложного результата, следует использовать комбинацию Ctrl++ (на цифровой части
клавиатуры) или Ctrl+=.

i '•

Размер холста
В программе Photoshop изображение находится на холсте. На холст можно встав-
лять графические элементы и фрагменты фотографий, перемещать объекты в его
пределах, рисовать различными инструментами и т. д. Если отредактировать размер
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фотографии с помощью диалогового окна Image Size (Размер изображения), соот-
ветственно изменится и размер холста. Но программа позволяет изменять размер
холста, сохраняя размер изображения, в этом случае при увеличении холста во-
круг изображения появляются свободные области, а при уменьшении часть изобра-
жения удаляется. Вам может понадобиться увеличить холст для создания колла-
жей или склейки панорамы из нескольких фотографий.

Чтобы изменить размеры холста, сохранив размеры изображения, нужно выпол-
нить команду Image > Canvas Size (Изображение > Размер холста). На экране появит-
ся одноименное диалоговое окно, которое продемонстрировано на рис. 14.3.

Рис. 14.3. Диалоговое окно Canvas Size (Размер холста) позволяет
добавлять свободные области вокруг изображения

В нижней части диалогового окна находится квадрат, разбитый на девять областей.
Центральная область белого цвета обозначает существующее изображение. Чтобы
увеличить размер холста, нужно ввести новые блыпие значения в поля Width (Шири-
на) и Height (Высота) раздела New Size (Новый размер) диалогового окна, причем
с помощью расположенных справа раскрывающихся списков вы можете изменить
единицу измерения (например, с дюймов на сантиметры или пикселы). По умолча-
нию исходное изображение располагается по центру нового увеличенного холста,
но при необходимости можно добавить свободную область только с одной, двух
или трех сторон изображения. Для этого следует указать программе, в какую сторону
будет происходить изменение размеров. Зафиксируйте положение исходного изобра-
жения щелчком на одной из восьми областей со стрелками, являющихся частями
квадрата A n c h o r (Якорь), и холст увеличится в соответствии с этой настройкой.

Здесь также можно и уменьшить размер холста, при этом разрешение изображе-
ния не изменится, а размеры его сократятся — будут отрезаны области, указанные
в диалоговом окне Canvas Size (Размер холста). Для уменьшения холста также сле-
дует ввести новые уменьшенные значения в поля раздела New Size (Новый размер).
По умолчанию изображение обрезается со всех сторон (положение его центра не
меняется), но с помощью квадрата Anchor (Якорь) можно обрезать снимок только
с каких-то конкретных сторон.

Если установить флажок Relative (Относительно), то в полях Width (Ширина) и Height
(Высота) нужно будет указывать только величину, на которую требуется изме-
нить размер холста. В некоторых случаях пользоваться таким способом гораздо
удобнее.
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Свободное изменение размеров
Существует еще один метод одновременного изменения размеров изображения
и его пропорций, при котором вы видите на экране все преобразования и можете
их оценить. Откройте изображение и выполните следующее.

1. По умолчанию исходное изображение располагается на фоновом слое (кото-
рый также называется слоем заднего плана и в палитре Layers (Слои) обознача-
ется Background (Фон)). Возможности по обработке этого слоя ограничены, и в
данном случае нам необходимо преобразовать его в обычный слой (слои более
подробно рассматриваются в главе 20). Для этого выполните команду Layer >
New > Layer from Background (Слой > Н о в ы й > Слой из фона). В открывшемся диа-
логовом окне можно изменить название слоя в поле Name (Имя) и следует на-
жать на кнопку ОК. В результате в вашей фотографии как был, так и останется
один всего слой — поменяется его название и увеличатся возможности по его
обработке.

2. Если вы собираетесь уменьшать снимок по ширине и высоте, этот шаг можно
опустить. В противном случае сначала требуется увеличить холст — эту про-
цедуру мы рассматривали в предыдущем разделе. Новые размеры оцениваются
приблизительно, и если в результате останутся не заполненные изображением
области, их всегда можно будет обрезать (инструмент Crop (Обрезать) рассмат-
ривается далее).

3. Выполните команду Edit > Transform > Scale (Редактирование > Трансформация >

Масштаб).

ПРИМЕЧАНИЕ -
Команды подменю Transform (Трансформация) позволяют различным образом изменять форму
изображения, выделенной области или слоя (изображение нужно предварительно выде-
лить или преобразовать в слой, и тогда к нему будут применимы все команды этого подме-
ню. Выделение фрагментов изображения подробно рассматривается в главе 16, слои —
в главе 20). Для выполнения той же задачи предназначается команда Free Transform (Сво-
бодная трансформация). Ее действие в сочетании с клавишами Shift, Ctrl и Alt заменяет все
команды подменю Transform (Трансформация) за исключением зеркального отражения,
о котором будет рассказано далее.

4. Вокруг изображения появится рамка с маркерами по углам и на серединах сто-
рон, как показано на рис. 14.4. Первые мы назовем угловыми, а вторые — цент-
ральными. Если нажать на кнопку мыши, когда указатель находится внутри
изображения, и передвинуть мышь, то изображение сместится относительно
холста.

5. С помощью центральных маркеров можно скорректировать пропорции изоб-
ражения. Если подвести указатель мыши к такому маркеру, он примет вид дву-
направленной стрелки. Нажмите кнопку мыши и передвиньте указатель — мар-
кер переместится следом.

6. Угловые маркеры также служат для изменения размера изображения. Чтобы
сохранить пропорции, нужно нажать клавишу Shift при перемещении углового
маркера. Если нажать клавишу Alt, размеры будут изменяться симметрично
относительно центра изображения.
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Рис. 14.4. Здесь изображение увеличивается без сохранения пропорций

7." Выполнив, преобразования, щелкните на кнопке с галочкой, расположенной
справа в палитре настройки инструментов. Размер изображения и его пропорции
изменятся. Если вы не желаете сохранять результаты своей работы и хотите
вернуть снимку его первоначальный вид, нажмите на кнопку с перечеркнутой
окружностью, расположенную слева от кнопки с галочкой, или клавишу Esc.

Отмена выполненных преобразований
Корректируя изображение в программе Photoshop (Photoshop Elements или лю-
бом другом графическом редакторе, предназначенном для обработки растровой
графики), вы перераспределяете составляющие его пикселы. То есть происходит
изменение позиции и цвета пикселов, и каждый раз программа вычисляет их цвет
и расположение. Если повторить перераспределение пикселов много раз, качество
изображения значительно ухудшится, поэтому имеет смысл минимизировать ко-
личество операций при обработке снимков.

Избежать этих ужасающих последствий можно, редактируя копию исходного изоб-
ражения. В этом случае, выполнив неудачную последовательность действий, вы
можете еще раз скопировать снимок и начать работу заново. Кроме того, програм-
ма предоставляет в ваше распоряжение команду Undo (Отменить) меню Edit (Редак-
тирование) и сочетание клавиш Ctrl+Z. Действие этих инструментов одинаково: они
отменяют последнюю операцию. Существует и более мощный инструмент — па-
литра History (История). В ней сохраняется заданное количество выполненных дей-
ствий, по умолчанию это 20 операций. Вы всегда можете выбрать в палитре любую
из зафиксированных операций, щелкнуть на ней и вернуться таким образом на
несколько шагов назад.

Если же вы довольны результатами своей работы, стоит сохранить изображение.
Тогда при совершении непоправимой ошибки вам не придется возвращаться в са-
мое начало. Профессионалы, как правило, оставляют неприкосновенным исход-
ное изображение и делают копии после выполнения серии успешных операций.
При этом копии сохраняют в разные файлы, а после имени добавляют порядко-
вый номер, например myfilel.psd, myfile2.psd и т. д. Таким образом, они всегда го-
товы вернуться к любому этапу работы.
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Ориентация
Все фотографии сохраняются на носителе камеры горизонтально, независимо
от того, как они были сняты. Если фотография имеет вертикальную ориентацию,
то ее нужно повернуть, чтобы нормально просмотреть на экране компьютера. Для это-
го требуется выполнить команду Image > Rotate Canvas > 90° CW или 90° CCW (Изобра-
жение > Повернуть холст > 90° по часовой стрелке или 90° против часовой стрелки).

Кроме того, можно зеркально отразить изображение по горизонтали или по верти-
кали с помощью команд Flip Horizontal (Отразить горизонтально) или Flip Vertical (От-
разить вертикально). Представьте себе горизонтальную и вертикальную прямые,
проходящие через центр изображения. При горизонтальном отражении точки, рас-
положенные на вертикальной прямой, остаются на месте, а левые и правые отно-
сительно нее точки меняются местами. При вертикальном отражении происходит
то же самое, но относительно горизонтальной прямой. Чтобы понять этот процесс,
проще всего попробовать выполнить команду.

Если требуется немного повернуть изображение, чтобы выровнять егозили же по-
вернуть на угол, не равный 90°, выберите команду Image > Rotate Canvas > Arbitrary
(Изображение > Повернуть холст > Произвольно). В открывшемся диалоговом окне
нужно ввести величину угла, на который следует повернуть изображение (к сожа-
лению, здесь можно указывать только целые величины), выбрать направление вра-
щения и нажать на кнопку ОК. Программа повернет снимок на заданный угол, а
размер холста увеличится так, чтобы на нем поместилось все изображение. По-
явившиеся области будут залиты белым цветом. Лишние части можно обрезать,
уменьшив размер холста или воспользовавшись инструментом Crop (Обрезать), ра-
бота с которым рассматривается в следующем разделе.

Существуют и другие способы выполнения этой операции. Можно выделить все
изображение, например, выполнив команду Select > All (Выделить > Все), затем вы-
брать команду Edit > Transform > Rotate (Редактирование > Трансформация > Поворот).
Штриховая бегущая рамка, появившаяся после вызова первой команды, преобра-
зуется в сплошную с маркерами. Теперь нужно подвести указатель мыши к любо-
му из маркеров — он примет вид двунаправленной изогнутой стрелки — и, нажав
кнопку мыши, повернуть изображение на любой угол. При этом появляются про-
зрачные свободные области, а части изображения скрываются за пределами хол-
ста, и если требуется включить их в итоговое изображение, необходимо увеличить
размеры холста. Кстати, если нажать кнопку мыши, когда указатель находится
внутри изображения, и передвинуть мышь, переместится и изображение.

Также можно поворачивать изображение с помощью инструмента Crop (Обрезать),
рассматриваемого в следующем разделе. В некоторых случаях этот способ будет
самым удобным.

Мы уже упоминали о слоях, описывая свободное изменение размеров изображе-
ния. Повернуть снимок также можно, преобразовав фон в слой и выбрав команду
Edit > Transform > Rotate (Редактирование > Трансформация > Поворот) или Rotate 90° CW
(Поворот на 90° по часовой стрелке), или Rotate 90° CCW (Поворот на 90° против часо-
вой стрелки). При этом вращается сам слой, ориентация холста остается неизмен-
ной, и в результате на холсте появляются свободные прозрачные области, а часть
изображения скрывается за рамкой холста. Теперь, исходя из поставленной зада-
чи, можно увеличить или уменьшить размеры холста.
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ПРИМЕЧАНИЕ
Чтобы понять, что такое слои, проведите следующий эксперимент. Возьмите три прозрач-
ных листа одинакового размера, на каждом из которых что-то нарисовано. Сложите их
в стопку. Стопка представляет собой изображение, состоящее из нескольких слоев. Теперь
«поменяйте ориентацию одного из слоев», то есть разверните один из листов — при этом
ориентация других листов осталась прежней. Именно такую работу выполняет команда
Edit»Transform * Rotate (Редактирование > Трансформация > Поворот) и другие команды,
находящиеся в подменю Transform (Трансформация).

Кадрирование
При работе с фотографиями очень часто требуется обрезать снимки. Например,
фотография получилась размером 5 х 7,5 дюймов, и она немного велика для рамки
размером 5 x 7 дюймов. Или же на самом краю снимка обнаруживается нежела-
тельный элемент, который разумно удалить из кадра, например часть чьей-нибудь
головы или фрагмент стены. В данном случае проще всего обрезать фотографию,
и для этого предусмотрены инструмент Crop (Обрезать) и одноименная команда меню
Image (Изображение). Понятно, что, обрезая снимок, мы изменяем одновременно
его размеры и размеры холста — еще один способ решения описанной выше задачи.

Чтобы обрезать изображение, выполните следующее.

1. Выведите на экран панель инструментов, если она скрыта (команда Window >
Tools (Окно > Инструменты)). Щелкните на инструменте Crop (Обрезать). Активи-
зировать этот инструмент можно также с помощью клавиши С.

2. Подведите указатель мыши к изображению, нажмите левую кнопку мыши и «на-
рисуйте» рамку, перетащив указатель. Все фрагменты изображения за преде-
лами рамки после применения инструмента будут удалены. Маркеры, располо-
женные на серединах сторон и углах рамки, позволяют изменить ее размер. Если
нажать кнопку мыши внутри рамки и передвинуть указатель, рамка сместится
следом за указателем. Рамку можно даже повернуть или произвольно дефор-
мировать. Если подвести указатель к любому из маркеров за пределами рамки,
то он примет вид двунаправленной стрелки — теперь рамку можно вращать.
При этом все части изображения, вышедшие за пределы холста, также будут
обрезаны после применения инструмента. Чтобы деформировать рамку, требу-
ется установить флажок Perspective (Проекция) на панели настроек инструмен-
та. После этого, потянув за угловой маркер, можно прямоугольную рамку пре-
образовать в любой выпуклый четырехугольник. В результате применения
инструмента фрагменты изображения, оказавшиеся за пределами рамки, будут
обрезаны, а оставшаяся часть заполнит прямоугольный холст и, соответственно,
видоизменится.

3. Для применения инструмента следует нажать клавишу Enter или кнопку с га-
лочкой на панели настройки. Для отмены и удаления рамки с экрана нажмите
клавишу Esc или кнопку с перечеркнутой окружностью на панели настройки.

ПРИМЕЧАНИЕ
Есть и другой способ выполнения этой операции, связанный с выделением областей. Можно
выделить фрагмент изображения с помощью инструментов выделения, а затем применить
команду Image > Crop (Изображение > Обрезать). Выделение областей рассматривается
в главе 16.
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Коррекция фотографий
Иногда искажения, образовавшиеся на фотографии вследствие неподходящего угла
съемки, не исправить простым кадрированием, изменением размеров или поворо-
том. В некоторых случаях дефекты поможет устранить свободная деформация,
выполненная с помощью инструмента Crop (Обрезать). Программа предлагает еще
несколько инструментов, которые позволяют исправить геометрические искаже-
ния, возникающие на снимках.

Команда Perspective (Перспектива)
Команда Perspective (Перспектива) дает возможность исправить дефекты, связанные
с неудачной или искаженной перспективой на фотографии. Например, высокое
здание слишком сужается в направлении снизу вверх, или боковая сторона здания
наклонилась больше, чем следует, по сравнению с реальным объектом. Такой дефект
называется трапецеидальностью.

Команда Perspective (Перспектива) находится в подменю Transform (Трансформация),
поскольку это один из способов изменения формы изображения, выделенной об-
ласти или слоя (изображение нужно предварительно выделить или преобразовать
в слой). В нашем примере со зданием, у которого слишком мала верхняя часть по
сравнению с нижней, при применении этой команды происходит фактическое из-
менение размеров верхней части снимка, в то время как нижняя остается неизмен-
ной. Попробуйте выполнить следующую последовательность операций — это по-
может вам понять действие данного инструмента.

1. Откройте изображение. Для демонстрации работы команды Perspective (Перс-
пектива) лучше всего подойдет фотография высокого здания или прямоуголь-
ного объекта. Если среди ваших снимков нашлось изображение высокого дома,
сделанное с земли, то, скорее всего, на нем заметно, что верхняя часть здания
получилась уже его подножия вследствие эффекта трапецеидальное™.

2. Преобразуйте фоновый слой в обычный, выполнив команду Layer > New > Layer
From Background (Слой > Новый > Слой из фона).

3. Расширьте рабочее пространство, увеличив размер холста (вы же будете растя-
гивать верхнюю часть изображения). Для этого выполните команду Image >
Canvas Size (Изображение > Размер холста) и введите новое значение ширины,
большее предыдущего.

4. Выберите команду Edit > Transform > Perspective (Редактирование > Трансформа-
ция > Перспектива). Вокруг изображения появится рамка с маркерами.

5. Щелкните на правом верхнем маркере и оттащите его вправо, не отпуская кнопку
мыши. Ничего страшного, если маркер все-таки вышел за пределы холста —
изображение не обрежется по размеру холста, и при желании холст можно будет
увеличить после применения команды.

6. Отпустите кнопку мыши. Изображение изменилось примерно так, как показа-
но на рис. 14.5.

7. Вероятно, с первого раза вы не смогли добиться требуемого эффекта, например,
слишком удалив маркер. Тогда можно отменить последнее изменение рамки,
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выбрав команду Edit > Undo (Редактирование > Отменить) или нажав сочетание
клавиш Ctrl+Z, а можно продолжить ее редактирование, потянув за этот же или
любой другой маркер.

8. Настроив рамку нужным образом, примените преобразование — для этого тре-
буется нажать клавишу Enter. Теперь лишние части холста нетрудно удалить
с помощью инструмента Crop (Обрезать), как описано в предыдущем разделе.

Рис. 14.5. С помощью команды Perspective (Перспектива)
можно изменить перспективу в изображении

Деформация
Команда Distort (Деформация) позволяет исправить возникшее по какой-либо при-
чине искажение прямых углов. Может быть, при съемке фотоаппарат был направ-
лен под углом к зданию или прямоугольной коробке, и на снимке одна сторона
объекта наклонилась чуть больше, чем другая. Тогда изображение будет выгля-
деть немного странно. Также эта команда находит применение, когда требуется
несимметричное исправление перспективы снимка. Пустые области, появившие-
ся в результате искажения изображения, можно обрезать с помощью инструмента
Crop (Обрезать), заполнить каким-нибудь цветом или скопированным фрагментом
изображения, например небом. Эти процедуры мы обсудим дальше.

Команда Distort (Деформация) входит в группу команд, изменяющих размер изоб-
ражения, поэтому она также находится в подменю Transform (Трансформация) и при-
меняется к выделенной области или слою, отличному от слоя заднего плана или
фонового. Сделайте следующее.

1. Откройте изображение и преобразуйте фоновый слой в обычный, выполнив
команду Layer > New > Layer From Background (Слой > Новый > Слой из фона).

2. Выберите команду Edit > Transform > Distort (Редактирование > Трансформация > Де-
формация).

3. Вы увидите вокруг изображения уже знакомую рамку с маркерами. Щелкните
мышью на маркере из верхнего правого угла и, не отпуская кнопку мыши, пере-
тащите его ближе к центру изображения.

4. Затем также перетащите по направлению к центру изображения левый ниж-
ний угловой маркер.
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5. Программа перерисует изображение, и у вас должно получиться нечто, похо-
жее на рис. 14.6.
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Рис. 14.6. Действие команды Distort (Деформация)

Яркость и контраст
Очень часто фотографии получаются вовсе не такими, как предполагалось: слиш-
ком темными или «плоскими» (то есть чересчур контрастными). Следующие две
команды помогут исправить подобные недостатки и оживить снимки.

Автоматическая настройка яркости/контраста
и цветовой гаммы
Этот способ позволяет легко и быстро скорректировать яркость, контраст и цвето-
вую гамму изображения, но результаты его действия не всегда получаются удов-
летворительными. Выполните следующее:
1. Откройте неконтрастное изображение, это может быть фотография, сделанная

в дождливый осенний день.
2. Выполните команду Image > Adjustments > Auto Contrast (Изображение * Настройки >

Автоконтраст) или нажмите клавиши Alt+Ctrl+Shift+L. Для корректировки цвето-
вой гаммы выберите команду Image > Adjustments > Auto Color (Изображение >
Настройки > Автоцвет).

3. Программа обработает снимок, улучшая его на основе исходных цветов и зна-
чений яркости. Если полученное изображение вас не устраивает, отмените по-
следнюю операцию, нажав Ctrl+Z, и попробуйте откорректировать контраст вруч-
ную. Также можно попробовать выполнить автоматическую настройку уровней
(команда Auto Levels (Автоуровни) того же меню).

Настройка яркости/контраста вручную
Команда Brightness/Contrast (Яркость/Контраст) применяется в тех случаях, когда
требуется осветлить или затемнить снимок. Откройте темное изображение
в Photoshop и выполните следующее.
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1. Выберите команду Image > Adjustments > Brightness/Contrast (Изображение > На-
стройки > Яркость/Контраст). На экране появится одноименное диалоговое окно,
показанное на рис. 14.7.

Рис. 14.7. Чаще всего изображение можно улучшить, используя только настройку яркости
и контраста

2. Если флажок Preview (Предварительный просмотр) снят, установите его. Это по-
зволит увидеть результаты изменения яркости и контрастности изображения
до применения команды.

3. Потяните мышью ползунок настройки яркости вправо до тех пор, пока изобра-
жение не станет достаточно светлым. В поле Brightness (Яркость) появится не-
которое положительное значение, например +30. Если заранее известна вели-
чина, на которую требуется изменить яркость снимка, можно сразу ввести ее
в это поле.

4. Теперь потяните вправо ползунок настройки контраста до тех пор, пока изоб-
ражение не станет достаточно «ярким». Также можно сразу ввести известное
значение в поле Contrast (Контраст).

5. Для применения изменений яркости и контраста нужно нажать кнопку О К,
в противном случае — кнопку Cancel (Отмена).

Следует запомнить
Q Одним из основных преимуществ цифровой фотографии является возможность

редактирования различных параметров снимка. Программа Photoshop позво-
лит вам изменить размер изображения и скорректировать искажения в перс-
пективе.

Q Можно создать свободные области вокруг снимка или обрезать лишние фраг-
менты.

а Вам больше не придется расстраиваться из-за слишком темных кадров или
фотографий с неправильной цветовой гаммой, полученных из фотолабораторий.
Контраст и яркость можно настроить самостоятельно.

Q И последнее: помните, что всегда нужно работать с копией изображения.
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Прекрасный мир цвета

Q Инструменты, предназначенные для настройки цвета

а Цветовые модели
О Глубина цвета

О Увеличение резкости, добавление размытия и шума

Для коррекции фотографии достаточно часто приходится настраивать цветовую
гамму — это такая же стандартная операция, как исправление яркости, контраста
или перспективы изображения. У вас когда-нибудь получались слишком синие
или желтоватые снимки? Правильная настройка цветов позволяет устранить по-
добные дефекты, оживить фотографии и сделать их более реалистичными. Стоит
потратить время и тщательно отредактировать изображения — вид снимков улуч-
шится, а вы приобретете необходимый опыт и достаточно скоро сможете быстро
исправлять недостатки цветовой гаммы.

Цвет
Инструменты графического редактора, предназначенные для настройки цветов,
помогут придать фотографии естественный вид или, наоборот, сделать цвета фан-
тастическими. Можно внести минимальные исправления или полностью изменить
изображение. Но не следует забывать о том, что цвета на экране монитора зависят
от его настройки. Если они не соответствуют печатаемым принтером, то отпечаток
яркого и полноцветного изображения может получиться тусклым и серым. Также
нужно учитывать и то, что методы отображения цветов у монитора и принтера
различны, и на экране монитора, как правило, присутствуют цвета из большего
диапазона оттенков. Профессионалы, работающие с цифровой графикой, обычно
пользуются достаточно дорогим специальным оборудованием для настройки со-
ответствия своих еще более дорогих мониторов и принтеров. Этот процесс назы-
вается калибровкой.
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Но вы тоже можете откалибровать свой монитор. Процессу калибровки посвяще-
на глава 22, кроме того, сведения о калибровке можно получить в справочной сис-
теме программы Photoshop (откройте раздел Producing Consistent Color (Photoshop) >
Creating an ICC monitor profile (Согласование цветов (Photoshop) > Создание ICC-профиля
монитора) и прочитайте все его подразделы).

При настройке цветовой гаммы прислушивайтесь к своим ощущениям, доверяйте
интуиции и экспериментируйте! Попробуйте напечатать тестовое изображение на
дешевой бумаге, и только получив удовлетворительные цвета, переходите на фото-
бумагу.

Цветовой баланс
Иногда получаются фотографии с искаженной цветовой гаммой. Это может про-
изойти, если, например, свет, отраженный от какого-либо цветного предмета, по-
пал на объект съемки. Так, ярко освещенная желтая стена, несомненно, изменит
оттенки на фотографии. А если вспомнить о том, что цвет зависит от температуры
(см. главу 10), становится понятно, что внешние, в частности погодные, условия
также влияют на цвета снимка. Все это, к сожалению, не зависит от вас, но вы мо-
жете скорректировать цветовой баланс изображения в программе Photoshop.
1. Откройте изображение, имеющее какой-нибудь оттенок (например, слишком

синее).

2. Вызовите команду Image > Adjustments > Color Balance (Изображение > Настрой-
ки > Цветовой баланс). Появится диалоговое окно, продемонстрированное
на рис. 15.1.
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Рис. 15.1. Диалоговое окно Color Balance (Цветовой баланс) поможет настроить цвета
изображения

3. Убедитесь в том, что флажок Preview (Предварительный просмотр) установлен.
4. Перед вами три регулятора, каждый из которых отвечает за определенный цвет:

красный, зеленый и синий. Попробуйте настроить цветовую гамму изображе-
ния, смещая ползунки вправо и влево. Так, если снимок получился слишком
синим, сдвиньте влево ползунок синего цвета и вправо — красного (при этом
уменьшится количество голубого). Возможно, также придется подвинуть и «зе-
леный» движок.

5. Добившись желаемого результата, примените выполненные изменения нажа-
тием кнопки ОК.

Вспомните составленный из двух треугольников шестиугольник, о котором расска-
зывалось в главе 2. В нем напротив первичных цветов (красный, зеленый и синий)
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расположены вторичные (голубой, пурпурный и желтый). Изменение одного
из цветов влияет на противоположный ему — именно поэтому на них можно воз-
действовать, перемещая один ползунок. Так, добавление в изображение синего
цвета означает уменьшение желтого, а снижение пурпурного приводит к увеличе-
нию зеленого.

Этот инструмент можно применять к целому изображению, слою или выделенной
области. Он очень удобен, но требует некоторых навыков.

Настройка цвета с помощью уровней
Если вам понадобилось не только скорректировать оттенки изображения, но и уве-
личить контрастность снимка, возможно, более полезной окажется команда Image >
Adjustments > Levels (Изображение > Настройки > Уровни). Она поможет и в случае,
когда области изображения, которые должны быть белыми или черными, приоб-
рели сероватый или какой-либо другой оттенок.

1. Откройте изображение, в котором нужно скорректировать цвета.

2. Выполните команду Image > Adjustments > Levels (Изображение > Настройки > Уров-
ни). Появится одноименное диалоговое окно, показанное на рис. 15.2.

Рис. 15.2. Цвета также можно корректировать с помощью уровней

3. Убедитесь в том, что флажок Preview (Предварительный просмотр) установлен.

4. В правой части окна, под кнопками, расположены три пипетки. Первая отвеча-
ет за установку черного цвета, вторая серого, а третья — белого. Щелкните на
первой пипетке и щелкните на той части изображения, которая должна быть
абсолютно черной. Затем щелкните на третьей пипетке и на той точке, которая
должна быть белой. Теперь таким же образом с помощью второй пипетки уста-
новите серый цвет — это самая сложная операция, которая требует определен-
ных навыков.

5. Цвета изображения также можно настраивать с помощью регуляторов, распо-
ложенных под гистограммой. Попробуйте поэкспериментировать с ними. Удоб-
но установить белую и черную точки, а затем настроить гамму, перемещая цен-
тральный движок.

6. Добившись желаемых изменений, нажмите кнопку ОК.
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Цветовой тон, насыщенность и осветление
Цветовой тон (иногда его называют оттенком, а иногда — просто цветом) обозна-
чает расположение цвета на цветовом шестиугольнике, о котором рассказывалось
в главе 2. Под насыщенностью понимается количество цвета, то есть его интенсив-
ность. Если представить шестиугольник в виде круга — это делается в некоторых
цветовых моделях, — то цветовой тон указывает на положение цвета на окружно-
сти, а насыщенность показывает, насколько окружность приближена к центру.
Осветление обозначает количество добавленной в цвет белой краски.

Photoshop позволяет управлять тоном и насыщенностью цветов изображения,
а также их осветлением.

1. Откройте изображение в окне программы и выберите команду Image > Adjust-
ments > Hue/Saturation (Изображение > Настройки > Цветовой тон/Насыщенность),
чтобы вызвать одноименное диалоговое окно, которое показано на рис. 15.3.

Рис. 15.3. Это диалоговое окно предназначено для настройки тона и насыщенности цвета

2. Убедитесь в том, что в диалоговом окне установлен флажок Preview (Предвари-
тельный просмотр).

3. По умолчанию в раскрывающемся списке Edit (Редактировать) выбран пункт
Master (Все цвета). Не меняйте эту установку и попробуйте сместить движок Hue
(Цветовой тон) вправо и влево. Замечаете, как изменяются цвета изображения?
В нижней части диалогового окна расположены две цветные полосы; верхняя
соответствует исходным цветам, нижняя — получающимся в результате пере-
мещения движка Hue (Цветовой тон). Их сравнение позволяет понять, какие цвета
заменят исходные цвета изображения.

Возможно, вам требуется откорректировать цветовой тон только в некоторой
области снимка. Для этого нужно предварительно выделить фрагмент изобра-
жения. Вы сможете сделать это, прочитав главу 16.

4. Теперь попробуйте подвигать ползунок Saturation (Насыщенность). Если фото-
графия снималась при рассеянном (мягком) освещении, увеличение насыщен-
ности сделает цвета более яркими и оживит изображение.

5. Смещение движка Lightness (Осветление) вправо равносильно добавлению в изобра-
жение белой краски, влево — черной. И то и другое снижает контрастность фо-
тографии. Видимо, именно по этой причине я пользовался данным параметром
всего раз или два за всю свою карьеру фотографа. Тем не менее попробуйте
подействовать на снимок, смещая этот движок, и помните о его существовании.
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6. Если вам понравились результаты изменений, выполненных с помощью этого
диалогового окна, нажмите кнопку О К, в противном случае щелкните на кнопке
Cancel (Отмена). Если же нужно вернуть все регуляторы в исходное состояние
и еще раз попытаться откорректировать цветовую гамму изображения, не закры-
вая диалоговое окно, нажмите клавишу Alt и щелкните на кнопке Reset (Сброс),
которая появится на месте кнопки Cancel (Отмена).

Рис. 15.4. Всякий будет выглядеть глупо, если его изображение сделать слишком ярким

Корректирующие слои
Корректировка цветовой гаммы с помощью трех описанных выше методов влияет
на пикселы изображения. Конечно, можно работать с копией снимка и в случае
неудачи вернуться к оригиналу, но тогда будут полностью потеряны все выпол-
ненные изменения. Если же отменить настройку цвета с помощью палитры History
(История), то будут утрачены только те изменения, которые были внесены после
воздействия на цвет. Это, естественно, намного лучше, но все равно не идеально.
В данном случае программа Photoshop позволяет целиком избежать каких-либо
потерь путем создания корректирующего слоя и выполнения на нем всех изменений
цветовой гаммы. Тогда, если впоследствии потребуется отменить настройку цветов,
достаточно будет удалить корректирующий слой — при этом сохранятся результаты
всех остальных операций. Корректирующим называется специальный слой, воз-
действующий на слой, расположенный под ним.

Попробуем создать слой, корректирующий цветовой тон и насыщенность изобра-
жения.

1. Откройте изображение и убедитесь в том, что палитра Layers (Слои) находится
на экране. Если она отсутствует, выберите команду Window > Layers (Окно > Слои).

2. Выполните команду Layer > New Adjustment Layer > Hue/Saturation (Слой > Новый
корректирующий слой > Цветовой тон/Насыщенность) или в палитре Layers (Слои)
нажмите кнопку Create new fill or adjustment layer (Создать новый заполняющий или
корректирующий слой) (круг с черной верхней половиной и белой нижней)
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и укажите тип слоя Hue/Saturation (Цветовой тон/Насыщенность), как продемон-
стрировано на рис. 15.5.

Рис. 15.5. Воспользуйтесь третьей справа кнопкой внизу палитры и выберите
в открывшемся меню вариант Hue/Saturation (Цветовой тон/Насыщенность)

3. На экране появится уже знакомое диалоговое окно Hue/Saturation (Цветовой тон/
Насыщенность), в котором можно настроить цвета изображения и их насыщен-
ность. Но теперь в результате применения сделанных изменений будет создан
и вставлен в палитру Layers (Слои) специальный корректирующий слой.

4. Справа от названия корректирующего слоя в палитре Layers (Слои) расположе-
ны две миниатюры. Если впоследствии вам понадобится отредактировать на-
стройку цветов изображения и их насыщенности, щелкните на первой мини-
атюре, и откроется уже знакомое диалоговое окно Hue/Saturation (Цветовой тон/
Насыщенность) с текущими значениями параметров. Если же потребуется уда-
лить все изменения, сделанные в окне Hue/Saturation (Цветовой тон/Насыщен-
ность), перетащите название корректирующего слоя на самую левую кнопку
внизу палитры Layers (Слои).

Варианты
Средство Variations (Варианты) является очень удобным инструментом. С его по-
мощью можно быстро настроить цветовой баланс или тон изображения и одновре-
менно откорректировать насыщенность. То есть вам не придется вызывать по оче-
реди два диалоговых окна — достаточно будет открыть только диалоговое окно
Variations (Варианты). Выполните следующее.

1. Откройте в программе Photoshop изображение, требующее коррекции. Выберите
команду Image > Adjustments > Variations (Изображение > Настройки > Варианты).
На экране появится одноименное диалоговое окно, содержащее несколько
уменьшенных копий изображения, каждая из которых снабжена поясняющей
надписью. Оно продемонстрировано на рис. 15.6. Справа в верхней части окна
находится группа переключателей, при помощи которых можно выбрать из-
меняемый параметр и фрагменты изображения (по яркости): Shadows (Тени),
Midtones (Средние тона), Highlights (Светлые области) и Saturation (Насыщенность).
Слева расположены два изображения с подписями Original (Оригинал) и Current
Pick (Текущее); ко второму применяются все вносимые изменения.

2. Щелкните на наиболее подходящем варианте изображения. Он займет цен-
тральное место, имеющее подпись Current Pick (Текущее), а программа предложит
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новые варианты, основанные уже на текущем изображении, а не на исходном.
Степень отличия вариантов от оригинала можно регулировать — для этого пред-
назначается шкала, расположенная в верхней части диалогового окна. С ее по-
мощью качество обработки можно изменять между конечными величинами Fine
(Превосходное) и Coarse (Грубое).
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Рис. 15.6. Средство Variations (Варианты) может оказаться полезным,
когда требуется быстро откорректировать снимок

3. Продолжайте применять различные варианты, переключая настройки и изме-
няя качество до тех пор, пока не добьетесь желаемого результата. При необхо-
димости можно вернуться к исходному изображению и начать работу сначала,
не выходя из диалогового окна. Для этого нажмите клавишу Alt и нажмите кноп-
ку Reset (Сброс), которая появится на месте кнопки Cancel (Отмена). Если же
нужно отменить только последний вариант, не меняя параметры, щелкните на
противоположном варианте.

4. Получив требуемое изображение, щелкните на кнопке ОК.

Учтите, что не стоит слишком увеличивать насыщенность цветов фотографии. Во-
первых, при этом часто теряются детали; во-вторых, изображение может стать не-
естественным; и в-третьих, яркий снимок, превосходно выглядящий на экране,
может получиться относительно плохим при печати.

Негатив
Чтобы получить негативное изображение, выберите команду Image > Adjustments >
Invert (Изображение > Настройки > Инвертировать). Возможно, это средство покажется
ненужным для редактирования домашних фотографий, но я часто пользуюсь им
при выполнении оплачиваемой работы. Оно позволяет создавать необычные изобра-
жения и оживлять блеклый задний план.
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Цветовые модели
Существует множество способов описания цвета, каждый из них представляет
определенную цветовую модель. Наиболее стандартной является модель RGB (red,
green, blue — красный, зеленый, синий). Кроме того, программа Photoshop позво-
ляет использовать модели CMYK, LAB и HSB. В каждой из них цвет раскладыва-
ется на различные составляющие, что влияет на отображение цвета на экране мо-
нитора и при печати.

Модель RGB
Как мы уже говорили, модель RGB представляет собой наиболее стандартный ме-
тод описания цвета или цветового пространства. Она построена на излучаемых
цветах, которые воспринимает человеческий глаз. В отсутствие света, например
ночью, никто из нас не сможет различить цвет, и только при увеличении освеще-
ния цвет становится видимым.

Цветов огромное количество, но из них выделено только три основных, или пер-
вичных: красный, зеленый и синий (Red, Green, Blue). Смешивание основных цве-
тов в различных пропорциях дает возможность получить все остальные цвета.
Например, если соединить красный и синий и не добавлять зеленый, результиру-
ющим будет пурпурный цвет. Первичные цвета также называют аддитивными,
поскольку в результате смешивания всех трех цветов максимальной яркости по-
лучается белый свет.

Помните, мы уже говорили об этих цветах, рассматривая процесс получения изоб-
ражения на цветной фотопленке или матрице цифрового фотоаппарата? И плен-
ка, и матрица подобно человеческому глазу воспринимают свет. Эта же цветовая
модель используется в мониторе компьютера — изображение на его экране стро-
ится при помощи излучения люминофора.

Цвет может иметь разную яркость. В итоге получается трехмерное цветовое
пространство. Обычно модель RGB изображают в виде куба, в одном из углов
которого находится точка абсолютно черного цвета — начало координат. По трем
ребрам, выходящим из этого угла, — трем координатным осям — откладывает-
ся «количество», или яркость, красного, зеленого и синего цвета от минималь-
ной до максимальной. Соответственно, на других концах этих ребер цвета имеют
самую большую яркость. В углу куба, противолежащем по сумме диагона-
лей от начала координат, находится абсолютно белый цвет, а на линии, соеди-
няющей черный и белый углы, располагаются оттенки серого цвета. И белый,
и серый цвета являются результатом смешивания равного количества трех основ-
ных цветов.

Больше мы не будем вдаваться в техническое объяснение теории цвета. Из пред-
ставленного ранее важно то, что размерность цветового пространства равна трем,
то есть для определения цвета необходимо указать как минимум три составляю-
щих. В модели RGB это количества красного, зеленого и синего. В каждой цвето-
вой модели для описания цветового пространства используется своя фигура — это
может быть и куб, и пирамида, и сфера.
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Модель CMYK
Возьмите в руки лист белой бумаги хорошего качества — сейчас вы имеете дело
со светом, отраженным от листа бумаги, и в данном случае он отражается пол-
ностью. Добавление света или цвета не позволит сделать бумагу еще белее. Зато
вы можете покрасить бумагу и таким образом получить цвет. Накладываясь
на бумагу и друг на друга, чернила поглощают часть проходящего через них и от-
ражающегося от бумаги белого света, поэтому процесс покраски называется вычи-
танием цвета. Цвета, получаемые после вычитания основных аддитивных, назы-
ваются субтрактивными, и на их основе строится модель CMYK. Эта модель
используется при цветной печати. Большинство дешевых принтеров смешивают
три основных субтрактивных цвета: голубой, пурпурный и желтый, а также добав-
ленный к ним черный цвет (Cyan, Magenta, Yellow и ЫасК), или печатают четыре
слоя изображения.

Вспомним еще раз цветовой шестиугольник, о котором рассказывалось в главе 2.
В нем голубой, пурпурный и желтый цвета располагаются напротив красного, зе-
леного и синего соответственно. Взаимодействие этих цветов также хорошо было
заметно при настройке цветового баланса изображения в программе Photoshop.
Если провести аналогию со смешиванием аддитивных цветов, теоретически при
смешивании всех субтрактивных цветов максимальной яркости должен получаться
черный цвет. Но с помощью этой модели обычно описывают краски, которые далеко
не так идеальны, как световой луч. Краски не могут перекрыть весь цветовой диапа-
зон света, и вместо черного получается темный «грязный» цвет. Для компенсации
этого недостатка в цветовую модель CMY был введен черный цвет, а в название
добавлена буква К (ЫасК).

При печати RGB-изображение раскладывается на CMYK-составляющие. Эту опе-
рацию называют цветоделением, и ее способен выполнять графический редактор
или принтер, в зависимости от настроек.

ПРИМЕЧАНИЕ
Цвет может быть представлен в природе, на экране монитора, на бумаге. Во всех случаях
возможный диапазон цветов, или цветовой охват, будет разным. Самым широким, разумеется,
он будет в естественной среде. Часть из того, что существует в природе, может передать
монитор, а часть из того, что передает монитор, можно напечатать. В графических редакто-
рах режим CMYK предназначается для подготовки изображения к печати в типографии,
и в нем за качество цвета отвечают реальные красители, поэтому цветовой охват в режиме
CMYK несколько меньше, чем в режиме RGB. Процесс печати изображений более подробно
будет рассматриваться в части 5.

Модель LAB
Модель LAB была создана для того, чтобы стать аппаратно-независимой моделью
и определять цвета без оглядки на особенности устройства (монитора, принтера
и т. д.). В этой модели цвет определяется осветлением (Lightness) и двумя цвето-
выми компонентами: А — изменяется от красного до зеленого, В — от желтого до
синего. Более подробно мы будем рассматривать эту модель в главе 22, в которой
описывается процесс калибровки монитора и принтера.
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Модель HSB
В модели HSB для описания цвета используется цветовой тон — Hue (этот пара-
метр описывает цвет или длину волны света), насыщенность — Saturation (коли-
чество цвета) и яркость — Brightness (количество света). При нулевой насыщен-
ности получаются оттенки серого, а при нулевой яркости — черный цвет. С этой
моделью мы сталкивались в программе Photoshop, когда определяли цвета в диа-
логовом окне Hue/Saturation (Цветовой тон/Насыщенность) и встретимся при выборе
цвета в диалоговом окне Color Picker (Палитра цветов), но представить изображение
в модели HSB нельзя.

Глубина цвета
Компьютер представляет всю информацию в бинарном виде, или в битах. Один
бит передает только два состояния: ноль-единица или включен-выключен. Цвет
также можно записать в бинарном виде. Например, если в изображении присут-
ствует только черный и белый цвет, для каждого пиксела достаточно будет одного
бита: черный цвет соответствует состоянию «выключен», белый — «включен».
В цифровом описании цвета под глубиной (bit depth) понимается количество би-
тов, отведенных для определения цвета одного пиксела. Черно-белое изображе-
ние имеет однобитовую глубину цвета.

Если под цвет отводится два бита, с их помощью можно закодировать четыре цве-
та. При этом глубина цвета будет равна двум. И так далее, по степени с основани-
ем 2. Таким образом, чем больше глубина цвета устройства или изображения, тем
больше цветов в состоянии передать (воспроизвести) устройство (например, мо-
нитор) или содержать изображение. В табл. 15.1 показано соответствие количе-
ства битов, кодирующих цвет, и количества цветов, которое можно закодировать
при данной глубине цвета.

Цифровой фотоаппарат или сканер, создающие изображения в модели RGB, полу-
чают данные, которые располагаются на трех цветовых слоях или передаются тре-
мя каналами (по одному каналу на каждый первичный цвет). Если фотоаппарат
может записать 8 битов (1 байт) информации для каждого канала, то под хранение
цвета каждого пиксела изображения он предоставляет 24 бита памяти. Из табл. 15.1
следует, что такой фотоаппарат способен передать более 16 миллионов оттенков,
что достаточно много.

Таблица 15.1. Глубина цвета и доступное количество цветов

Глубина
цвета

1

2

3

4

5

6

Количество
цветов

2

4

8

16

32

64

Глубина
цветов

7

8

16

24

32

Количество
цветов

128

256

32768

16 777 216

миллиарды и миллиарды цветов!
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Существуют сканеры и фотоаппараты, которые кодируют цвет, используя 12, 14
или даже 16 битов для передачи каждого канала. Это прекрасно, но возникает одна
маленькая проблема: печатающее устройство может воспроизвести цвет, каналы
которого передаются 8 битами. Что же делать с дополнительной информацией
и зачем она вообще нужна?

Увеличение цветовых данных позволяет сохранить большее количество деталей
и обеспечить более плавные переходы цветов. Попробуйте открыть в Photoshop
изображение, передаваемое 16 битами на канал, скопируйте его, преобразуйте копию
в 8-битовый режим (команда Image t Mode > 8 Bits/Channel (Изображение > Режим >
8 бит/канал)) и сравните изображения. 16-битовое будет содержать больше дета-
лей и цветов. Это можно использовать даже при редактировании 8-битовых изоб-
ражений. Если преобразовать снимок к 16-битовой глубине цвета, потом настро-
ить цвет, яркость и контраст, а потом преобразовать назад, в 8-битовый режим, то
получится изображение лучшего качества.

Режим битовой карты
В режиме битовой карты (Bitmap, Line Art Graphic) глубина цвета равна единице,
и каждый пиксел может быть только черного или белого цвета. Он применяется
только для графики, нарисованной одним цветом, например черной тушью, с чет-
кими границами, и, как правило, используется очень редко. Естественно, что даже
полутоновой режим, в котором отображаются только оттенки серого цвета, обес-
печивает несравнимо большую плавность переходов от белого к черному. Преиму-
ществом рассматриваемого режима является небольшой размер файлов, что дает
возможность увеличивать разрешение.

Полутоновой режим
В этом режиме каждый пиксел кодируется не одним битом, а 8 битами, то есть
одним 8-битовым каналом. В результате в нем можно получить 256 оттенков серо-
го, которые изменяются от черного цвета до белого, или так называемую «серую
шкалу яркости» (grayscale). Исходя из такого количества цветов режим получил
свое наименование: режим градаций серого (grayscale), или полутоновой. В нем
каждый пиксел характеризуется процентным содержанием черной краски от 0%
(белый цвет) до 100% (черный цвет). Вы, несомненно, сталкивались с ним в жиз-
ни — так отображаются любые черно-белые изображения: иллюстрации в книгах
и газетах, черно-белые фотографии и т. д.

Индексированные цвета
В режиме индексированных цветов (indexed color) изображение передается опреде-
ленным количеством цветов, максимально — 256, которые определяются в соот-
ветствии с таблицей или палитрой цветов. Палитры бывают разные — могут исполь-
зоваться, например, системные палитры Windows или Macintosh, равномерная
(uniform) или адаптированная палитры. Если при переводе RGB-изображения в режим
индексированных цветов какой-либо цвет отсутствует в палитре, с помощью кото-
рой осуществляется преобразование, программа подбирает из палитры ближайший
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к нему оттенок. Иногда промежуточные цвета создаются за счет соседства двух
и более индексированных цветов. При достаточном разрешении человеческий глаз
будет воспринимать несколько пикселов как одно целое, имеющее промежуточ-
ную окраску. Смешивание нескольких цветов с целью получения другого, проме-
жуточного цвета называется сглаживанием.

Как правило, режим индексированных цветов не используется при обработке изоб-
ражения, одной из причин этого является невозможность применения фильтров
и слоев. Но он очень удобен для создания элементов, имеющих простую окраску,
таких как логотипы или кнопки для веб-страниц. При сохранении полноцветного
изображения в форматах GIF или PNG сокращение количества используемых цве-
тов происходит во время сохранения.

Понятно, что уменьшение глубины цвета приводит к уменьшению файла изобра-
жения. Это широко применяется в веб-графике, где размер файлов очень заметно
влияет на скорость загрузки страниц на компьютеры пользователей. Если вы хо-
тите получить более подробную информацию по различным цветовым режимам,
стоит обратиться к специализированным книгам по программе Photoshop, справ-
ке Photoshop или Интернету.

Преобразование изображений в различные режимы в программе Photoshop вы-
полняется командами меню Image > Mode (Изображение > Режим).

Увеличение резкости изображения
Как правило, графические редакторы позволяют улучшать резкость изображений.
Это помогает исправить дефекты, полученные при неправильной фокусировке
и в результате несовершенства объектива фотоаппарата или светочувствительной
матрицы.

Сравните правильно сфокусированный снимок с нерезким. Резкое изображение
имеет большую контрастность. Это свойство используется инструментами, увели-
чивающими резкость, — они создают эффект повышения контраста, усиливая гра-
ницы между темными и светлыми областями изображения. С темной стороны гра-
ницы пикселы немного затемняются, а со светлой стороны — осветляются, что
позволяет визуально выделить края объектов на изображении.

Улучшение резкости всегда приводит к увеличению размера файла изображения,
поэтому если для вас важен маленький размер файла, например, если снимок под-
готавливается для размещения в Интернете, имеет смысл подумать, действитель-
но ли стоит делать его еще более резким.

Также бывают ситуации, когда требуется увеличить резкость только части изобра-
жения. Например, на фотографии изображен пейзаж, одной из составляющих ко-
торого является небо в облаках. Делать небо резким совсем необязательно, более
того, после применения фильтров оно может даже ухудшиться, поскольку при
увеличении резкости выделяются не только объекты съемки и их детали, но также
все мелкие дефекты. В таком случае нужно предварительно выделить те области,
к которым будет применяться фильтр. О том, как это сделать, вы узнаете, прочи-
тав главу 16.
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ПРИМЕЧАНИЕ
Я обычно применяю фильтр, увеличивающий резкость, в последнюю очередь, то есть перед
окончательным сохранением результатов работы.

Рассмотрим инструменты программы Photoshop, предназначенные для усиления
резкости изображений.

Фильтр Sharpen (Резкость)
Фильтр Sharpen (Резкость) вызывается командой Filter > Sharpen > Sharpen (Фильтр *
Резкость > Резкость) и применяется к изображению без дополнительных запросов
к пользователю, то есть на экране не появляется диалоговое окно. Отменить дей-
ствие фильтра можно с помощью команды Undo (Отменить) меню Edit (Редактирова-
ние) или палитры History (История). Применив фильтр Sharpen (Резкость) один раз,
можно воздействовать им на изображение еще раз, но теперь для этого достаточно
будет нажать сочетание клавиш Ctrl+F или выбрать первую команду меню Filter
(Фильтр).

Фильтр Sharpen More (Усиленная резкость)
Этот фильтр, вызываемый командой Filter > Sharpen > Sharpen More (Фильтр > Рез-
кость > Усиленная резкость), также усиливает контраст на границах темных и свет-
лых областей, но его эффект более заметен. В зависимости от изображения двой-
ное применение фильтра Sharpen (Резкость) способно привести к тем же результатам,
что и единственное применение фильтра Sharpen More (Усиленная резкость). Этот
фильтр также не имеет параметров и не дает возможности регулировать градацию
резкости. Попробуйте воздействовать им на изображение и оцените результат.

Фильтр Sharpen Edges (Контурная резкость)
Фильтр Sharpen Edges (Контурная резкость) поступает немного по-другому. Он нахо-
дит в изображении контрастные границы объектов и выделяет их точно так же,
как фильтр Sharpen (Резкость). Остальные области изображения сохраняются без
изменения. Вызывается этот фильтр командой Filter > Sharpen > Sharpen Edges (Фильтр >
Резкость > Контурная резкость). По сравнению с предыдущими двумя фильтрами он
действует более избирательно, но так же, как и они, не позволяет контролировать
уровень резкости.

Фильтр Unsharp Mask (Нерезкая маска)
Несмотря на свое, на первый взгляд, смешное название фильтр U n s h a r p Mask (Не-
резкая маска) является очень полезным инструментом и предназначается для уве-
личения резкости. В нем объединено действие всех трех описанных выше филь-
тров, и это единственный фильтр, допускающий управление степенью увеличения
резкости. Когда требуется сделать кадр более четким, как правило, я пользуюсь
именно этим фильтром.

Рассмотрим применение фильтра Unsharp Mask (Нерезкая маска) к нечеткому изоб-
ражению.
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Выполните команду Filter t Sharpen > U n s h a r p Mask (Фильтр > Резкость > Нерезкая
маска). На .экране появится диалоговое окно, представленное на рис. 15.7.

'2.'

3.

Рис. 15.7. Фильтр Unsharp Mask (Нерезкая маска) позволяет регулировать уровень резкости

1/ Если установлен флажок Preview (Предварительный просмотр), изменения будут
немедленно отображаться в окне документа.

Поле A.mpiurt (Количество) определяет силу влияния фильтра. Чем выше значе-
ние в этом поле, тем больше будет контрастность на границах темных и свет-
лых областей.

Поле Radius (Радиус) задает отступ в пикселах от границы, в пределах которого
применяется фильтр. Это значение влияет на ширину получающихся краев
объектов. Установка радиуса меньше 1 пиксела снижает эффект, определяемый

'''полем Amburtt (Количество).

4. Поле threshold (ftopor) задаёт Пороговое значение яркости, на которое должны
отличаться пикселы в границах, установленных полей Radius (Радиус), чтобы
к ним применялся фильтр. Если в это поле ввести ноль (0), то есть указать, что
яркость не имеет значения, фильтр будет применен ко всему изображению. Если
указать значение 5, то фильтр будет воздействовать на пикселы, яркость кото-

-,,;|,з вых ат/щчаетс^ на 5 уровней;

••(5.1; В 0кне предварительного просмотра диалогового окна демонстрируется фраг-
мент, изображения под действием фильтра. Если навести на него указатель мыши

, ;и нажать кнопку мыши, будет показан фрагмент исходного изображения. Здесь
можно изменять масштаб, щелкая на кнопках со значками «плюс» и «минус» —
это позволяет лучше рассмотреть результаты операции.

Добившись прйШЙВмого-Зффекга, нажмите кнопку ОК. Если же вы не удовлетво-
рены итогом, то или нажмите кнопку Cancel (Отмена), или восстановите исходные
установки фильтрд, нажав клавишу Alt и щелкнув на кнопке Reset (Сброс), которая
рбярляется на ме'с-fe'кнопки Cancel (Отмена).

! ; / > О *S ~v. С * 7 Я • ' ; ' 'Л\Н ! '.• , < ' -'' > ' '• " : , : ; _

В табл. 15,2, я предлагаю, вашему вниманию начальные установки для фильтра
,fy,nshar,p_ Mask(Де.ре,зкая ^аска). Помните, что это всего лишь начальные значения
для трех параметров. Для разных изображений характерны различные диапазоны
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яркости и контрастности, и, соответственно, для разумного увеличения резкости
требуются различные установки параметров фильтра. Обычно для больших изобра-
жений нужно повышать значения параметров, особенно величину в поле Amount
(Количество). Поэтому я, как всегда, советую вам поэкспериментировать.

Таблица 15.2. Начальные значения для параметров фильтра Unsharp Mask
Amount (Количество)
[в процентах]

50
75
100
125
150
175
200
200+

Radius (Радиус)
[в пикселах]

0,7
от 0,8 до 1
от 1 до 1,1
от 1,1 до 1,2
1,2
1,3
1,5
Не имеет значения, в любом
случае получится
неестественное изображение

Threshold (Порог)
[в уровнях]

0
0
0
0
0
0
1

Достаточно трудно заранее определить, какой фильтр лучше обработает изобра-
жение. Фильтр Unsharp Mask (Нерезкая маска), как правило, действует очень хоро-
шо, но требует некоторых временных затрат на подбор параметров. Нередко мож-
но добиться превосходных результатов с помощью самого простого фильтра Sharpen
(Резкость), поэтому имеет смысл попробовать применить его, прежде чем обращать-
ся к более сложному фильтру Unsharp Mask (Нерезкая маска).

Размытие
Размывающие фильтры часто применяются к отдельным фрагментам изображе-
ния. Их нужно предварительно выделить, и вы научитесь это делать, прочитав гла-
ву 16. Размывающие фильтры помогут избавиться от ступенчатости на границах
объектов изображения или снизить шум.

Фильтр Blur (Размытие)
Чтобы применить фильтр Blur (Размытие), выберите команду Filter > Blur > Blur
(Фильтр > Размытие > Размытие). Так же, как и фильтр Sharpen (Резкость), этот фильтр
не имеет параметров, позволяющих управлять степенью размытия изображения.
Он уменьшает шум и смягчает цветовые переходы, усредняя значения соседних
пикселов. После его применения изображение становится немного нерезким.

Фильтр Blur More (Усиленное размытие)
Как понятно из названия фильтра Blur More (Усиленное размытие), его действие экви-
валентно многократному применению фильтра Blur (Размытие), но принцип обра-
ботки изображения у них одинаковый. Вызывается он командой Filter > Blur > Blur
More (Фильтр > Размытие > Усиленное размытие). Если требуется получить наиболее
сильный эффект, лучше один раз применить этот фильтр, чем дважды — фильтр
Blur (Размытие).
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Фильтр Gaussian Blur (Размытие по Гауссу)
Фильтр Gaussian Blur (Размытие по Гауссу) более удобен, потому что позволяет
управлять степенью размытия изображения. Вызывается он командой Filter >
Blur > Gaussian Blur (Фильтр > Размытие > Размытие по Гауссу). Для определения степе-
ни размытия используется поле Radius (Радиус); указанная в нем величина задает
количество пикселов, на основе которых происходят расчеты. Чем больше радиус,
тем больше размытие. Этот фильтр создает эффект дымки.

Фильтры Motion Blur (Размытие в движении)
и Radial Blur (Радиальное размытие)
Фильтр Motion Blur (Размытие в движении) позволяет создавать эффект размытости
от движения в определенном направлении и определённой интенсивности. Фильтр
Radian Blur (Радиальное размытие) имитирует эффект размытия при увеличении или при
вращении. Оба эти фильтра предназначены скорее для создания интересных эффектов,
чем для коррекции фотографий, поэтому мы не будем рассматривать их подробно.

Фильтр Smart Blur (Резкое размытие)
Если требуется размыть изображение, я обычно пользуюсь именно этим филь-
тром, потому что он очень удобен — с его помощью можно добиться сразу несколь-
ких результатов. Чтобы применить фильтр Smart Blur (Резкое размытие), выполни-
те команду Filter > Blur > Smart Blur (Фильтр > Размытие > Резкое размытие). Откроется
диалоговое окно, показанное на рис. 15.8. Оно очень похоже на диалоговое окно
фильтра Unsharp Mask (Нерезкая маска).

ж

Рис. 15.8. Диалоговое окно Smart Blur (Резкое размытие) позволяет управлять степенью
размытости изображения

1. В окне предварительного просмотра диалогового окна также можно не только
оценивать результат действия фильтра, но и видеть исходное изображение.
Для этого нужно навести на него указатель мыши и нажать кнопку мыши.
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2. Чтобы в окне предварительного просмотра показать другой фрагмент изобра-
жения, надо навести на окно указатель, нажать кнопку мыши и перетащить
изображение. Увеличивать и уменьшать масштаб позволяют кнопки со значками
«плюс» и «минус», расположенные под окном предварительного просмотра.

3. Регулятор Radius (Радиус) определяет силу эффекта. Чем ниже значение в одно-
именном поле, тем больше размытие.

4. Значение в поле Threshold (Порог) задает диапазон яркости, как в фильтре Unsharp
Mask (Нерезкая маска). Если соседние пикселы по яркости отличаются меньше
чем на пороговое значение, к ним применяется фильтр. Соответственно, чем
больше пороговое значение, тем сильнее будет размыто изображение.

5. В раскрывающемся списке Quality (Качество) можно задать качество обработки
изображения: Low (Низкое), Medium (Среднее) и High (Высокое). Список Mode
(Режим) позволяет выбрать эффект, который применяется к границам облас-
тей с разной яркостью. При варианте Normal (Обычный) обрабатывается все изоб-
ражение. При варианте Edge Only (Только края) белым цветом выделяются обла-
сти с переходом цветов, остальное закрашивается черным, а в режиме Overlay
Edge (Перекрытие краев) границы также выделяются белым, но в остальном
изображении сохраняется цвет, и оно размывается.

Добившись желаемого эффекта, нажмите кнопку ОК. Здесь также можно восстано-
вить исходные установки фильтра, нажав клавишу Alt и щелкнув на кнопке Reset
(Сброс), которая появляется на месте кнопки Cancel (Отмена).

Фильтр Despeckle (Песчинки)
Очень часто в темных областях фотографий появляется шум. Это говорит о недоста-
точной светочувствительности матрицы и качестве обработки цветовой информа-
ции. Шум проявляется в виде разноцветных точек или черточек. Фильтр Despeckle
(Песчинки) хотя и относится к группе фильтров Noise (Шум), предназначается не
для добавления шума, а для его удаления. Конечно, не всегда удается справиться
с любыми дефектами снимка, но с помощью этого фильтра можно в значительной
степени очистить изображение. Иногда случается, что после сохранения снимка
в формате JPEG с высокой степенью сжатия голубое небо приобретает крапчатую
окраску. Это тоже можно попытаться исправить с помощью данного фильтра.
Выполните следующее.

1. Откройте изображение с шумом. Если вам повезло, и в вашей библиотеке нет
ни одного такого снимка, возьмите фотографию с небом в облаках, сохраните
ее в формате JPEG с низким качеством (сильным сжатием) и откройте в про-
грамме Photoshop.

2. Выполните команду Filter > Noise > Despeckle (Фильтр > Шум > Песчинки).

3. Фильтр не имеет дополнительных параметров, поэтому он сразу обработает
изображение, а в результате уберет шум и немного размоет снимок.

Существует и другой фильтр, больше подходящий для удаления дефектов, появ-
ляющихся при сканировании изображения. Он называется Dust and Scratches ( П ы л ь
и царапины), и его мы будем рассматривать в главе 18.
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Следует запомнить
а В программе Photoshop имеется возможность откорректировать цветовой ба-

ланс изображения, сделав цвета более естественными или приятными для глаз.

а Можно усилить или ослабить цвет, увеличивая или уменьшая его насыщен-
ность.

Q Существует масса способов улучшения цветовой гаммы изображения — нужно
уметь творчески подходить ко всем предоставленным вам инструментам.

Q Улучшить снимок также можно, усилив резкость или размыв некоторые фраг-
менты изображения.

;r i -i
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Инструменты и методы выделения

а Выделение областей с помощью инструмента Marquee (Выделение)

а Инструменты группы Lasso (Лассо)

а Использование инструмента Magic Wand (Волшебная палочка)

а Команды меню Select (Выделение)

Инструменты выделения незаменимы для обработки изображений. Без них стало
бы очень сложным создание множества интересных эффектов, устранение дефек-
тов, исправление недостатков и т. д. Я говорю «очень сложным», потому что, ко-
нечно, можно работать с каждым пикселом по отдельности, но согласитесь, что
гораздо приятнее иметь дело с выбранным по своему усмотрению фрагментом изоб-
ражения. Инструменты выделения постоянно взаимодействуют с другими инст-
рументами, средствами и фильтрами. Они позволяют скопировать часть изобра-
жения или удалить ее, защитить области рисунка или фотографии от цветовой
коррекции или ретуши. Овладев инструментами выделения, вы поймете, насколь-
ко увеличились ваши возможности по обработке изображения.
Все инструменты, фильтры и команды, описанные в главах 14 и 15, to есть коман-
ды, служащие для трансформации изображения, цветовой коррекции, настройки
яркости и контраста, а также фильтры, увеличивающие резкость или размываю-
щие изображение, можно применять не только ко всему изображению, но и к вы-
деленной области. Это же относится и к большинству других средств программы
Photoshop. Чтобы изменить вид фрагмента изображения с помощью известного
или еще не знакомого вам инструмента, сначала следует выделить этот фрагмент.

Расположение инструментов выделения
Перед тем как я начну рассказывать о задачах, для решения которых требуется
выделять области, и описывать процесс выделения, попробуем найти предназна-
ченные для этого инструменты в окне программы Photoshop. Программа всегда
предоставляет в наше распоряжение несколько средств, отвечающих за выполнение
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похожих операций, — вы уже знакомы с командами цветокоррекции, усиления
резкости и т. д. Но больше всего в программе Photoshop инструментов, с помощью
которых можно выделить области изображения.

Часть из них расположена на перемещаемой панели инструментов, которая нахо-
дится в рабочем окне программы и по умолчанию присутствует на экране. Если вы
случайно скрыли панель, выберите команду Window > Tools (Окно > Инструменты).
Каждая кнопка панели инструментов служит для включения определенного инст-
румента. Чтобы вывести на экран всплывающую подсказку с названием инстру-
мента и обозначением соответствующей ему горячей клавиши, наведите на кноп-
ку инструмента указатель мыши. Если в правом нижнем углу кнопки нарисован
маленький треугольник, значит, инструмент имеет несколько разновидностей или
под одной кнопкой скрывается несколько инструментов, и чтобы показать их все,
требуется навести указатель на кнопку инструмента, щелкнуть правой кнопкой
мыши или нажать левую кнопку мыши и некоторое время не отпускать ее. Пере-
ключиться от одного варианта к другому можно с помощью мыши или одновре-
менным нажатием клавиши Shift и горячей клавиши инструмента.

Панель инструментов представлена на рис. 16.1. В верхней ее части находятся ин-
струменты выделения, перемещения, обрезки и нарезки, последний из которых
широко используется для подготовки веб-графики. В следующей группе размещают-
ся инструменты для рисования, заполнения и стирания, потом средства для создания
геометрических фигур, текста и контуров. Далее — вспомогательные инструменты,
переключатели цветов переднего и заднего плана, и в последних трех группах рас-
полагаются кнопки для перехода в различные режимы и активизации программы
ImageReady, в которой очень удобно подготавливать графику для размещения
в Интернете. Таким образом, эта панель содержит массу полезных и нужных инст-
рументов, многие из которых станут для вас предметом первой необходимости.

ПРИМЕЧАНИЕ
Плавающие палитры и панели, такие как панель инструментов, дают возможность сэконо-
мить время и уменьшить количество нажатий клавиш, но они занимают место на экране.
Чтобы поменять положение такой палитры, нужно щелкнуть кнопкой мыши на ее заголовке
и, не отпуская кнопку мыши, перетащить палитру в новое место. Таким образом, ее можно
передвинуть поближе к области, над которой ведется работа, и сократить время, требуемое
на перемещение мыши для включения нового инструмента. Точно так же передвигается
окно, в котором содержится несколько палитр, только щелкать в этом случае нужно на
верхней строке окна.

Если же палитры мешают просмотру изображения, можно переключиться в один из полно-
экранных режимов с помощью кнопок панели инструментов или клавиши Tab, скрыть неис-
пользуемые палитры или убрать их из рабочей области в область палитр. О последней
рассказывалось в главе 14. Кроме того, если дважды щелкнуть на заголовке палитры или
верхней полосе окна, окно с палитрой свернется и видимыми останутся только верхняя
полоса окна и закладки с заголовками палитр. В принципе, запомнив клавиатурные комби-
нации для всех необходимых инструментов, можно убрать панель инструментов с экрана.

Если желательно сохранить расположение плавающих палитр в расчете на следующий се-
анс работы в программе Photoshop, просто закройте программу, не перемещая и не скрывая
палитры. Если же требуется восстановить стандартное расположение палитр, выберите
команду Window > Workspace > Reset Pallete Locations (Окно > Рабочее пространство > Распо-
ложить палитры по умолчанию).
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Healing Brush (Лечебная
кисть) и Patch (Заплатка)

Blur (Размытие), Sharpen
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History Brush (Кисть истории)
и Art History Brush (Художественная кисть)

Gradient (Градиентная заливка)
и Paint Bucket (Заливка)

Dodge (Осветлитель), Burn (Затемнитель)
и Sponge (Губка)

цветов переднего плана и фона

Включение режима Quick Mask
(Быстрая маска)

Переключение в разные виды
полноэкранного режима

л _ п

Рис. 16.1. Инструменты выделения Marquee (Выделение), Lasso (Лассо) и Magic Wand
(Волшебная палочка) размещаются в верхней части панели инструментов

Для выделения фрагментов изображения, кроме инструментов, программа предо-
ставляет целый набор команд, объединенных в меню Select (Выделение).

Зачем нужно выделение областей
изображения?
Существует множество причин, побуждающих нас пользоваться инструментами
выделения.
Q С их помощью осуществляется передвижение отдельных пикселов изображе-

ния или группы пикселов, то есть выделенную область можно передвинуть
с одного места на другое в пределах изображения; вырезать ее или скопиро-
вать, а затем вставить или в исходное изображение, или в какое-нибудь другое,
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также открытое в программе Photoshop. Пусть, например, у нас выделено кра-
сивое облако. Теперь его можно переместить по небу, улучшая композицию,
или же скопировать и вставить в другой снимок.

Q Если в изображении выделена какая-то область, то все остальные инструменты бу-
дут воздействовать только на нее. Это свойство очень часто используется, когда
требуется применить фильтр к конкретной части изображения или скорректи-
ровать цвета только в некотором фрагменте. Например, практически на всех
фотографиях, снятых на природе, присутствует небо и, как правило, не нужно
увеличивать его резкость — на небосклоне обычно отсутствуют четкие детали,
а усиление резкости может проявить дефекты и шум. В подобных случаях вы-
деляют все изображение за исключением неба и к нему применяют фильтр.

О Иногда выделение используется для точного позиционирования в изображе-
нии вставляемого фрагмента. Для этого нужно создать выделенную область там,
куда требуется вставить фрагмент, и тогда его центр совпадет с центром выде-
ленной области.

Представьте следующую ситуацию. На важный семейный праздник со всей стра-
ны съехались все ваши дальние и ближние родственники, и вы только что сфото-
графировали свое огромное семейство. Светит солнце, мгновенье остановлено и все
прекрасно в этом мире, если не помнить о его непостоянстве. Чтобы сделать каж-
дому родственнику подарок на память о таком замечательном событии, а заодно
продемонстрировать свою новую игрушку, вы решаете немедленно переписать
снимок на компьютер и напечатать фотографии. И тут обнаруживается, что пле-
мянник Петя на снимке закрыл глаза.

Неужели опять придется собирать, выстраивать и фотографировать всю ораву род-
ственников? Не обязательно, поскольку существует второй способ решения про-
блемы, а если вы научитесь работать в Photoshop, он покажется вам проще. По-
ставьте Петю примерно на то же самое место, которое он занимал в групповом
снимке, и сфотографируйте его еще раз. Важно постараться обеспечить то же осве-
щение и желательно сохранить расстояние до мальчика, по крайней мере, не уве-
личить дистанцию. Затем перепишите снимок на компьютер, откройте его в про-
грамме Photoshop, выделите только Петино лицо и скопируйте его. Потом откройте
групповой снимок и вставьте в него скопированный фрагмент. Теперь осталось
только правильно расположить вставленную область, и, возможно, немного изме-
нить ее размеры, но вы уже умеете делать это.

Инструменты выделения
Рассмотрим более подробно инструменты выделения, предоставляемые програм-
мой Photoshop. Вы, конечно, можете просто прочитать главу, но я предлагаю сразу
попробовать воспользоваться каждым из описываемых инструментов. Для этого
расположитесь перед своим компьютером поудобнее и откройте изображение
в программе Photoshop. Убедитесь в том, что панель инструментов присутствует
в окне программы, в противном случае выведите ее на экран командой Window >
Tools (Окно > Инструменты) —она нам скоро понадобится. Чтобы активировать любой
из инструментов, нужно щелкнуть мышью на соответствующей кнопке на панели
инструментов или нажать его клавишу быстрого доступа.
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ПРИМЕЧАНИЕ —г —
Многие сторонние фирмы создают дополнительные фильтры, называемые"эффектами,
и другие более мощные инструменты для программы Photoshop, которые покупаются от-
дельно. Некоторые компании, такие как Extensis (www.extensis.com), продают дополнитель-
ные модули, предназначенные для упрощения процесса выделения.

Чаще всего с веб-сайта компании можно загрузить пробную или демонстрационную версии
программы. Это очень удобно, так как дает возможность поработать с новым модулем, а также
проверить его функционирование на определенной платформе и взаимодействие с установ-
ленным программным обеспечением. И, прежде всего, это позволяет понять, действительно
ли вам необходим такой модуль.

Команды меню Select (Выделение)
В первую группу списка, открывающегося при щелчке на пункте меню Select (Вы-'1

деление) (рис. 16.2), включены четыре простейших, постоянно используемых ин-
струмента выделения.

ТО Н-")! '*!'}Г

; Ч<. • •.( i '-,' vj

Рис. 16.2. Команды для выделения областей и преобразования,выделения ,

> л ; , : ' сгг. , ' i
Q АИ ( Все). Эта команда предназначена для .выделения всего изображения.

ленная область ограничивается штриховым мерцающим кодтуром. К тому же
результату приводит нажатие клавиш Ctrl+A. .

Q Deselect (Снять выделение). Как следует из названия команды, она служит длв
снятия выделения. Клавиатурная комбинация для'эТбй'комянда** GtrbfrDinvn

Q Reselect (Восстановить выделение). Если случайно было снято'нужное:выделе'2

ние, его легко восстановить с помощью этой команды или клавиш Shift+Ctrl^E).
То же самое можно сделать, отменив последнюю операцию нажатием клавиш
Ctrl+Z или выбрав команду Edit > Undo (Редактироваиие^^Огие*^^,)^ , * ,- г-м" |̂

Q Inverse (Инвертировать). Данная команда или сочетание клавиш Shift+Ctrl+I
применяется, когда требуется выделить всю невыделенную В: данный (момент
область изображения. Например, если вы работаете над изображением цветка
и хотите немного размыть задний план, сохранив цветок резким, то выделите
цветок, обратите выделение и примените фильтр Blur (Размьгше). ! . : . - ; о,>>; q

Далее в меню Select (Выделение) представлены команды.

Q Команды Color Range (Цветовой диапазон), Grow (Увеличить) и Simitar (Поi обраШ)
служат для выделения областей на основе цветов изображения. Первую команду
мы далее рассмотрим подробно. Вторая команда расширяет.текущее выдёдёнщ
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добавляя к нему новые смежные области на основе исходного значения допуска
инструмента Magic Wand (Волшебная палочка), который будет рассмотрен далее.
Третья команда захватывает все пикселы изображения, которые попадают
в диапазон уже выделенных фрагментов.

a Feather (Размытие) размывает изначально резкий край выделения, то есть факти-
чески на краю выделенной области создается плавный переход от непрозрачного
к прозрачному. Степень размытия измеряется в пикселах, а область перехода
располагается как внутри, так и снаружи границы выделенного участка.

a Modify (Модифи цировать) позволяет модифицировать контур выделения четырьмя
различными способами: Border (Граница), Smooth (Сгладить), Expand (Расширить)
и Contract (Сузить). Первая команда выделяет полосу пикселов вдоль границы
области предыдущего выделения; вторая позволяет закруглять углы выделенной
области; третья и четвертая соответственно увеличивает или уменьшает выде-
ленный фрагмент путем перемещения его границы наружу или внутрь на ука-
занное число пикселов.

a Transform Selection (Трансформировать выделение) в сочетании с клавишами Alt,
Ctrl и Shift используется для изменения формы именно выделенного контура,
а не размеров фрагмента изображения. Попробуйте выделить какую-нибудь
область и трансформировать ее с помощью этой команды аналогично тому, как
вы деформировали целое изображение и изменяли его размеры.

а Последним двум командам — Load Selection (Загрузить выделение) и Save Selection
(Сохранить выделение) — будет посвящен целый раздел этой главы.

Инструменты группы Marquee (Выделение)
К этой группе относятся самые простые инструменты выделения после команды
All (Все). Слово marquee означает «шатер», и инструменты получили такое название,
так как границы выделенных с их помощью фрагментов напоминают вспыхивающие
огоньки, которые украшали навесы перед старыми театральными шатрами. Если
требуется выделить большую область прямоугольной или эллиптической формы,
чтобы ее передвинуть, повернуть или изменить ее размеры, используются именно
эти инструменты. Они включаются левой верхней кнопкой на панели инструментов.

Выделение прямоугольной области
Для выделения областей прямоугольной формы служит инструмент Rectangular
Marquee (Прямоугольное выделение). Если значок на левой верхней кнопке в панели
инструментов отображает квадратную штриховую рамку (а не окружность), значит,
данный инструмент можно включить, щелкнув на этой кнопке. В противном случае
для выбора типа выделения требуется сначала щелкнуть правой кнопкой мыши.
Чтобы выделить область, нужно подвести указатель мыши к точке, где будет нахо-
диться один из углов будущего выделенного прямоугольника, нажать левую кноп-
ку мыши и переместить указатель по диагонали, рисуя прямоугольную рамку, по-
добную показанной на рис. 16.3.
Можно обвести контуром квадратную область — для этого при выделении требу-
ется удерживать нажатой клавишу Shift, а чтобы размеры области изменялись оди-
наково относительно ее центра, а не угла, нужно нажать клавишу Alt. На панели
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настройки инструмента, по умолчанию располагающейся под строкой меню про-
граммы, есть раскрывающийся список Style (Стиль), пункты которого соответствуют
режимам выделения. При выборе второго режима Constrained Aspect Ratio (Фиксиро-
ванное соотношение сторон) необходимо указать пропорцию ширины и высоты, кото-
рая будет сохраняться в процессе выделения. Чтобы обвести квадрат, нужно задать
ширину и высоту, равные 1. Третий режим выделения — Fixed Size (Фиксированный
размер) — может оказаться полезным, если требуется вырезать фрагмент изображения
заданного размера, например, чтобы создать кнопки или значки для веб-страницы.

Рис. 16.3. Выделите часть изображения с помощью инструмента Marquee (Выделение)

Параметр Feather (Размытие) по своему действию аналогичен одноименной команде
меню Select (Выделение). Разница заключается в том, что команда меню применя-
ется к уже существующему выделению, а значение параметра в поле следует уста-
навливать до начала процедуры выделения какой-либо области. Тогда область будет
иметь размытые границы. Этот параметр есть у всех инструментов выделения.

Чтобы переместить выделенную область, нужно щелкнуть внутри нее и, не отпуская
кнопку мыши, перетащить штриховую рамку. Кроме того, область можно редакти-
ровать с помощью описанных выше команд меню Select (Выделение).

Пример: обесцвечивание фрагмента изображения
Вы когда-нибудь видели фотографию, которая выглядит черно-белой, но некото-
рые ее фрагменты остались цветными? Этот прием широко используется дизайне-
рами для придания выразительности рекламе и в печатных изданиях. Попробуем
достичь подобного результата.

1. Откройте изображение и включите инструмент Rectangular Marquee (Прямоугольное
выделение). Если желательно, чтобы цветная часть плавно переходила в черно-
белую, установите значение параметра Feather (Размытие) между 5 и 25 пиксела-
ми (поле для ввода этого значения находится на палитре параметров инструмен-
та, расположенной под строкой меню).

2. Нажмите клавишу Shift и мышью выделите квадратную область в центре изоб-
ражения.

3. Выберите команду Select > Inverse (Выделение > Инвертировать), чтобы выделить
область за пределами только что нарисованной.

4. И наконец, выберите команду Image > Adjustments > Desaturate (Изображение >
Настройки > Обесцветить) или нажмите клавиши Shift+Ctrl+U.
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Ваше изображение станет черно-белым, за исключением защищенной области, как
на рис. 16.4. Цветным останется только фрагмент, ограниченный нарисованным
на втором шаге квадратом.

Рис. 16.4. Если выделить центральную область изображения,
оставшуюся часть можно обесцветить

СОВЕТ
Если вы уже начали выполнять некоторую операцию, например выделять область, но вдруг
решили, что это вам не нужно, отменить процесс можно, нажав на клавишу Esc. Такая
отмена сэкономит время, особенно если файл настолько большой, что применение любой
команды, инструмента или фильтра отнимает несколько секунд.

Выделение эллиптических областей и линий
Под кнопкой Marquee (Выделение) скрываются еще три инструмента. Первый
из них называется Elliptical Marquee (Эллиптическое выделение) и предназначается
для выделения областей в форме эллипса или круга. Действует он точно так же,
как инструмент Rectangular Marquee (Прямоугольное выделение). Чтобы полу-
чить правильную окружность, нужно при выделении удерживать нажатой клави-
шу Shift, если же нажать клавишу Alt, область будет растягиваться из центральной,
а не из угловой точки. При эллиптическом выделении становится доступен пара-
метр Anti-aliased (Сглаживание). Если этот флажок установлен, скругленные гра-
ницы выделения сглаживаются. Чтобы переключиться от прямоугольного выде-
ления к эллиптическому, можно открыть меню инструмента мышью или нажать
клавиши Shift+M.
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Два последних инструмента из группы Marquee (Выделение) выделяют горизонтальные
и вертикальные полосы шириной в один пиксел. Он№ используются достаточно
редко и поэтому не имеют клавиатурных команд, и обратиться к ним можно только
через меню инструмента, открываемого щелчком правой кнопкой мыши.

Инструменты группы Lasso (Лассо)
Инструменты группы Лассо (Lasso) позволяют получать выделенные области»да
имеющие правильной геометрической формы. С их помощью можно выделить
объект изображения, последовательно обводя его границы. К этой группе относят-
ся Lasso (Лассо), Polygon Lasso (Многоугольное лассо) и МадпеДс ̂ здХМагнщдое дас,-
со). Конкретный тип инструмента активируется щелчком на кнопке инструмента
или нажатием клавиши L; переключиться между инструментами группы Лассо
(Lasso) позволяет сочетание клавиш Shift+L.

Lasso (Лассо) > i i * ' j
Когда требуется выделить объект, имеющий необычную форму, используется имен-
но этот инструмент. Работает он следующим образом: нужно нажать кнопку мыши
в точке, откуда должно начаться выделение, и, не отпуская ее, передвигать мышь,
рисуя указателем кривую вокруг объекта. Если соединить начальные и конечные
точки, то при отпускании кнопки мыши будет выделена область внутри кривой.
В противном случае кривая замкнется автоматически. На самом деле, если объект
имеет достаточно сложную форму, его тяжело выделить за один проход, кроме того,
требуются определенные навыки рисования мышью. Иногда полезно прежде, чем
начинать выделение объекта, увеличить масштаб изображения. Photoshop позво-
ляет добавлять любые фрагменты к уже выделенной области (это мы рассмотрим
в последнем разделе данной главы) и таким образом точно выделять с помощью
инструмента Lasso (Лассо) большие области с любым контуром.

СОВЕТ — = ' - ^foCJ
Бывает, что требуется выделить объект, граница которого состоит,̂ з прямы^отрезков и
кривых. Нарисовать вручную прямую линию очень сложно, и даже выглядящая прямой ли-
ния при масштабировании обычно оказывается немного волнистой.

К счастью, программа Photoshop предоставляет средство, позволяющее рщитьдедобные
проблемы. Если, работая инструментом Lasso (Лассо),1в^екотоцои_10чке.цэжат1?_клавишу
Alt, отпустить кнопку мыши, сдвинуть указатель и щелкнуть, после кривого контура будет
нарисована прямая линия. Следующим щелчком можно создать еще один отрезок и продол-
жить таким образом контур ломаной линией.,Ято6ь1'Опя£ь!начать Вч(̂ чивё1Й1з$ейзЬс(я»
ной формы, требуется нажать кнопку мыши и отпустить клавишу Alt. Замкнуть выделение,
работая в режиме рисования ломаной, можно двойным щелчком мыши. . - . , .; i ;;

Polygon Lasso (Многоугольное лассо)
Многоугольное лассо работает так же, как обычное лассо при нажатой 'клавиш^
Alt, то есть с его помощью удобно создавать выделения с ломаный контуром-. Если
же при использовании многоугольного лассо нажать клавишу Alt и кнопку чйЫшЙ1,
можно будет продолжить контур кривой линией1^ Инструмент "йереключйтЬЙ'ни
обычное лассо. Чтобы лучше понять принцип работы'многоуйлЬногО'лассо'," по-
пробуем выделить объект, не имеющий кривых границ, ' >
1. Откройте изображение с таким объектом и активизируйте^йнйрумёйт'РВЩбТ!

Lasso (Многоугольное лассо).
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2. Щелкн ите на одном из углов объекта, передвиньте указатель к следующему углу
и еще раз щелкните. Каждый щелчок добавляет отрезки к контуру выделения.
Продолжайте работу, перемещая мышь вдоль границы объекта.

3. Приблизившись к начальной точке, дважды щелкните мышью. Вы получите
примерно такую выделенную область, как представленная на рис. 16.5.

Рис. 16.5. Инструмент Polygon Lasso (Многоугольное лассо)
позволяет выделять многоугольники различной формы

Выделение на основе цветовой информации
Любой пользователь старается делать так, чтобы компьютер выполнял за него как
можно больше работы. Одним из способов выгодного расходования «лошадиных
сил» электронного помощника является выделение фрагментов изображения на
основе близости цветов. Если вам нужно выделить замечательную красную розу,
расположенную на фоне зеленой листвы, то почему бы не предоставить это компь-
ютеру, а не строить вручную сложный контур? Соответственно, требуется выде-
лить красный цвет в изображении, и роза будет обособлена от зеленого фона. Все
так просто!

Magnetic Lasso (Магнитное лассо)
Читая про средства из группы Lasso (Лассо), вы должны были заметить, что мы
пропустили третий инструмент — Magnetic Lasso (Магнитное лассо). Его можно при-
менить, когда граница объекта четко отделена от фона, например, если нужно вы-
делить белый объект на темном заднем плане. Магнитное лассо отслеживает раз-
ницу яркости двух областей и рисует контур выделения по их границе, вам при
этом нужно лишь вести указатель мыши, обозначая приблизительный контур,
и щелчками ставить узловые точки в важных местах, подсказывая инструменту,
на что следует обратить внимание. Магнитное лассо неплохо работает даже в случае,
если выделяемая область содержит несколько различных цветов, но имеет четкую
границу. Если же требуется выделить область одного цвета, возможно, удобнее
будет воспользоваться следующим инструментом.



Инструменты выделения 225

Magic Wand (Волшебная палочка)
Инструмент Magic Wand (Волшебная палочка) позволяет выделять области, окрашен-
ные в одинаковые цвета, и чаще всего используется, когда нужно выделить боль-
шие одноцветные фрагменты, например зеленый луг или синее небо. Щелкните
на кнопке инструмента, затем щелкните на нужном цвете. Будут выделены все со-
прикасающиеся с выделенными пикселы, цвет которых отличается от цвета пер-
воначального пиксела на величину, определенную в поле Tolerance (Допуск). Чем
меньше эта величина, тем меньше цветов будет охвачено. При этом может слу-
читься так, что маленькие кусочки неба или травы окажутся невыделенными из-за
значительного отличия от исходного цвета, и тогда придется «вычищать» выделе-
ние — добавлять к нему пропущенные кусочки. Это происходит всякий раз, когда
в одноцветную область попадают пикселы другого цвета, например при наличии
шума. Их можно присоединить к рабочей области, нажав клавишу Shift и отметив
любым из инструментов выделения.
Если требуется выделить не только соприкасающиеся пикселы, а все одноцветные
области в изображении, следует снять флажок Contiguous (Смежные) на панели на-
стройки инструмента. Если установить флажок Use All Layers (Все слои), фрагменты
с похожими цветами будут выделяться на всех слоях изображения.
По умолчанию параметр Tolerance (Допуск) имеет значение 32. Его можно изменить,
просто введя новую величину в одноименное поле на панели настройки инструмен-
та. Попробуйте открыть изображение одного хорошо различимого объекта, как
на рис. 16.6, и поэкспериментировать на нем с волшебной палочкой. Попытайтесь
подобрать такие параметры, чтобы одним-единственным щелчком мыши выделить
весь объект.

ВНИМАНИЕ
При установке очень маленькой величины в поле Tolerance (Допуск), например 1, волшеб-
ная палочка примет во внимание только пикселы, цвет которых совпадает с цветом исход-
ной точки. Это находит применение в ситуации, когда требуется зафиксировать один цвет и
изменить его на другой. Если же задать очень большой допуск, например 255, будет выде-
лено все изображение.

Рис. 16.6. Волшебная палочка помогла выделить утенка
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Команда Color Range (Цветовой диапазон)
Эта команда, расположенная в меню Select (Выделение), является альтернативой
инструменту Magic Wand (Волшебная палочка). Она обеспечивает возможность очень
гибкого выбора цвета пикселов для помещения их и им подобных в выделенную
область. При выборе этой команды на экране появляется одноименное диалоговое
окно, продемонстрированное на рис. 16.7, в котором есть функция предваритель-
ного просмотра. В нем отображается либо выделенная область (положение пере-
ключателя Selection (Выделение)), либо весь рисунок (положение переключателя
Image (Изображение)). Список Select (Выделить) определяет способ выделения:
Sampled Colors (Цвета по образцу) — выбор цветов осуществляется с помощью рас-
положенных справа от окна предварительного просмотра пипеток; шесть вариан-
тов выделения всех пикселов соответствующего цветового диапазона (красных,
желтых, зеленых, голубых, синих, пурпурных); Highlights (Светлые области), Midtones
(Средние тона), Shadows (Тени) — выделение всех пикселов соответствующего ярко-
стного диапазона; Out Of Gamut (Вне CMYK) — выделение пикселов, цвета которых не
могут быть адекватно воспроизведены с использованием полиграфических красок.

Щ None
JBfrffijgfflv:. .•'jsalaiffiia!

Рис. 16.7. Это диалоговое окно позволяет выбирать пикселы изображения, входящие в заданный
цветовой диапазон

Для того чтобы поместить в выделенную область пикселы с любым произвольным
цветом, нужно остановиться на первом пункте в списке Select (Выделить). Тогда
станут доступны три пипетки и регулятор Fuzziness (Разброс), функция которого
аналогична параметру Tolerance (Допуск) инструмента Magic Wand (Волшебная па-
лочка). Выберите левую пипетку и щелкните на изображении в основном окне или
в окне предварительного просмотра на пикселах того цвета, который необходимо
поместить в выделенную область, затем отрегулируйте параметр Fuzziness (Разброс).
Пипетка со значком «плюс» предназначена для добавления цвета (или несколь-
ких цветов) в выделенную область, а пипетка с «минусом» — для удаления цвета
(или нескольких цветов) из выделенной области.

Это очень мощный и удобный инструмент. Попробуйте открыть то же самое изоб-
ражение, над которым вы колдовали с помощью волшебной палочки, и решить
задачу с помощью диалогового окна Color Range (Цветовой диапазон), и вы в этом
убедитесь.
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Режим Quick Mask (Быстрая маска)
Этот режим предназначается для выделения областей с помощью любых инстру-
ментов рисования, которые мы будем рассматривать в следующей главе. Таким
образом, режим Quick Mask (Быстрая маска) в сочетании с другими инструментами
выделения обеспечивает широчайший диапазон возможностей по созданию выде-
ленных областей.

Переключаются в него с помощью соответствующей кнопки на панели инструмен-
тов (третий ряд снизу). Если был выделен какой-либо фрагмент, при переходе
в режим Quick Mask (Быстрая маска) области за его пределами окрасятся в некоторый
цвет, по умолчанию красный. Теперь для редактирования маски следует включить
подходящий инструмент и добавить или удалить фрагменты изображения. По
умолчанию рисование черным цветом увеличивает маскируемую область и соот-
ветственно уменьшает выделенную область, а рисование белым цветом приводит
к противоположному результату. Рисование серым цветом создает частично вы-
деленные, то есть полупрозрачные области — как при использовании команды
Feather (Размытие). К маске также можно применять любые фильтры.

После переключения в стандартный режим с помощью кнопки Edit in Standard Mode
(Редактировать в стандартном режиме) на панели инструментов (или клавишей Q)
немаскируемая область отображается в обычном порядке.

Сохранение выделения
Разве не замечательно было бы иметь возможность сохранения выделенной с та-
ким трудом области со сложнейшим контуром, чтобы использовать ее в дальней-
шем? Или сохранить промежуточные результаты в случае, когда вы не успеваете
завершить работу, но должны срочно закрыть файл, чтобы выполнить другое зада-
ние или выключить компьютер? Запись выделений позволяет возвращаться к ним
снова и снова. Делается это следующим образом.

1. Создайте выделенную область, которую нужно сохранить. Затем откройте меню
Select (Выделение) и выберите команду Save Selection (Сохранить выделение).

2. В появившемся диалоговом окне установлены все параметры, необходимые для
создания нового выделения. От вас требуется только ввести его название в поле
Name (Имя) и нажать кнопку ОК.

3. Чтобы воспользоваться только что сохраненным выделением, выберите команду
Select > Load Selection (Выделение > Загрузить выделение). В раскрывающемся спис-
ке Channel (Канал) выберите название сохраненного выделения и нажмите кнопку
ОК. Будет восстановлено состояние до сброса выделения.

Копирование и удаление фрагментов
изображения
Итак, для чего нам снова и снова приходится выделять фрагменты фотографий?
Во-первых, чтобы увеличить резкость или настроить цвета только в части снимка.
Если выделена какая-либо область, все команды настройки и фильтры будут
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воздействовать только на ее содержимое. Во-вторых, чтобы выполнять операции,
описанные в самом начале главы — копировать фрагменты из одного изображе-
ния в другое или в пределах одной фотографии.

Копируется выделенная область очень просто: следует нажать клавиши Ctrl+C или вы-
брать команду Edit > Сору (Редактирование > Копировать). При этом фрагмент помещает-
ся в буфер памяти. Чтобы вставить его из буфера в это или другое изображение, тре-
буется переключиться в нужное окно, открыв подменю Window > Documents (Окно >
Документы) и выбрав название нужного изображения, затем нажать клавиши Ctrl+V
или выбрать команду Edit > Paste (Редактирование > Вставить). В этом случае вставлен-
ный фрагмент всегда помещается на новый слой. (Слои рассматриваются в главе 20.)

Выделенную область можно скопировать, не помещая ее в буфер, что позволит
сэкономить ресурсы компьютера. Для этого следует нажать клавишу Alt и пере-
двинуть выделение с помощью инструмента Move (Перемещение), кнопка которого
находится на панели инструментов в верхнем правом углу.

Кроме того, выделенные фрагменты изображения можно удалять и вырезать.
В последнем случае область удаляется со своего места, но сохраняется в буфере,
и тем самым готова для вставки в исходное или другое изображение. Чтобы удалить
область, выделите ее и нажмите клавишу Delete. Чтобы вырезать — выделите и выбе-
рите команду Edit > Cut (Редактирование * Вырезать).

Видоизменение выделенных областей
Часто требуется добавить фрагменты к выделенной области или исключить из нее
некоторые части, или даже скомбинировать две области. Мы уже говорили, что
если нажать клавишу Shift, создаваемое выделение будет объединяться с уже
существующим. Если же нажать клавишу Alt, новая выделенная область будет
исключаться из совокупного выделения. Этих же результатов можно добиться
с помощью четырех кнопок, присутствующих на панели настройки каждого из ин-
струментов выделения: New Selection (Новое выделение), Add to Selection (Добавить
к выделению), Subtract from Selection (Исключить из выделения) и Intersect with Selection
(Пересечение). Они изображены на рис. 16.8.

Рис. 16.8. Кнопки для переключения в один из четырех режимов выделения

Q В режиме New Selection (Новое выделение) удаляется любое существующее вы-
деление и создается новая выделенная область.

Q В режиме Add to Selection (Добавить к выделению) существующее выделение со-
храняется, и к нему добавляется новая выделенная область. К тому же резуль-
тату приводит нажатие клавиши Shift.

Q В режиме Subtract from Selection (Исключить из выделения) фрагменты, выделяе-
мые инструментом, исключаются из существующей выделенной области, что
равносильно выделению при нажатой клавише Alt.

Q В режиме Intersect with Selection (Пересечение) выделенными остаются только
те области, которые входят как в существующее выделение, так и в создаваемое.
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ВНИМАНИЕ
Не нужно забывать о командах меню Select (Выделение), предназначенных для редактиро-
вания выделений: Transform Selection (Трансформировать выделение), Grow (Увеличить),
Similar (По образцу), и о четырех командах, объединенных в группу Modify (Модифициро-
вать). Они помогут увеличить или уменьшить выделенную область, а также изменить ее
форму.

Иногда штриховая рамка, обозначающая границы выделенной области, мешает
просмотру результатов выполненных преобразований. Границу выделения можно
скрыть, нажав клавиши Ctrl+H или выбрав команду View t Show > Selection Edges
(Вид > Показать > Границы выделения). Только потом не нужно удивляться, почему
это, например, в результате увеличения резкости, четче стала только часть изобра-
жения. Чтобы отобразить границы выделения, следует выбрать ту же команду или
опять нажать Ctrl+H.

Фотография с растушеванными краями
Для получения прелестного эффекта, действие которого продемонстрировано на
рис. 16.9, выполните следующее.

1. Выберите инструмент выделения, обычно используется El l ipt ical Marquee
(Эллиптическое выделение) или Rectangle Marquee (Прямоугольное выделение).

2. На панели настройки инструмента установите величину параметра Feather
(Размытие) где-нибудь между 5 и 25. Чем больше это значение, тем мягче выхо-
дят края изображения.

3. Выделите основную часть изображения.

4. Установите белый цвет фона (квадрат Set background color (Установить цвет фона)
на панели инструментов).

5. Выполните команду Select > Inverse (Выделение > Инвертировать) и нажмите кла-
вишу Delete.

6. Если требуется, отсеките лишние края изображения с помощью инструмента
Crop (Обрезать) (см. главу 14).

В результате у вас должна получиться картинка, похожая на показанную на рис. 16.9.
Изображение в центре плавно соединяется с рамкой цвета фона (мы выбирали
белый, но также подходит любой другой цвет).

Рис. 16.9. Инструменты Photoshop позволяют растушевать края фотографии
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Следует запомнить
О Выделение областей является важным элементом, помогающим редактировать

изображения.

Q Допускается копирование и передвижение выделенных областей. С помощью
выделения можно защитить части изображения от воздействия фильтра или
средств цветовой коррекции.

О Инструменты позволяют выделять как большие области фиксированной фор-
мы, так и мелкие детали, имеющие сложный контур, который во втором случае
рисуется вручную.

а С помощью инструмента Magic Wand (Волшебная палочка) можно выделить об-
ласти из пикселов, цвета которых попадают в заданный диапазон. Для этого же
есть и более мощное средство — команда Color Range (Цветовой диапазон).

Q Выделение можно сохранить для последующего использования.

Q К выделенной области допустимо добавлять и исключать из нее фрагменты;
выделение поддается редактированию и видоизменению.
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Рисование и заливка

Q Способы заполнения выделенной области
Q Выделенную область можно закрасить цветом или залить текстурой
Q Рисование с помощью инструментов Brush (Кисть), Pencil (Карандаш), Shape

(Фигура) и Eraser (Ластик)

Существует множество способов придать выразительность изображению и доба-
вить интересный визуальный эффект. В этой главе мы рассмотрим заполнение
выделенных областей цветом или текстурой. Программа Photoshop предоставляет
множество режимов наложения одного цвета на другой, позволяющих резко изме-
нять вид исходного изображения или, наоборот, нежно воздействовать на ориги-
нал, мягко, едва заметно варьируя оттенки.

Некоторые из нас постоянно хотят что-нибудь нарисовать. И они не разочаруются
в Photoshop — программа предоставляет возможность взять «в руки» кисть. Вы смо-
жете приукрасить бледные пикселы изображения или нарисовать улыбку на хмурой
физиономии приятеля.

Рисовать новые элементы или добавлять цвета в изображение допускается, как
всегда в Photoshop, несколькими способами.

Q Заливка позволяет заполнять одним цветом большие, предварительно выде-
ленные фрагменты изображения. Можно заливать области с помощью инстру-
мента Gradient (Градиентная заливка), который создает плавный переход от одно-
го цвета к другому.

Q Инструменты для рисования позволяют добавлять элементы изображения при-
мерно так же, как если вы бы делали это на бумаге карандашами или кисточкой.

Заливка
Существуют два основных вида заливки.

О Обычное заполнение заливает выделенные области изображения одним цве-
том или текстурой.
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а Градиентная заливка также предназначена для заполнения выделенной облас-
ти, но она формирует плавный переход от одного цвета ко второму по выбран-
ному пользователем правилу.

Для обоих видов заливки доступны 24 режима наложения краски (раскрывающий-
ся список Mode (Режим)), позволяющих создавать самые невообразимые эффекты.

Простое заполнение
Чтобы применить заполнение, выделите фрагмент изображения, а затем вызовите
диалоговое окно Fill (Заполнение), выбрав команду Edit > Fill (Редактирование > За-
полнение). Это окно, продемонстрированное на рис. 17.1, содержит две секции —
Contents (Содержимое) и Blending (Смешивание).

|| Foreground Color Ц]

I Normal Л

Рис. 17.1. Диалоговое окно Fill (Заполнение) предоставляет множество способов заполнения
выделенной области

Раздел Contents (Содержимое)
Основным элементом этого раздела является раскрывающийся список Use (Исполь-
зовать), с помощью которого определяется цвет или текстура заливки. Список раз-
делен на три части.

а Первые два элемента — Foreground Color (Цвет переднего плана) и Background Color
(Цвет фона) — позволяют заливать выделенную область любым цветом. К сожале-
нию, цвет нельзя напрямую выбрать в диалоговом окне Fill (Заполнение), а нуж-
но предварительно определить с помощью элементов-квадратов Set Foreground
Color (Установить цвет переднего плана) и Set Background Color (Установить цвет фона),
расположенных на панели инструментов.
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О Использование элементов второй группы приводит к различным результатам.

• Пункт списка Pattern (Образец) предназначен для заливки текстурой, опре-
деляемой пользователем. При выборе этого варианта становится доступной
раскрывающаяся палитра Custom Pattern (Заказной образец). Щелкните на
кнопке с маленькой стрелкой, чтобы раскрыть палитру, и выберите любую
из текстур. Если ни один из стандартных вариантов вас не устраивает, в ка-
честве текстуры можно определить любой прямоугольный фрагмент изобра-
жения. Выделите область инструментом Rectangular Marquee (Прямоугольное
выделение), выберите команду Edit > Define Pattern (Редактирование > Опреде-
лить образец), введите название образца и нажмите кнопку ОК. Теперь он го-
тов к применению.

ПРИМЕЧАНИЕ -
Палитра Custom Pattern (Заказной образец) имеет собственное меню, которое раскрывается
при щелчке на маленькой круглой кнопке со стрелкой, расположенной в верхнем правом
углу палитры. Часть команд этого меню вы будете использовать, например Rename Pattern
(Переименовать образец) или Delete Pattern (Удалить образец), а некоторые, возможно, вам
никогда не понадобятся. Так, команда Load Pattern (Загрузить образец) позволяет добавить
текстуру в палитру, при этом файл с текстурой должен иметь расширение PAT.

• Пункт списка History (История) предназначен для восстановления выделен-
ной области изображения в промежуточное состояние, имевшее место в про-
цессе работы. История последних выполненных операций, по умолчанию 20,
запоминается программой в палитре History (История). Чтобы вернуть фраг-
мент к любому из сохраненных состояний, нужно выделить область, щелк-
нуть в палитре на квадратике слева от названия состояния — там появится
значок с кисточкой, а затем вызвать диалоговое окно Fill (Заполнение), в ко-
тором установить обсуждаемый вариант заливки.

Q Элементы третьей группы позволяют залить выделенную область белым (White),
черным (Black) или серым (50% Gray) цветом.

Но проще всего заполнить выделенную область, вылив на нее «ведро краски»
с помощью инструмента Paint Bucket (Заливка), который находится на одной кнопке
с инструментом Gradient (Градиентная заливка). Его действие по характеру отбора
пикселов напоминает работу инструмента Magic Wand (Волшебная палочка), но он
не очерчивает область, а заливает ее фоновым цветом или текстурой образца. Сто-
ит поэкспериментировать с этим инструментом, меняя параметры Mode (Режим),
Opacity (Непрозрачность) и Tolerance (Допуск), чтобы подобрать приемлемые значения.

СОВЕТ
Тем, кто любит экспериментировать, очень пригодится палитра History (История). По умолча-
нию в ней запоминаются 20 последних операций, но это значение можно увеличить, тем
самым предохранив себя от напрасных огорчений. Выберите команду Edit > Preferences >
General (Редактирование > Установки > Общие) и измените величину в поле History States
(Состояния истории) на более реалистичное значение, например на максимально допустимое
программой число 100! Конечно, у такого подхода есть свои минусы. Чем больше состояний
запоминается, тем больше требуется памяти для работы программы, при этом сначала заби-
вается оперативная память, потом создается временный файл на жестком диске. Поэтому
при работе с большим изображением или при ограниченном объеме памяти лучше отслежи-
вать не больше 20 или 30 операций.
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Раздел Blending (Смешивание)
Раздел Blending (Смешивание) диалогового окна Fill (Заполнение) отвечает за способ
смешивания накладываемого цвета или текстуры с исходным изображением. Анало-
гичные параметры имеет и инструмент Paint Bucket (Заливка).
Q В поле Opacity (Непрозрачность) задается прозрачность наносимой краски. Вели-

чина 100% означает, что покрытие полностью непрозрачно, то есть сквозь него
не будет проступать исходное изображение. Если требуется слегка изменить
оттенок, а не нанести яркий цвет, попробуйте установить значение 50%.

Q Раскрывающийся список Mode (Режим) определяет способ наложения заливки.
Здесь можно выбрать любой из перечисленных далее режимов смешивания цве-
тов (эти же режимы используются при наложении слоев изображения, кото-
рые мы будем рассматривать в главе 20).
• В режиме Normal (Нормальный) происходит полная замена исходного цвета

на наносимый.
• Чтобы увидеть действие режима Dissolve (Растворение), следует установить

в поле Opacity (Непрозрачность) величину, отличную от 100%. В результате
часть точек, выбранная случайным образом, но в зависимости от коэффици-
ента прозрачности, окрашивается накладываемым цветом.

• Режим Behind (Подложка) доступен только при работе со слоями, имеющи-
ми прозрачные области, которые полностью окрашиваются цветом заливки.

• Режим Clear (Очистка) также доступен только при работе со слоями. В актив-
ном слое точки выделенной области становятся прозрачными.

• В режиме Darken (Затемнение) заливка применяется только к тем пикселам,
которые светлее накладываемого цвета, то есть затемняются все пикселы,
на которые воздействует заливка. Темные же пикселы остаются без изменений.

• В режиме,МиШр1у (Умножение) красный, зеленый и синий компоненты исход-
ного и накладываемого цветов по очереди перемножаются и делятся на 255,
поэтому результирующий цвет всегда получается темнее исходного. При
заливке черным цветом (все компоненты равны нулю) образуется область
черного цвета, заливка белым цветом не влияет на исходное изображение.

• В режиме Color Burn (Форсирование цвета) происходит затемнение исходных
цветов за счет увеличения контраста, чтобы жестко отразить накладываемый
цвет. Заливка белым в этом режиме не отражается на исходном изображении.

• В режиме Linear Burn (Линейное форсирование) происходит затемнение ис-
ходных цветов за счет уменьшения яркости. Заливка белым также не отра-
жается на исходном изображении.

• В режиме Lighten (Осветление) заливка воздействует только на те пикселы,
цвет которых темнее накладываемого цвета. В результате эти пикселы освет-
ляются. Правда, в этом и в режиме Darken (Затемнение) все три составля-
ющие цвета сравниваются по отдельности, поэтому для цветного изображе-
ния результат не совсем предсказуем.

• В режиме Screen (Экран) исходный и накладываемый цвета «делятся», по-
этому результирующий цвет получается всегда светлее исходного.

• В режиме Color Dodge ( К о м б и н и р о в а н и е цвета) происходит осветление
исходных цветов за счет уменьшения контраста, чтобы мягко передать
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присутствие накладываемого цвета. Заливка черным не влияет на исходное
изображение.

• В режиме Linear Dodge (Линейное комбинирование) происходит осветление
исходных цветов за счет увеличения яркости.

• Режим Overlay (Наложение) усиливает или ослабляет яркость в зависимости
от исходного цвета: цвет заливки не заменяет собой исходный цвет, а наклады-
вается поверх него, при этом сохраняется соотношение светлых областей и теней.

• Режим Soft Light (Мягкий свет) усиливает или ослабляет яркость в зависимости от
накладываемого цвета, результат напоминает освещение рассеянными лучами.

• В режиме Hard Light (Жесткий свет) также происходит усиление или ослабле-
ние исходного цвета в зависимости от накладываемого цвета, но результат
напоминает освещение резким светом.

• В режиме Vivid Light (Яркий свет) эффект освещения образуется за счет умень-
шения или увеличения контраста в зависимости от накладываемого цвета.
Цвет темнее 50% серого будет затемнять изображение.

• В режиме Linear Light (Прямой свет) то же самое выполняется за счет измене-
ния яркости в зависимости от накладываемого цвета.

• В режиме Pin Light (Точечный свет) на основе сравнения исходного и накладывае-
мого цветов между собой, а также накладываемого с 50-процентным серым про-
исходит замена компонентов исходного цвета компонентами накладываемого.

• В режиме Difference (Разность) результирующий цвет составляется из разно-
стей по модулю цветовых компонентов двух пикселов. Цвета могут полу-
чаться самые неожиданные, но четко прогнозируемые математически.

• Режим Exclusion (Исключение) напоминает предыдущий режим, но действу-
ет несколько мягче.

• В режиме Hue (Цветовой тон) изображение приобретает общий цветовой тон
накладываемого цвета (вспомним диалоговое окно настройки цветового тона
и насыщенности),: но сохраняет значения насыщенности и яркости исход-
ных цветов.

• В режиме Saturation (Насыщенность) изображение получает насыщенность
накладываемого цвета, но сохраняет цветовой тон и яркость исходного.

• В режиме Color (Цвет) результирующий цвет сохраняет яркость исходного
цвета, но получает цветовой тон и насыщенность накладываемого. При этом
в изображении сохраняются все светлые области и тени. Данный режим ча-
сто используется при цветном тонировании черно-белого изображения.

• В режиме Luminosity (Яркость) не оказывается влияния на цветовой тон и насы-
щенность изображения, но привносится яркость накладываемого цвета.

Результаты воздействия заливки в некоторых режимах можно представить, в других
же, например в режимах Overlay (Наложение) или Difference (Разность), они практически
непредсказуемы, но бывают очень интересными. Профессиональные художники
любят усложнять изображения с помощью таких режимов наложения цветов. Вам
же я настоятельно советую поэкспериментировать с различными способами за-
ливки. Словами описать все богатство возможностей просто нереально; лучше один
раз увидеть все собственными глазами, чем много раз услышать.
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Градиентная заливка
Применительно к цвету градиентом называется направление плавного перехода
от одного цвета к другому (в среде художников эффект чаще называется «растяж-
кой»). Для создания градиентной заливки используется инструмент Gradient (Гра-
диентная заливка), расположенный на одной кнопке с инструментом Paint Bucket
(Заливка). Применяется градиентная заливка аналогично обычному заполнению:
следует выделить область, которая будет закрашиваться, щелкнуть на кнопке ин-
струмента или нажать клавишу G (или Shift+G) и установить параметры на панели
настройки инструмента. Первые два элемента: раскрывающаяся палитра и пять
кнопок — определяют цвета заливки и вид их перехода друг в друга. Простой гра-
диент создает переход от цвета переднего плана к цвету фона, которые определя-
ются с помощью соответствующих квадратов на панели инструментов. Но раскрыв
палитру щечком на кнопке со стрелкой справа от образца перехода цветов, можно
задать любой из стандартных вариантов или из меню палитры (круглая кнопка со
стрелкой в правом верхнем углу палитры), загрузить встроенные палитры гради-
ентов и задать любой из хранящихся в них вариантов. Также можно редактиро-
вать существующие варианты в окне Gradient Editor (Редактор градиента), которое
открывается щелчком на образце градиента. Список Mode (Режим) и поле Opacity
(Непрозрачность) ничем не отличаются от одноименных параметров инструмента
Paint Bucket (Заливка) (или элементов диалогового окна Fill (Заполнение)). И послед-
ний шаг: требуется нарисовать мышью в выделенной области направление пере-
хода цветов. Обязательно попробуйте воспользоваться этим инструментом, и вы
получите изображение, подобное продемонстрированному на рис. 17.2.

Рис. 17.2. С помощью инструмента Gradient (Градиентная заливка) закрасьте выделенную
область двумя цветами, плавно'переходящими друг в друга
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Изменяем погоду с помощью Photoshop
Используя инструменты выделения и заливку, можно скопировать небесную ла-
зурь из одного снимка и заменить ею пасмурное небо на другой фотографии. Люди
будут думать, что во время ваших путешествий всегда стоит прекрасная погода!

1. Откройте два изображения: одно с мрачным небосводом, другое — снятое в сол-
нечный день.

2. С помощью инструментов выделения, описанных в главе 16 — например, Rectangular
Marquee (Прямоугольное выделение), Magic Wand (Волшебная палочка) или Poligonal
Lasso (Многоугольное лассо), выделите небо на фотографии с плохой погодой.
Не забывайте, что добавлять фрагменты к выделенной области можно, нажав
клавишу Shift или переключившись в соответствующий режим выделения
на панели параметров инструмента. Вокруг выделенной области появится бегу-
щая штриховая линия, как на рис. 17.3.

•

Рис. 17.3. На этом снимке небо было выделено инструментом Magic Wand (Волшебная палочка)

3. Переключитесь на солнечное изображение, щелкнув на нем или выбрав его на-
звание в подменю Window > Documents (Окно > Документы).

4. Включите щелчком на кнопке на панели инструментов инструмент Eyedropper
(Пипетка). Указатель мыши примет вид пипетки.

5. Подведите указатель к самому яркому участку синего неба и щелкните. Цвет
неба станет цветом переднего плана — квадраты Set foreground color (Установить
цвет переднего плана) на панели инструментов и в палитре Color (Цвет) окрасят-
ся в выбранный пипеткой синий цвет.



238 Глава 17. Рисование и заливка

6. Теперь щелкните на квадрате Set background color (Установить цвет фона) — от-
кроется диалоговое окно Color Picker (Выбор цвета), показанное на рис. 17.4. Дан-
ное окно предназначается для установки цвета вручную, но сейчас мы сделаем
это пипеткой. Если окно закрыло изображение, щелкните на области заголовка
и сдвиньте окно в сторону. Затем наведите пипетку на участок светло-голубого
цвета, серого или белого, в зависимости от собственных предпочтений, и снова
щелкните. Этот цвет нужен для создания облаков. Нажмите кнопку О К, чтобы
закрыть диалоговое окно.

7. Переключитесь назад к изображению с пасмурным небосводом. Небо осталось
выделенным, а цвета переднего плана и фона сохранились теми, которые были
определены на двух предыдущих шагах.

Рис. 17.4. Диалоговое окно Color Picker (Выбор цвета) служит для выбора цвета
переднего плана или фона

Рис. 17.5. Какое небо голубое — и только вы знаете правду!
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8. Выберите команду Filter > Render > Clouds (Фильтр > Представление > Облака),
и программа, смешивая два заданных цвета, без всякого разбоя и очевидного
мошенничества сымитирует восхитительную погоду. Подобный результат, про-
демонстрирован на рис. 17.5.

ПРИМЕЧАНИЕ

При систематизации фотографий имеет смысл помечать снимки, на которых запечатлены
красивые облака и небо в солнечный день — их в дальнейшем удобно использовать для
улучшения других изображений. Таким образом создаются коллекции фрагментов фотогра-
фий, из которых можно собирать целые коллажи. Например, я при необходимости заполняю
небо облаками, которые сфотографировал несколько лет назад. Ведь чтобы добиться нуж-
ных с точки зрения композиции расположения и формы облаков, возможно, придется ждать
часы или дни! А программа Photoshop позволяет скопировать облако в одном изображении
и вставить в другое или перенести облако с помощью инструмента Cloner Stamp (Клонирую-
щий штамп), о котором рассказывается в главе 18.

Инструменты рисования
Инструменты рисования довольно забавны. С их помощью можно стереть части
изображения, откорректировать некоторые фрагменты или нарисовать что-нибудь
поверх фотографии. Если вы создаете в программе Photoshop иллюстрации для
деловой презентации, вам никто не запрещает нарисовать стрелки или кружки,
чтобы привлечь внимание к определенным участкам изображения.

Рассмотрим те инструменты, которые программа отдает в наше распоряжение:

Q Brush (Кисть) и Pencil (Карандаш);

а инструменты группы Eraser (Ластик);

а инструменты группы Shape (Фигура);

Q History Brush (Восстанавливающая кисть) и Art History Brush (Художественная кисть),

Инструменты Brush (Кисть) и Pencil (Карандаш)
Эти два инструмента располагаются на одной кнопке в панели инструментов
и активируются клавишей В (не забывайте, что для вызова инструментов и команд
используется английская раскладка клавиатуры) и предназначены для свободно-
го рисования. Инструмент Brush (Кисть) действует подобно обычной кисти, то есть,
включив его и передвигая указатель мыши, можно рисовать на экране практиче-
ски так же, как кистью по бумаге. Инструмент Pencil (Карандаш) имитирует рисова-
ние карандашом и создает линии с более четкими краями, в отличие от линий,
полученных инструментом Brush (Кисть).

По умолчанию в программе Photoshop при включении инструмента указатель
мыши принимает вид этого инструмента. Данная настройка поддается изменению.
Для этого следует открыть диалоговое окно Preferences (Установки), выбрав команду
Edit > Preferences > Display & Cursors (Редактирование > Установки > Отображение и кур-
соры). Это окно содержит три секции, левая нижняя относится к инструментам
рисования, правая нижняя определяет вид указателя мыши для остальных инст-
рументов.



240 Глава 17. Рисование и заливка

Если переключатель в секциях Painting Cursors (Рисующие курсоры) и Other Cursors
(Другие курсоры) установлен в положение Standard (Стандартный), указатель мыши
будет принимать вид инструментов. Например, при включении инструмента Paint-
brush (Кисть) указатель превратится в маленькую кисточку — так проще отслежи-
вать, какой инструмент активен в данный момент. Если установить вариант Precise
(Точный), указатель не будет меняться при переключении инструментов. Он ста-
нет похож на маленькое перекрестие, что создает возможность для более точного
управления инструментами. И в третьем варианте, Brush Size (Размер кисти), указатель
принимает вид активной для этого инструмента на данный момент кисти с учетом
ее формы и размера. Я обычно использую именно последнюю настройку.

Будем рассматривать действие этих инструментов на примере кисти. Включите
его щелчком на кнопке Brush (Кисть) панели инструментов. На панели настройки,
показанной на рис. 17.6, отобразятся параметры инструмента — здесь можно уточнить
вид кисти и размер следа, задать режим наложения краски и прозрачность. Значения
параметров допускается изменять по своему желанию, а чтобы восстановить уста-
новки, принятые по умолчанию, требуется щелкнуть правой кнопкой мыши на
самой левой кнопке (со значком инструмента) на панели настройки и выбрать ва-
риант Reset Tool (Восстановить инструмент).

Рис. 17.6. Панель параметров позволяет задавать размер и вид кисти, а также режим рисования

Вид и размер кисти
Слева на панели настройки инструмента находится кнопка с заголовком Brush:
(Кисть:). Значок представляет кисть, выбранную на данный момент — вид кисти
и размер следа. Если след слишком велик и не помещается на значке, размер указы-
вается в цифрах. Программа Photoshop предоставляет для кистей множество стан-
дартных форм и размеров, любую из которых можно выбрать, щелкнув на стрелке
«вниз», расположенной справа от значка. Откроется палитра стандартных кистей.
Она также имеет собственное меню, которое раскрывается щелчком на круглой
кнопке со стрелкой. Команды меню позволяют при желании изменить диаметр
следа кисти (регулятор Master Diameter (Главный диаметр)), сохранить или загрузить
целую палитру кистей, удалить кисть из палитры или воспользоваться одной из
нескольких палитр кистей, входящих в комплект программы Photoshop. Кроме того,
можно создать собственную кисть на основе любой из существующих, для этого
используется появившаяся в Photoshop 7 палитра Brushes (Кисти), представленная
на рис. 17.7. Если она скрыта, выберите команду Window > Brushes (Окно > Кисти) или
нажмите самую правую кнопку на панели настройки инструмента.

Палитра разделена на три части: слева находится список регулируемых настроек,
справа появляются параметры каждой из настройки, а внизу демонстрируется
мазок кистью. Чтобы изменить кисть, при выбранном инструменте рисования
откройте палитру, выберите кисть в списке справа при активном пункте в левой
части палитры Brush Presets (Заданные кисти), далее щелкните на пункте Brush Tip
Shape (Форма следа кисти) и настройте такие параметры, как Spacing (Интервалы между
мазками) — он присутствует у любых кистей, Diameter (Диаметр), Hardness (Жест-
кость), Angle (Угол наклона) и Roundness (Округлость) — для круглых и овальных
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кистей. Для каждого из инструментов, использующих кисть, существует свой набор
доступных кистей, который и отображается в этой, палитре. После изменения кисти
все значения параметров сохраняются, а чтобы вернуть исходные установки, доста-
точно щелкнуть правой кнопкой мыши на панели настройки инструмента на кнопке
со значком кисти и выбрать вариант Reset Tool (Восстановить инструмент).
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Рис. 17.7. Палитра для изменения и настройки кистей

Цвет кисти
Задать цвет рисования очень просто: кисть наносит краску цветом переднего пла-
на, указанным в квадрате Set foreground color (Установить цвет переднего плана), ко-
торый есть на панели инструментов и в палитре Color (Цвет). Щелкните на этом
квадрате — откроется уже знакомое вам диалоговое окно Color Picker (Выбор цвета)
(см. рис. 17.4), которое позволяет установить любой цвет в качестве цвета перед-
него плана.

Режим наложения краски и прозрачность
Для изменения способа наложения краски инструментом Brush (Кисть) предназна-
чен список Mode (Режим), расположенный на панели параметров. Все режимы на-
ложения мы кратко рассмотрели в разделе, посвященном диалоговому окну Fill
(Заполнение). Действие кисти в большинстве из этих режимов сложно предсказать,
поэтому при желании стоит попробовать порисовать в каждом из них. Кроме того,
нужно учесть, что при рисовании на чистом белом или прозрачном холсте разница
в некоторых режимах не будет проявляться заметно.

С помощью поля Opacity (Непрозрачность) можно задать прозрачность накладыва-
емой краски. Этот параметр позволяет организовать легкую «дымку» вокруг объек-
та съемки и создать множество других эффектов, например иллюзию движения.
На рис. 17.8 представлены четыре полосы, нарисованные с разной прозрачностью.
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Для лучшей оценки практического влияния параметра использовалось изображение
с прозрачным фоном и включенной сеткой, которая помогает создать равномерно рас-
положенные штрихи (команда View > Show > Grid (Вид > Показать > Сетка); для при-
вязки к сетке должен быть установлен флажок Snap (Привязка) в меню View (Вид)).
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Рис 17.8. Линии нарисованы с непрозрачностью 100%, 75%, 50% и 25%

ПРИМЕЧАНИЕ
Прозрачностью рисования кистью можно управлять за счет прозрачности слоя, на который
накладывается краска. Слои подробно рассматриваются в главе 20.

Другие параметры
Программа Photoshop позволяет изменять размер, прозрачность и цвет кисти за
несколько шагов. За это в палитре Brushes (Кисти) отвечают настройки Shape Dynamics
(Динамическое изменение формы), Color Dynamics (Динамическое изменение цвета)
и Other Dynamics (Другое динамическое изменение) (слева от названия настройки дол-
жен быть установлен флажок, он ставится щелчком мыши). По умолчанию кисть
рисует одинаково, независимо от количества мазков, и все параметры находятся
в состоянии Off (Выключено) или равны 0%. Соответственно, вы можете с их по-
мощью регулировать динамические свойства кисти, например сделать так, чтобы
за указанное количество мазков размер кисти или непрозрачность изменялись от
исходного значения до нуля, а цвет рисования — от цвета переднего плана до цвета
фона. С помощью этого набора параметров удобно создавать различные декора-
тивные орнаменты.

При установленном флажке Scattering (Разброс) и большем нуля параметре Scatter
(Разброс) при рисовании кистью получается не линия, а наносятся пятна в форме
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следа по полосе, ширина которой равна величине разброса. Настройка Texture
(Текстура) позволяет кистью наносить цвет переднего плана с определенной тексту-
рой. Настройка Dual Brush (Двойная кисть) дает возможность сдваивать разные следы,
что открывает новые просторы в создании уникальных кистей.

В мазки кисти можно включить шум (флажок Noise). Кисти для инструмента Brush
(Кисть) имеют параметр Wet Edges («Мокрые» края). Когда этот флажок установлен,
имитируется рисование акварелью, при котором на краях мазков образуются ма-
ленькие лужицы краски. Если установить флажок Airbrush (Аэрограф), что равно-
сильно нажатию кнопки Set to enable airbrush capabilities (Режим аэрографа) на панели
настройки инструмента, то кисть будет рисовать, как аэрограф (пульверизатор) —
формировать мазки с размытыми краями, которые отличаются мягкостью и легко
смешиваются с любым рисунком. Флажок Smoothing (Сглаживание) отвечает за сглажи-
вание мазков кисти, а при установленном флажке Protect Texture (Защита текстуры)
все кисти, создающие текстурные мазки, будут использовать одну и ту же текстуру,
заданную в параметрах настройки Texture (Текстура).

Инструмент Pencil (Карандаш), по своей сути, не предназначен для рисования в ре-
жиме аэрографа, но у него есть другой флажок: Auto Erase (Автоматическая очистка).
Если последний установлен, карандаш рисует цветом переднего плана, но, попа-
дая на пиксел цвета переднего плана, он использует цвет фона.

Рисование кистью
Процесс рисования очень прост: включите инструмент, нажмите левую кнопку
мыши и проведите указателем мыши, образуя линию. Попробуйте нарисовать пет-
лю и закрасить ее внутреннюю часть. Интересно, не правда ли? Помните, что если
выделена некоторая область изображения, инструмент будет действовать только
внутри нее.

Случается, что штриховая бегущая линия, обрамляющая выделенные области изоб-
ражения, мешает просмотру результатов рисования. Тогда ее можно скрыть, сняв
флажок View > Show > Selection Edges (Вид > Показать > Края выделения) или нажав
клавиши Ctrl+H. Чтобы вернуть рамку на место, требуется установить этот флажок
или нажать то же самое сочетание клавиш. Снять выделение совсем, если оно «пу-
тает карты», можно нажатием клавиш Ctrl+D.

Также при рисовании часто приходится изменять масштаб отображения рисунка,
но в данном случае это удобно делать, не переключая инструменты. Увеличивает
изображение нажатие клавиш Ctrl++, уменьшает — Ctrl+-.

ПРИМЕЧАНИЕ
Чтобы провести прямую линию, нужно всего лишь нажать и удерживать в этом состоянии
клавишу Shift. При этом рисовать отрезки можно щелчками мыши.

Pencil (Карандаш)
Напомним, что карандаш во всем очень похож на кисть, но создает линии с четкими
краями. Если для инструмента Brush (Кисть) и инструмента Pencil (Карандаш) уста-
новить одинаковый след и воспользоваться каждым из них, линии будут отличаться
ровностью границы.



244 Глава 17. Рисование и заливка

Инструменты группы Eraser (Ластик)
Инструменты из этой группы предназначаются для стирания фрагментов изобра-
жения, но их возможности только отчасти напоминают возможности реального
прототипа. Простая стирательная резинка Eraser (Ластик) изменяет цвет всех пиксе-
лов на фоновый, если обрабатывается подложка (слой Background (Фон)), или делает
все пикселы прозрачными, если редактируется обычный слой (не подложка). Тогда
становится видно изображение на нижележащем слое. Слои подробнее рассматри-
ваются в главе 20. Ластик может принимать либо собственную прямоугольную
форму (вариант Block (Квадрат) списка Mode (Режим) на панели настройки инструмен-
та), либо форму одного из трех других инструментов: Pencil (Карандаш), Brush (Кисть)
или кисть в режиме аэрографа (вариант Brush (Кисть) при нажатой кнопке Set to
enable a irbrush capabilities (Режим аэрографа)).

Background Eraser (Фоновый ластик) — это один из нескольких инструментов силуэт-
ного стиля, позволяющих отделять объект на фотографии от окружающего его
фона. Соответственно, лучше всего он работает с контрастными элементами изобра-
жения, например с белым столом, стульями и зонтиком, выставленными во внут-
ренний дворик из темного камня, который возвышается над гладкой поверхностью
моря цвета кобальта. Инструмент действует следующим образом: он запоминает
цвет пиксела, попавшего в перекрестие указателя, и стирает в соответствии со значени-
ем поля Tolerance (Допуск) этот цвет и близкие к нему в области, покрываемой кистью.
В результате образуются прозрачные фрагменты, как показано на рис. 17.9. Есть
еще и побочный эффект: если поработать фоновым ластиком на слое Background
(Фон), последний автоматически преобразуется в обычный слой.
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Рис. 17.9. Инструмент Background Eraser (Фоновый ластик) позволяет создавать прозрачные
области на основном слое изображения
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Попробуйте провести инструмент вдоль контура объекта, чтобы стереть весь фон.
В нашем примере фотографии белой мебели на фоне темного камня можно попы-
таться демонтировать пол и застелить дворик ковровой текстурой. Для этого нуж-
но, активизировав фоновый ластик, навести указатель на пол, нажать кнопку мыши
и провести указатель над требующими стирания пикселами. При этом необходи-
мо следить за тем, чтобы крестик не коснулся белой мебели. Таким образом удаля-
ется весь каменный пол, а на его месте создается прозрачная область, которую за-
тем можно заполнить ковровым орнаментом.

Параметры и поведение обычного ластика и фонового во многом похожи на пара-
метры инструмента Brush (Кисть). Вы вправе задать размер и форму кисти, прозрач-
ность для обычного ластика, а также в тех случаях, где это необходимо, указать
цвет фона или переднего плана и дополнительно определить динамические свой-
ства кисти. Фоновый ластик имеет два дополнительных раскрывающихся списка.
Пункты списка Limits (Границы) в сочетании со значением в поле Tolerance (Допуск)
определяют стираемые пикселы в области, покрываемой кистью: Discontiguous (He-
смежные), Contiguous (Смежные) и Find Edges (Найти края). Элементы списка Sampling
(Взятие образца) задают режим определения цвета, относительно которого стира-
ются пикселы. При установленном варианте Cont inuous ( Н е п р е р ы в н ы й ) , на мой
взгляд, наиболее полезном, образцы цвета непрерывно меняются при движении
указателя мыши, то есть непрерывно обновляется диапазон цвета, предназначен-
ного для удаления. В режиме Once (Единожды) стираемый цвет выбирается в мо-
мент первого щелчка мыши, а в режиме Background Swatch (Образец фона) можно
стирать только те пикселы, которые попадают в диапазон фонового цвета.

Причиной для названия инструмента Magic Eraser (Волшебный ластик) послужило
не наличие у него магических свойств, а поведение, во многом похожее на дей-
ствие инструмента Magic Wand (Волшебная палочка). Его параметры практически
идентичны установкам волшебной палочки. Если использовать волшебную палоч-
ку для удаления цвета, необходимо щелкнуть где-либо на изображении и затем
нажать клавишу Delete. Инструмент Magic Eraser (Волшебный ластик) выполняет обе
задачи посредством одного щелчка мыши. Его удобно применять для очистки боль-
ших более-менее одноцветных областей, например неба, а обработка сложных
многоцветных изображений, скорее всего, потребует нескольких щелчков, и часто
в подобных ситуациях лучше воспользоваться фоновым ластиком.

Инструменты группы Shape (Фигура)
На одной кнопке в панели инструментов располагается шесть инструментов, пред-
назначенных для формирования различных фигур.

Q Инструмент Rectangle (Прямоугольник) выбран по умолчанию. Как нетрудно
догадаться, с его помощью удобно рисовать прямоугольники и квадраты.

Q Инструмент Rounded Rectangle (Закругленный прямоугольник) позволяет создавать
прямоугольники и квадраты с закругленными углами — это дает возможность
смягчить суровую прямоугольную действительность, сопутствующую цифро-
вым изображениям.

Q Инструмент Ellipse (Эллипс) предназначен для получения овалов и окружностей.

Q Инструмент Polygon (Многоугольник) служит для рисования правильных много-
угольников с заданным количеством сторон (рис. 17.10). Чем больше число
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сторон, тем ближе будет многоугольник к окружности. Каждый инструмент
в группе Shape (Фигура) имеет собственную палитру параметров. Ее можно вы-
вести на экран щелчком на маленькой стрелке, которая расположена на панели
настройки инструмента справа от кнопок, включающих инструменты. Палитра
параметров инструмента Polygon (Многоугольник) позволяет закруглить углы
(флажок Smooth Corners (Сгладить углы)), нарисовать звезду с заданным количе-
ством лучей (флажок Star (Звезда) и поле Indent Sides By (Вырезать сторону на)),
скруглить внутренние углы звезды (флажок Smooth Indents (Сгладить вырезы))
и зафиксировать размер фигуры (поле Radius (Радиус)).

{«Adobe Photoshop
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Рис. 17.10. Установка флажкрв в палитре параметров инструмента Polygon (Многоугольник)
позволяет создавать такие замечательные фигуры

Q По поводу инструмента Liпе (Линия) можно сказать немного: с его помощью мож-
но рисовать прямые линии (то же самое умеют инструменты Brush (Кисть) и Pencil
(Карандаш)) и линии со стрелками на концах. Преимущество линии, нарисован-
ной таким образом, состоит в том, что она является векторным объектом, то есть
при любом увеличении имеет более четкие края, чем растровая линия, пока слой
с фигурой не будет преобразован из векторного в растровый, это автоматически
происходит, например, при объединении слоев. Подробнее об особенностях слоев
с векторными объектами рассказано в главе 19 при описании текста в Photoshop.

ПРИМЕЧАНИЕ
Программа Photoshop в принципе предназначена для обработки и создания растровых изобра-
жений, но в ней есть несколько векторных элементов. Это фигуры, располагающиеся на спе-
циальных слоях, текст и контуры. Векторная природа позволяет безболезненно преобразовы-
вать размеры этих объектов неограниченное количество раз, что недопустимо делать
с растровыми объектами. Слои с фигурами, по своей сути, очень похожи на текстовые слои,
и поскольку тексту посвящена отдельная глава, большинство особенностей, связанных с век-
торными свойствами, я не рассматриваю здесь подробно и отсылаю читателя к главе 19.
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Q Инструмент Custom Shape (Произвольная фигура) предоставляет на ваш выбор
множество различных форм — смена рисуемой фигуры осуществляется в рас-
крывающейся палитре Shape (Фигура) (кнопка на панели настройки инструмен-
та). Установив Photoshop, вы можете обнаружить, что такие фигуры отсутству-
ют. Это легко исправить, загрузив файл Custom Shapes.csh через меню палитры
Shape (Фигура). Кроме того, вы сами можете создавать фигуры любой формы.
Один из способов: включить в изображение стандартную фигуру (или несколь-
ко), видоизменить ее с помощью команды Free Transform Path (Свободная транс-
формация) контекстного меню, открывающегося нажатием правой кнопки мыши,
когда указатель наведен на фигуру, и сохранить ее в качестве произвольной
фигуры с помощью команды Define Custom Shape (Определить произвольную фигу-
ру) того же контекстного меню. Другой способ подразумевает использование
инструмента Реп (Ручка): требуется нарисовать фигуру любых очертаний этим
инструментом, а затем выбрать команду Edit > Define Custom Shape (Редактиро-
вание > Определить произвольную фигуру).

Инструменты группы Shape (Фигура) имеют довольно много различных парамет-
ров, помимо уже упомянутых здесь. При первом нажатии на кнопку Shape (Фигура)
на панели параметров инструмента появляются три кнопки, определяющие режим
формирования фигуры.

Во-первых, фигуры можно рисовать на специальных слоях — при активной пер-
вой кнопке, называющейся Shape Layers (Слои фигур). В этом случае требуется опре-
делить параметры Layer Style (Стиль слоя), Mode (Режим наложения) и Opacity (Не-
прозрачность), и для каждой фигуры будет создан отдельный слой, который потом
можно будет переместить, удалить, поменять местами с другим слоем и т. д, кроме
того, к каждой фигуре допустимо применить свой режим смешивания и стиль слоя.
Подробнее слои рассматриваются в главе 20, а стили слоев — в главе 19.

При активной второй кнопке Paths (Контуры) каждый из инструментов создает соб-
ственную фигуру, которая является всего лишь контуром, добавляющимся в па-
литру Paths (Контуры) в качестве рабочего контура. Подробное рассмотрение кон-
туров, к сожалению, выходит за пределы нашей книги, здесь же необходимо сказать,
что контур, как уже упоминалось, является векторным объектом; для работы с кон-
турами предназначены инструменты группы Реп (Ручка) и палитра Paths (Контуры);
форму контура можно изменять самыми различными способами с помощью инст-
рументов группы Реп (Ручка) и свободной трансформации, а кроме того, контуры
допускается преобразовывать в обычные выделения и заполнять цветом или тек-
стурой с помощью диалогового окна Fill (Заполнение).

Проще всего понять, как работает инструмент, включив третью кнопку Fill pixels
(Создать заполненную область). Этот режим полностью соответствует своему назва-
нию: вы выбираете инструмент, рисуете фигуру и получаете область, ограничен-
ную силуэтом фигуры и заполненную цветом переднего плана. Как и для различ-
ных видов рисования, здесь требуется задать режим наложения краски и процент
прозрачности. В этом случае фигура является растровым объектом и становится
частью слоя, на котором ее нарисовали.

Далее в режиме формирования контуров после создания первой фигуры появля-
ются четыре кнопки, определяющие, каким образом новые фигуры добавляются
к уже нарисованным. Если помните, точно такие же режимы устанавливались для
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инструментов выделения (см. главу 16). Как действует какой-либо из инструмен-
тов, нетрудно понять по значкам на кнопках: в первом случае фигуры объединя-
ются; во втором видимой остается та часть первой фигуры, которая не входит во
вторую; в третьем результатом является пересечение двух фигур, а в четвертом —
все за исключением пересечения.
Одним из наиболее интересных параметров при создании фигур на специальных
слоях является уже упоминавшаяся палитра Layer Style (Стиль слоя). Обязательно
попробуйте открыть палитру щелчком на стрелке" вниз, порисовать в каждом из
стандартных стилей, а также с помощью меню, раскрывающегося щелчком на круг-
лой кнопке со стрелкой, загрузить другие каталоги стилей (их список расположен
в нижней части меню). Исследование стилей настолько увлекательно, что может
отнять часы, но наверняка у вас появится масса новых идей!

Инструменты History Brush
(Восстанавливающая кисть) и Art History
Brush (Художественная кисть)
Инструмент History Brush (Восстанавливающая кисть) во многом похож на обычную
кисть. Эта кисть может изменять размер, непрозрачность и накладывать данные
в соответствии с выбранным режимом рисования, но источником рисуемой инфор-
мации служит палитра History (История). Таким образом, мазки восстанавливаю-
щей кисти позволяют вернуть определенную область изображения к одному из
предыдущих его состояний, которое выбирается достаточно просто. В палитре
History (История) слева есть столбец с пустыми квадратиками. Если щелкнуть на
таком квадратике, в нем появится значок инструмента History Brush (Восстанавли-
вающая кисть), а соответствующее состояние становится источником данных для
самого инструмента. Теперь можно им рисовать, как обычной кистью.

Другой вариант кисти назван Art History Brush (Художественная кисть). Она смазыва-
ет пикселы, получаемые из предыдущего состояния, имитируя живопись импрес-
сионистов. Учтите, что обработанное этой кистью изображение способно выгля-
деть очень эффектно, но достоверность будет потеряна, если одним из его объектов
является автомобиль или, например, микроволновая печь.

Следует запомнить
а Выделенную область можно закрасить каким-либо цветом или заполнить тек-

стурой.

Q Градиентная заливка позволяет изменить изображение целиком или только
предварительно выделенный фрагмент.

Q Вы можете рисовать с помощью инструментов Paintbrush (Кисть), Pencil (Карандаш)
и создавать различные фигуры, пользуясь инструментами группы Shape (Фигура).

Q Электронный ластик, в отличие от обычного, не ограничен в функционально-
сти только стиранием части изображения.

О Все инструменты, описанные в данной главе, имеют несколько параметров.
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Ретушь фотографий

а Использование инструмента Clone Stamp (Клонирование)

Q Удаление нежелательных элементов

Q Копирование фрагментов из одного изображения в другое

Q Инструмент Pattern Stamp (Узорный штамп)

Q Инструменты Healing Brush (Лечебная кисть) и Patch (Заплатка)

О Фильтр Dust and Scratches (Пыль и царапины)

На мой взгляд, инструмент Clone Stamp (Клонирование) всегда являлся одним из
наиболее полезных и универсальных орудий в арсенале инструментов Photoshop,
хотя теперь его потеснили и отчасти заменили новые средства Healing Brush (Лечебная
кисть) и Patch (Заплатка), специально предназначенные для ретуши. Этот волшебный
инструмент позволяет копировать «хорошие» пикселы и-заменять ими «плохие»,
что дает возможность легко удалять с фотографий царапины, пылинки и другие
досадные дефекты, появляющиеся как в процессе съемки, так и при проявке плен-
ки, печати снимков и сканировании. С его помощью можно даже удалять (факти-
чески, замазывать) нежелательные элементы, например здания с морского побе-
режья или провода из фотографии парка, причем детали могут быть подчищены
настолько незаметно, что никто не сумеет обнаружить даже сам факт изменения
изображения. Этот инструмент настолько важен для обработки фотографий и при-
носит столько пользы, что ему было решено посвятить отдельную главу книги.

Начало работы
В стандартном режиме инструмент Clone Stamp (Клонирование) рисует не одним
цветом, а целыми областями смежных пикселов. Такие области часто берутся из
того же самого изображения, но можно пользоваться наборами пикселов и из дру-
гих открытых файлов.
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Активизируется инструмент нажатием одноименной кнопки на панели инструмен-
тов или нажатием клавиши S. Под той же кнопкой скрывается и второй инстру-
мент: Pattern Stamp (Узорный штамп), работающий с произвольными образцами. Его
можно вызвать, если щелкнуть на кнопке инструмента правой кнопкой мыши или
нажать сочетание клавиш Shift+S. Мы сначала рассмотрим клонирование, а потом
вернемся к варианту с образцами.

При включении инструмента все его параметры появляются на панели настроек.
Для обоих штампов можно определить кисть точно так же, как для инструментов
рисования, которые описывались в предыдущей главе. Я обычно выбираю кисть
достаточно большого размера — 45,65 или 100 пикселов, хотя это, конечно, зависит
от поставленной задачи. Поэтому в данном случае очень удобно, что указатель
может принимать форму используемого следа кисти — становятся видны его конту-
ры и легко определяется покрываемая кистью область. Если указатель не отобра-
жает форму кисти, выполните команду Edit > Preferences > Display & Cursors (Редакти-
рование > Установки > Отображение и курсоры) и в открывшемся диалоговом окне
в ce'KUHH'Painting Cursors (Рисующие курсоры) установите переключатель в положение
Brush Size (Размер кисти). Помните, вы уже выполняли эту процедуру, настраивая
инструмент Paintbrush (Кисть) (см. главу 17)?

Удаление нежелательных фрагментов
изображения
Рассмотрим работу инструмента Clone Stamp (Клонирование) на конкретном при-
мере. Откройте изображение с дефектами — это могут быть, например, царапины,
провода линий электропередач, не вписывающиеся в снимок изумительного зака-
та, совершенно лишние здания на заднем плане фотографии, палец или часть чьей-
то половы, случайно попавшие в кадр. Теперь попробуем вместе избавиться от этих
проблем.

ПРИМЕЧАНИЕ
Не забывайте о том, что изображение стоит периодически сохранять, особенно после вы-
полнения ряда-сложных операций, например многошагового клонирования. Ведь палитра
History (История) записывает только ограниченное количество действий (по умолчанию 20),
которое легко превысить как при работе любым рисующим инструментом, так и при исполь-
зовании клонирования, поскольку каждый мазок кистью означает ровно одно действие. Тогда,
если в какой-то момент потребуется вернуться к некоторому промежуточному состоянию,
вы, возможно, огорчитесь — его может уже не оказаться в палитре History (История), и вам
придется перейти к последнему сохраненному состоянию. Поэтому стоит сохранять изобра-
жение после выполнения особенно важных этапов работы. Кроме того, если файл имеет
небольшой размер, стоит увеличить количество запоминаемых состояний. Нажмите клави-
ши Ctrl+K и измените число в поле History States (Состояния истории).

1. Если требуется, откорректируйте изображение, при этом обязательно исправь-
те все геометрические искажения. Перед использованием клонирования сни-
мок должен выглядеть максимально хорошо с точки зрения композиции, цве-
тового баланса и т. д.

2. Увеличьте масштаб отображения фотографии на экране. Вы должны во всех
подробностях видеть дефекты, а также окружающие их нормальные фрагменты
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изображения. При этом необязательно, чтобы все изъяны одновременно и це-
ликом поместились на экране.

3. Щелкните на кнопке Clone Stamp (Клонирование) на панели инструментов или
нажмите клавишу S. Если активизировался Pattern Stamp (Узорный штамп), пото-
му что в последний раз вы работали именно им, нажмите клавиши Shift+S. Па-
нель настройки инструмента, изображенная на рис. 18.1, позволяет выбрать след
кисти, режим наложения пикселов, прозрачность и т. д.

ГГЭ|
• . ' .

Рис. 18.1. Панель настроек инструмента Clone Stamp (Клонирование)

ПРИМЕЧАНИЕ -
При клонировании областей изображения инструментом Clone Stamp (Клонирование), как
и при работе с любым инструментом рисования (см. главу 17), вы будете использовать кисть.
На панели настройки инструмента расположена раскрывающаяся палитра Brush (Кисть),
предназначенная для выбора формы кисти, кроме того программа предоставляет в наше
распоряжение отдельную палитру Brushes (Кисти), предназначенную для установки раз-
личных свойств существующих кистей и создания новых инструментов. Эту палитру мы по-
дробно рассмотрели в главе 17. Одни кисти имеют резкие края, другие — размытые, последние
оставляют мягкие, полупрозрачные мазки, которые прекрасно накладываются на существую-
щее изображение и потому отлично подходят для клонирования. Необычная форма некото-
рых кистей, как правило, находит применение в создании интересных эффектов, а не при
коррекции снимков.

4. Откройте палитру Brushes (Кисть), щелкнув на кнопке со стрелкой вниз, и выбе-
рите из стандартного набора кистей круглый след размером 35 пикселов с мягки-
ми краями (он должен быть тринадцатым по счету). Теперь следует определить
данные для серийного копирования фрагментов, то есть для клонирования.
Подведите указатель к области, которую имеет смысл использовать для закраши-
вания нежелательного объекта, нажмите клавишу Alt и щелкните — инструмент
запомнит, какие пикселы ему следует копировать. Если требуется, например,
закрасить провода окружающей их листвой деревьев, то необходимые пикселы
для штампа следует брать из листвы или с неба, как показано на рис. 18.2. Для
царапин, как правило, подходят любые близлежащие фрагменты изображения.
Убедитесь, что установлен флажок Aligned (Выравнивание). В этом случае в'момент
наложения первого отпечатка на изображение образуется выравнивающая связь,
которая будет активна до тех пор, пока вы не выберете другой источник для
клонирования.

5. Теперь подведите указатель мыши к фрагменту, который требуется закрасить
копируемыми пикселами. Если дефект имеет небольшой размер и полностью за-
крывается кистью, щелкните один раз, и пикселы из области-источника вставят-
ся поверх исходных. Если же дефект не закрашивается одним мазком, нанесите
еще несколько. При этом можно не только подводить указатель и щелкать, но
и «рисовать» мышью, держа нажатой кнопку и проводя указателем по изображению.

6. Если для реалистичного удаления объекта требуется скопировать еще какую-
нибудь часть снимка, повторите шаги 4 и 5.

7. Закончив работу, сохраните изображение. Ваш результат должен быть подобен
полученному на рис. 18.2. В качестве примера мы взяли фрагмент фотографии
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берега озера, в котором есть неудачные области: провода на фоне неба и здания.
Этот фрагмент показан на рис. 18.2 слева. Справа — увеличенный фрагмент ча-
стично обработанного изображения с почти скрытым светлым проводом. Внизу
представлен снимок, полностью исправленный с помощью инструмента Clone
Stamp (Клонирование).

Рис. 18.2. Пример удаления с фотографии нежелательных объектов с помощью инструмента
Clone Stamp (Клонирование)

ПРИМЕЧАНИЕ
В процессе рисования инструментом Clone Stamp (Клонирование) на экране присутствует
небольшой крестик. Это второй указатель, который соответствует центральному пикселу
копируемой области. В случае если установлен флажок Aligned (Выравнивание), после пер-
вого мазка крестик не меняет своего положения относительно кисти до тех пор, пока не
будет выбран новый источник клонирования (для этого нужно нажать клавишу Alt и щелк-
нуть). Если же флажок снят, то связь не сохраняется, и каждым мазком мыши вы будете
копировать все ту же одну область, пока не будет выбран новый источник клонирования.
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Это не совсем простой инструмент, и чтобы научиться добиваться требуемых
результатов с его помощью, необходимо немного попрактиковаться. По моему
мнению, рисование штампом является высокоуровневым тестом на взаимную
координацию глаз, руки и указателя мыши. Достаточно удобно вместо мыши исполь-
зовать планшет. Это устройство воспринимает степень нажатия при рисовании
и соответственно регулирует прозрачность кисти, то есть чем сильнее вы нажимаете
на перо планшета, тем больше краски накладывается на экране, а в терминах Photo-
shop — тем непрозрачней становится мазок.

Я иногда бессмысленно терял время, рисуя штампом, поскольку забывал, какие
фрагменты выделены в данный момент, а какие — нет. Если попытаться изменить
изображение за пределами активной выделенной области, ничего не произойдет!
Чтобы понять, что же сейчас выделено, я обычно уменьшаю масштаб отображения
фотографии. Если видны внешние границы (снимок окружает штриховая мигаю-
щая рамка), значит, выделена внешняя часть изображения, и если требуется нари-
совать что-то во внутренних фрагментах, нужно инвертировать выделение коман-
дой Select > Inverse (Выделение > Инвертировать). Это может Понадобиться, если,
например, необходимо изменить листву дерева, сохранив небо.

А когда изображение состоит из нескольких слоев, стоит обратить внимание на
флажок Use All Layers (Использовать все слои) на панели настройки инструмента.
При снятом флажке новые оттиски будут вставляться только на активный слой, и,
удалив слой, можно ликвидировать все последствия рисования — это еще один
удобный способ отмены изменений. Если же требуется, чтобы клонируемые обла-
сти размножались по всем слоям изображения, этот флажок следует установить.

СОВЕТ
Исправляя с помощью техники Clone Stamp большие области изображения, желательно пе-
риодически менять область-источник. Самыми сложными для реставрации являются облас-
ти с плавным переходом цветов, хотя теперь, при наличии инструментов Healing Brush (Ле-
чебная кисть) и Patch (Заплатка), эта процедура значительно упростилась. Но в некоторых
ситуациях все же удобнее работать штампом. В подобных случаях старайтесь наносить маз-
ки щелчками мыши, а не ее протягиванием, тогда мазки будут менее заметны, и почаще
меняйте кисти. Клонируйте области, находящиеся вокруг уничтожаемого объекта, и щел-
кайте прямо над объектом, при этом наилучшим образом подбирая соответствие источника
клонирования и целевого фрагмента. При необходимости увеличивайте масштаб изображе-
ния и аккуратно закрашивайте пиксел за пикселом. Не спешите итне старайтесь как можно
быстрее закончить работу — плохо выполненное клонирование легко заметить. Уделите
время тщательной обработке снимка, и тогда, приобретя некоторый опыт, вы сможете очи-
стить свои фотографии практически от любых дефектов и лишних элементов.

Клонирование из одного изображения
в другое
Точно так же, как вы переносили область из одной части снимка в другую, с помощью
инструмента Clone Stamp (Клонирование) можно копировать фрагменты из одного
изображения в другое. Взгляните на снимок, продемонстрированный слева
на рис. 18.3. Здесь мужчина, расположенный почти в центре фотографии, нарушает
композицию и делает снимок неинтересным. Я избавлюсь от него, скопировав закры-
ваемую им часть пристани с лодкой с другой фотографии, сделанной мгновением
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позже. Исправить иначе снимок никак нельзя — или клонирование будет заметно,
или придется вместе с мужчиной стереть всю пристань, но тогда изображение ста-
нет неинтересным, и процедура потеряет смысл. При этом для моих целей удобно
будет создать слой и на него вставить клонируемые области, чтобы потом иметь
возможность изменить их размер, выполнить геометрическую трансформацию
и переместить по изображению.

Итак, я собираюсь перенести часть пристани, окружающую ее воду и часть берега
из центрального в левый снимок, чтобы получить изображение, представленное
справа. Следя за моими действиями, попробуйте аналогичным образом удалить
объект с какого-либо из своих снимков.

Рис. 18.3. Используя инструмент Clone Stamp (Клонирование) и второй снимок,
я удалил попавшего в кадр мужчину

1. Откройте изображение, куда будут копироваться области. В моем случае это
снимок слева, назовем его изображением А.

2. Создайте новый слой, выполнив команду Layer > New > Layer (Слой > Создать > Слой).

3. Активируйте инструмент Clone Stamp (Клонирование).

4. Откройте второе изображение, содержащее источник для клонирования — это
центральный снимок, назовем его изображением Б.

5. При активном изображении Б подведите указатель к области, которую требу-
ется перенести в изображение А, нажмите клавишу Alt и щелкните.

6. Переключитесь в изображение А, щелкнув на заголовке его окна или, если по-
следнего не видно, выбрав название изображения в подменю Window > Documents
(Окно > Документы), и начинайте, как обычно, рисовать инструментом Clone Stamp
(Клонирование). Он переносит фрагменты на созданный вами новый слой, ко-
торый затем можно дополнительно обработать. За информацией о том, как это
сделать, обращайтесь к главе 20, посвященной слоям и их использованию.

Инструмент Pattern Stamp (Узорный штамп)
Иногда требуется заполнить некоторую часть изображения какой-нибудь тексту-
рой. Можно, конечно, выделить область и затем залить ее текстурой с помощью
команды Fill (Заполнение), но иногда удобнее выполнить данную операцию инст-
рументом Pattern Stamp (Узорный штамп). Напоминаю, что если до этого момента
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работа велась клонирующим штампом, включить узорный можно двумя способа-
ми: нажать сочетание клавиш Shift+S или подвести указатель к кнопке инструмен-,
та, щелкнуть правой кнопкой мыши или нажать и не отпускать какое-то время
левую и выбрать в раскрывшемся меню нужный вариант. Узорный штамп имеет
свою собственную настройку, которая появляется на панели настроек при его акти-
визации: раскрывающуюся палитру Pattern (Образец). Мы рассматривали такую же
палитру при обсуждении команды Fill (Заполнение) (см. главу 17). Выберите тексту-
ру и начинайте рисовать. Если среди стандартных текстур и в дополнительных
наборах, которые можно загрузить с помощью меню палитры (щелкните на круглой
кнопке со стрелкой), нет подходящих, программа позволяет определить в качестве
текстуры любой прямоугольный фрагмент изображения. Для этого выделите прямо-
угольную область и выполните команду Edit > Define Pattern (Редактирование > Опре-
делить образец).

Изображение, представленное на рис. 18.4, получено следующим образом. С по-
мощью инструмента Elliptical Marquee (Эллиптическое выделение) на фотографии были
выделены девочки, затем выделение обратили с помощью комамДы Select* -Inverse
(Выделение > Инвертировать). После этого в области, внешней по отношению к изобра-
жению девочек, инструментом Pattern Stamp (Узорный штамп) была нарисована тексту-
ра и, чтобы придать рамке необычный вид, ее обработали фильтром Chalk & Charcoal
(Мел и уголь) (команда Filter > Sketch > Chalk & Charcoal (Фильтр > Эскиз > Мел и уголь)).
На последнем шаге рабочая область была опять инвертирована — чтобы выделен-
ными оказались девочки, из выделенной области был создан слой командой Layer >
New > Layer via Copy (Слой > Создать > Слой через копирование) и к нему применили
один из эффектов слоев, чтобы получить эффект углубления (команда Layer > Layer
Style > Inner Shadow (Слой > Стиль слоя > Внутренняя тень)). В результате получилось
уникальное изображение, ради которого девочки наверняка стали бы прыгать
вокруг вас. Попробуйте сделать что-либо подобное с одной из своих фотографий.

Ч Т )

Рис. 18.4. Здесь с помощью инструмента Pattern Stamp (Узорный штамп) была создана
декоративная рамка

Инструменты Healing Brush (Лечебная
кисть) и Patch (Заплатка)
Они располагаются на одной кнопке в панели инструментов, рядом с кистью, и вызы-
ваются клавишей 3. Появление этих «умных» инструментов вызвало чувство ра-
дости — настолько они облегчают трудоемкие задачи ретуши, требующие точности
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и немалой усидчивости. Особую пользу они приносят там, где довольно сложно
работать штампом: в областях с плавным переходом цветов, наиболее часто встре-
чающимся примером которых служит небо.

Применяется инструмент Heal ing Brush (Лечебная кисть) практически так же, как
Clone Stamp (Клонирование). После установки кисти подходящего размера вам тре-
буется нажать клавишу Alt и щелкнуть на участке изображения без дефектов —
создать область-источник, причем она необязательно должна абсолютно точно со-
впадать по цвету с областью вставки, — а затем зарисовывать ненужные элементы:
царапины, провода и т. д. мазками кисти. Программа выявляет дефекты под нане-
сенным мазком, закрашивает дефекты, но сохраняет исходные цвет и текстуру,
которые удалило бы клонирование. У лечебной кисти, как и у штампа, есть фла-
жок Aligned (Выравнивание) , но закрашивать ею дефекты на относительно одно-
родном фоне удобнее при снятом флажке, поскольку плавные изменения тонов
отслеживаются автоматически.

Действие инструмента Patch (Заплатка) похоже на работу лечебной кисти. Вы как
обычным лассо выделяете область-заплатку, затем путем перетаскивания накла-
дываете ее на «дырку» — область с каким-либо дефектом, и заплатка сливается
с исходным изображением, удаляя дефект и сохраняя исходные цвета и текстуру.
Например, если ваш фотоаппарат имеет режим отображения текущей даты и вре-
мени, и вы снимали в этом режиме, в углу каждого снимка появятся цифры. Одна
из фотографий получилась очень хорошо, вы хотите напечатать ее и вставить
в рамку, но для этого желательно стереть дату. И здесь вам поможет инструмент
Patch (Заплатка).

Удаление пятен фильтром Dust
and Scratches (Пыль и царапины)
Часто на фотографиях — особенно это касается кадров, снятых на пленку, проявлен-
ных и отпечатанных в фотолабораториях и затем отсканированных, — появляется
множество мелких дефектов: точки, царапины, нежелательный блеск в глазах и т. д.
Удалять их с помощью клонирования было бы процессом, ощутимо растянутым
по времени, но тем не менее, на мой взгляд, в большинстве случаев стоит не торопить-
ся и потратить время на методичную обработку снимка. Но можно попробовать
устранить все мелкие недостатки за один шаг — иногда это приносит вполне достой-
ные плоды. Для удаления пылинок и царапин программа Photoshop предоставляет
фильтр Dust and Scratches ( П ы л ь и царапины). Лучше всего для демонстрации работы
фильтра подойдет старый отсканированный снимок, возможно, даже черно-белый.
Откройте изображение и увеличьте масштаб, приблизив фрагмент, содержащий
дефекты. Как вы увидите в дальнейшем, фильтр, удаляя пылинки, немного размывает
изображение, поэтому, исходя из собственного опыта, я советую применять его
к выделенной области, как показано на рис. 18.5, а не ко всему снимку.

Выполните следующие действия.

1. Выделите в открытом изображении проблемные области. Это можно сделать
с помощью инструментов группы Marquee (Выделение), Lasso (Лассо), Magic Wand
(Волшебная палочка) или режима Quick Mask (Быстрая маска).
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Рис. 18.5. В диалоговом окне фильтра Dust and Scratches (Пыль и царапины)
флажок Preview (Предварительный просмотр) снят специально,

чтобы продемонстрировать дефекты исходного снимка

2. Выполните команду Filter > Noise > Dust and Scratches (Фильтр > Шум > П ы л ь и ца-
р а п и н ы ) . Появится диалоговое окно, изображенное на рис. 18.5, в котором мож-
но задать радиус (регулятор и поле Radius (Радиус)) и пороговую величину (ре-
гулятор и поле Threshold (Порог)) для коррекции.

3. При настройке параметров фильтра следует контролировать его воздействие
на изображение. Для этого, во-первых, нужно установить флажок Preview (П ред-
варительный просмотр) — тогда результат действия фильтра будет более очеви-
ден, но при обработке больших фрагментов файлов большого размера умень-
шится быстродействие. Во-вторых, не стоит забывать об окне предварительного
просмотра самого диалогового окна. Если корректируется фрагмент, который
помещается целиком в окне предварительного просмотра, то просматриваемую
область можно переместить одним из двух способов. Наведите указатель на окно
предварительного просмотра — он примет вид ладони, нажмите кнопку мыши
и перетащите изображение. Или же в основном окне изображения подведите
указатель (он имеет вид квадратика) к интересующей области и щелкните.
Масштаб изображения в окне предварительного просмотра можно уменьшать
и увеличивать с помощью кнопок со значками + и -.

4. Обратившись к методу проб и ошибок, подберите подходящие значения пара-
метров Radius (Радиус) и Threshold (Порог). Фильтр работает так: в области, опре-
деленной радиусом, он ищет пикселы, отличающиеся по яркости от соседних
на пороговую величину, и заливает их цветом соседних пикселов. Чем меньше
порог и больше радиус, тем сильнее размывается изображение.

5. Получив удовлетворительные результаты, примените фильтр, нажав кнопку О К.
Теперь при необходимости можно выделить другую часть снимка и повторить
процедуру.
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Еще раз напоминаю, что фильтр лучше применять к небольшой выделенной обла-
сти, а не ко всему изображению. Во-первых, тогда сохранится резкость в необрабо-
танных фильтром частях снимка. Во-вторых, параметры, превосходно сработав-
шие для одного дефекта, не всегда позволяют удалить другой.

Следует запомнить
Q С помощью инструмента Clone Stamp (Клонирование) можно копировать или

перемещать фрагменты изображения.

Q Клонирование осуществляется с различной степенью прозрачности.

а Программа позволяет клонировать части одного изображения в другое.

Q Чтобы скрыть факт клонирования, следует иногда менять области-источники
и кисти.

Q Инструмент Pattern Stamp (Узорный штамп) позволяет рисовать текстурными
плитками.

Q А уменьшить количество пятен и царапин можно с помощью фильтра Dust and
Scratches (Пыль и царапины).



Глава 19

Средства для работы с текстом

а Включение текста в фотографии
а Маленькие секреты
а Добавление тени
а Добавление свечения
а Как создать прозрачный текст

Вы можете захотеть написать что-то на изображении или рядом с ним, чтобы, напри-
мер, создать поздравительную открытку или календарь. Текст также используется
при формировании логотипов, кнопок и баннеров, которые располагаются на веб-стра-
ницах, для подписей и пояснений к фотографиям, смешных надписей или плакатов.
Программа Photoshop предоставляет в ваше распоряжение усовершенствованные
инструменты группы Туре (Текст), позволяющие добавлять надписи к изображениям.

Вставка текста
Если вы собираетесь добавить текст к изображению, в любом случае сначала требует-
ся открыть последнее в программе Photoshop. Но при желании сначала можно изучить
особенности отображения текста на чистом белом фоне. Для этого требуется создать
новое изображение нажатием клавиш Ctrl+N или выбором команды File > New (Файл >
Создать). Затем нажмите на кнопку Horisontal Type (Горизонтальный текст) на панели
инструментов (значок «Т»), чтобы активировать одноименный инструмент. Панель
настройки инструмента примет вид, представленный на рис. 19.1, но некоторые пара-
метры станут доступны только тогда, когда вы начнете вводить символы с клавиатуры.

СОВЕТ
Попробуйте запомнить клавиатурные комбинации, вызывающие ваши самые любимые ин-
струменты — поверьте, результат оправдает потраченные усилия. Вам не придется отры-
ваться от работы и отодвигать указатель мыши от изображения, чтобы переключить инст-
рументы. Инструмент Туре (Текст) вызывается клавишей Т.
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И!
Рис. 19.1. Панель настройки инструментов группы Туре (Текст)

Удерживая кнопку Туре (Текст) некоторое время или щелкнув на ней правой кноп-
кой мыши, можно вызвать меню, позволяющее выбрать одну из разновидностей
инструмента. К ним относятся ввод вертикально ориентированного текста и по-
строение вместо текстового слоя выделенной области (при этом текст вводится
в режиме Quick mask (Быстрая маска), о котором рассказывалось в главе 16).

Легко понять, что представляет собой вертикальный текст. В этом режиме симво-
лы располагаются в вертикальном направлении, как будто каждая буква печатает-
ся с новой строки.

Объяснить разницу между текстовым слоем и текстовой маской несколько слож-
нее. В режиме, устанавливаемом по умолчанию, буквы помещаются на специаль-
ный текстовый слой, на котором в дальнейшем текст может быть отредактирован,
при этом допускается не только изменение букв, но также шрифта и цвета. Кроме
того, к текстовому слою применимы практически все операции, доступные для
обычных слоев: перемещение, трансформирование, применение слоевых эффек-
тов и режимов наложения, а также любые корректировки цвета и фильтры — пос-
ле растеризации текста (об этом процессе будет рассказано далее). Работу с обыч-
ными слоями мы рассмотрим в главе 20. В режиме Type Mask (Маска текста) создается
выделенная область, имеющая форму введенного текста. К ней, так же как и к лю-
бой выделенной области, можно применить эффекты и фильтры, ее можно скопи-
ровать, переместить, трансформировать и т. д.

Сейчас мы подробнее рассмотрим ввод текста в обычном режиме, а к инструменту
Type Mask (Маска текста) вернемся позже. Чтобы добавить текст к изображению,
выполните следующее.

1. Активизируйте инструмент, нажав на кнопку со значком «Т» на панели инст-
рументов. Слева на панели настроек расположена кнопка, позволяющая менять
ориентацию текста. Правее от нее находятся два раскрывающихся списка: пер-
вый список предназначается для выбора шрифта, второй — для выбора стиля
начертания. Как правило, это обычное начертание, курсив, полужирное и полу-
жирный курсив, но у некоторых из шрифтов часть стилей отсутствует. Третий
список служит для определения кегля шрифта. Задайте все три параметра.

2. Четвертый список определяет метод сглаживания. Значение None (Нет) означа-
ет отключение этой возможности, три других варианта приводят к разной сте-
пени сглаживания границ символов. Чтобы увидеть разницу начертаний букв
в каждом из случаев, увеличьте изображение так, чтобы были заметны отдель-
ные пикселы (клавиши Ctrl++, установите масштаб больше 100%), установите
большой кегль шрифта, напечатайте что-нибудь и выберите по очереди каж-
дый пункт списка. Для варианта None (Нет) все наклонные и изогнутые края
символов будут ступенчатыми, а для каждого из видов сглаживания программа
смешивает цвет на границе символов с фоном таким образом, что человеческо-
му глазу границы кажутся гладкими. Вариант None (Нет) чаще используется
для маленьких по размеру символов — они могут оказаться излишне размыты-
ми, в остальных случаях предпочтение обычно отдается сглаженным символам.
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3. С помощью трех кнопок, расположенных после списков, задайте выравнива-
ние будущего абзаца: по левому краю, по центру или по правому краю. Это име-
ет значение, если вы собираетесь вводить несколько строк.

4. Далее следует кнопка для выбора цвета текста. Текст всегда отображается цве-
том переднего плана, соответственно его цвет можно также установить, щелк-
нув на квадрате Set foreground color (Установить цвет переднего плана), присут-
ствующем как на панели инструментов, так и в палитре Color (Цвет). В результате
щелчка на любом из трех упомянутых элементов откроется диалоговое окно
Color Picker (Выбор цвета), с которым мы уже сталкивались, выбирая цвет для
инструментов рисования и заливки (см. главу 17). Установите цвет текста. Если
вы готовите изображение для размещения в Интернете, имеет смысл выбрать
цвет из палитры веб-цветов. Для этого нужно установить флажок Only Web Colors
(Только веб-цвета)1.

5. Предпоследняя кнопка на панели параметров (Create wrapped text (Создать изо-
гнутый текст)) позволяет перейти в режим геометрической деформации текста.
Можно создать выпуклый или вогнутый абрис, изогнуть текст волной или рас-
положить надпись по дуге окружности. Последняя кнопка предназначена для
вызова двух палитр, управляющих отображением текста. Они содержат точно
такие же, как на панели настройки, списки для выбора шрифта и его размера,
дополнительные параметры шрифта, кнопки для определения выравнивания
абзаца и несколько других настроек.

6. Теперь переместите указатель в область изображения и обратите внимание на
то, что он изменил свой вид — стал похож на раскрытую книгу. Щелкните на
любом месте изображения. На экране появится стандартный текстовый кур-
сор: вертикальная (для горизонтального текста) мигающая линия, высота ко-
торой соответствует заданному кеглю шрифта. Введите текст.

7. Выделите весь введенный текст или некоторую его часть. Это можно сделать
мышью: нажать кнопку и провести мышь от первого до последнего символа;
нажав сочетание клавиш Ctrl+A, трижды щелкнув на тексте или дважды щелк-
нув на значке «Т» в палитре Layers (Слои). Все изменения параметров, сделан-
ные на панели настроек, будут сказываться на выделенном тексте. Попробуйте
поменять шрифт с помощью первого раскрывающегося списка.

При сохранении изображения для размещения в Интернете важнейшее значение имеет размер фай-
ла. Все изображения, которые встречаются на веб-страницах, упрощенно можно разделить на фото-
графии и логотипы. Фотография — это полноцветное изображение с непрерывным фоном, логоти-
пом называют изображение с текстом, содержащее ограниченное количество цветов. Для фотографий
чаще всего используется формат JPEG, логотипы же, как правило, сохраняют в формате GIF, в кото-
ром запоминается максимум 256 цветов, причем изображение требуется преобразовать в режим ин-
дексированных цветов (см. главу 15) с помощью цветовых таблиц или палитр. При этом все цвета
изображения заменяются наиболее близкими им из выбранной палитры или пигментарно смешива-
ются из нескольких соседних. Программа Photoshop предоставляет несколько таких палитр, одной
из которых является «безопасная» палитра веб-цветов. В нее входят 216 цветов, поддерживаемые
всеми браузерами, то есть любой цвет из этой палитры не преобразовывается браузером в другой
цвет, и логотип, отображаемый браузером пользователя, будет выглядеть адекватно созданному вами
оригиналу. Цвета же, не включенные в веб-палитру, каждым браузером будут отображаться по-сво-
ему. Именно поэтому многие веб-дизайнеры без какого-либо внешнего давления выбирают ограни-
чение данной палитрой. — Примеч. перев.
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8. Хотя все вносимые изменения мгновенно отображаются на экране, они не бу-
дут применены, если не подтвердить произведенные действия. Для этого на-
жмите кнопку с галочкой на панели параметров или просто выберите любой
другой инструмент. Поскольку текст размещается на специальном текстовом
слое, теперь неплохо будет открыть палитру Layers (Слои), если, конечно, она
скрыта. Для этого требуется выбрать команду Window > Layers (Окно > Слои) или
щелкнуть на ее язычке вкладки, если палитра присутствует на экране, но не
видна в данный момент. В палитре созданный текстовый слой обозначается знач-
ком «Т», а в качестве его названия используются несколько первых символов.
На рис. 19.2 представлены два текстовых слоя, сформированных в «горизон-
тальном» и «вертикальном» режимах. Некоторые операции над слоями более
подробно рассматриваются в главе 20.

(Normjl 3-

Рис. 19.2. Так как текст располагается на отдельном слое, его можно изменять и передвигать
независимо от остальной части изображения

Изменение текста
Представьте, что вы закончили набор текста, выполнили несколько других операций,
например нарисовали что-нибудь, и вдруг обнаружили, что шрифт или цвет надпи-
си совершенно не подходят к новому рисунку. Вам требуется изменить эти атрибуты
текста и, кроме того, дописать слово. Это совсем несложно выполнить: активизируй-
те текстовый слой, щелкнув на нем в палитре Layers (Слои), включите инструмент
Туре (Текст), щелкните на надписи или выделите ее и делайте что задумали.

ПРИМЕЧАНИЕ
Для того чтобы передвинуть невыделенный текст, воспользуйтесь инструментом Move (Переме-
щение) из состава панели инструментов (в верхнем правом углу), который также активируется
нажатием клавиши V. Кроме того, можно поменять направление текста с горизонтального
на вертикальный и наоборот с помощью кнопки Change the text orientation (Изменить ориен-
тацию текста), появляющейся на панели настроек инструмента туре (Текст). Я предпочитаю
вводить текст в «горизонтальном» режиме, а потом преобразовывать его в «вертикальный».
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О сохранении изображения, содержащего текст, следует рассказать отдельно. Если
требуется записать файл так, чтобы осталась возможность редактирования текста,
например, на промежуточном этапе работы, сохраняйте его в «родных» форматах
программы Photoshop: PSD и PDD. К записи файла в любом другом формате стоит
отнестись более внимательно и вот почему.

Текст в программе Photoshop является векторным объектом. Векторные рисунки
отличаются от растровых тем, что описываются математическими объектами —
формулами и уравнениями. По формулам строятся контуры, формирующие буквы.
Кроме того, текст не замещает собой информацию о цвете пикселов исходного изоб-
ражения, а как бы накладывается поверх них. При любой деформации буквы контур
перерассчитывается и рисуется заново, а фон, то есть основное изображение, при
этом не меняется. Данное свойство позволяет безболезненно увеличивать размеры
контуров, соответственно — букв, поворачивать, трансформировать их и прочее
любое количество раз. Именно векторная природа текста позволяет редактировать
слова после их создания, а также деформировать надписи без потери качества, чего
нельзя сказать о работе с растровыми объектами.

Текстовый слой отличается от обычных слоев еще и в некоторых других аспектах.
Это выражается, например, в том, что у вас не получится выполнить некоторые
операции, например применить фильтр к такому слою — программа попросит пре-
образовать векторные буквы в растровые объекты. Можно ответить Yes (Да), но
нужно помнить, что при этом теряется возможность редактирования текста, а так-
же при любых геометрических деформациях будут снижаться его качественные
характеристики. При записи файла в формате, отличном от PSD, PDD и TIFF,
программа автоматически преобразует текст в растровый объект и, более того, све-
дет все слои в один, ликвидируя отдельный текстовый слой. Поскольку всегда су-
ществует небольшая вероятность, что надпись придется изменить, рекомендуется
сохранять в этих форматах только окончательный вариант изображения, а еще
лучше — его копию, записав первый экземпляр в формате PSD или TIFF.

Итак, текст является векторным объектом. Из-за этого к нему невозможно приме-
нить фильтры, закрасить его любым рисующим инструментом, также не допускает-
ся заливка текста цветом или текстурой и изменение цветовых настроек текстового
слоя с помощью команд коррекции. Все перечисленные операции можно выпол-
нить только после растеризации текста, например, командой Layer > Rasterize > Type
(Слой > Растеризовать > Текст). Но для векторного текста остаются доступными такие
мощные средства, как трансформация слоя, режимы наложения и стили слоев —
они влияют на вид текста, при этом сохраняется возможность его редактирования
и не затрагивается остальная часть изображения. Чтобы трансформировать тексто-
вый слой, выберите команду Edit > Transform (Редактирование > Трансформация), кото-
рая подробно рассматривалась в главе 14. Режим наложения слоя задается с помощью
раскрывающегося списка Set the blending mode (Установить режим смешивания) на панели
Layers (Слои). Различные режимы смешивания были рассмотрены в главе 17 при обсуж-
дении команды Fill (Заполнение) заливки. Они в той же мере применимы и к пере-
крытию слоев.

Стилем слоя называют набор эффектов, который пользователь устанавливает
по своему вкусу и потребностям. Эти эффекты отличны от уже известных нам
заливки и фильтров. Стиль слоя позволяют определить два различных элемента
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управления программы. Самый простой способ — воспользоваться встроенными
стилями, которые доступны из палитры Styles (Стили) (рис. 19.3), по умолчанию
расположенной в одной группе с палитрами Color (Цвет) и Swatches (Каталог). Что-
бы применить любой из них, активизируйте слой, щелкнув на нем в палитре Layers
(Слои), и щелкните на значке стиля в палитре Styles (Стили).

5^Ш> • •

Hill

Рис. 19.3. Палитра стилей слоев

Дополнительные наборы стилей можно загрузить с помощью меню палитры, от-
крывающегося при щелчке на круглой кнопке со стрелкой вправо. Второе средство
становится доступным, если щелкнуть правой кнопкой мыши на названии слоя
в палитре Layers (Слои) и выбрать в контекстном меню команду Blending Options (Па-
раметры смешивания). Это диалоговое окно LayerStyle (Стиль слоя), в котором можно
определить различные эффекты, а также задать режим наложения слоя. Оно же
появляется при выборе любой команды из первых двух разделов подменю Layer
Style (Стиль слоя) меню Layer (Слой). На рис. 19.4 продемонстрировано это диалого-
вое окно, а более подробно мы рассмотрим его далее.

Рассказывая об элементах панели параметров текста, мы упомянули о кнопке Create
wrapped text (Создать изогнутый текст) — предпоследней на панели. Под этой скром-
ной кнопкой скрывается масса интереснейших возможностей. Активизируйте слой,
содержащий надпись, выберите инструмент Туре (Текст) и щелкните где-нибудь
внутри введенного текста (или просто введите текст заново). Затем щелкните на
кнопке Create wrapped text (Создать изогнутый текст). На экране появится диалоговое
окно Wrap Text (Изогнуть текст). Так как ваш текст пока не был деформирован,
в списке Style (Стиль) диалогового окна показан вариант None (Нет). Попробуйте
повыбирать другие варианты, «поиграйте» с параметрами, и ваш текст, возможно,
примет вид, изображенный на рис. 19.5.
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Рис. 19.4. Диалоговое окно Layer Style (Стиль слоя)
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Рис. 19.5. Диалоговое окно Wrap Text (Изогнуть текст) позволяет деформировать текст самым
необычным образом

Пример: создание тени
Один из эффектов, доступных в диалоговом окне Layer Style (Стиль слоя), носит на-
звание Drop Shadow (Отбросить тень), то есть он создает тень, откидываемую объек-
том, в нашем случае — текстом. Тени придают тексту объемность, делают границы
букв более четкими, а сами буквы — рельефными и как бы приподнятыми над изоб-
ражением, и дизайнеры очень часто прибегают к этому эффекту.
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Чтобы создать тень, отбрасываемую надписью, выполните следующее.

1. В соответствии с алгоритмом из предыдущего раздела откройте изображение
и введите текст или воспользуйтесь уже созданной надписью.

2. Активизируйте слой с текстом, щелкнув на его названии в палитре Layers (Слои).

3. Выберите команду Layer > Layer Style > Drop Shadow (Слой > Стиль слоя > Отбросить
тень). На экране появится диалоговое окно, изображенное на рис. 19.6.

Рис. 19.6. Параметры стиля Drop Shadow (Отбросить тень)

У тени есть множество параметров, которые я уже установил на рис. 19.6; ре-
зультат продемонстрирован на рис. 19.7. Режим наложения тени выбирается
в списке Blend Mode (Режим смешивания), для установки цвета тени служит квад-
ратик справа от списка Blend Mode (Режим смешивания), а прозрачность регули-
руется регулятором Opacity (Непрозрачность). Для тени чаще всего используется
режим Multiply (Умножение), черный цвет и непрозрачность 50%, то есть она по-
лучается серой. Параметр Angle (Угол) задает угол наклона падающего света на
объект. Флажок Use Global Light (Использовать глобальное освещение) означает,
что при расчете тени будет учитываться общее (единое для всех слоев) освещение,
параметры которого установлены в диалоговом окне, вызываемом командой
Layer > LayerStyle * Global Light (Слой > Стиль слоя > Глобальное освещение). Регуля-
торы Distance (Расстояние), Spread (Распространение) и Size (Размер) позволяют
управлять размерами и видом тени. Параметр Contours (Контуры) задает кривую
произвольной формы, также определяющую вид тени. Программа предостав-
ляет в распоряжение пользователя несколько стандартных кривых и также до-
пускает их создание и изменение пользователем — чтобы открыть инструмент
Contour Editor (Редактор контуров), нужно щелкнуть на квадратике с контуром.
Кроме того, Photoshop позволяет установить сглаживание тени (флажок Anti-
aliased (Сглаживание)) и зернистость (регулятор Noise (Шум)). Получаемая
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5.

в результате тень демонстрируется внутри рамки, расположенной в правой ча-
сти диалогового окна, и на самом изображении, если установлен флажок Preview
(Предварительный просмотр). Попробуйте поэкспериментировать со всеми па-
раметрами и выберите подходящие. Нажмите кнопку ОК.

Теперь ваш текст порождает превосходную тень, например, как показано на
рис. 19.7. Обратите внимание на палитру Layers (Слои). Вид слоя изменился,
кроме того, ниже него добавились две строчки (полосы): Effects (Эффекты) и Drop
Shadow (Отбросить тень). Можно отключить отображение тени — для этого надо
щелкнуть по квадратику с изображением глаза, расположенному в строке Drop
Shadow (Отбросить тень); вновь показать тень позволит повторный щелчок. Если
же полученный результат вас не устраивает, можно вернуться в окно настрой-
ки параметров тени и изменить их. Для этого следует дважды щелкнуть на строке
Drop Shadow (Отбросить тень).

Рис. 19.7. При добавлении к спою какого-нибудь эффекта, например Drop Shadow (Отбросить
тень), после его названия в палитре Layers (Слои) появляется буква «f» в кружочке

ВНИМАНИЕ
Самым замечательным в стилях слоев является то, что они привязаны к содержимому слоя,
то есть они применяются к объектам, расположенным на слое, и отдельно от них не суще-
ствуют. Если изменить рисунок на слое, например поменять слово в надписи, соответствен-
но изменится и отбрасываемая текстом тень.

Изменение прозрачности текста
К сожалению, мы вынуждены констатировать, что текст не имеет такого парамет-
ра, как прозрачность, и сам по себе не может быть полупрозрачным. Это ограниче-
ние программы можно обойти за счет того, что текст записывается на собственный
слой. Полупрозрачный слой представляет собой столь же часто встречающийся
элемент, как и, например, частично прозрачный мазок кисти. Кроме того, одним из
параметров слоя является режим наложения — об этом уже упоминалось ранее.
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Элементы экрана, позволяющие настраивать полупрозрачность слоя и режим нало-
жения, находятся в верхней строке палитры Layers (Слои). Элементы раскрывающе-
гося списка Blend Mode (Режим с м е ш и в а н и я ) определяют способ смешивания цветов
пикселов на активном слое с цветами пикселов на нижележащем слое. Регулятор
Opacity (Непрозрачность), как несложно догадаться, устанавливает степень прозрач-
ности активного слоя, то есть определяет, насколько сквозь него будет просвечивать
нижележащий слой. Если задать непрозрачность равной нулю, вы не увидите актив-
ный слой — он будет обесцвечен. Соответственно, чтобы сделать текст полупро-
зрачным, нужно уменьшить непрозрачность слоя, на котором этот текст находится.

Откройте изображение с одним или несколькими текстовыми слоями или создай-
те надпись заново, а потом попробуйте поэкспериментировать с режимами нало-
жения любого из слоев и прозрачностью. Объединяя все это со стилями слоев,
можно создавать действительно фантастические надписи.

Ко всем параметрам слоев мы еще вернемся в главе 20.

Пример: светящийся текст
Выполнив это упражнение, вы научитесь создавать свечение вокруг текста, а по-
путно — копировать, переименовывать и скрывать слои. Воспользуемся текстом
с тенью, сформированным в предыдущем примере. Откройте файл с этой надписью,
а затем проделайте следующее.

1. Откройте палитру Layers (Слои).

2. Щелкните на слое Backgrond (Фон) и заполните его каким-нибудь цветом или
текстурой.

3. Скопируйте слой, на котором расположен текст с тенью. Для этого мышью
перетащите его название на значок в правом нижнем углу палитры, на котором
нарисована страница. Второй способ — щелкните на названии слоя правой
кнопкой мыши и выберите команду Duplicate Layer (Дублировать слой).

4. Переименуйте скопированный слой. Для этого дважды щелкните на названии
слоя и наберите новое название или щелкните правой кнопкой мыши, выберите
в контекстном меню команду Layer Properties (Свойства слоя) и в открывшемся
диалоговом окне в поле N a m e (Имя) введите новое название glow (свечение).

5. Щелкните на квадратике-глазе, примыкающем слева к названию и значку «Т»
исходного слоя, чтобы скрыть последний. Таким образом мы убираем слой из
области видимости, но сохраняем его для использования в дальнейшем.

6. Вернитесь к слою glow, щелкнув на его названии.

7. Откройте диалоговое окно Layer Style (Стиль слоя). Это можно сделать нескольки-
ми способами. В предыдущем примере выбиралась команда в подменю Layer Style
(Стиль слоя) меню Layer (Слой). Поскольку на данный момент мы собираемся
создать эффект свечения, сейчас нам понадобится команда Layer > Layer Style >
Outer Glow (Слой > Стиль слоя ¥ Внешнее свечение). Другие способы: можно дваж-
ды щелкнуть на строках эффектов в палитре Layers (Слои), щелкнуть правой
кнопкой мыши на названии слоя и выбрать команду Blending Options (Параметры
смешивания), щелкнуть той же кнопкой мыши на значке «f» или на строках
эффектов и выбрать команду Outer Glow (Внеш нее свечение) и, наконец, открыть
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меню палитры щелчком на кружке со стрелкой и выбрать команду Blending
Options (Параметры смешивания). Выбирайте самый удобный для себя способ.

8. В диалоговом окне Layer Style (Стиль слоя) снимите флажок Drop Shadow (Отбро-
сить тень), чтобы скрыть созданную тень — это равносильно удалению значка
глаза, расположенного у левого края строки с названием стиля слоя в палитре
Layers (Слои). Сам эффект не удаляется, и тень можно включить заново, устано-
вив флажок или щелкнув на самом левом квадрате в строке с названием слоя
(чтобы появился значок с глазом). Затем в диалоговом окне Layer Style (Стиль
слоя) щелкните на строке Outer Glow (Внешнее свечение).

9. В правой части окна отобразятся параметры внешнего свечения, которые не-
много отличаются от параметров эффекта Drop Shadow (Отбросить тень). Появил-
ся переключатель для выбора цвета: можно задать одноцветное свечение (щелчок
на цветном квадратике открывает знакомую палитру Color Picker (Выбор цвета))
или выбрать многоцветное из раскрывающейся палитры. Как всегда, программа
позволяет загрузить в палитру другой набор переходов цветов — для этого
следует воспользоваться меню палитры, и отредактировать используемый гра-
диент — для этого щелкните на полосе, отображающей изменение цвета. Кроме
того, элементы раскрывающегося списка Technique (Техника) вместе с уже зна-
комыми регуляторами Spread (Распространение) и Size (Размер) определяют дру-
гие характеристики свечения. Под параметром Contour (Контур) объявились
два новых регулятора: Range (Диапазон) и Jitter (Дрожание). Первый задает
уровень свечения, а воздействие второго очень похоже на результат выбора
режима наложения Dissolve (Растворение).

10. Поварьируйте параметры и выберите подходящие к размеру и виду надписи.
Нажмите кнопку ОК.

Вот и все. Вы получили искомый светящийся текст. На мой взгляд, надпись будет
выглядеть гораздо лучше и станет объемной, если активизировать слой с тенью,
расположенный над слоем со свечением, как показано на рис. 19.8.
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Рис. 19.8. Светящаяся объемная надпись, полученная с помощью стиля слоя Outer Glow
(Внешнее свечение) выглядит замечательно
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Следует запомнить
Q На фотографии можно разместить любую надпись.

О При создании текста образуется специальный текстовый слой.

Q Текст является векторным объектом, и для выполнения некоторых операций,
а также сохранения файла в любом формате, отличном от оригинальных форма-
тов Photoshop и универсального формата TIFF, требуется преобразовывать
надписи к растровому виду.

Q Программа позволяет изменять содержание надписи, а также ее цвет, размер
и расположение.

О Немного потрудившись, можно сделать текст прозрачным.

Q Тени, внешнее свечение и другие слоевые эффекты дают возможность созда-
вать интересные и необычные надписи.



Глава 20

Немного о слоях

О Отделение элементов изображения друг от друга
а Порядок слоев
Q Добавление и удаление слоев
Q Что можно увидеть сквозь стену? Прозрачность
Q Режимы наложения и стили слоев

Мир цифровой графики сделал огромный шаг вперед, когда компания Adobe выпус-
тила версию Photoshop 3.0, в которой впервые были введены слои. Обнаружив
преимущества нового подхода к обработке изображений, многие производители гра-
фических редакторов последовали примеру Adobe. Слои открыли огромный диапа-
зон возможностей для художников и дизайнеров и позволили реализовать самые
невероятные, дерзкие, а также забавные идеи. До появления слоев любое изображе-
ние, являющееся документом Photoshop, то есть открытое в этой программе, рас-
полагалось на фоновом слое, который называется Background (Фон). Он и сейчас
сохранил свое название. При добавлении к изображению любого элемента происхо-
дила его вставка на фоновый слой, а информация о фрагменте исходного изображе-
ния, находившемся на этом месте до появления элемента, терялась. Это означало,
что, вставив элемент, дизайнер уже не мог подвинуть его или изменить его раз-
мер — для выполнения подобных операций приходилось прибегать к довольно
сложным ухищрениям. Кроме того, программа позволяла отменить только самую
последнюю операцию. Поэтому дизайнерам приходилось на каждом шаге сохранять
результаты своей работы, и они не имели права на ошибку. А допустив ошибку, они
были вынуждены начинать все сначала или от некоторого сохраненного состояния.

Понятие слоя
Проще всего представить слои как стеклянные пластинки или куски прозрачной
пленки, наложенные на изображение. На одной пластинке написан текст, на вторую
скопирован фрагмент исходного снимка, на третьей нарисовано что-нибудь, а самая
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нижняя содержит исходную фотографию. Если сложить пластинки в стопку,
то получится изображение с надписью и нарисованным элементом, и вы в любой
момент можете вытащить одну из пластинок из стопки, удалив таким образом
надпись, элемент или даже фон. Согласитесь, это гораздо удобнее, чем рисовать
и писать поверх фотографии, не имея возможности впоследствии стереть надпись
так, чтобы восстановились скрытые под ней части снимка. На прозрачных плас-
тинках можно создавать как непрозрачные, так и полупрозрачные объекты, сквозь
которые будет просвечивать фон.

Слои в программе Photoshop аналогичны описанным пластинкам. Они уложены
в стопку поверх исходного изображения, а нарисованные на них картинки пере-
крываются и объединяются друг с другом и с фоном, образуя общую композицию.
При этом любой слой из стопки можно удалить или просто скрыть на некоторое
время. Мы горячо рекомендуем располагать каждый новый элемент на отдельном
слое — тогда его можно будет изменять и перемещать, не влияя на остальные со-
ставляющие изображения, кроме того, удаление слоя представляет собой еще один
простой способ отмены части выполненных действий.

По умолчанию при открытии программы Photoshop в ее окне появляется палитра,
в которой объединены три палитры: Layers (Слои), Channels (Каналы) и Paths (Конту-
ры). Чтобы показать палитру Layers (Слои), щелкните на ее язычке-закладке. Если
же закладка отсутствует на экране, выберите команду W i n d o w > Layers (Окно > Слои).
По умолчанию любое изображение располагается на фоновом слое, который ото-
бражается в палитре слоев при открытии файла изображения. Палитра принимает
вид, продемонстрированный на рис. 20.1.
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Рис. 20.1. Вид палитры Layers (Слои), когда изображение впервые открывается в Photoshop

Слой Background (Фон) не является прозрачным слоем, и любая вырезанная из него
область заполняется цветом фона. Все остальные слои обесцвечены, то есть если
вырезать часть изображения, размещенного на слое, станет виден нижележа-
щий слой. Существует еще несколько отличий фона от обычных слоев, например,
к нему нельзя применить режим наложения или стиль слоев, о которых будет
рассказано позже. Фон можно преобразовать в обычный слой командой Layer >
New > Layer From Background (Слой > Создать > Слой из фона), и тогда он также станет
прозрачным.

Помимо фоновых и обычных слоев в программе Photoshop существуют текстовые
слои (глава 19), слои фигур (глава 17) и корректирующие слои (глава 15). У каж-
дого вида слоев свое назначение и есть свои собственные свойства, но общие прин-
ципы работы со слоями одинаковы. Их мы сейчас и рассмотрим.
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Слои образуются автоматически
Выше неоднократно отмечалось, что проще всего научиться работать с новым эле-
ментом, проведя собственные исследования. На этот раз начнем с создания нового
изображения.

1. Нажмите клавиши Ctrl+N или выберите команду File > New (Файл > Создать).

2. В открывшемся диалоговом окне следует задать параметры нового изображения.
Введите любое название в поле Name,(Имя). Поскольку наше изображение пред-
назначено только для просмотра на экране, оставьте разрешение 72 ppi (поле
Resolution (Разрешение), единицы измерения указываются в списке справа, а раз-
решение мы рассматривали в главе 11). Задайте размер 360 х 288 пикселов (поля
Width ( Ш и р и н а ) и Height (Высота)), параметру Mode (Режим) присвойте значение
RGB Color (Цвета RGB) и в разделе Contents (Содержимое) установите переключатель
в положение White (Белый). Программа создаст новый документ, заполненный
белым цветом, и откроет соответствующее окно. Во втором положении пере-
ключателя Background Color (Цвет фона) изображение заполняется фоновым цве-
том, а в третьем Transparent (Прозрачный) — остается прозрачным. В последнем
случае изображение не имеет фонового слоя.

3. Нарисуйте фигуру (см. главу 17) или введите любой текст (см. главу 19).

4. Обратите внимание на палитру Layers (Слои). Исходный слой в ней назван
Background (Фон). Это самый нижний слой изображения и по своей сути он име-
ет нулевой номер. Видно, что инструменты Shape (Фигура) или Туре (Текст) со-
здали новые слои, называющиеся соответственно нарисованным элементам.
Таким образом, некоторые средства программы Photoshop автоматически до-
бавляют слои к исходному изображению.

5. Сохраните изображение.

Создание слоев
Если требуется добавить к изображению новые элементы и расположить их на от-
дельном слое, нужно будет создать для них этот слой. Выполните следующее.

1. Еще раз создайте такое же изображение, как в предыдущем примере.

2. Щелкните в палитре Layers (Слои) на значке со страницей, расположенном
в нижней строке палитры. Автоматически будет сформирован пустой прозрач-
ный слой с названием Layer 1 (Слой 1) (рис. 20.2). Также можно создать слой,
выбрав команду Layer > New > Layer (Слой > Создать > Слой) или нажав сочетание
клавиш Shift+Ctrl+N.

3. Итак, новый слой получил название Layer 1(Слой 1). Программа автоматически
генерирует названия с порядковыми номерами для тех слоев, которые создают-
ся пользователем вручную, а не с помощью какого-либо инструмента. Нуле-
вым считается фоновый слой. При образовании слоя с помощью команды меню
или сочетания клавиш открывается диалоговое окно, в котором в поле N a m e
(Имя) можно ввести любое название слоя. Названия часто напоминают нам
о содержимом слоя, поэтому дизайнеры переименовывают слои для удобства
работы. Вы тоже вправе сделать это.
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ПРИМЕЧАНИЕ
Вам может показаться недоразумением, что нумерация слоев начинается с нуля. Но это
очень типично для любой программы. Дело в том, что во многих языках программирования стру-
ктурные элементы отсчитываются с нуля, а не с единицы, и программу Photoshop писали про-
граммисты на каком-то языке. Для них, без сомнения, такое обозначение слоев имеет смысл.

Режим наложения

Вкладка палитры

Регулятор непрозрачности

Кнопка дополнительных
настроек
Переключатель блокировки слоя

Миниатюра

Ш
ш"'~~\шшЩ Ш

11 1
Признак активности слоя

Переключатель — Ц
видимости слоя

]— Настройка размера палитры

Удаление слоя
Создание нового слоя

Настройка и заполнение слоя

Рис. 20.2. Элементы палитры Layers (Слои) позволяют редактировать слои
и изменять их порядок

4. Создайте еще один слой, повторив шаг 2. Программа назовет его Layer 2 (Слой 2).

5. Дважды щелкните на названии этого слоя в палитре Layers (Слои) и введите
новое название. Второй способ: щелкните правой кнопкой мыши на названии слоя,
выберите'команду Layer Options (Свойства слоя) и в поле Name (Имя) задайте назва-
ние. Фон, в отличие от обычных слоев, переименовать нельзя — он преобразуется
в обычный слой.

6. Можете переименовать и первый созданный вами слой, используя как латиницу,
так русские буквы.

7. Сохраните изображение в формате PSD или TIFF, выполнив команду File > Save
As (Файл > Сохранить как), — тогда ни один из слоев не потеряется. В любом дру-
гом формате программа автоматически сводит все слои в один, и вернуться
к отдельным впоследствии невозможно.

СОВЕТ
Когда требуется расположить на отдельном слое выделенный фрагмент изображения, вос-
пользуйтесь командой Layer > New > Layer via Copy (Слой > Создать > Слой через копирова-
ние). Это не только удобно, но и экономит память компьютера — для выполнения этой
операции не используется буфер, как при обычном копировании и вставке.

Активация слоя
В многослойном документе все средства программы воздействуют только на ак-
тивный слой, за исключением, разве что, инструмента Crop (Обрезать) и команд,
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изменяющих размер холста и изображения. Вы не сможете выполнить ни одну из
стандартных операций: настройку цвета, заливку, применение фильтра или пере-
мещение объекта — до тех пор, пока слой, на который должно влиять используе-
мое средство, не станет активным. И наоборот, если выполнить какое-либо дей-
ствие на активном слое, все другие слои затронуты не будут. Активировать слой
очень просто: щелкните на слое в палитре Layers (Слои). Активный слой в палитре
выделяется цветом, кроме того, во втором слева квадратике в строке слоя появля-
ется изображение кисти, как показано на рис. 20.3.

Рис. 20.3. Активным является слой Layer 2

ПРИМЕЧАНИЕ
Если вы пытаетесь рисовать или стирать что-то на слое, а на экране ничего не происходит,
убедитесь, является ли этот слой активным. Если вы в самом деле забыли активировать
нужный слой, обязательно проверьте тот слой, который был текущим в момент рисова-
ния — вполне возможно, что вы на нем что-то нарисовали или стерли. Я даже не могу
сказать, сколько раз это случалось со мной!

Показ и скрытие слоев
С левой стороны каждой строки слоя в палитре Layers (Спои) находится маленький зна-
чок в виде глаза. Если он там, где полагается, значит, слой виден в данный момент.
Если же глаз отсутствует, то слой скрыт, и его содержимое не влияет на отображаемую
в данный момент композицию. Скрыть или показать слой можно простым щелчком
на этом квадратике с глазом, причем скрывать можно одновременно несколько слоев.

На рис. 20.4 видны два слоя: фон и Layer 1, слой Green Circle в данный момент не
показывается. И в окне изображения мы, соответственно, наблюдаем белый фон и
серую звездочку, а большой зеленой окружности, принадлежащей последнему слою,
нет. Обратите внимание: активным может быть даже скрытый слой.
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Рис. 20.4. Слой с окружностью Green Circle невидим
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Удаление слоев
Вряд ли вы найдете более простую операцию в программе Photoshop. Чтобы уда-
лить слой, в палитре Layers (Слои) захватите его мышью и перетащите на значок
Delete layer (Удалить слой) в левом нижнем углу палитры. Можно действовать и по-
другому: сделать слой активным и щелкнуть на значке Delete layer (Удалить слой)
или щелкнуть на названии слоя правой кнопкой мыши и выбрать команду Delete
layer (Удалить слой). Программа запросит подтверждения удаления, нажмите кноп-
ку Yes (Да).

Если вы случайно убрали не тот слой или изменили свое решение по поводу уда-
ления, отмените операцию, например, нажав Ctrl+Z. Однако следует всегда помнить,
что отменять можно только те действия, которые сохраняются в палитре History
(История), по умолчанию это 20 операций. Если вы не уверены в том, что слой дей-
ствительно больше не понадобится, просто скройте его (см. предыдущий раздел).

Порядок слоев
Программа Photoshop позволяет менять порядок слоев, и поверьте, это очень удоб-
но. На экране слои располагаются именно так, как они представлены в палитре
Layers (Слои): верхний слой в палитре и в стопке (вспомните аналогию с прозрач-
ными пленками) всегда закрывает слои, находящиеся под ним. Но вы можете взять
и передвинуть этот слой в середину или даже самый низ стопки, если в ней нет
фонового слоя. Это позволяет менять взаимное расположение слоев и содержа-
щихся на них элементов. Фон же всегда занимает самую нижнюю позицию, но его
тоже можно переместить, преобразовав в обычный слой командой Layer > New > Layer
From Background (Слой > Создать > Слой из фона).

Перед тем как начать изучать способы перемещения слоев, мы йарисуем фигуры
в изображении, созданном в предыдущем примере.

1. Откройте это изображение.

2. Удалите лишние слои, оставив только фон и пустой слой. Удаление слоев опи-
сано в предыдущем разделе. Убедитесь в том, что пустой слой является види-
мым. Активируйте его и залейте желтым цветом с помощью команды Edit > Fill
(Редактирование > Заполнение); назовите его Layer 1.

3. Включите инструмент Rectangle (Прямоугольник) из группы Shape (Фигура), из-
мените цвет переднего плана на красный (квадрат Set foreground color (Устано-
вить цвет переднего плана) на панели инструментов) и нарисуйте большой крас-
ный прямоугольник. (Если вы забыли, как рисовать геометрические фигуры,
обратитесь к главе 17.) В палитре Layers (Слои) появится новый слой.

4. Скройте фоновый слой и Layer 1, щелкнув на квадратиках с глазом в соответ-
ствующих строках палитры Layers (Слои).

5. Активируйте слой с прямоугольником, щелкнув на его названии в палитре Layers
(Слои).

6. Теперь нарисуйте большой овал с помощью инструмента Ellipse (Эллипс) и из-
мените его цвет на зеленый с помощью квадрата Color (Цвет) на панели настрой-
ки инструмента. Программа создаст еще один слой.
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7. Скройте слой с прямоугольником, щелкнув на квадратике с глазом в строке
с названием этого слоя, и сделайте активным слой с овалом.

8. Воспользуйтесь инструментом Polygon (Многоугольник) и нарисуйте большой
синий треугольник. Будет сформирован еще один слой. Изображение примет
вид, представленный на рис. 20.5.

9. Сохраните файл в формате PSD.

Рис. 20.5. Видимы только два слоя, треугольник с верхнего слоя закрывает часть овала
с нижнего слоя

Теперь рассмотрим наложение слоев друг на друга и изменение их порядка в «стоп-
ке». На нашем рисунке зеленое солнце располагается позади голубой горы, при
этом красный прямоугольник, желтый слой и фон скрыты. Сохраняя изображение
в формате PSD, программа записывает информацию обо всех слоях изображения,
как видимых, так и скрытых. И любой из скрытых слоев можно сделать видимым.

1. Щелкните на квадратиках, расположенных справа в строках желтого слоя и слоя
с прямоугольником в палитре Layers (Слои), чтобы проявить эти слои. Теперь
зеленое солнце встает на фоне красного неба и желтой пустыни из-за синей
горы. Несмотря на фантастичность, такое изображение прекрасно подходит для
наших целей.

2. Передвинем один из слоев. Когда указатель перемещается над строками палит-
ры Layers (Слои), он принимает вид ладони. Расположите его над названием слоя
с овалом, нажмите кнопку мыши и, не отпуская ее, перетащите слой на место
ниже слоя с прямоугольником. Теперь 'по-прежнему на переднем плане будет
красоваться синий треугольник, но овал окажется полностью закрытым крас-
ным прямоугольником, как показано на рис. 20.6. Видимым остался только его
контур (при активном слое с овалом).
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Рис. 20.6. Невзирая на то, что слой с овалом является видимым, овал оказался полностью
закрыт красным прямоугольником
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ПРИМЕЧАНИЕ
Изменить положение слоя также можно с помощью команд подменю Arrange (Упорядочить)
меню Layer (Слой) и горячих клавиш Ctrl+[ и Ctrl+] (перемещение на шаг назад и вперед
соответственно).

3. Попробуйте изменить прозрачность слоя с прямоугольником. Активируйте его
и воспользуйтесь регулятором Opacity (Непрозрачность), расположенным в верхней
части палитры Layers (Слои). Насыщенность краски прямоугольника снизится —
он станет просвечивающим. Сквозь него будет проглядывать овал, но в резуль-
тате смешивания зеленого и красного цветов он приобретет коричневый окрас.

Обработка слоев
Со слоями или на них можно выполнить практически все операции программы
Photoshop. Но о некоторых средствах и задачах следует упомянуть отдельно.

Вращение, деформация и изменение размеров
Если при любом активном слое, кроме фонового, выбрать одну из команд подме-
ню Transform (Трансформация) меню Edit (Редактирование), вокруг объекта или объек-
тов, принадлежащих слою, появится рамка с квадратными маркерами. Мы уже
имели с ней дело, рассматривая различные изменения размеров и формы изобра-
жения в главе 14 и выделенной области — в главе 16. Перемещая маркеры, можно
модифицировать форму объекта, расположенного на слое: изменить размеры, по-
вернуть его или деформировать, в зависимости от выбранной вами команды. Вы-
полненные изменения повлияют на все объекты слоя. Если же, например, требует-
ся повернуть какую-то одну часть слоя, нужно выделить ее перед применением
команд из группы Transform (Трансформация).

ПРИМЕЧАНИЕ
В многослойном документе построение выделенной области означает выделение фрагмен-
та, который находится одновременно внутри нее и на активном слое. Переключая активные
слои, вы можете выделять разные части изображения, не создавая при этом новых выде-
ленных областей.

Перемещение содержимого слоев
Чтобы переместить содержимое слоя относительно остальной части изображения,
необходимо передвинуть сам слой.

1. Активируйте слой щелчком на его названии в палитре Layers (Слои).
2. Щелкните на инструменте Move (Перемещение), расположенном в верхнем пра-

вом углу палитры инструментов. Указатель превратится в сплошную черную
стрелку с маленьким крестиком.

3. Наведите указатель на изображение, нажмите кнопку мыши и, удерживая кноп-
ку, переместите указатель.

Чтобы передвинуть слой из одного изображения в другое, выполните следующее.
1. • Откройте два изображения, одно из них должно быть многослойным.
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2. Расположите их в окне программы так, чтобы оба были одновременно видны
на экране. При необходимости масштабируйте изображения, используя команду
View > Zoom Out (Вид > Уменьшить масштаб) или нажимая клавиши Ctrl+Alt+-. Кла-
виатурная комбинация больше подходит для наших целей, поскольку приводит к то-
му, что вместе с изображением уменьшается и окно, в котором оно отображается.

3. Щелкните на многослойном изображении.

4. Захватите мышью в палитре Layers (Слои) тот слой, который хотите скопиро-
вать, и перетащите его на второе изображение. Другой вариант: активируйте
слой, включите инструмент Move (Перемещение), щелкните на многослойном
изображении и перетащите мышью слой во второе изображение (просто на-
жмите кнопку мыши и передвиньте указатель ко второму окну).

5. В палитре Layers (Слои) для второго изображения появился новый слой с назва-
нием, которое он имел в первом изображении. Слои первого изображения оста-
лись в исходном состоянии.

СОВЕТ
Очень часто случается, что область (слой или выделенный фрагмент), копируемая из одно-
го изображения в другое, оказывается слишком большой или слишком маленькой. Это объяс-
няется тем, что изображения имеют разные разрешения. Чтобы видеть соотношение разме-
ров изображений, нужно одинаково масштабировать их, например установить для обоих
снимков масштаб 50%. И даже при одинаковом разрешении размеры объектов могут сильно
различаться в зависимости от расстояния, с которого была снята фотография. В обеих ситу-
ациях после копирования области следует изменить ее размер с помощью команд группы
Transform (Трансформация) меню Edit (Редактирование).

Стирание фрагментов на слоях
Инструмент Eraser (Ластик) предназначается для стирания пикселов со слоя.
Стертые места становятся прозрачными (это относится только к обычным слоям,
см. главу 17), и сквозь них начинают просвечивать фрагменты нижнего слоя. Иногда
удобнее пользоваться ластиком, чем выделять область и вырезать ее. Попробуйте
включить инструмент щелчком на кнопке Eraser (Ластик) на панели инструментов.
Выберите кисть нужного размера из раскрывающейся палитры на панели настройки
инструмента, а также установите остальные параметры, затем проведите ластиком
по активному слою, нажав кнопку мыши. Если выбрать большую кисть с размыты-
ми краями и стереть границы объекта, расположенного на активном слое, создастся
эффект плавного перехода цветов. Мы тоже с помощью ластика получили замеча-
тельную картинку, изображенную на рис. 20.7.

Рис. 20.7. Теперь синий треугольник стал чем-то похож на кусок швейцарского сыра
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Копирование объектов с одного слоя на другой
Вспомним еще одну стандартную операцию. Довольно часто приходится выделять
какие-то элементы изображения, копировать их и вставлять на новые места или
даже в другие изображения. Вставленная область всегда располагается на новом,
выделенном специально для нее слое. Иногда края такого объекта получаются
слишком резкими и поэтому выглядят неестественно. Выполните следующее
упражнение, чтобы понять мою мысль.

1. Откройте изображение, на котором есть какой-нибудь светлый объект, напри-
мер белое здание или что-то подобное.

2. Увеличьте масштаб изображения, чтобы отчетливо видеть границы объекта.

3. Выберите подходящий инструмент выделения. Возможно, вам достаточно бу-
дет инструмента Magic Wand (Волшебная палочка), а может быть, удобнее вос-
пользоваться инструментами из группы лассо (см. главу 16).

4. Выделите объект.

5. Выберите команду Edit > Сору (Редактирование > Копировать) или нажмите соче-
тание клавиш Ctrl+C (это типовая клавиатурная комбинация почти для всех
программ, работающих под управлением Windows). Выделенный фрагмент ско-
пируется в буфер обмена.

6. Откройте другое изображение с более темными тонами. Если же в исходном
изображении есть темная область, сгодится и оно.

7. Вставьте объект, выполнив команду Edit > Paste (Редактирование > Вставить) или
нажав клавиши Ctrl+V. Объект появится в центре изображения, а в палитре Layers
(Слои) образуется новый слой.

СОВЕТ
Программа предоставляет более простой и удобный способ копирования фрагментов из
одного изображения в другое, при котором не задействуется буфер обмена. Это существенно,
если работа ведется над файлами очень большого размера. Выделите объект, включите
инструмент Move (Перемещение), нажмите клавишу Alt, нажмите кнопку мыши и, удерживая
клавишу и кнопку, перетащите объект в новое изображение. Результат аналогичен использо-
ванию команд копирования-вставки. Если точно так же действовать в пределах одного изобра-
жения, скопированный объект не будет помещен на новый слой. Это не всегда приемлемо.

8. С помощью инструмента Move (Перемещение) переместите слой так, чтобы объект
расположился поверх темной части изображения, как показано на рис. 20.8.

9. Увеличьте масштаб — вам нужно внимательно разглядеть объект. Его края вы-
глядят слишком резкими на темном фоне. Так и цветок на голове девочки на
рис. 20.8 кажется немного неестественным.

Рис. 20.8. Вставленный цветок располагается на новом слое и имеет очень резкие края
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Исправить подобный недостаток можно несколькими способами. Мы рассмотрим
два из них. О первом рассказывалось в предыдущем разделе — с помощью инстру-
мента Eraser (Ластик), подобрав подходящую кисть, небольшую, но с расплывчаты-
ми краями, сотрите границу объекта. Правда, такая техника не всегда работает.
Она хороша, когда требуется сгладить границы облака на небе, но неприемлема,
когда объект имеет четко очерченные края, которые нельзя удалять. Второй под-
ход предполагает использование параметра Feather (Размытие).

Копирование объекта с размытием границ
Функция размытия границ выделенных областей предоставляется многими гра-
фическими редакторами. Это позволяет «плавно» соединять вставленную область
с нижележащим слоем. Воспользуемся теми же самыми изображениями, что и в
предыдущем примере. Требуется, чтобы цветок на голове девочки более естественно
объединялся с окружающим фоном, для этого вставляемая область должна иметь
немного размытые края.

1. Отмените все операции, выполненные в предшествующем упражнении. Если
вы сохраняли и закрывали файлы, то первый не претерпел изменений, а во вто-
ром нужно удалить слой с объектом — мы вставим его заново.

2. В первом изображении следует выделить объект. Однако на этот раз вам нужно
обратить внимание на настройки инструментов выделения. У каждого из них
есть параметр Feather (Размытие). Выберите нужный инструмент выделения
и установите величину размытия, большую нуля, например 2 или 3 пиксела.
Выделите объект.

3. Дальше действуйте, как в предыдущем примере: скопируйте и вставьте объект.
Если результат по какой-то причине вас не удовлетворяет (величина размытия
оказалась больше или меньше желаемой), повторите заново шаг 2. Поскольку
нужную величину размытия можно определить только экспериментально, ве-
роятно, более удобным вам покажется другой способ, при котором не требуется
каждый раз заново выделять объект.

Выделите объект, не размывая края выделения (параметр Feather (Размытие)
равен нулю). Затем выполните команду Select > Feather (Выделение > Размытие)
или нажмите клавиши Alt+Ctrl+D. На экране появится диалоговое окно, изобра-
женное на рис. 20.9. В поле Feather Radius (Радиус размытия) введите величину
больше нуля. Границы выделения будут размыты. После этого скопируйте
и вставьте объект. Если размытие оказалось недостаточным или слишком боль-
шим, вернитесь в первое изображение, с помощью палитры History (История)
отмените применение размытия, еще раз вызовите диалоговое окно Feather
Selection (Размытие выделения) и задайте новую величину. Потом повторите про-
цесс копирования-вставки.

- -

Рис. 20.9. Окно, определяющее размытие границ выделения
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Убедившись, что вставленный фрагмент идеально сочетается с исходным изобра-
жением и вам не придется больше его редактировать, вы можете соединить слои.
В принципе, мы рекомендуем вообще не выполнять эту операцию и сохранять две
копии окончательного варианта изображения: в формате PSD или TIFF со всеми
слоями и в любом другом формате. При записи в любом другом формате програм-
ма самостоятельно сведет все слои в один. Но если в изображении накопилось слиш-
ком много слоев, можно уменьшить их количество, соединив часть из них в еди-
ный слой. Скройте те слои, которые не требуется объединять, активируйте один
из видимых, затем выполните команду Layer > Merge Visible (Слой > Соединить види-
мые). Если же объединяемые слои находятся друг под другом, щелкните на верх-
нем слое и выполните команду Layer > Merge Down (Слой > Соединить с н и ж н и м ) или
нажмите клавиши Ctrl+E. Третья команда из этой группы Layer > Flatten Image (Слой >
Плоское изображение) сливает все слои изображения вместе.

Такая методика копирования и вставки позволяет получать фотографии, изобра-
жающие то, чего никогда не было на самом деле. Но только вы будете знать о них
всю правду!

Режимы наложения и стили слоев
К обычным слоям применимы все средства программы, например фильтры и цве-
товая коррекция, но специально для них был также создан набор эффектов, кото-
рые используются только по отношению к слоям. Под стилями слоев понимают
набор эффектов, который можно сохранить, изменить и применить к слою в лю-
бой момент. Если вы когда-нибудь работали в текстовых редакторах, например
Word, то вам будет понятна аналогия между текстовыми стилями и стилями слоев.
Кроме того, слой можно не просто размещать поверх предыдущего слоя с той или
иной степенью прозрачности, а смешивать его цвета с Нижележащими по некоторым
математическим законам — ведь любой цвет в компьютере описывается несколь-
кими цифрами. Способ наложения слоя определяется режимом смешивания.

Доступные режимы наложения слоя ничем не отличаются от режимов наложения
краски для инструмента Fill (Заполнение) и рисующих инструментов; они перечис-
лены в главе 17. Выбрать режим наложения можно с помощью палитры Layers (Слои):
активизируйте слой и укажите подходящий вариант в раскрывающемся списке,
отвечающем за режим смешивания (см. рис. 20.2).

Если дважды щелкнуть на полосе с названием слоя в палитре Layers (Слои) (не на
самом названии), открывается диалоговое окно Layer Style (Стиль слоя), изображен-
ное на рис. 20.10.

Управляющие элементы этого окна позволяют применить к слою один или не-
сколько различных эффектов, а также задать параметры наложения и сохранить
стиль для последующего использования. В левой части окна представлен список
эффектов, каждый из которых имеет свои настройки. Если щелкнуть на названии
эффекта, он окажет соответствующее воздействие на слой. Это мгновенно отра-
зится на изображении в основном окне, если в диалоговом окне установлен фла-
жок Preview (Предварительный просмотр), а в квадрате слева от названия эффекта
появится флажок (галочка). Чтобы отменить применение эффекта, нужно снять
флажок рядом с его названием.
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Рис. 20.10. В этом диалоговом i наложения слоя и слоевые
эффекты

Первыми в списке располагаются параметры наложения. В них входят: прозрач-
ность слоя, режим смешивания и дополнительные настройки в разделе диалогово-
го окна Advanced Blending (Дополнительное смешивание), предназначенные для кор-
ректировки 17 основных способов смешивания. Далее следуют стили Drop Shadow
(Отбросить тень), Inner Shadow (Внутренняя тень), Outer Glow (Внешнее свечение), Inner
Glow (Внутреннее свечение), Bevel A n d Emboss (Скос и рельеф), Satin (Атлас), Color Overlay
(Наложение цвета), Gradient Overlay (Наложение градиентной заливки), Pattern Overlay
(Наложение образца), Stroke (Штриховая обводка). Два из них, Drop Shadow (Отбросить
тень) и Outer Glow (Внешнее свечение), мы подробно рассматривали в главе 19, со-
здавая текст, отбрасывающий тень, и светящийся текст. С остальными стилями
работа ведется аналогично, их параметры в основном похожи, поэтому вам пред-
лагается поэкспериментировать самим.

К слою одновременно можно применять несколько из перечисленных стилей, что
позволяет создавать еще более замысловатые эффекты. Стили широко использу-
ются для обработки текста, различных элементов веб-графики (кнопок, стрелок
и т. д.), декоративных элементов в рекламных листках, на страницах журналов,
а также во множестве других случаев. Часто возникает ситуация, когда один и тот
же набор эффектов требуется применить к изображениям, хранящимся в разных
файлах. Это могут быть, например, кнопки на веб-странице. Программа преду-
сматривает подобные ситуации и позволяет сохранить набор эффектов в виде сти-
ля слоя в специальной палитре Styles (Стили), расположенной в одной группе вме-
сте с палитрами Color (Цвет) и Swatches (Каталог). Для этого, определив все эффекты
в диалоговом окне Layer Style (Стиль слоя), нужно нажать на кнопку New Style (Со-
здать стиль), ввести название стиля и нажать кнопку ОК. Чтобы затем применить
к слою записанный выше стиль, а также любой стиль из уже присутствующих
в палитре, следует активировать слой и нажать на соответствующую кнопку в палитре
Styles (Стили) — это, согласитесь, легко и очень удобно.
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Как всегда, программа предоставляет некоторый набор стандартных стилей и с по-
мощью меню палитры, открывающегося щелчком на круглой кнопке со стрелкой,
позволяет загрузить еще несколько наборов (они перечисляются в последней груп-
пе команд).

Следует запомнить
О Элементы изображения могут располагаться на отдельных слоях.

Q Вы вправе менять порядок слоев.

а Объекты на верхнем слое перекрывают объекты на нижних слоях.

а Бывают прозрачные слои, и прозрачность — регулируемый параметр.

О Используются различные режимы наложения слоев, а также к слоям можно
применить множество интереснейших эффектов.
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Фильтры программы Photoshop

а Многообразие фильтров
Q Влияние фильтров на изображение

Q Последовательное применение нескольких фильтров

а Эффекты

Фильтры предназначены как для улучшения качества изображения, так и для со-
здания художественных эффектов. В главе 15 мы уже рассматривали фильтры,
увеличивающие резкость и размывающие растр фотографии. Первые позволяют
сделать снимок более четким, вторые — избавиться от точек в одноцветных фрагмен-
тах изображения, являющихся следствием недостаточного качества светочувстви-
тельной матрицы или крупной зернистости пленки. С помощью некоторых филь-
тров можно наложить текстуру, другие имитируют различные манеры рисования
кистью или карандашом, а третьи — делают изображение рельефным. Экспери-
ментируя более чем со 100 фильтрами, сопровождающими программу Photoshop,
вы прекрасно проведете время и сможете достичь поразительных результатов.
Перед вами открываются новые неизведанные просторы для творчества.

Что такое фильтр?
Человеку, плохо знакомому с компьютером, фильтры, возможно, покажутся чем-
то волшебным, но на самом деле они представляют собой наборы математических
формул (называемых алгоритмами), которые применяются к пикселам изображе-
ния. Вычисление данных по формулам реализуется с помощью небольших, вы-
полняющих специальные задачи программ, которые можно вызывать из Photoshop.
Задача может быть простой, например найти каждый зеленый пиксел и изменить
его на красный, или усложненной, например найти те пикселы изображения, сре-
ди соседних пикселов к которым есть более темные, чем они сами, и затемнить
найденные пикселы. Соответственно, фильтры различаются по сложности обра-
ботки цветовой информации, а также по сложности настройки. Некоторые быстро
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выполняют свою работу, для применения части фильтров достаточно выбора од-
ной команды, другие же потребуют длительного процесса настройки параметров
и в течение нескольких секунд или, для большого файла, минут займут максимум
ресурсов компьютера.
Как правило, люди вовсе не задумываются о том, как устроен фильтр, а считают,
что это название употребляется в отношении большого количества миниатюрных,
специализированных программ. Мы тоже не будем изучать математические фор-
мулы, а подойдем с практической точки зрения.

ПРИМЕЧАНИЕ
Наиболее часто используемыми являются фильтры, увеличивающие резкость. Мы рассмат-
ривали их в главе 15. Своим появлением эти фильтры, так же как и вся цифровая фотогра-
фия, обязаны научным и военным исследованиям. Увеличение резкости фотографий позво-
лило, например, выделять отдельные звезды в скоплении или определять урожай на
какой-нибудь ферме в Небраске.

Применение фильтров к изображению в поисках нужного эффекта может превра-
титься в интереснейший процесс, занимающий минуты или даже часы. Вам не будет
скучно! Фильтры позволяют не только изменить вид изображения, но также его
настроение и содержание. Но прежде чем начать рассказывать о фильтрах, я должен
предупредить, что осторожность при обращении с фильтрами не помешает: больше
не всегда значит лучше. Злоупотребление эффектами чаще всего делает снимки
неестественными, оно оправданно только в чисто декоративных композициях.

Если требуется сохранить реальность фотографии, аккуратно применяйте филь-
тры. Создайте акценты или чуть оттените изображение. Никогда не используйте
фильтр только по той причине, что вы можете это сделать. Также учтите: если вам
приходится несколько раз применить фильтр, два или три, чтобы улучшить фото-
графию, значит, снимок изначально не был хорош. Возможно, проще будет снять
или отсканировать его заново. Своим студентам, обучающимся цифровой фото-
графии и электронной обработке изображений, я не разрешаю пользоваться филь-
трами до тех пор, пока они не начинают получать качественные снимки с интерес-
ными с художественной точки зрения композициями. Фильтры созданы для того,
чтобы улучшать уже «звучащее» изображение, а не для превращения цифрового
хлама в чуть более привлекательные, но также безынтересные картинки.

Какие фильтры бывают в Photoshop
Фильтры, встроенные в Photoshop, невероятно разнообразны, их называют стан-
дартными фильтрами, и они загружаются вместе с программой. Если для обработки
фотографий вы пользуетесь другим приложением, поставляемым вместе с фото-
аппаратом, оно также может содержать фильтры. Кроме того, существует огром-
ное количество пакетов фильтров, издаваемых сторонними программными разра-
ботчиками.

Большинство графических редакторов, включая Photoshop, позволяют подсоединять
различные пакеты фильтров, в то время как множество фирм занимается разработ-
кой специализированных фильтров. Эффекты, фильтры и прочее часто называют
расширениями, или подключаемыми модулями (plug-ins), поскольку они тесно
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интегрируются с базовыми программами. Как правило, приложение имеет папку
Plug-ins, в которой хранятся фильтры; есть такая папка и в программе Photoshop.

Неплохой список фильтров третьих фирм доступен по адресу www.thepluginsite.com/
resources, где они разделены на бесплатные и платные. Кроме того, сторонние разра-
ботчики обычно имеют собственные веб-сайты, на которых можно получить инфор-
мацию об их продукции. Чтобы найти такие сайты, воспользуйтесь традиционными
поисковыми системами Интернета. Часто с сайтов можно загрузить демонстраци-
онные версии подключаемых модулей, которые в большинстве случаев имеют огра-
ниченную функциональность (например не допускается сохранение результатов
работы), либо срок действия, но можете быть уверенными — этого более чем доста-
точно для разжигания вашего аппетита. Прежде чем покупать какой-нибудь фильтр,
имеет смысл загрузить его демонстрационную версию и убедиться в том, что про-
грамма будет работать в вашей системе, а также что вам действительно требуются
получаемые с ее помощью результаты. Будет весьма обидно, если заставить зара-
ботать купленный за довольно большие деньги фильтр можно будет, только обновив
аппаратное обеспечение или сменив операционную систему.

СОВЕТ
Фильтры — это великолепно, но не нужно забывать о многообразии эффектов, предостав-
ляемых стилями слоев и режимами смешивания. В некоторых ситуациях бывает выгоднее
применить стиль слоя, в других — фильтры.

Использование фильтров
Мы могли бы рассмотреть каждый фильтр Photoshop по отдельности, но это потре-
бовало бы много времени и, кроме того, чтение подобного описания стало бы довольно
скучным занятием. Поэтому мы подробно обсудим лишь несколько фильтров из раз-
ных групп. Чтобы познакомиться с остальными встроенными фильтрами программы
Photoshop, откройте изображение и щелкните на меню Filter (Фильтр). Команды
меню показаны на рис. 21.1. Вы обнаружите здесь больше ста фильтров; попро-
буйте развлечься, применяя наиболее приглянувшиеся эффекты к изображению.

I

I
ц
ill

Рис. 21.1. В каждой группе, доступной в меню Filter (Фильтр), содержится несколько фильтров
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При работе с фильтрами следует помнить следующее:

Q фильтры в программе Photoshop вызываются из меню Filter (Фильтр);

Q их можно применить к целому изображению, выделенной области или актив-
ному слою;

Q чтобы применить последний использовавшийся фильтр, не меняя его парамет-
ров, достаточно выбрать первую команду меню Filter (Фильтр) или нажать Ctrl+F;

Q отменить действие фильтра можно, нажав клавиши Ctrl+Z или выбрав команду
Edit > Undo (Редактирование > Отменить);

а если вы изменили настройки фильтра и хотите вернуть их в исходное состоя-
ние, то при открытом диалоговом окне фильтра нажмите клавишу Alt и щелк-
ните на кнопке Reset (Сброс), которая появится на месте кнопки Cancel (Отмена).

ПРИМЕЧАНИЕ -
В диалоговых окнах фильтров обычно есть окно предварительного просмотра и несколько
реже присутствует флажок Preview (Предварительный просмотр). Если флажок установлен,
результат действия фильтра демонстрируется в основном окне изображения в процессе
настройки параметров. Это, несомненно, очень удобно. Но зачастую результаты можно уви-
деть только в окне предварительного просмотра. Для увеличения или уменьшения масшта-
ба отображения служат расположенные под окном предварительного просмотра кнопки со
знаками «плюс» и «минус». Можно просмотреть несколько фрагментов изображения крупным
планом — для этого при подходящем масштабе нужно подвести указатель к окну, нажать
кнопку мыши и передвинуть изображение. Если просто нажать кнопку мыши, когда указатель
находится над окном, вы увидите исходное изображение и сможете сравнить картинку
до и после действия фильтра.

Фильтры в меню разделены на 13 типов, названия которых в большинстве случаев
позволяют определить, что делает та или иная группа фильтров. Дополнительные
фильтры сторонних фирм располагаются внизу списка. Группы стандартных филь-
тров называются следующим образом (см. рис. 21.1): Artistic (Художественные), Blur
(Размытие), Brush Strokes (Мазки кисти), Distort (Деформация), Noise (Шум), Pixelate
(Объединение пикселов), Render (Представление), Sharpen (Резкость), Sketch (Эскиз),
Stylize (Стилизация), Texture (Текстура), Video (Видео), Other (Другие).

Самую нижнюю позицию в меню Filter (Фильтр) занимает группа Digimarc (Водяные
знаки). Название фильтра на английском языке является сокращением от «digital
watermark» (цифровые водяные знаки), а сам фильтр представляет технологию,
используемую для внедрения в изображения кода, позволяющего отследить со-
блюдение авторских прав. Вы можете добавить электронную метку к своему изобра-
жению и проверить любое изображение на наличие электронной метки. Собствен-
ный идентификационный номер можно получить у компании Digimarc Corporation
(www.digimarc.com) за определенную плату.

Фильтры группы Artistic (Художественные)
Фильтры из этой группы пытаются воспроизвести эффекты применения инстру-
ментов рисования с соответствующими названиями. Поверх исходного изображе-
ния накладываются штрихи карандаша, мазки кисти или светящиеся цвета. К этой
группе относится довольно много эффектов; мы рассмотрим применение фильтра
Colored Pencil (Цветной карандаш).
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1. Откройте изображение, которое, на ваш взгляд, выглядело бы неплохо, если бы
было нарисовано карандашом. Подойдет достаточно контрастная фотография
с яркими цветами.

2. Выберите команду Filter > Artistic > Colored Pencil (Фильтр > Художественные > Цвет-
ной карандаш).

3. Откроется диалоговое окно фильтра, представленное на рис. 21.2. Параметр
Pencil Width (Толщина карандаша) определяет толщину штрихов, параметр Stroke
Pressure (Нажим) влияет на степень сохранения исходных цветов изображения,
и параметр Paper Brightness (Яркость бумаги) изменяет цвет бумаги (фона, который
программа определяет самостоятельно) от черного до цвета, заданного в квад-
рате Set background color (Установить цвет фона). Подвигайте ползунки, чтобы
настроить параметры.

Рис. 21.2. Действие фильтра с заданными параметрами отображается
в окне предварительного просмотра

4. Добившись приемлемого эффекта, нажмите кнопку ОК.

5. С помощью команды File > Save As (Файл > Сохранить как) запишите файл под
новым названием, чтобы сохранить оригинал.

Фильтры группы Blur (Размытие)
Фильтры из этой группы достаточно подробно мы рассматривали в главе 15. Как
правило, они используются для улучшения качества изображений — один из та-
ких примеров как раз и был представлен в главе 15. Но в некоторых случаях с по-
мощью таких фильтров, как Motion Blur (Размытие в движении) и Radial Blur (Радиаль-
ное размытие), можно получить очень привлекательные эффекты.

1. Откройте фотографию, на которой изображен объект в движении, например
катящийся автомобиль или бегущий человек, как на рис. 21.3.

2. Командой Window > Layers (Окно > Слои) выведите на экран палитру Layers (Слои),
если она скрыта в данный момент.
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3. Скопируйте фоновый слой. Для этого щелкните на названии слоя в палитре
Layers (Слои) и, удерживая кнопку мыши, перетащите слой на кнопку Create a new
layer (Создать новый слой) внизу палитры (вторая кнопка справа).

4. Копия фонового слоя автоматически становится активной. Это уже обычный слой,
и его можно переименовать с помощью команды Layer Options (Свойства слоя).

5. Хотя фильтр применим ко всему изображению, часто к лучшим результатам
приводит предварительное выделение фрагментов, которые следует защитить
от действия фильтра. Выберите подходящий инструмент выделения и выдели-
те объект на переднем плане. Прямоугольные, овальные или круглые объекты
удобно выделять с помощью инструментов группы Marquee (Выделение), для
одноцветных элементов используется Magic Wand (Волшебная палочка). Объек-
ты с контрастной границей проще всего выделить с помощью инструмента
Magnetic Lasso (Магнитное лассо), а неконтрастные, разноцветные объекты при-
дется выделять вручную, работая обычным и многоугольным лассо. Помните,
что можно комбинировать результаты выделения любыми инструментами, для
этого требуется перейти в соответствующий режим выделения. За более по-
дробной информацией о выделении областей обращайтесь к главе 16.

6. Имеет смысл немного размыть границу выделенной области. Выберите команду
Select > Feather (Выделение > Размытие). Задайте радиус размытия 1-3 пиксела.

7. Выберите команду Select > Inverse (Выделение > Инвертировать), чтобы выделить
все изображение за исключением объекта на переднем плане.

8. Выберите команду Filter > Blur > Motion Blur (Фильтр > Размытие > Размытие в дви-
жении). В открывшемся диалоговом окне установите подходящее значение па-
раметра Distance (Расстояние), позволяющее создать иллюзию движения объек-
та. Чтобы иллюзия была полной, требуется сохранить направление движения -
для этого предназначен параметр Angle (Угол). Если объект перемещается по
горизонтали, оставьте угол равным нулю.

9. Нажмите кнопку ОК. Вы получите изображение, похожее на представленное
на рис. 21.3.

Рис. 21.3. В этом примере я размыл слишком загруженный объектами задний план
и заодно создал иллюзию движения

Инструмент Smudge (Палец)
Инструмент Smudge (Палец) действует аналогично фильтру Motion Blur (Размытие в дви-
жении). Он расположен на палитре инструментов в одной группе с инструментами
Blur (Размытие) и Sharpen (Резкость) и позволяет смазывать изображение подобно
тому, как это было сделано с фотографией, показанной на рис. 21.4.
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Рис. 21.4. С помощью инструмента Smudge (Палец)
на этой фотографии имитируется сильный ветер

Попробуйте применить инструмент Smudge (Палец). Включите его, на панели па-
раметров выберите кисть большого размера — чтобы был заметен результат —
и проведите указателем над изображением, нажав кнопку мыши. Все выполняется,
как при рисовании любым из инструментов. В обычном режиме работы инстру-
мента пикселы, расположенные под кистью, сдвигаются в направлении движения
указателя, при этом они размываются, и создается иллюзия смазывания краски.
В режиме рисования (когда установлен флажок Finger Painting (Рисование пальцем)
на панели настройки инструмента) на место первого щелчка кистью наносится цвет
фона, который при движении инструмента смазывается вместе с изображением.
Чтобы нанести больше цвета, можно щелкнуть несколько раз, а чтобы сильнее его
размазать — несколько раз провести инструментом. Параметры инструмента по-
зволяют выбирать размер кисти и регулировать нажим.

С помощью инструмента Smudge (Палец) также можно получить видимость дви-
жения. Работая с ним, я всегда создаю копию слоя, на которой применяю инстру-
мент. Затем иногда снижаю непрозрачность обработанного слоя, чтобы снизить
эффект смазывания.

ПРИМЕЧАНИЕ
Как нетрудно догадаться, два других инструмента, скрывающихся под той же кнопкой, что
и инструмент Smudge (Палец), размывают изображение или увеличивают его резкость подоб-
но фильтрам Blur (Размытие) и Sharpen (Резкость). Только действуют они в пределах обла-
сти, покрываемой аппликатором кисти. Иногда, например когда требуется усилить резкость
небольшого объекта на достаточно размытом фоне, это очень удобно.

Фильтры группы Texture (Текстура)
Последней группой фильтров, рассматриваемой в книге, будет группа Texture (Тек-
стура). Эти любопытнейшие фильтры неплохо подходят для создания структуриро-
ванного заднего плана или интересных эффектов. Не бойтесь экспериментировать.
Если вы придерживаетесь стратегии сохранения копий изображения и работы на
слоях, вы всегда сможете отменить результаты действия любого инструмента. В эту
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группу входят фильтры Craquelure (Кракелюр1), Grain (Зерно), Mosaic Tiles (Мозаика),
Patchwork (Цветные лоскуты), Stained Glass (Витраж) и Texturizer (Текстуризация).

Попробуйте применить фильтры. Для этого, как всегда, откройте изображение
и выберите любую команду из подменю Texture (Текстура) меню Filter (Фильтр).
На рис. 21.5 продемонстрировано действие двух фильтров — Mosaic Tiles (Мозаика)
и Patchwork (Цветные лоскуты).

Рис. 21.5. Изображение слева кажется напечатанным на рельефной поверхности, справа —
основой для вышивки крестом

Пример: применение нескольких фильтров
К одному изображению можно последовательно применить несколько фильтров.
Это позволяет придумывать интересные композиции, как в следующем примере.

1. Создайте новое изображение. Для этого выберите команду File > New (Файл > Соз-
дать) и в открывшемся диалоговом окне введите имя файла, задайте ширину
5 дюймов (inch), высоту 4 дюйма и разрешение 72 dpi (пикселов/дюйм), ре-
жим — RGB.

2. Назначьте один из первичных цветов (красный, зеленый или синий) в качестве
цвета фона. Воспользуйтесь для этого соответствующим квадратом на панели
инструментов.

3. Затем выберите команду Edit > Fill (Редактирование > Заполнение) и в списке Use
(Использовать) установите вариант Background Color (Цвет фона). Нажмите кноп-
ку О К, и изображение заполнится цветом фона, как на рис. 21.6.

4. Выберите команду Filter > Noise > Add Noise (Фильтр > Шум > Добавить шум).

5. В диалоговом окне Add Noise (Добавить шум) установите переключатель в поло-
жение Gaussian (По Гауссу), установите флажок Monochromatic (Монохроматиче-
ский) и введите в поле Amount (Количество) цифру 155, как показано на рис. 21.7.

Франц. Craquelure — растрескивание грунта, красочного слоя или лака картины. — Примеч. ред.
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9.

10.

11.

Рис. 21.6. Начинаем работу с однотонного заднего плана

Рис. 21.7. Воздействие фильтра Add Noise (Добавить шум) на однотонный фон

6. Нажмите кнопку О К. Получился отличный фон, похожий на ковровое покры-
тие с грубым ворсом.

7. С помощью инструмента Rectangle Marquee (Прямоугольное выделение) выдели-
те в центре прямоугольник, занимающий примерно 2/3 изображения.

8. Выберите команду Filter > Blur > Motion Blur (Фильтр > Размытие > Размытие в дви-
жении).

Задайте параметр Distance (Расстояние) равным 50, щелкните на кнопке ОК, и вы
получите картинку, изображенную на рис. 21.8 слева.

Опять воспользуйтесь инструментом Rectangle Marquee (Прямоугольное выде-
ление), чтобы выделить в центре размытой области прямоугольник.

Выберите команду Filter > Distort > Ripple (Фильтр > Деформация > Рябь). Оставьте
параметры, установленные по умолчанию, как показано на рис. 21.8, и нажми-
те кнопку ОК. В результате вы из пустого изображения создали три замеча-
тельных текстуры, которые можно использовать в роли декоративных элемен-
тов изображений или их обрамлений.
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Рис. 21.8. Размытие фрагмента изображения подготовило его к применению ряби

Создание собственного фильтра
Если среди стандартных фильтров не обнаружилось подходящего, или вам при-
шлось много раз применить один и тот же фильтр, возможно, имеет смысл попробо-
вать создать собственный фильтр. Выберите команду Filter > Other > Custom (Фильтр >
Другие > Заказной). Откроется довольно сложное диалоговое окно, изображенное
на рис. 21.9. В нем таблица с 25 пустыми полями предназначена для ввода число-
вой матрицы размером 5x5. Центральное поле обозначает рассматриваемый в дан-
ный момент пиксел, новое значение яркости которого формируется исходя из пер-
воначального значения и величин окружающих его 24 пикселов с коэффициентами,
задаваемыми матрицей. Фильтр проходит по изображению и по очереди вычисля-
ет яркость каждого пиксела. Он умножает яркость каждого из 25 пикселов на чис-
ло, введенное в соответствующее поле таблицы, суммирует полученные цифры,
делит их на параметр Scale (Масштаб) и прибавляет параметр Offset (Смещение).
В поля таблицы можно заносить целые числа от -999 до +999, но обычно исполь-
зуются небольшие числа. Если ввести в центральное поле 1, оставив остальные
пустыми, а масштаб сохранить равным 1, нетрудно понять, что вид изображения
не изменится.

Чтобы избежать полной потери деталей, а также сильного осветления или за-
темнения изображения, следует поддерживать отношение суммы коэффициентов
(чисел, вводимых в поля таблицы диалогового окна) к масштабу примерно
равным 1. Во всех предопределенных наборах чисел для фильтрации изображе-
ний величина масштаба равна сумме всех коэффициентов. Если увеличивать сум-
му коэффициентов и не менять масштаб, изображение осветляется, а если умень-
шать? Правильно, затемняется. При этом не требуется вводить коэффициенты
во все поля окна, просто пикселы, соответствующие пустым полям, не будут влиять
на результат.
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Ш

Рис. 21.9. При снятом флажке Preview (Предварительный просмотр) в основном окне
отображается фотография до применения данного заказного фильтра,

а в окне предварительного просмотра — после

Здесь добиться желаемого результата можно только методом проб и ошибок, и это
довольно сложно. Если же вы получили требуемый фильтр, сохраните его для даль-
нейшего использования, нажав на кнопку Save (Сохранить). Фильтры записывают-
ся в файлы с расширением ACF. В Интернете я нашел следующую матрицу, кото-
рая немного раздваивает изображение:
0 1 2 1 0
1 -1 -2 -1 1
2 - 2 4 - 2 2
1 -1 -2 -1 1

1 1 2 1 0

Результат действия такого фильтра с масштабом 8 (сумма всех коэффициентов
равна 8) представлен на рис. 21.9. Можно поиграть со значениями масштаба и сме-
щения, изменяя контраст и осветляя или затемняя изображение. На рис. 21.9 сме-
щение выбрано нулевым.

Вот еще один фильтр, мягко размывающий изображение:

01210

13431

24942

13431

01210

Сумма всех коэффициентов равна 53, поэтому масштаб лучше взять равным 53,
а смещение — нулевым. Это фактически приближение гауссова размытия (фильтр
Gaussian Blur (Размытие по Гауссу)). Посмотрите на результат его действия и, если
вам понравилось, сохраните фильтр.

Множество рецептов по созданию заказных фильтров, а также готовых фильтров
можно найти в Интернете на сайтах, посвященных программе Photoshop и в целом
графическому дизайну.
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Следует запомнить
Фильтром называется обрабатывающая изображение программа, которая реа-
лизует некоторый математический алгоритм.

Существуют фильтры, встроенные в программы — стандартные, кроме того,
допускается использование фильтров сторонних фирм и создание собственных.

Фильтры можно применять ко всему изображению, к выделенной области или
слою. Последние два метода позволяют защитить от действия фильтра любые
фрагменты изображения.

Одно изображение можно обработать несколькими фильтрами. Последователь-
ное применение нескольких фильтров способно привести к уникальным резуль-
татам.



Глава 22

Калибровка устройств

Q Цвета на экране монитора и на отпечатке могут не совпадать
а Калибровка монитора
а Настройка принтера
Q Когда ничего не помогает, можно действовать последовательными при-

ближениями

Зайдите как-нибудь в магазин, торгующий телеаппаратурой, и внимательно рас-
смотрите стоящие на полках телевизоры. Скорее всего, вы не сможете найти двух
абсолютно одинаковых экранов — все выглядят по-разному. Один будет чуть тем-
нее своих соседей, другой — светлее, изображение на третьем покажется немного
зеленым, а на четвертом — слишком контрастным. Который же из них отображает
правильный цвет и какой лучше покупать?

Итак, мы столкнулись с одной из самых неприятных проблем цифровой фотогра-
фии — управлением цветом. Как быть уверенным в том, что просматриваемая на
экране монитора фотография имеет правильные цвета? И будет ли изображение,
прекрасно выглядящее на вашем экране, отображаться точно так же на других мо-
ниторах? Будут ли правильно передаваться цвета, яркость и контраст?

Управление цветом не ограничивается только настройкой монитора. Если плани-
руется печатать изображения, нужно учитывать параметры принтера. Все принте-
ры по-разному воспроизводят цветовую гамму. Можно пойти в магазин, продаю-
щий компьютеры, и попробовать распечатать одно изображение на трех моделях
принтеров — вы получите три совершенно разных результата. На самом деле, даже
если напечатать изображение на трех принтерах одной модели, результаты будут
немного отличаться друг от друга.

Проблема различия передачи цвета разными устройствами называется аппарат-
ной зависимостью цвета. И если не прикасаться к монитору и принтеру, вероят-
ность получить совпадение цветов изображения на экране и на бумаге с теми крас-
ками, которые должен был передать фотоаппарат, будет очень маленькой. Это
дело случайности! Скорее всего, они будут отличаться друг от друга. Описанная
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проблема стоит перед всеми пользователями, так или иначе имеющими дело с циф-
ровой графикой. Специально для ее решения была создана система управления
цветом (Color Management System — CMS). Разработчики этой системы попыта-
лись гармонично связать различия цветов входных и выходных устройств, для чего
была придумана цветовая модель с аппаратно-независимыми цветами. Такими
цветами намного проще управлять. Потратив некоторое время на тестирование
и настройку, вы сможете получать согласованное представление идентичных цве-
тов и предсказуемые конечные результаты независимо от используемых моделей
монитора и принтера.

Как это делают профессионалы
Чтобы объяснить, как работает механизм управления цветом, я собираюсь расска-
зать о системе, принятой в профессиональной фотографии и в типографиях. За-
тем мы обсудим ее применение обычными пользователями на своих компьютерах.
Данная система не только обеспечивает согласованность цветов, но и позволяет
при подсоединении различных устройств (мониторов и принтеров) получать оди-
наковый результат. Сейчас нам необходимо будет углубиться в некоторые техни-
ческие детали, о чем я вас заранее предупреждаю. Не нужно пугаться. Сядьте по-
удобнее и прочтите следующие разделы; в конце все обретет смысл.

Модель LAB
Расположим все видимые человеческим глазом цвета в трехмерном пространстве.
Для трехмерного представления цвета используются различные фигуры, такие как
куб, сфера или даже пирамида. Мы уже говорили о цветовых моделях в главе 15,
они называются RGB, CMYK, HSB и LAB, сейчас мы будем обсуждать последнюю.
В ней по координатным осям откладываются осветление (Lightness) и две цветовые
кооординаты: А (от зеленого до красного) и В (от синего до желтого) (рис. 22.1).
Это позволяет для каждого из цветов указать его точное место в цветовом про-
странстве. Например, яркий огненно-красный имеет координаты L = 52, А = 70,
В = 59. Поскольку определенная таким образом система координат не зависит от ви-
дения цвета конкретным человеком, координаты в ней «яркого огненно-красного»
цвета также не будут обуславливаться человеческим зрением. Таким образом,
можно точно описать трехмерное цветовое пространство, и это описание является
аппаратно-независимым.

Международная комиссия по освещению (CIE) разработала данную модель
в 1931 году, а в 1976 году преобразовала ее и назвала цветовой системой CIELAB.
Теоретически, в ней представлены все цвета, различаемые человеческим глазом,
и каждый цвет можно описать тремя координатами. До тех пор пока все будут ис-
пользовать модель CIE LAB для поиска и воспроизведения цветов (дальше мы
будем называть ее просто LAB), все будут получать одинаковое отображение иден-
тичных цветов. То есть если мы говорим, что увидим L = 65, А = 62, В = 64 (оран-
жевый), мы должны увидеть именно оранжевый. Данная цветовая модель, реали-
зующая согласованный подход к описанию цвета, является ключом к управлению
цветом, то есть ее можно использовать в качестве некоторой основы для сравне-
ния цветов и устройств, связанных с отображением цветов.
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Рис. 22.1. Для описания цвета в пространстве LAB используются три координатных оси

Ранее, говоря о цвете, я всегда описывал его в составляющих RGB. Что же заставило ме-
ня переключиться на модель LAB и почему в данном случае не подходит модель RGB?

В последней используется аддитивный метод описания цвета, то есть цвет опреде-
ляется присутствием в нем красного, синего и зеленого света. Эта модель приме-
няется в мониторе — речь идет об интенсивности освещения точек экрана. Также
часто употребляемой является модель CMYK, хотя она упоминалась всего один
раз — она применяется при печати. В этой системе цвет определяется количеством
голубой, пурпурной, желтой и черной красок, попавших на бумагу.
Проблема заключается в том, что для отображения одного и того же цвета в разных
мониторах используются разные типы люминофорных покрытий. Если на одном
экране яркий огненно-красный имеет составляющие 235R, 28G, 28В, то на другом —
235R, 25G, 31В. Аналогично, для создания одного и того же цвета при печати в моде-
ли CMYK разными принтерами используется разное количество красителей.
Обе системы, RGB и CMYK, являются аппаратно-зависимыми, то есть определе-
ние цвета меняется от устройства к устройству, оно отталкивается от качествен-
ных характеристик люминофоров или краски. А составляющие модели LAB не
привязаны к конкретным краскам или люминофорам, поэтому она считается ап-
паратно-независимой. Не имеет значения, на каком устройстве воспроизводится
яркий огненно-красный цвет — различий мы не увидим, хотя он создается разным
количеством краски или светящегося люминофора.
Какой из всего этого можно сделать вывод? Ответ достаточно прост — для калиб-
ровки (то есть настройки согласованного отображения цветов) монитора и прин-
тера мы воспользуемся аппаратно-независимой моделью LAB, после чего пред-
ставление цветов вашими устройствами станет безукоризненным.

Профили ICC
Итак, модель LAB позволяет описать любой требуемый нам цвет, включая яркий
огненно-красный. То есть мы знаем желаемый результат, и теперь необходим метод,
дающий возможность определить, насколько мы в данный момент далеки от этого
результата. Организация ICC (International Color Consortium — Международный
комитет по цветам), которая состоит из представителей восьми лидеров индуст-
рии цифрового дизайна, таких как Kodak, Adobe, Apple Computer и AGFA, разра-
ботала требуемое средство. Благодаря чему, определив свою позицию относительно
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желаемого результата, мы можем внести в модель соответствующие поправки
и индексировать систему так, чтобы цвета отображались правильно.

Система ICC действует достаточно просто, и с ее помощью поддается настройке
любое устройство, управляющее цветами. Сначала нужно отобразить на мониторе
или принтере набор цветов, для которых известны их координаты LAB (в примере
будет использоваться монитор). После того как цвет, скажем, L - 100, А - 80, В = 60,
появился на экране, следует измерить его с помощью специального устройства,
так называемого калибратора мониторов — оно показано на рис. 22.2. Калибратор
воспримет цвет, демонстрируемый на мониторе, и представит его в модели LAB.
Предположим, что калибратор получил цвет L - 98, А = 80, В = 60. Разница -2 по
координате L фиксируется в профиле ICC.

-

Рис. 22.2. Калибратор монитора измеряет цвет, отображаемый монитором, с целью создания
профиля ICC

Вполне возможно, что у вас нет под рукой калибратора монитора. Что же делать
в этом случае? Здесь подойдет один из стандартных цветовых профилей, которые
производители теперь создают для каждого устройства, или же сформированный
собственноручно профиль, основанный на личном зрительном восприятии цвета.
Имея в качестве «фундамента» стандартный профиль ICC (если профиль отсут-
ствует в документации к устройству, вам придется обратиться за ним к произво-
дителю), можно скорректировать настройки практически с той же точностью, ка-
кую предоставляет дорогой калибратор.

Точная настройка мониторов и принтеров
Если вы действительно готовы потратить много денег, а обработка изображений
является необходимой составляющей вашей работы или любимым увлечением,
без которого вы себя не представляете, купите профессиональный монитор с кали-
братором, куда должен входить и пакет для калибровки. Конечно, можно приобре-
сти калибратор и необходимое программное обеспечение отдельно от монитора.
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Стоимость этих устройств и программ различна— от самых дешевых до $1000.
Калибраторы высокого качества жизненно важны только людям, профессиональ-
но работающим с цветом: дизайнерам, фотографам и т. п., остальным вполне по-
дойдут достаточно дешевые устройства среднего уровня. Лучше всего, на мой
взгляд, искать и покупать калибратор через Интернет или по каталогам, а допол-
нительные сведения о калибровке и программном обеспечении, предназначенном
для измерения цвета, можно получить по адресу www.color.com.

Но обычные пользователи, не имеющие таких специальных устройств, как калибра-
тор, теперь также легко могут настроить свои мониторы, воспользовавшись широко
доступными стандартными профилями и программами калибровки, поставляемыми,
например, вместе с Adobe Photoshop. Программы калибровки на компьютерах с опе-
рационной системой Windows отличаются от аналогичных программ на компьюте-
рах Macintosh (в последних чаще всего используется панель управления ColorSync).

Калибровка монитора
Может быть, у вас розовая роза и получается розовой, но также нужно удостове-'
риться в том, что красная роза выглядит красной, а желтая — желтой. Приступим
к работе.

Программа калибровки действует следующим образом: она координирует и отсле-
живает все профили и обеспечивает соответствующую настройку аппаратуры. Так,
считав профиль, который был получен в примере предыдущего раздела, програм-
ма будет добавлять 2 по координате L к любому цвету, посылаемому на монитор.
Тогда любой цвет будет выглядеть должным образом.

Все системы калибровки немного отличаются друг от друга, но общий принцип
остается неизменным. Рассмотрим основные шаги процесса настройки монитора.

1. Включите компьютер и дайте ему проработать как минимум полчаса (а луч-
ше — несколько часов), чтобы прогрелся монитор.

2. Запустите программу калибровки. Если у вас установлена программа Photoshop,
то одновременно с ней автоматически в папке Панель управления (Control Panel)
размещается модуль Adobe Gamma. Запустите его, выбрав в Windows команду
Пуск > Настройка > Панель управления (Start t Settings > Control Panel) и в открыв-
шейся папке щелкните на ярлыке Adobe Gamma.

3. В открывшемся диалоговом окне, представленном на рис. 22.3, установите пе-
реключатель в положение Step By Step (Wizard) (По шагам (Мастер)) и нажмите
кнопку Next (Далее). Если вы случайно выбрали вариант Control Panel (Панель
управления), в ней нажмите на кнопку Wizard (Мастер) в правом нижнем углу.

4. На следующем шаге мастер попросит загрузить стартовый ICC-профиль ваше-
го монитора. Если таковой имеется, нажмите на кнопку Load (Загрузить) и в спис-
ке профилей выберите нужный. В противном случае оставьте профиль, уста-
новленный программой. Щелкните на кнопке Next (Далее).

5. На третьем шаге появляется окно, показанное на рис. 22.4. Оно предназначено
для настройки яркости и контрастности монитора, которая может осуществ-
ляться с помощью маленьких ручек внизу или сбоку монитора или из программ-
ной панели, которая вызывается на экран нажатием кнопки спереди монитора.
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В соответствии с пояснениями в диалоговом окне установите максимальный
контраст. После этого уменьшайте яркость до тех пор, пока внутренний квад-
рат еще будет виден на фоне черного внешнего квадрата, а белая рамка будет
оставаться яркого белого цвета. Затем нажмите кнопку Next (Далее).
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Рис. 22.3. Выберите установленный по умолчанию вариант Step By Step (Wizard) (По шагам
(Мастер))
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Рис. 22.4. Настройте яркость и контрастность в соответствии с указаниями программы

6. Затем вас попросят указать тип кинескопа. К примеру, если вы знаете, что
в вашем мониторе установлен Sony Trinitron CRT, выберите именно этот вари-
ант. Данная информация должна содержаться в документации к монитору. Если
нужного типа кинескопа в списке нет, но вы располагаете информацией о тех-
нических данных монитора, следует выбрать вариант Custom (Заказной), в про-
тивном случае оставьте вариант, используемый по умолчанию. Нажмите кноп-
ку Next (Далее).

7. Снимите флажок View Single Gamma Only (Просмотр только общей гаммы). Диало-
говое окно примет вид, представленный на рис. 22.5, в котором красный, зеленый
и синий квадраты соответствуют трем каналам. Установите ползунки в такие
положения, чтобы центральные части квадратов слилась с полосатой рамкой.
Затем опять нажмите на кнопку Next (Далее).

8. В следующем окне модуля Adobe Gamma нужно указать параметр Hardware White
Point (Значение белой точки) вашего монитора. «Белая точка» характеризует
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температуру максимально яркого белого цвета, отображаемого экраном кинескопа.
Даже если вы знаете значение белой точки, для его подтверждения следует
щелкнуть на кнопке Measure (Измерить). В новом окне с инструкцией по измерению
белой точки следует щелкнуть на кнопке ОК. Экран станет черным, и на нем
появятся три серых квадрата. Щелкните на правом или левом в зависимости от
того, какой из них вам кажется более близким к нейтральному серому. Продолжай-
те процесс до тех пор, пока в центре не окажется наилучший с вашей точки
зрения вариант. Для завершения процедуры щелкните на среднем квадрате,
а в диалоговом окне модуля Adobe Gamma нажмите кнопку Next (Далее).
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Рис. 22.5. Для настройки гаммы годится любое число в диапазоне от 1,0 до 3,0, но на данном
этапе лучше оставить значение Windows Default (По умолчанию для Windows)

9. Далее вас спросят о том, не хотите ли вы работать при температуре белой точки,
отличной от реального значения этого параметра для вашего монитора (только
что измеренного). В большинстве случаев лучше ответить на этот вопрос
отрицательно и, соответственно, оставив параметры без изменений, нажать
кнопку Next (Далее).

10. На последнем шаге, показанном на рис. 22.6, с помощью переключателя мож-
но посмотреть на отображение экраном цветов до и после настройки. Затем
щелкните на кнопке Finish (Готово) и сохраните созданный профиль со своим
названием.
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Рис. 22.6. Здесь можно посмотреть на цвета до и после настройки монитора



304 Глава 22. Калибровка устройств

ПРИМЕЧАНИЕ
Важно понимать, что программы калибровки не изменяют содержимое файлов изображе-
ний, Они только контролируют представление изображений на экране монитора или вывод
на печать. Следовательно, если вы передаете кому-нибудь файл, и монитор или принтер
этого пользователя были правильно откалиброваны, то есть для них созданы 1СС-профили,
которые загружаются при запуске системы, то на таком компьютере изображение будет
выглядеть так же, как и на вашем мониторе.

Выполнив калибровку один раз, не думайте, что это навечно. Со временем в мони-
торе цветовые составляющие «сдвигаются», поэтому периодически следует зано-
во настраивать цвета. Если вы разобрались с каждым из этапов калибровки, мож-
но выполнить их все вместе в одном диалоговом окне, изображенном на рис. 22.7.
Для того чтобы попасть в него, требуется на третьем шаге выбрать вариант Control
Panel (Панель управления).

' ' ЩЩйШ

Рис. 22.7. Опытные пользователи могут работать с панелью управления модуля Adobe Gamma

Калибровка принтера
В программное обеспечение некоторых принтеров входят калибровочные тесты.
Они обычно включают в себя тестовые примеры, которые следует напечатать и в
соответствии с полученными цветами выбрать набор образцов цвета.

Профессионалы настраивают принтер, индексируя цвета LAB с помощью специ-
ального оборудования для калибровки принтера. То есть они делают тестовый от-
печаток, а затем измеряют полученный цвет, используя, например, такой калибра-
тор для принтера, как представленный на рис. 22.8. Калибратор при небольшом
участии программного обеспечения генерирует ICC-профиль для принтера. На-
пример, мой принтер воспроизводит цвета, имеющие L = 100, со значением L = 110,
следовательно, его ICC-профиль равен +10. И когда система отправляет цвет на
печать, из его составляющей L вычитается 10 — поскольку это число добавляется
самим принтером.
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Рис. 22.8. Калибратор для принтера используется для измерения цвета на любой отражающей
поверхности, такой как бумага

К счастью остальных пользователей, больше таких проблем не существует! Про-
грамма Photoshop предоставляет средства для управления цветом при печати.
Выполните следующее.

1. Откройте программу и выполните команду File > Print with Preview (Файл > Пе-
чать с предварительным просмотром).

2. Установите флажок Show More Options (Показать больше параметров), если он снят.

3. В раскрывающемся списке выберите вариант Color Management (Управление цве-
тами) и в списке Profile (Профиль) укажите вариант, соответствующий вашему
принтеру.

4. В списке Intent (Цель) для фотографий обычно устанавливают вариант Perceptual
(Учитывающий восприятие).

СОВЕТ
ICC-профиль можно внедрить в изображение при сохранении, установив в диалоговом окне
Save As (Сохранить как) соответствующий флажок. Так как ваш принтер откалиброван, это
приведет к отображению правильных цветов.

Калибровка принтера вручную
Если вы по каким-то причинам не в состоянии использовать одну из последних
версий программы Photoshop или подобного приложения или ICC-профили, вам
придется настраивать принтер вручную.

1. Выполните калибровку монитора.

2. Откройте какое-нибудь изображение, желательно, тестовое, то есть содержа-
щее чистые основные цвета (его можно быстро создать, нарисовав на белом фоне
квадраты и раскрасив их в разные цвета).

3. Назовите этот файл Original (Исходное) и напечатайте изображение.

4. Сравните отпечаток с изображением на экране. Если цвета в них совпадают,
процесс калибровки закончен. Но если цвета различны, скажем, отпечаток по-
лучился немного синее и темнее изображения на экране, нужно проделать еще
несколько операций.

5. Скопируйте исходное изображение и закройте его, а копию назовите «Тест1».
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6. Настройте цвета в изображении «Тест!» так, чтобы оно стало чуть светлее
и менее синим, то есть более желтым. Настройка цветов подробно обсуждалась
в главе 15. Общая идея состоит в том, чтобы подобрать такие параметры изобра-
жения на экране, которые компенсировали бы цветовые сдвиги принтера. Также
следует учитывать яркость и контраст.

7. Следует запоминать все внесенные изменения — можно просто записать их на
листке бумаги, который потом прикрепить к монитору.

8. Напечатайте измененное тестовое изображение.

9. Откройте файл с исходным изображением, при этом скрыв или закрыв тесто-
вое изображение. Стали ли цвета на отпечатке ближе к исходным? Если они
одинаковы, то внесенные изменения, которые вы записывали на бумаге, нужно
сохранить, чтобы впоследствии применять к изображениям. Их можно назвать
«параметрами калибровки». Если отпечаток все еще сильно отличается от ис-
ходного изображения, сделайте еще одну тестовую копию и повторите весь про-
цесс. Возможно, вам придется выполнить всю процедуру несколько раз, пока
результат не станет приемлемым.

Далее работа с изображениями будет такой.

1. Полностью отредактируйте изображение, предназначенное для печати, чтобы
оно выглядело на экране наилучшим образом.

2. Сохраните изображение.

3. Внесите все изменения по яркости, контрасту и цветам, которые записаны
в ваших параметрах калибровки.

4. Напечатайте изображение. Оно должно выглядеть идентично изображению на
экране монитора, поскольку вы внесли все изменения, необходимые для пра-
вильного представления цветов принтером.

Я понимаю, что это достаточно надуманный и немного странный способ печати
изображений, но он работает. Возможно, для некоторых случаев параметры ка-
либровки будут отличаться от подобранных вручную, но от них все же гораздо
легче отталкиваться.

Следует запомнить
Q Добиться воспроизведения аппаратно-независимых цветов можно с помощью

программ ColorSync или Adobe Gamma, которые используют 1СС-профили.

О Если вы работаете на достаточно старом оборудовании, не так сложно своими
силами определить параметры калибровки и затем также вручную их применять.

П Создать ICC-профили монитора и принтера позволяют специальные устрой-
ства, измеряющие излучаемый или отражаемый свет. Но большинство людей
довольствуются доступным теперь программным обеспечением, которое пре-
доставляет неплохую настройку устройства на основе восприятия цвета чело-
веческим глазом.



Часть V

Демонстрация фотографий
Несомненно, замечательно рассматривать изображения на ярком экране монитора.
Но еще более интересно получить из цифрового изображения хорошие фотогра-
фии на бумаге. Создание превосходных отпечатков, «достойных обрамления», яв-
ляется весьма ценным опытом.

В принципе, печатать изображения очень легко. После калибровки устройств прин-
тер будет точно воспроизводить цвета, отображаемые на экране монитора. Следо-
вательно, вы можете напечатать столько одинаковых копий любой картинки, сколь-
ко пожелаете. Только подумайте — вам больше никогда не понадобится покупать
поздравительные открытки, поскольку вам будет под силу самим создавать их,
рисовать и печатать!

Я захотела напечатать
картинку с парой кроликов,
но прежде, чем я поняла,

что сделала,
появились сотни копий.
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Печать изображений

а Печать изображений

Q Создание нескольких копий

Q Печать прямо с камеры

а Создание индекс-отпечатка

Существует только один процесс, который может быть даже более захватываю-
щим, чем первый просмотр фотографий на экране компьютера, — это ожидание
появления из лотка принтера листа бумаги с отпечатанным изображением.
В главе 5 мы кратко рассмотрели все доступные на данный момент модели прин-
теров и описали преимущества различных технологий, а теперь остановимся на
том, как напечатать изображение. Это увлекательная, быстрая и достаточно про-
стая процедура!

Установка принтера
Прежде чем вы начнете тратить свое время, бумагу и чернила на печать изображе-
ний, вам необходимо самостоятельно ознакомиться с принтером. Если принтер
еще не подсоединен к компьютеру, подключите его, следуя инструкциям по уста-
новке, а также загрузите все требуемые драйверы (программы, реализующие об-
мен данными между компьютером и принтером). Любой принтер продается вмес-
те с программой установки, которая или автоматически устанавливает драйверы,
или с помощью различных вопросов и пояснений упрощает этот процесс.
Затем нужно протестировать принтер. Если сразу приняться за печать фотографий
из графических редакторов, результат может разочаровать вас. Тестировать принтер
лучше всего с помощью знакомой программы, например текстового редактора типа
Microsoft Word. Это позволит выявить и устранить неполадки, которые могут воз-
никнуть в ходе присоединения принтера к системе. Убедившись в том, что принтер
правильно печатает текстовые документы, можно приступать к его настройке из гра-
фических редакторов, и вполне вероятно, что вы сразу получите хорошие изображения.
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Разрешение принтера
Мы уже не раз обсуждали в этой книге вопрос разрешения изображений, и как раз
при печати оно играет очень важную роль. Если изображение имеет недостаточ-
ное разрешение (а следовательно, файл — небольшие размеры), вы вряд ли до-
стигнете хороших результатов. Отпечатанное изображение будет выглядеть как
бы состоящим из квадратиков, то есть окажется разбитым на пикселы, кроме того,
станет нерезким. Чем меньше сохранено цифровых данных, тем меньше мелких
деталей можно будет рассмотреть на отпечатке.

Разрешение принтера измеряется количеством точек, которые тот наносит на бу-
магу, чтобы нарисовать линию длиной один дюйм. Единица измерения обознача-
ется dpi — dots per inch. Довольно подробно понятие разрешения мы уже рассмат-
ривали в главе 11, и сейчас повторим пройденное.

ПРИМЕЧАНИЕ —
Раньше, когда использовались «настоящие» печатающие прессы, разрешение определялось
количеством точек, которое можно было нанести на негатив. Из готового негатива вытравли-
вались печатные формы. (Делался негатив, из него с помощью контактной съемки создавали
позитивную металлическую печатную форму, а с нее чернила попадали на бумагу.)

Разрешение изображения измеряется в пикселах на дюйм (ppi, или pixels per inch),
и оно не эквивалентно разрешению принтера (dpi). Многие принтеры в состоянии
наносить на бумагу несколько точек для каждого пиксела. Оптимальное соотно-
шение количества точек на пиксел для вашего печатающего устройства проще всего
найти не методом экспериментов, а прочитав руководство к принтеру. Подобная
информация может быть написана даже на упаковке (коробке) принтера, как один
из пунктов, указывающих на преимущества данного изделия.

ПРИМЕЧАНИЕ -
Разрешающая способность современных принтеров все более и более увеличивается.
В рекламе производителей можно увидеть такие определения, как «микроточки», «крошеч-
ные точки» и даже описания технологии «мельчайших точек». Подобные различия в терми-
нологии затрудняют процесс сравнения разных моделей принтеров. К сожалению, есть только
один способ узнать, какой принтер позволяет получить наилучшие изображения — напеча-
тать снимок на нескольких аппаратах и сравнить результаты. Если вы еще не приобрели
собственный принтер, но собираетесь это сделать, за дополнительной информацией обра-
щайтесь к главе 5.

После определения оптимального разрешения для принтера нужно принять реше-
ние о будущих размерах напечатанного изображения. Тогда, исходя от противно-
го, вы сможете определить размеры требуемого для этого файла. Например, ваш
принтер хорошо печатает изображения, имеющие разрешение 300 ppi (помните,
что это количество пикселов на дюйм). Если фотография состоит из 675 х 1200 пик-
селов, отпечаток будет иметь размеры 2,25 х 4 дюйма (675 пикселов / 300 пиксе-
лов/дюйм = 2,25 дюйма; 1200 пикселов / 300 пикселов/дюйм = 4 дюйма). Анало-
гично, если вы хотите напечатать изображение длиной 6 дюймов, необходимо,
чтобы по его длине укладывались 1800 пикселов. Если вы не сумели найти инфор-
мацию об оптимальном разрешении для принтера, в большинстве случаев можно
считать, что принтер лучше всего печатает изображения с разрешением 300 ppi.
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Если понизить разрешение изображения, например с целью увеличения размеров
его отпечатка, снизится качество полученной картинки. Например, если то же самое
изображение размером 675 х 1200 пикселов напечатать так, чтобы отпечаток имел
длину 5 или б дюймов вместо 4, результат будет хуже оптимального. Вероятно,
у вас получится разглядеть отдельные пикселы, а рисунок станет немного размытым.

ПРИМЕЧАНИЕ
Если изображение предназначается для печати в типографии, то в определении его разре-
шения и размера участвует еще один параметр. В типографских машинах устанавливается
разрешение полиграфического растра путем подсчета количества линий (состоящих из то-
чек) на дюйм. Этот параметр называется линиатурой и измеряется в Ipi (line per inch). Поэто-
му, подготавливая изображение, спросите у сотрудников типографии, какая будет исполь-
зоваться линиатура. Стандартное соотношение между разрешением (dpi) и линиатурой (Ipi)
равно 2:1, следовательно, если изображение будет печататься при 150 Ipi, следует устано-
вить разрешение 300 ppi. Если вам сложно понять все эти тонкости, то попросите сотрудни-
ков типографии указать размеры изображения, которые потребуются для печати картинки
с заданными вами размерами.

Печатаем изображение
Чтобы напечатать изображение из программы Photoshop, сначала следует выпол-
нить калибровку принтера (см. главу 22), а затем сделать следующее.

1. Откройте изображение, готовое к печати.

2. Если требуется напечатать только часть изображения, выделите ее с помощью
инструментов выделения. В противном случае пропустите этот шаг.

3. Выберите команду File > Page Setup (Файл > Параметры страницы). Откроется диа-
логовое окно Page Setup (Параметры страницы), вид которого зависит от модели
принтера, используемой операционной системы и версии Photoshop, но, в об-
щем и целом, похож на представленный на рис. 23.1.

етоеыбор

Рис. 23.1. В диалоговом окне Page Setup (Параметры страницы) определите размер бумаги
и ее ориентацию
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5.

Укажите формат используемого листа бумаги (стандартный лист имеет фор-
мат А4) и ее ориентацию. Закройте окно. Заданные значения останутся на-
стройками по умолчанию до тех пор, пока вы их не измените.

Если вы еще не определили будущий размер изображения и, соответственно, раз-
решение, сделайте это сейчас. Выберите команду File > Print with Preview (Файл >
Печать с предварительным просмотром) или нажмите клавиши Ctrl+P.

6. В открывшемся диалоговом окне, показанном на рис. 23.2, есть окно предва-
рительного просмотра, в котором показывается, как будет выглядеть изобра-
жение на листе бумаги при установленных параметрах. Кроме того, здесь мож-
но задать позицию изображения относительно границ листа, если снять флажок
Center Image (Центрировать изображение), установленный по умолчанию. Во вто-
рой секции Scaled Print Size (Масштаб отпечатка) определяется размер изобра-
жения на бумаге в дюймах или сантиметрах, или масштаб печати. Все три ве-
личины: Scale (Масштаб), Height (Высота) и Width ( Ш и р и н а ) — связаны между
собой, то есть здесь вы уже не вправе изменять пропорции изображения. При
установленном флажке Show Bounding Box (Показать рамку) в окне предвари-
тельного просмотра вокруг изображения появляется рамка с маркерами, так-
же предназначенными для редактирования размеров отпечатка.

Из этого же диалогового окна можно попасть в окно Page Setup (Параметры стра-
ницы), если нажать одноименную кнопку.

: !Ш
/..Position;:-

:.:-.:'~-.""'::.J::.;:':::;::
:. S?' Center»

:.KaBdf>r!ntSiffi':*:;'̂ :;?;;

:: [cm

ЛУ Show'Bounc-:

:Г": Caiier" Crop Marks

m'- : ....______: : _ • ! • : a
Рис. 23.2. Диалоговое окно, в котором выполняется настройка печати изображения

7. Чтобы показать остальные параметры, доступ к которым производится из нижней
части окна, нужно установить флажок Show More Options (Показать остальные
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параметры). С их помощью можно изменить цвет фона, создать границу во-
круг изображения, напечатать его название и т. д.

Теперь пора приступать непосредственно к печати изображения. Для этого
нажмите кнопку Print (Печать) (если вы закрыли диалоговое окно, выберите
команду File > Print (Файл > Печать) или нажмите клавиши Alt+Ctrl+P). Появит-
ся диалоговое окно, похожее на изображенное на рис. 23.3. Его вид зависит от
используемой операционной системы.

|НГ> DeskJet400

.Тип:; 11 ; ' . ; ' |

,йнИ:<ргШ<Г

Рис. 23.3. Диалоговое окно, в котором можно определить используемый принтер

9. Если в системе установлено несколько принтеров, укажите, на каком из них
следует печатать Изображение. Кроме того, имеет смысл нажать на кнопку Свой-
ства (Properties) и в открывшемся диалоговом окне, вид которого зависит от
модели принтера, проверить все параметры принтера. Особое внимание сле-
дует уделить разделу, посвященному качеству печати и способу наложения
краски. Возможно, вам придется перебрать все варианты, прежде чем вы смо-
жете найти приемлемые параметры, но в дальнейшем вы уже будете знать зна-
чение каждой настройки. Обычно для печати окончательного варианта изоб-
ражения выбирается самая качественная печать, а предварительные копии
можно печатать в более скоростном режиме (который также, как правило, под-
ходит для печати текстовых документов).

10. Помимо принтера в диалоговом окне Печать (Print) (см. рис. 23.3) можно вы-
брать диапазон печати: все изображение или только выделенный фрагмент,
и задать количество экземпляров (копий). Затем вам останется только нажать
на кнопку ОК.

Печать нескольких изображений на одной
странице
Крайне неприятно, когда приходится бессмысленно тратить бумагу, особенно если это
хороший дорогой материал высокого качества. Иногда можно попытаться сэконо-
мить на печати. Если изображение имеет маленькие размеры, а вам нужно несколько
копий, почему бы не отпечатать их все на одном листе? Это не так уж трудно.
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Чтобы напечатать несколько картинок на одном листе из программы Photoshop,
нужно выбратькоманду File * Automate (Файл > Автоматизация) и выбрать настройку
Contact Sheet (Индекс отпечаток) или Picture Package (Комплект изображений). При
печати контактного листа все изображения из указанной папки располагаются
на одном листе в виде миниатюр и нумеруются — в фотолабораториях такой лист
называется индекс-отпечатком. Вариант Picture Package (Комплект изображений)
позволяет разместить на листе одно или несколько изображений с различными
размерами. При этом важно не забыть правильно задать размер листа бумаги.

Для тех, кто работает в Photoshop, я предлагаю еще одно универсальное решение -
так вы сможете напечатать на одном листе несколько любых изображений:

1. При открытом изображении выведите на экран палитру Layers (Слои) (коман-
да Window > Layers (Окно > Слои)). Преобразуйте фоновый слой в обычный ко-
мандой Layer > New > Layer From Background (Слой > Создать > Слой из фона) и на-
зовите его «Холстом».

2. Увеличьте размер холста до реальных размеров листа бумаги (команда Image >
Canvas Size (Изображение > Размер холста), см. главу 14).

3. Определите, сколько копий изображения вы хотите разместить на листе
(и сколько там поместится). Не забудьте, что нужно оставить немного места
по краям листа и между изображениями. Скопируйте изображение столько
раз, сколько требуется копий. Например, если вы собираетесь сгруппировать
на листе четыре изображения, сделайте четыре копии (воспользуйтесь коман-
дой Layer > New > Layer via Copy (Слой > Создать > Слой через копирование), соче-
танием клавиш Ctrl+0 или в палитре Layers (Слои) мышью перетащите название
слоя на значок со страничкой Create new layer (Создать новый слой)).

4. Активируйте слой Холст.

5. Нажмите Ctrl+A, чтобы выделить его целиком.

6. Заполните слой белым цветом — это основа, или фон, на котором будут расположе-
ны изображения. Если вы забыли, как выполнять заливку, обратитесь к главе 17,

7. Далее включите инструмент Move (Перемещение) и проделайте с каждым слоем
следующую операцию: активируйте слой и переместите его, так чтобы нахо-
дящееся на нем изображение заняло нужную позицию. Если вы хотите напе-
чатать фотографии с белыми рамками, не забудьте оставить свободное про-
странство вокруг каждого изображения (при ширине рамки 0,4 см расстояние
между изображениями должно быть минимум 0,8 см).

8. Если требуется выровнять копии изображения по горизонтали и вертикали,
то для удобства работы можно включите показ измерительных линеек нажатием
клавиш Ctrl+R. Убираются линейки с экрана тем же сочетанием клавиш. Что-
бы еще больше упростить себе жизнь, выведите на экран сетку командой View >
Show > Grid (Вид > Показать > Сетка) и установите привязку к сетке, выбрав коман-
ду View > Snap То > Grid (Вид > Привязка к > Сетке). Тогда содержимое передвигаемо-
го слоя будет автоматически «прилипать» к ближайшим линиям сетки.

Существует еще один удобный способ выравнивания — можно нарисовать на-
правляющие, к которым также будут «прилипать» стороны изображений. Для
этого при включенных линейках подведите указатель мыши к одной из них
(если требуется вертикальная направляющая — к вертикальной линейке,
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горизонтальная — к горизонтальной). Указатель примет вид белой стрелки.
Нажмите кнопку мыши и, удерживая ее, протащите указатель в сторону изобра-
жения. Когда вы отпустите кнопку, будет нарисована направляющая, по умол-
чанию ярко-голубого цвета. Переместите ее мышью в то положение, по кото-
рому должны выравниваться изображения. Затем, если нужно, создайте еще
несколько направляющих и сформируйте из них сетку. После этого с помощью
инструмента Move (Перемещение) расположите в этой сетке изображения.
Чтобы они «прилипали» к сетке, должен быть установлен флажок View > Snap
То > Guides (Вид > Привязка к > Направляющим). У вас должно получиться нечто,
похожее на рис. 23.4. Направляющие, так же как и сетка, не печатаются — это
вспомогательные элементы программы. Их нельзя скрыть, но можно удалить
командой View > Clear Guides (Вид > Убрать направляющие).

'йй Untitled-1 ® Z5»'e (layer 1 «аду 5, RGB)

Рис. 23.4. Направляющие помогают выравнивать фрагменты изображений

9. Сохраните результат под новым именем.

10. Хотя изображение теперь можно печатать, я предлагаю предварительно объеди-
нить слои (команда Layer > Flatten Image (Слой > Плоское изображение)). Это
приведет к уменьшению размеров файла и ускорению процесса печати.

11. Напечатайте полученное изображение, а затем разрежьте его на части.

СОВЕТ
Если вы еще не печатали это изображение, лучше сначала вывести только одну копию на
бумаге, предназначенной для тестовых экземпляров. А после этого, если вам понравился
результат, уже можно печатать все копии на хорошей бумаге.
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Нетрудно догадаться, что, действуя аналогично описанной выше процедуре, можно
на одном листе бумаги напечатать несколько разных изображений, если они имеют
подходящий размер. В этом случае вам нужно будет скопировать изображения из
разных окон в одно. Создайте новое заполненное белым цветом изображение нуж-
ного размера — холст, активируйте инструмент Move (Перемещение), затем по очере-
ди откройте каждую фотографию и, захватив изображение мышью, переместите
ее на холст. Изображения при этом копируются. Далее действуйте по алгоритму.

Печать индекс-отпечатка прямо с фотоаппарата
Не знаю, верите вы мне или нет, но программное обеспечение многих, если не почти
всех, фотоаппаратов позволяет печатать снимки прямо с камеры. При этом достаточно
подключить камеру напрямую к принтеру, компьютер для данной операции не
нужен. Я часто пользуюсь этой возможностью для создания индекс-отпечатка, то есть
листа, на котором в уменьшенном виде демонстрируются все кадры, хранящиеся
в памяти фотоаппарата. Подобный индекс-отпечаток представлен на рис. 23.5.

1998/01/01 004
т

Рис. 23.5. Печать прямо с камеры позволяет быстро увидеть все хранящиеся в ней снимки



316 Глава 23. Печать изображений

Управление фотоаппаратами и принтерами немного различается от модели к мо-
дели, поэтому я не буду подробно рассматривать процедуру печати. Главное, необ-
ходимо напрямую подключить фотоаппарат к принтеру (в большинстве случаев
вам понадобится кабель для соединения двух портов: порта камеры, через кото-
рый всегда происходит передача данных на компьютер, с портом принтера, через
который принтер подключается к компьютеру). Остальную информацию можно
почерпнуть из руководства к фотоаппарату и принтеру.

Печать фотографий, достойных
помещения в рамку
Многие производители принтеров продают бумагу «для печати фотографий» для
своих аппаратов (приобретая принтер, вы можете получить в подарок небольшую
пачку такой бумаги). Но фотобумага является достаточно дорогим удовольстви-
ем, поэтому дополнительная экономия не помешает. Если у вас струйный или ла-
зерный принтер, попытайтесь подобрать для регулярной печати более дешевый
тип бумаги. При этом необходимо убедиться, что принтер не будет ее «зажевы-
вать», что очень вредно для его «пищеварения». Фотографии лучше выглядят под
глянцевым покрытием. Например, можно попробовать воспользоваться почтовой
бумагой хорошего качества или бумагой, предназначенной для рисования. Фото-
графии, отпечатанные на тонкой качественной бумаге под акварель, если она по-
дошла к принтеру, будут смотреться интересно и необычно. Где-то даже будет
к месту цветная бумага — здесь нет предела для экспериментов! Но всегда следует
заботиться о работоспособности принтера. Мой наставник как-то обратил на это
мое внимание, и я готов поделиться уроком с вами: «Если у вас лазерный принтер,
следует использовать только ту бумагу, которая специально предназначена для
печати на лазерном принтере, иначе он может сломаться! Лазерные принтеры пе-
чатают за счет нагревания порошка, и если будут работать на неправильном типе
бумаги (особенно на глянцевой бумаге для струйных принтеров), их движущиеся
части могут оплавиться от перегрева. Поверьте мне. Я как-то с этим столкнулся,
и это был весьма дорогой урок. Для лазерных принтеров существует отдельный
вид глянцевой бумаги».

ПРИМЕЧАНИЕ
В состав некоторых типов бумаги входят сильные кислотные составляющие, что вызывает
пожелтение бумаги со временем или обесцвечивание снимков. Чтобы избежать этих про-
блем, обращайте внимание на состав бумаги, который иногда указывается на упаковках.

Чернила сторонних фирм
Чернила, выпускаемые для термодиффузионных принтеров сторонними фирмами,
вы найдете в специализированных фотомагазинах, ориентированных на профес-
сионалов. С помощью этих красителей можно получить даже более замечатель-
ные цвета, чем при печати стандартными чернилами, поставляемыми вместе с прин-
тером. Например, некоторые из наборов черных чернил позволяют создавать
отпечатки просто изумительного качества. Я видел изображения, отпечатанные
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такими чернилами на не очень дорогих (но и не дешевых) принтерах, и их невоз-
можно отличить от фотографий, сделанных традиционным способом. Какой на-
прашивается вывод? Сейчас технология уже настолько развита, что в вашей влас-
ти создавать превосходные цветные и черно-белые отпечатки, пользуясь только
цифровыми устройствами.

Следует запомнить
Q Для быстрой и простой печати лучше всего сохранять разрешение изображе-

ния 300 ppi.
О Можно напечатать несколько копий изображения на разных листах бумаги,

задав соответствующий параметр в диалоговом окне печати, а можно разместить
их на одном листе (если позволяет размер).

Q Программное обеспечение камеры чаще всего позволяет создавать индекс-от-
печаток — список фотографий с их уменьшенными копиями.

Q Чем выше качество бумаги, тем лучше будут результаты. Попробуйте исполь-
зовать глянцевую бумагу.



Глава 24

Другие способы демонстрации
снимков

а Отправка фотографий по электронной почте

Q Размещение текста и фотографий на веб-сайте

Q Демонстрация снимков на экране телевизора

а Фотография в качестве фонового рисунка на рабочем столе компьютера

а Другие возможности, предоставляемые цифровыми фотоаппаратами

Согласитесь, что не всегда бывает удобно или возможно пригласить знакомого в гос-
ти, чтобы показать ему свои замечательные творения на экране монитора, а отправка
отпечатанных снимков обычной почтой занимает слишком много времени, требует
дополнительных усилий с вашей стороны и может стать весьма дорогим удоволь-
ствием (фотографии сначала нужно напечатать). В итоге вы будете пользоваться
этим способом только при крайней необходимости, а показать особо удавшиеся
фотографии часто хочется всем своим знакомым. Но мы живем в век Интернета,
и всё больше людей" пользуются электронной почтовой связью. Высокоскорост-
ные технологии позволяют нам передавать сообщения и файлы в любую точку света
в течение нескольких минут. Тогда почему бы и вам не взять на вооружение явные
преимущества этого метода и не посылать фотографии в электронном виде?

Показать свои фотографии в любой точке мира, куда дотянулся Интернет, можно
двумя способами.

Q Через электронную почту. Сейчас существует достаточно много почтовых про-
грамм, и невозможно рассмотреть их все в рамках книги, посвященной цифро-
вой фотографии. Поэтому я кратко расскажу о том, как подготовить снимок
к отправке по электронной почте, и в качестве примера мы обсудим отправку
изображений в Microsoft Outlook Express двумя способами.

Q Разместив на веб-сайте. Большинство интернет-провайдеров предоставляют
своим клиентам пространство на сервере для создания веб-сайта. Почему бы
в таком случае не воспользоваться столь прекрасной возможностью?
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Подготовка изображений к отправке
по электронной почте
Прежде всего, требуется определить, для чего предназначается посылаемое изоб-
ражение. Его будут распечатывать или, например, просто просматривать на экра-
не компьютера?

Не забывайте о том, что при возрастании размеров файла увеличивается время его
передачи. Это становится особенно существенно, если соединение с Интернетом
осуществляется посредством модема через обычную телефонную сеть. Размеры
несжатых изображений зачастую равняются нескольким мегабайтам, и передача
таких файлов по стандартным для большинства пользователей каналам может за-
нять десятки минут или даже часы. Понятно, что вы осведомлены обо всех этих
проблемах, если сами работаете с обычным модемом. Тогда, независимо от адреса-
та, вы сами захотите уменьшить размеры письма просто для того, чтобы не столк-
нуться с проблемами при его отправке. Но если вам повезло — вы имеете доступ
к высокоскоростным соединениям с Интернетом, вы можете сильно разозлить адре-
сата, не подумав и послав ему «огромную» фотографию. В лучшем случае он не
будет тратить время и деньги на получение этого письма, а удалит его прямо
с почтового сервера, так и не увидев ваше творение. Поэтому, если вы хотите, что-
бы адресат просто просмотрел снимок на экране компьютера, следует уменьшить
размер файла, чтобы увеличить скорость его передачи. Другое дело, если снимок
предназначен для последующей печати, о чем знает его получатель. Чтобы сохра-
нить достаточное для печати разрешение, вам придется переслать большой файл,
но все же его размер можно оптимизировать, используя несколько рассмотренных
ниже приемов.
Поскольку экран всегда отображает только 72 пиксела на дюйм, то изображение,
имеющее разрешение, например, 300 ppi и физические размеры 5 x 4 дюйма, на
экране в масштабе 100% будет выглядеть значительно больше (его длина будет
равна 5 х 300 /72 = 20,83 дюйма) — такой снимок попросту не поместится ни на
вашем экране, ни на экране получателя. Если изображение предназначено для про-
смотра на дисплее компьютера, то зачем пересылать столько лишней информа-
ции? Нужно уменьшить размеры снимка, и эту процедуру мы рассмотрим на при-
мере Photoshop. Используемые элементы программы описывались в главе 14, а о
размерах изображений и разрешении подробно рассказывалось в главе 11.

1. Откройте изображение в Photoshop и сделайте масштаб отображения равным
100% с помощью инструмента Zoom (Масштаб). Вполне возможно, что оно не
поместится целиком в своем окне, тогда справа и снизу появятся полосы про-
крутки.

2. Определите, насколько вы хотите уменьшить изображение. Желательно ли,
чтобы оно занимало весь экран? Чем меньше будут размеры на экране, тем су-
щественнее снизится «вес» файла. Решить этот вопрос можно по ходу процедуры.

3. Откройте диалоговое окно Image Size (Размер изображения) (см. рис. 14.2).

4. В разделе Pixel Dimensions (Размеры в пикселах) показаны размеры изображе-
ния в пикселах, то есть так, как оно отображается на экране. Если у вас уста-
новлен видеорежим 1024 х 768 точек, а изображение имеет размеры, например,
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1772 х 1190 пикселов (при разрешении 300 ppi размер отпечатка будет равен
стандартной фотографии 10 х 15 см), то изображение должно выходить за пре-
делы экрана. Введите в одно из полей Width (Ширина) или Height (Высота) этой
группы соответствующий размер экрана. Выбор поля зависит от ориентации
изображения: для горизонтальной нужно вводить ширину экрана в пикселах
в поле Width (Ширина), для вертикальной — высоту в поле Height (Высота). При
этом должен быть установлен флажок Constrain Proportions (Сохранять пропор-
ции) — тогда второй размер скорректируется автоматически. Если нужно, об-
режьте лишние части снимка.

5. Взгляните на изображение в основном окне. Если вы считаете, что оно все еще
велико, вызовите окно Image Size (Размер изображения) и задайте новые размеры.

6. Теперь можно увеличить резкость с помощью фильтров группы Sharpen (Рез-
кость), которые рассматривались в главе 15. Это немного увеличит размер файла
изображения, поэтому в данном случае всегда приходится выбирать между каче-
ством и скоростью передачи. Кроме того, если здесь увеличить резкость, а потом,
чтобы уменьшить размер файла, сохранить его в формате JPEG с низким коэф-
фициентом, то качество результата, возможно, будет даже хуже, чем качество
изображения до повышения резкости (поэтому я всегда советую сохранять про-
межуточные результаты и работать с копией изображения). Но в случае отправки
одного снимка несколько десятков лишних килобайтов не сыграют большой
роли. Учитывайте и то, что чем меньше размеры изображения на экране, тем
незначительнее будет разница в объеме файла до и после увеличения резкости.

7. Снимок готов, и его нужно сохранить. Поскольку нам важны размеры, имеет
смысл записать его в формат, использующий методы сжатия (см. главу 12) -
это касается всех изображений, как подготовленных для просмотра на экране,
так и предназначенных для печати. Традиционным и наиболее выгодным в дан-
ном случае является формат JPEG (команда File > Save As (Файл > Сохранить как)
вызовет окно, где в раскрывающемся списке Format (Формат) следует выбрать
вариант JPEG).

8. Откроется диалоговое окно (см. рис. 12.3), в котором нужно указать параметры
сохранения в этом формате, в частности коэффициент сжатия. Если его уста-
новить максимальным, изображение будет сжато без потери информации, если
же коэффициент слишком снизить, заметно упадет качество. Для снимков, пред-
назначенных для просмотра на экране, я обычно устанавливаю значения коэф-
фициента от 5 до 8. Помогут подобрать этот параметр величины, отображаемые
в разделе Size (Размер): программа показывает будущий размер файла при за-
данном коэффициенте и скорость его загрузки при заданной скорости соедине-
ния с Интернетом.

Можно еще больше уменьшить размер файла, исключив лишнюю информацию
о цветах (см. главу 15). Это делается в случае, когда плавность переходов цветов
не очень важна, и снимок предназначен для просмотра на экране монитора, по-
скольку при этом разница между миллионами и 256 цветами не сильно заметна.
Перейдя в режим индексированных цветов, вы не сумеете сохранить изображение
в формате JPEG, стандартным является формат GIF или PNG. Этот способ, как
правило, используется для рисунков с простой графикой и логотипов, а не для
фотографий.
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Если вы собираетесь отправлять одновременно несколько изображений, дополни-
тельно снизить размер письма поможет сохранение их в одном файле в програм-
ме-архиваторе, такой как Stufflt, PKZip, WinZip или WinRAR (см. главу 12). Это
позволяет выиграть до 100 Кбайт. Понятно, что тогда следует отправлять архи-
вный файл. Также необходимо упаковать изображение, если вы сохраняли его
в формате, отличном от JPEG, — многие из графических файлов достаточно хорошо
сжимаются.

Таким образом, файл можно отправлять. Посмотрите на его размер. В зависимо-
сти от скорости соединения с Интернетом, файлы больше 500 Кбайт могут переда-
ваться быстро или бесконечно долго. Второй вариант неприятен. Следует учиты-
вать также то, что при присоединении файла к письму его размер увеличивается
процентов на двадцать. Чтобы узнать, сколько времени потребуется на доставку
письма, я иногда начинаю его отправку из почтовой программы и, если меня что-
то не устраивает, останавливаю процесс. Большинство программ показывает оце-
ночное время передачи файла или, по крайней мере, индикатор состояния. Если
файл слишком велик, можно отменить его пересылку, еще уменьшить его размер
и только после этого посылать письмо.

Когда отправляемое изображение предназначается для печати, в его подготовке
будет несколько отличий. В этом случае нельзя значительно уменьшить размер
снимка в пикселах — как рассказывалось в главе 23, разрешение изображения для
печати на большинстве принтеров должно равняться 300 ppi, и изменению подле-
жат только физические размеры, отображаемые в разделе Document Size (Размер
документа) окна Image Size (Размер изображения). Итак, сначала выставите разре-
шение 300 ppi, не меняя само изображение. Для этого в окне Image Size (Размер
изображения) нужно снять флажок Resample Image (Пересчитать изображение) и ввести
новое разрешение. Затем установите флажок и, если можно уменьшить физиче-
ские размеры, сделайте это. Фотографии, предназначаемые для печати, обычно не
переводят в режим индексированных цветов, поэтому снизить размер файла за счет
цвета мы не можем. Далее снимок нужно сохранить в формате JPEG, причем в дан-
ном случае, как правило, используется больший коэффициент сжатия (8-10), чем
для изображений, которые будут просматриваться на экране, поскольку при печа-
ти важно качество. Правда, это тоже не абсолютное утверждение: на плохом прин-
тере вы никогда не напечатаете хорошее изображение, и тогда качеством снимка
можно пожертвовать заранее — при сохранении его в JPEG.

Теперь снимок готов к отправке и последующей печати на хорошем принтере, но
его размер получился равным, например, 1,5 Мбайт. А вы знаете, что адресат, ко-
торый живет в другом городе, постоянно жалуется на низкую скорость соедине-
ния с Интернетом и частые обрывы связи, кроме того, его провайдер ввел ограни-
чения: размер письма не должен превышать 1 Мбайт. Что же делать в такой тяжелой
ситуации? Вам помогут программы-архиваторы. Большинство из них позволяют
запаковать один файл в несколько архивных файлов меньшего размера. Для из-
влечения файла из архива требуется наличие всех файлов, из которых он состоит.
Изображение размером 1,5 Мбайт имеет смысл разбить на три тома по 0,5 Мбайт
и каждый из архивных файлов послать в отдельном письме — это чуть-чуть увели-
чит время передачи всей информации, но сведет к минимуму проблемы с обрывом
связи и ограничениями провайдера. Есть и второй вариант: можно разместить изоб-
ражение на веб-сайте, откуда ваш адресат самостоятельно его загрузит.
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Отправка по электронной почте
Цифровые фотографии можно отправлять точно так же, как и любые другие файлы
и документы: присоединяя их к тексту письма. Если вы когда-либо посылали докумен-
ты таким образом, вы уже все знаете и прямо сейчас можете приступить к делу!
Получая фотографию, прикрепленную к письму, адресат должен сохранить вложенный
файл на свой жесткий диск и после этого просматривать или печатать изображение.

Некоторые почтовые программы позволяют встраивать изображения прямо в тело
письма, это зависит от их возможностей. В таком случае адресат увидит фотогра-
фию, открыв письмо (то есть для просмотра снимка ему не нужно будет запускать
программу просмотра изображений и, если он читает почту прямо на почтовом
сервере, таком как yahoo.com или mail.ru, сохранять письмо). Недостаток данного
способа заключается в том, что адресат, возможно, не увидит изображение цели-
ком. И конечно, файлы, предназначенные для печати, всегда присоединяют к пись-
му, а не встраивают в текст.

ПРИМЕЧАНИЕ —
К сожалению, я не имею возможности описать здесь все проблемы, связанные с использова-
нием Интернета вообще и электронной почты в частности. Но напомню об одной из основ-
ных опасностей: через Интернет распространяются различные вирусы. Поэтому вы обяза-
тельно должны установить на своем компьютере антивирусную программу и проверять все
загружаемые файлы. Если это возможно, настройте антивирусную программу так, чтобы
она автоматически проверяла все файлы, передающиеся на компьютер. Получив файл по
почте, прежде чем открывать его, проверьте его на наличие вирусов. Кроме того, проверяй-
те файлы, отправляя их, чтобы не послать вирус, который мог случайно проникнуть на ваш
компьютер — система защиты от вирусов, прежде всего, базируется на ответственности
каждого пользователя.

Пример: отправка изображений с помощью
Microsoft Outlook Express
Мы рассматриваем Microsoft Outlook Express, как простейший и достаточно попу-
лярный почтовый клиент. Чтобы послать фотографию, присоединив ее к письму,
выполните следующее.

1. Сжав файл изображения, откройте Outlook Express. Нажмите на кнопку Создать
(New), расположенную слева на панели инструментов.

2. Откроется окно нового сообщения. Введите адрес получателя письма в поле
Кому (То) и тему в поле Тема (Subject).

3. Наберите текст письма.

4. Чтобы присоединить фотографию (или любой другой файл), щелкните на кноп-
ке Вложить (Add Attachments) (на панели инструментов).

5. В открывшемся окне найдите на компьютере файл, который нужно присоединить.

6. Выделите его и нажмите кнопку Вложить (Add). Значок с названием файла по-
явится в поле Присоединить (Attachments), как показано на рис. 24.1. Это означа-
ет, что файл будет отправлен вместе с письмом.

7. Повторите шаги 4-6 для всех файлов, которые требуется прикрепить к письму.

8. Соединитесь с Интернетом и щелкните на кнопке Отправить (Send).



Отправка по электронной почте 323

Кнопка «Вложить»

Вложенная фотография -
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Рис. 24.1. Microsoft Outlook Express отошлет фотографию вместе с электронным письмом

Когда письмо придет по назначению, адресат увидит файл, присоединенный к со-
общению.

Второй способ, как уже говорилось, заключается во встраивании изображения в тело
письма. Для этого вместо шагов 4-7 предыдущего алгоритма выполните следующее.

4. Находясь в поле ввода текста сообщения, выберите команду Вставка > Рисунок
(Insert > Image).

5. В открывшемся окне нажмите на кнопку Обзор (Browse).

6. Найдите файл с фотографией, выделите его, нажмите кнопку Открыть (Open).

7. Нажмите кнопку ОК. Изображение появится в теле сообщения после введенно-
го текста, как показано на рис. 24.2.

I -
• • - • • - '

•!" Впо-иить

Рис. 24.2. Адресат увидит изображение в тексте письма
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Фотографии на веб-сайте
Был выходной, и я ездил на семейный праздник, на котором, конечно, фотографи-
ровал всех родственников. Ближе к концу праздника я раздал всем адрес моего
веб-сайта. Приехав домой, я быстро загрузил фотографии с камеры на компьютер
и немного отредактировал их. Затем построил веб-страницу, на которой размес-
тил отредактированные снимки, и присоединил страницу к своему веб-сайту (для
этого переслал изображения и страницу на сервер провайдера). После этого каж-
дый из моих родственников смог посмотреть фотографии!

Если хочется показать свои снимки всему миру, что может быть лучше, чем разме-
стить их на веб-сайте? Если вы незнакомы с процессом создания веб-страниц, я могу
предложить вам один простой и удобный способ создания фотогалереи, но для
построения более сложных сайтов или страниц с собственным дизайном, к сожале-
нию, вам придется обратиться к специальной литературе. Сейчас существует мно-
жество программ визуального программирования веб-сайтов, таких как FrontPage,
HomeSite и т. д., с помощью которых очень легко можно построить веб-страницу
и даже незамысловатый веб-сайт, а приобретя опыт, вы сумеете воплотить в жизнь
любую свою идею.

В подготовке снимков к размещению в Интернете есть несколько отличий. Во-пер-
вых, требуется определить, зачем вы это делаете. Если вы преследуете единствен-
ную цель: передать большой файл, содержимое которого известно, — то файл мож-
но запаковать программой-архиватором, а на веб-странице дать только ссылку на
его местоположение. Пользователь не сможет просмотреть файл прямо в веб-бра-
узере, ему придется загрузить архив на свой компьютер, и только потом раскрыть
его. Например, в коллекциях программного обеспечения так размещают устано-
вочные пакеты программ.

Но чаще всего изображения помещают в Интернет для того, чтобы их можно было
увидеть прямо на сайте, и тогда, как правило, поступают по-другому. Поскольку
при работе с Интернетом имеет значение время загрузки, невыгодно располагать
на одной странице много больших файлов. Представьте себе, что пользователю
придется ждать несколько минут, чтобы посмотреть на ваши замечательные снимки.
Скорее всего, ему это надоест. Поэтому для каждой фотографии создают умень-
шенную копию — миниатюру. На одной странице размещают все миниатюры, и де-
лают так, чтобы при щелчке на миниатюре открывалась отдельная страница, в кото-
рую загружалась бы большая фотография. Это позволяет посетителю страницы
быстро увидеть все снимки, выбрать из них наиболее понравившиеся и только их
посмотреть крупным планом.

Конечно, даже большие фотографии, открывающиеся на отдельных страницах,
обычно предназначены для просмотра на экране, поэтому процесс их обработки
аналогичен подготовке снимков к отправке по электронной почте. Разница в том,
что в этом случае фотографии не уплотняют с помощью программы-архиватора,
а всегда сохраняют в формате JPEG с небольшим коэффициентом сжатия (с макси-
мальной плотностью). Здесь вам опять придется выбирать между размером и ка-
чеством фотографии, регулируемыми резкостью и коэффициентом сжатия. Часто
имеет смысл уменьшить размеры в пикселах примерно до 800 х 600 или 600 х 400,
но сохранить прочие достоинства. Желательно, чтобы даже большая фотография
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не превышала 50 Кбайт. Размеры миниатюр не должны быть больше 200 х 150 пик-
селов и примерно 5 Кбайт.

Программа Photoshop имеет удобную команду File > Save For Web (Файл > Сохранить
для Веб). Она открывает диалоговое окно, в котором можно увидеть, как будет вы-
глядеть снимок и каков будет его размер в трех вариантах сохранения в разных
форматах или в одном, но с разной степенью сжатия, настроить все параметры со-
хранения для каждого из трех вариантов, выбрать наиболее приемлемый. И ко-
нечно, сохранить фотографию или как изображение, или как готовую веб-страницу.
Окно представлено на рис. 24.3.

1

•

Рис. 24.3. Выберите наилучший вариант сжатия

Программа Photoshop замечательна своей разносторонностью — с ее помощью мож-
но буквально одним движением построить сайт-фотогалерею. Для этого не нужно
создавать миниатюры — они сформируются автоматически, и даже не требуется
уменьшать размеры изображений, хотя и желательно. Позже я объясню почему.

Скопируйте все снимки, которые должны попасть в галерею, в одну папку. Затем
выполните команду File > Automate > Web Photo Gallery (Файл > Автоматизировать >
Веб-фотогалерея). Откроется диалоговое окно, показанное на рис. 24.4.

Выберите в первом списке Styles (Стили) шаблон для сайта. Затем в разделе Folders
( П а п к и ) нажмите на кнопку Browse (Обзор) и задайте папку с фотографиями для
галереи. Если требуется включить изображения, расположенные во вложенных
папках относительно выбранной, установите флажок Include All Subfolders (Включить
все подпапки). Затем щелкните на кнопке Destination (Место назначения) и опреде-
лите папку, куда будет сохранен сайт. Ее можно создать прямо в открывшемся окне.
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Рис. 24.4. Создаем сайт-фотогалерею

Теперь переходите к разделу Options (Параметры). При установленном варианте
Banner (Заголовок) ниже высвечивается поле для заголовка страницы, кроме того,
вы можете указать фотографа, дату, контактную информацию и определить пара-
метры шрифта. В заголовке же появится адрес электронной почты, если вы введе-
те его в поле E-mail (Электронная почта).

Следующий пункт списка определяет параметры больших изображений, которые
будут открываться при щелчке на миниатюре. Здесь вы можете указать размер
большей стороны снимка в пикселах, коэффициент сжатия при сохранении в фор-
мате JPEG и многое другое. Введите размер изображения в поле Resize Image (Из-
менить размер изображения), например 500 пикселов, и задайте подходящий коэф-
фициент сжатия (5-8) в поле J P E G Quality (Качество JPEG).

СОВЕТ
Для создания веб-страницы этим способом желательно заранее выполнить все операции по
подготовке изображений, кроме двух: во-первых, лучше сохранять файл в формате JPEG
без потери информации, то есть с коэффициентом 12, а сжатие определить сейчас, во-
вторых, не требуется формировать миниатюру. Программа автоматически уменьшит все
изображения до указанного размера в пикселах и, соответственно, не изменит снимки, если
их размер равен указанному. Если же оставить снимки большими (в пикселах), то, вероят-
нее всего, проявится один недостаток: после уменьшения размеров фотография может стать
нерезкой и в таком виде будет помещена на сайт.

Далее переключитесь в списке Options (Параметры) на вариант Thumbnai l s (Мини-
атюры) и задайте все параметры для миниатюр: размер, коэффициент сжатия, их
количество в рядах и столбцах и т. д. Пункт этого же списка Custom Colors (Цвета по
выбору пользователя) позволяет задать вспомогательные цвета, которые будут
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использоваться для текста на сайте. После установки всех параметров нажмите на
кнопку О К и немного подождите. В результате всех действий программы откроется
окно установленного по умолчанию в системе веб-браузера, в котором появится
стартовая страница созданного сайта-фотогалереи.

X

Просмотр снимков на экране телевизора
Многие новейшие цифровые фотоаппараты способны посылать видеосигнал, что
позволяет просматривать на экране телевизора изображения, хранящиеся на но-
сителе камеры. На самом деле видеосигнал можно посылать не только на телеви-
зор. Камеру можно подключить к жидкокристаллическому экрану или проекци-
онной системе и устраивать, например, деловые презентации. Представьте, что вы
провели целый день, осматривая промышленное предприятие, на котором работа-
ете, и теперь должны показать руководителям, где скрывается резерв для увеличе-
ния объема производимой продукции. Засняв все, что нужно, на заводе, вы теперь
можете просто подключить камеру к проекционной системе и наглядно аргумен-
тировать свои предложения.

Чтобы подключить фотоаппарат, подсоедините один конец видеокабеля к видео-
порту камеры, другой конец кабеля — к телевизору, видеомагнитофону или про-
екционной системе. Слайды теперь постепенно уходят в прошлое!

Изображение в качестве фонового рисунка
на экране
Расположить свое любимое изображение в качестве фонового рисунка на рабочем
столе операционной системы очень просто, причем как на платформе Windows,
так и в Macintosh. Мы рассмотрим все на примере Windows.

Перед тем как помещать снимок на экран, нужно настроить его размеры — в пик-
селах, поскольку речь идет об экране монитора. Для этого необходимо выяснить
установленный в системе видеорежим. Щелкните правой кнопкой мыши на рабо-
чем столе и в контекстном меню выберите пункт Свойства (Properties). В открыв-
шемся окне щелкните на пункте Настройка (Settings). Например, у вас установлены
размеры области экрана 1024 х 768 точек.

Если изображение в пикселах имеет меньшие размеры, то можно его увеличить —
это приведет к ухудшению качества, или поместить по центру экрана, тогда по краям
останутся области цвета рабочего стола. Если изображение имеет большие размеры,
уменьшите их до 1024 х 768 и, если нужно, обрежьте лишние части (см. главу 14).
Конечно, для Windows нет проблем автоматически уменьшать снимок, но она бу-
дет делать это каждый раз при перерисовке рабочего стола, что может сказаться на
быстродействии. Настроив размеры и само изображение (цвет, резкость), сохра-
ните его в формате BMP. Затем еще раз откройте диалоговое окно Свойства: Э к р а н
(Properties: Screen). Фон устанавливается на первой вкладке окна Фон (Background).
Щелкните на кнопке Обзор (Browse), найдите свое изображение и нажмите кнопку
Открыть (Open). Его название появится в списке слева. Найдите название в списке
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и выделите его. В раскрывающемся списке Отображение (Display) укажите, как рас-
полагать изображение: по центру, в виде плитки или растянуть на весь экран,
В нашем случае наиболее подходящим является вариант По центру (Center). Затем
нажмите кнопку П р и м е н и т ь (Apply) и закройте окно.

ПРИМЕЧАНИЕ
Я всегда помещаю какую-нибудь из своих фотографий на экран. Из долгой практики я вы-
вел следующее правило: нужно избегать активации, к которой стремится средство Windows
Active Desktop. А к его активации приводит, например, попытка использовать в качестве
фона изображение в формате JPEG. Именно поэтому я советую преобразовывать снимки
в формат BMP.

Как вы уже знаете, существует множество программ просмотра изображений.
Многие из них, например IrfanView или другая популярная программа — ACDSee, —
позволяют поместить изображение на рабочий стол в качестве фона с помощью
выбора одной команды или нажатия одной кнопки. Это гораздо удобнее!

Другие возможности, предоставляемые
цифровыми фотоаппаратами
Некоторые цифровые фотоаппараты могут работать как веб-камеры. Что такое веб-
камера? Если говорить кратко, это камера, которая подключается прямо к порту
компьютера (сейчас в основном используется USB-порт, но все еще существуют
веб-камеры, подсоединяющиеся к последовательному порту), и снимает все, что
происходит перед ее объективом. То есть такие камеры являются всего лишь ви-
деодатчиками, остальное выполняет программное обеспечение, установленное на
компьютер.

Веб-камеры используются для достижения самых разных целей. Самая первая в
Интернете веб-камера появилась в компьютерной лаборатории Кембриджского
университета в Англии. Она называлась Trojan Room Coffee Machine Cam и была
установлена на аппарате, варящем кофе. Каждые пятнадцать минут программное
обеспечение снимало изображение кофейника, на который указывала камера, пе-
редавало картинку на сайт в Интернет, и все сотрудники лаборатории могли, по-
смотрев на изображение, оценить наличие кофе. Им не нужно было спускаться
вниз по лестнице, чтобы обнаружить опустевший кофейник. Раньше изображение
кофейника можно было увидеть по адресу www.cl.cam.ac.uk/coffee/coffee.html, но
теперь его там нет. Первую кофейную машину с веб-камерой купила на онлайно-
вом аукционе eBuy одна немецкая компания, и теперь интернет-кофейник досту-
пен по адресу www.spiegel.de/netzwelt/netzkultur/0,1518,174146,00.html. Если щелк-
нуть на ссылке в середине верхней части страницы, которая называется «Cam 1»,
откроется новое окно с картинкой.

Второй старейшей в Интернете веб-камерой является Fish Cam (Рыбная камера)
компании Netscape. На заре сети World Wide Web ее запустил один из основате-
лей Netscape, разработчик Лу Монтулли (Lou Montulli), и скоро она стала очень
популярной. Несмотря на то что Fish Cam была не первой, а только второй веб-
камерой, она до сих пор считается воплощением бесполезности, хотя рыбы доста-
точно симпатичны, чтобы на них посмотреть. Компания AOL (America Online),
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которая теперь владеет Netscape, все еще поддерживает интернет-аквариум, и вы
можете увидеть его по адресу wp.netscape.com/fishcam/index.html.

И последней, наиболее интересной особенностью многих доступных в наши дни
цифровых фотоаппаратов является возможность записи небольших видеоклипов.
Как правило, их длительность ограничивается несколькими минутами, но этого
достаточно, чтобы заснять довольно много материала. В некоторых камерах огра-
ничение оговаривается прямо: клип может иметь определенную продолжитель-
ность. Другие позволяют снимать столько видеоинформации, сколько можно за-
писать на используемое устройство хранения информации, и в результате покупка
карты Compact Flash размером 1 Гбайт не покажется вам бессмысленной тратой
денег. Сняв свой небольшой видеофильм в первый раз, вы будете знать, какого
они получаются размера.

Следует запомнить
а Фотографии можно отправлять по электронной почте, присоединяя к письму

или встраивая в текст сообщения.

а Также нетрудно создать свой веб-сайт и разместить на нем фотографии, тогда
их увидит весь мир!

Р Большинство цифровых фотоаппаратов позволяют демонстрировать снимки
не только на компьютере, но и на экране телевизора.

О Цифровой фотоснимок — достойный вариант для фонового рисунка на рабо-
чем столе компьютера.
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Термины, связанные с цифровой
фотографией

ASA/ISO — единицы измерения светочувствительности матрицы фотоаппарата
или фотопленки.

CCD (Charged Couple Device — приборы с зарядовой связью, ПЗС) — улавлива-
ют фотоны света и вырабатывают электрический сигнал, то есть преобразуют свет
в электрическое напряжение.

CIE LAB — цветовая модель, разработанная Международной комиссией по осве-
щению (Commission Internationale de 1'Eclairage, CIE). Цвет определяется яркостью
(lightness) и двумя цветовыми компонентами: А — изменяется от красного до зе-
леного, В — от желтого до синего.

CMOS (Complementary Metal-Oxide Semiconductor — комплементарная струк-
тура металл-окисел-полупроводник, КМОП) — светочувствительная матрица,
которая улавливает фотоны света и преобразует в электрический заряд. Дешевле
в производстве, чем ПЗС-элементы, но используется реже, поскольку создает боль-
ше шума в изображениях.

CMYK — цветовая модель, используемая при печати. Основана на голубом, пур-
пурном, желтом и черном цветах (Cyan, Magenta, Yellow и blacK).

Cyan — голубой цвет, один из основных в модели CMYK.

dpi (dots per inch — точки на дюйм) — единица измерения разрешения при печати.

EPS (Encapsulated PostScript — встроенный PostScript) — формат графических
файлов, обычно ассоциирующийся с печатью.

f/stop — см. Диафрагма.

FlashPIX — формат, допускающий сохранение нескольких версий изображения
с разным разрешением. Не является широко распространенным.

GIF (Graphics Image Format — формат графического обмена) — изначально был
разработан и использовался компанией CompuServe; на данный момент является
одним из стандартных графических форматов в Интернете. При сохранении изоб-
ражения в этом формате осуществляется сжатие без потерь.
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GUI (Graphical User Interface — графический интерфейс пользователя) — дает
возможность пользователю при работе с программами оперировать графическими
элементами, такими как значки или раскрывающиеся меню и списки. Типичный
пример — оболочка операционной системы Windows.

HSB — цветовая модель, описывающая цветовой тон, насыщенность и яркость (hue,
saturation и brightness).

HSL — цветовая модель, описывающая цветовой тон, насыщенность и освещен-
ность (hue, saturation и lightness).

JPEG — произносится как «джей-пег». Графический формат (алгоритм), разрабо-
танный Joint Photographic Experts Group (Объединенной группой экспертов в об-
ласти фотографии), при сохранении в котором происходит сжатие с потерями.
В этом формате достигается максимальная степень сжатия изображений.

LAB - см. CIE LAB.

Ipi (lines per inch — линии на дюйм) — единица измерения разрешения принтера.

PCMCIA, карта памяти — съемное устройство для хранения информации.

PICT — формат графических файлов, стандартный для компьютеров Macintosh.

ppi (pixels per inch — пикселы на дюйм) — единица измерения разрешения изоб-
ражений.

RAM (Random Access Memory — память с произвольным доступом) — оператив-
ная память, в которой хранятся все данные, используемые компьютером в данный
момент, то есть операционная система и все запущенные программы.

RGB — цветовая модель с тремя основными цветами: красным, зеленым и синим
(red, green и blue).

SLR (Single Lens Reflex) — см. Зеркальный фотоаппарат.

TIFF (Tagged Image File Format — самодокументируемый формат файлов изоб-
ражений) — формат графических файлов, распознаваемый как на платформе PC,
так и на Macintosh.

TWAIN — стандарт, предназначенный для связи между цифровыми устройства-
ми, например фотоаппаратами, сканерами и компьютером. Драйверы TWAIN по-
зволяют передавать данные с камеры или со сканера.

WYSIWYG (What You See Is What You Get) — американский термин, «получаем
то, что видим». Принцип положен в основу текстовых и графических редакторов,
обеспечивает одинаковое представление документов и изображений как на экране
компьютера, так и при печати.

Zoom — см. Объектив с переменным фокусным расстоянием, вариообъектив.

Автофокус (система автоматической фокусировки) — устройство, посредством
которого фотоаппарат фокусируется на объекте съемки автоматически.

Апертура — отверстие в объективе, величина которого может меняться и через
которое свет попадает внутрь фотоаппарата.

Артефакт — ошибочная информация в изображении — проявляется в виде размытия
контрастных границ, искажения размеров и т. д. — возникает вследствие ошибок при
сжатии фотографии, слабого освещения или низкого качества компонентов камеры.

Байт — единица измерения информации, равная восьми битам.
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Балансировка цвета — процедура избавления от избытка одного цвета в изобра-
жении. Например, если снимок слишком синий, нужно добавить желтого цвета,
чтобы изображение стало сбалансированным.

Бит — минимальная единица измерения информации.

Режим Bitmap — режим, при котором каждый пиксел изображения кодируется
одним битом, то есть он может быть либо белым, либо черным.

Вспышка — дополнительный импульсный источник света при фотосъемке.

Выдержка — время, в течение которого открыт затвор фотоаппарата и происходит
экспонирование (освещение) пленки или светочувствительной матрицы.

Гигабайт - 1 000 000 000 байтов (точнее 1 073 741 824 байта).

Глубина резкости — величина, определяющая размер пространства, которое бу-
дет резким на фотографии при данных диафрагменном отверстии и расстоянии до
точки фокусировки.

Глубина цвета — количество битов, отведенных для определения цвета одного
пиксела. .

Градиентный переход тонов — плавный переход от светлых тонов в изображении
к темным (или наоборот) или от одного цвета к другому.

Диафрагма (диафрагменное число) — величина, определяющая, насколько открыта
диафрагма объектива. Чем меньше значение диафрагмы, тем больше отверстие в объ-
ективе, соответственно, больше света попадает на пленку, и тем меньше глубина резкос-
ти. Например, при диафрагме 16 глубина резкости больше, чем при диафрагме 2,8.

Диск — общее название носителей для хранения информации в компьютерной
технике. Бывают разные диски: гибкие, компакт-диски (CD) и т. д.

Длиннофокусный объектив — объектив, который имеет большое фокусное расстоя-
ние и острый угол зрения, он визуально приближает объекты съемки, и в кадр попада-
ет меньшее пространство по сравнению с широкоугольным объективом. Фокусное
расстояние таких объективов больше 90 мм для 35-миллиметрового фотоаппарата.

Драйвер — программа, отвечающая за управление определенным устройством
компьютера, внутренним или внешним.

Естественное освещение — такое как солнечный свеТ, без использования вспыш-
ки и дополнительных источников света.

Жесткий диск — несъемное устройство для хранения информации в компьютере.

Загрузка — процесс передачи данных с одного устройства на другое, например, вы
можете загрузить файл с веб-сайта на свой компьютер или фотографии с камеры
на компьютер.

Затвор — устройство, которое открывается, пропуская свет на пленку или свето-
чувствительную матрицу, и затем закрывается. Время, в течение которого затвор
открыт, определяет выдержку.

Зеркальный фотоаппарат (SLR — Single Lens Reflex) — фотоаппарат, в котором
встроенная система зеркал и призма позволяют видеть объект в видоискателе так же,
как он воспринимается через объектив — без смещения от оптической оси последнего.

Индексированные цвета — при переводе в режим индексированных цветов проис-
ходит уменьшение количества цветов, используемых для отображения рисунка,
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до некоторого фиксированного числа. Под цвет каждого пиксела отводится во-
семь или меньше битов. Этот режим, как правило, применяется для уменьшения
размера файла, если изображение содержит большие однотонные области (вида
«логотип»). Плохо подходит для фотографий.

Искусственное освещение — свет в помещении, без использования вспышки
и дополнительных источников света.

Калибратор монитора — устройство, которое используется для точной настройки
монитора.

Карта памяти (флэш-память) — съемное устройство для хранения информации,
отличающееся небольшими размерами.

Килобайт - 1024 байта (210 байта).

Клонирование — размножение, копирование частей изображения. Обычно кло-
нируемый фрагмент вставляется поверх другого. Также является обязательной
частью фильмов Феллини.

КМОП (комплементарная структура металл-окисел-полупроводник — Complementary
Metal-Oxide Semiconductor, CMOS) — светочувствительная матрица, которая улавли-
вает фотоны света и преобразует в электрический заряд. Дешевле в производстве, чем
ПЗС-элементы, но используется реже, поскольку создает больше шума в изображениях.

Контраст(ность) — разница в яркости на переходе от темных тонов к светлым
и наоборот. Изображение с низкой контрастностью выглядит серым или обесцве-
ченным.

Маска — специальный слой или выделение, используемое для защиты от измене-
ний некоторых фрагментов изображения.

Мегабайт - 1 048 576 байтов (точнее 220 байта).

Мегапиксел — единица измерения количества пикселов, используемая для характе-
ристики светочувствительной матрицы цифрового фотоаппарата. Равен 1 048 576 пик-
селам (220). Мегапиксел — это не мегабайт.

«Мыльница» — дешевый фотоаппарат без возможностей расширенного управле-
ния процессом съемки.

Насыщенность — интенсивность цвета, количественная его характеристика в ма-
шинной графике. Выражается в процентах как доля основного цвета в цветовом
оттенке.

Нормальный объектив — объектив, угол зрения которого приближен к углу зре-
ния человека. Как правило, имеет фокусное расстояние 50 мм для 35-миллиметро-
вых фотоаппаратов.

Объектив без системы фокусировки — объектив, который не может фокусиро-
ваться. Обычно настроен так, чтобы резко изображаемое пространство было при-
мерно от 4 футов до бесконечности. Встречается на дешевых «мыльницах».

Объектив с переменным фокусным расстоянием (zoom) — объектив, фокусное
расстояние которого может меняться за счет передвижения групп линз друг отно-
сительно друга.

Объектив с постоянным фокусным расстоянием — к таким объективам обычно отно-
сят модели, у которых фокусное расстояние не меняется, но на объекте съемки можно
сфокусироваться за счет перемещения объектива в направлении от плоскости пленки.
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Обрезка — удаление лишних частей изображения.

Оперативная память (RAM) — устройство, в котором хранятся все данные, ис-
пользуемые компьютером в данный момент, то есть операционная система и все
запущенные программы.

Основное освещение — создается дополнительным источником света, располо-
женным перед объектом съемки.

ПЗС (приборы с зарядовой связью — Charged couple device, CCD) — улавливают
свет и вырабатывают электрический сигнал, то есть преобразуют свет в электри-
ческие сигналы.

Пиксел — наименьший неделимый элемент изображения.

Платформа — компьютерная система.

Подключаемый модуль (plug-in) — дополнительный встраивающийся в программ-
ный пакет код. В компьютерной графике обычно ассоциируется с программами,
выполняющими фильтрацию или реализующими специальные эффекты.

Полутоновой режим (grayscale) — его также называют режимом в градациях се-
рого. Изображение в этом режиме выглядит подобно черно-белой фотографии, оно
содержит только белый, черный цвета и промежуточные оттенки серого.

Разбиение на пикселы — эффект, при появлении которого становятся видны
отдельные пикселы изображения даже при нормальном масштабе отображения.
Является результатом недостаточного разрешения.

Разрешение — количество минимальных элементов (пикселов, точек, линий)
на дюйм, является характеристикой цифровых изображений и всех работающих
с ними устройств.

Рассеянное освещение — свет от вспышки или другого источника, отраженный
от стены или другой поверхности. Такое освещение применяется при студийной
съемке.

Резкость — имеет отношение к фокусировке, резким называется изображение,
у которого ясно и четко видны все детали.

Рыбий глаз — объектив с очень большим углом зрения (до 180° и даже больше),
что приводит к появлению бочкообразной дисторсии (геометрическим искажени-
ям на краях изображения).

Светофильтр — цветное стекло, которое устанавливается перед объективом в це-
лях ограничения прохождения определенного диапазона светового излучения.

Светочувствительность — параметр, характеризующий восприимчивость фото-
пленки или цифровой матрицы к свету.

Сжатие — процесс уплотнения (архивации) данных. Позволяет уменьшить раз-
мер файлов, как текстовых, так и графических.

Сжатие без потерь — метод сжатия файлов, при котором восстановленное в даль-
нейшем изображение не теряет в качестве, сохраняя все без исключения детали
исходного изображения.

Сжатие с потерями — метод сжатия файлов, при котором теряется часть инфор-
мации. Лишние с точки зрения алгоритма метода данные выбрасываются.

Ступенчатость — эффект, наблюдаемый на всех линиях изображения, кроме го-
ризонтальных и вертикальных, при недостаточном разрешении.
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Установки, используемые по умолчанию (default setting) — настройки, предла-
гаемые программой или устройством, считаемые оптимальными в большинстве
случаев. Новый фотоаппарат или приобретенная программа обычно настроены
производителем по умолчанию.

Файл — именованная совокупность данных, таких как изображение или тексто-
вый документ.

Фильтр — инструмент в графическом редакторе, применяемый к изображению
с целью его изменения, например фильтр, увеличивающий резкость изображения.

Фокусировка — приведение объектива в состояние, при котором получаемая фо-
тография будет резкой (см. Резкость).

Фокусное расстояние — дистанция от центра объектива до его главного фокуса,
то есть до фокальной плоскости, в которой располагается пленка или матрица.
Исходя из фокусного расстояния определяется тип объектива: длиннофокусный,
широкоугольный или нормальный.

Формат файла — определяет способ чтения файла и трактовку заложенной в нем
информации. Многие программы имеют собственные форматы хранения данных.

Цветовая модель — метод описания и определения цвета. В качестве примеров
можно привести модели RGB, CMYK и HSB.
Цветовая температура — температура, при которой абсолютно черное тело излу-
чает такой же свет по спектральному составу, как и рассматриваемый свет. Темпе-
ратура цвета измеряется в градусах Кельвина. Обычная электрическая лампочка
излучает свет температурой около 2800 К, дневной свет имеет температуру 6500 К.

Цветовой охват (gamut) — диапазон цветов, который может воспроизвести уст-
ройство.
Цифровой — термин, используемый для описания системы или устройства, рабо-
тающего с двоичными (бинарными) данными.

Широкоугольный объектив — объектив, который имеет короткое фокусное
расстояние и широкий угол зрения, то есть в кадр попадает большое пространство.
Фокусное расстояние таких объективов примерно равно 35 мм для 35-миллимет-
рового фотоаппарата.
Шум — нежелательные помехи в изображении, вносимые техническими средства-
ми съемки и обработки фотографий. Обычно шум появляется в темных областях
снимков, вызывается плохим освещением и/или низким качеством светочувстви-
тельной матрицы.
Эффект «красных глаз» — выражается в том, что глаза всех людей и животных на
фотографии получаются красными. Проявляется, когда свет вспышки проникает
на сетчатку глаза. Его можно избежать, удалив вспышку от объектива.

Экспозиция — количество света, которое попадает на светочувствительную мат-
рицу или пленку. Определяется сочетанием диафрагмы (размер отверстия в объек-
тиве) и выдержки (время экспозиции). Процесс освещения пленки или матрицы
называют экспонированием.
Экспозамер — определение освещенности объекта съемки, на основе которого
выставляются значения выдержки и диафрагмы.

Экспорт — изменение формата (обычно исходного) файла на другой. Пример: экс-
порт из «родного» формата Photoshop (PSD) в формат TIFF.
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Создание панорам
Иногда случается так, что перед вами возникает замечательная композиция, но
фотоаппарат не позволяет уместить ее целиком в одном кадре. Возможно, следо-
вало бы использовать широкоугольный объектив, но его нет под рукой, а может
быть, вам не нравится «широкоугольник», потому что он вызывает нежелатель-
ные искажения или потерю деталей. Тогда вы можете снять серию частично пере-
крывающихся кадров, а затем объединить их с помощью специальной программы,
создающей панорамы. Мы будем рассматривать этот процесс на примере Photoshop
Elements. (Описываемую в этом разделе задачу можно успешно решить и с помо-
щью Photoshop, однако это потребует от пользователя больше «ручных» операций
и большей квалификации. — Примеч. ред.)

Автоматическое объединение
изображений
В качестве примера, который вы увидите на всех рисунках этого приложения,
я использовал фотографию заката солнца, которую снял как-то поздним вечером,
когда плыл со своим семейством на лодке. Тогда я взял с собой только цифровой
фотоаппарат с одним объективом, который не мог работать в режиме «широко-
угольника», и композиция не вписывалась в кадр. Но жена попросила меня сфото-
графировать этот прекраснейший закат. Я совсем недавно установил себе на компью-
тер программу Photoshop Elements и, услышав просьбу супруги, решил, что панорама
заката будет неплохим примером для проведения экспериментов. Тогда я снял 25
немного перекрывающихся кадров: 5 по ширине и 5 по высоте, слева направо и сни-
зу вверх. В книге демонстрируется объединение только трех из них с помощью
средства Create Photomerge (Соединить фотографии) программы Photoshop Elements.

Подготовка снимков
Если вы намереваетесь создавать панораму, я рекомендую сначала открыть все
необходимые файлы в программе Photoshop Elements или Photoshop. Расположи-
те их на экране так, чтобы они соприкасались сторонами, по которым будут соеди-
няться, или даже немного перекрывались. Теперь обязательно откорректируйте
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цветовую гамму, чтобы снимки по цветам не отличались друг от друга. Не нужно
активно обрабатывать место будущего соединения; просто попытайтесь сделать
так, чтобы все фотографии находились в одном цветовом диапазоне и не различались
по контрасту. У меня, например, средний снимок оказался более ярким, чем
остальные, поэтому я откорректировал все фотографии, используя методы, описанные
в главе 15, Программа Photoshop Elements не сильно отличается от Photoshop, в ней
применяются те же средства и инструменты. Данный этап имеет очень важное зна-
чение, потому что дальше снимки автоматически объединяются друг с другом, и вы
не сможете управлять этим процессом. Сохраните снимки и, если вы работали
не в Photoshop Elements, откройте их в этой программе.

СОВЕТ
Перед тем как снимать фотографии с целью создания панорамы, прочтите приложение до
конца, Это поможет избежать некоторых проблем.

Сборка панорамы
Выберите команду File > Create Photomerge (Файл > Соединить фотографии). Появит-
ся диалоговое окно, изображенное на рис. Б1. В разделе Source Files (Исходные фай-
лы) будут содержаться названия всех открытых на данный момент снимков. Здесь
же можно при необходимости добавить файлы (кнопка Browse (Обзор)) и, если
требуется, обратиться к справке, нажав на кнопку Help (Справка).

Photomerge
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Рис. Б1. В центральной части диалогового окна отображаются файлы,

предназначенные для объединения

ПРИМЕЧАНИЕ
Можно и не открывать снимки в программе заранее, а сделать это в диалоговом окне
Photomerge (Объединение фотографий). Если вы уверены в том, что все составляющие бу-
дущей панорамы сбалансированы по цвету, можно не тратить время на открывание отдель-
ных файлов.

Нажмите кнопку О К, чтобы соединить указанные снимки. В зависимости от коли-
чества фотографий и их размера процедура может занять довольно много време-
ни. Возможно, вы даже успеете пообщаться с семейством или вскипятить чайник.
Программа ищет в изображениях одинаковые элементы, затем делает обоснован-
ное предположение о том, как снимки должны накладываться друг на друга, и со-
здает итоговое изображение. Опять же, в зависимости от сложности фотографий
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и их количества, программа способна сразу правильно сцепить их, но исходя из лич-
ного опыта, могу сказать, что по крайней мере один кадр окажется не на своем месте.

Определение места изображения в панораме
Самое чудесное, что собранное изображение появляется в окне, которое также на-
зывается Photomerge (Объединение фотографий) (очень интересно, как два разных
диалоговых окна могут иметь одно и то же название, но некоторые программисты
считают, что это нормально). Оно показано на рис. Б2. Если какой-либо из сним-
ков попал не на свое место, активируйте инструмент Select Image (Выбрать изобра-
жение), нажав на кнопку со стрелкой в верхнем левом углу окна или клавишу А,
и перетащите снимок на правильную позицию. В процессе перетаскивания изобра-
жение станет полупрозрачным — это облегчит установку его в нужное положение.
Кроме того, после извлечения снимка из картинки справа от панорамы должен
появиться установленный флажок Snap to Image (Вставить в изображение) — тогда
после отпускания кнопки мыши программа автоматически выровняет снимок
и объединит его с окружающим изображением. Если снимок не очень хорошо сты-
куется с окружающими, попробуйте подвинуть его, опять воспользовавшись ин-
струментом Select Image (Выбрать изображение), или при необходимости повернуть
его на небольшой угол с помощью инструмента Rotate Image (Повернуть изображе-
ние) (режим включается кнопкой с окружностью со стрелкой или клавишей R).

! Photomerge

Ю

Рис. Б2. Снимки, находящиеся в верхнем светлом поле диалогового окна, не включены
в изображение

Удаление изображений
Если, например, по ошибке вы включили в панораму лишний снимок, его можно
удалить. Активировав инструмент Select Image (Выбрать изображение), перетащите
фрагмент из панорамы в белое поле, находящееся над рабочей областью окна
(см. рис. Б2), которое компания Adobe назвала «Light Box» (светлое поле). Снимки,
находящиеся здесь, можно впоследствии вставить в панораму, перетащив их в ниж-
нее поле.
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Слияние изображений
Если вам повезет, то все снимки прекрасно соединятся в панораму автоматически.
Они плавно перетекут друг в друга, и швы будут незаметны. Я же редко бываю
столь удачлив... Однако программы предоставляют нам инструменты, с помощью
которых можно совместить изображения, если это не получилось в результате ав-
томатических операций. Photoshop Elements пытается выполнить сращивание,
находя общие точки изображений. Я обнаружил, что программа намного лучше
объединяет фотографии, согласовывая их по положению общих точек, чем опира-
ясь на яркость или насыщенность цветов. Как я уже говорил, если предварительно
подогнать цветовую гамму и контраст снимков, результат улучшится. Кроме того,
попробуйте установить параметр Advanced Blending (Дополнительное с м е ш и в а н и е )
на панели, расположенной слева в окне Photomerge (Объединение фотографий).
Просмотрите предварительное изображение, нажав соответствующую кнопку.
На рис. БЗ показана панорама, в которой фрагменты практически сливаются друг
с другом в результате выполненной мной предварительной подготовки, и несмот-
ря на это центральный снимок все-таки немного отличается от двух крайних.

Рис. БЗ. Центральный снимок значительно насыщеннее двух крайних изображений

Использование корректирующих слоев
В ситуации, продемонстрированной на рис. БЗ, можно выделить слишком насы-
щенную часть изображения и наложить на нее корректирующий слой. Выделите
область с помощью инструментов выделения, например Lasso (Лассо), затем выберите
команду Layer > New Adjustment Layer > Brightness/Contrast (Слой > Н о в ы й корректирую-
щий слой > Яркость/Констраст). Откроется уже знакомое вам окно настройки яркости
и контраста. С помощью регуляторов поменяйте установки так, чтобы выделенная
область лучше сливалась с окружающими ее снимками. Часто имеет смысл перед
созданием корректирующего слоя немного размывать границы выделения.

Применение инструмента Smudge (Палец)
После коррекции яркости и контраста часто все еще остаются небольшие разли-
чия между краями настраиваемой области и окружающих частей панорамы. Тогда
я пользуюсь инструментом Smudge (Палец) в режиме Normal ( Н о р м а л ь н ы й ) или Color
(Цвет), которые устанавливаются на панели настройки инструмента. Методом проб
и ошибок вы найдете наиболее подходящее сочетание параметров инструмента
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в этих режимах. Режим Color (Цвет) позволяет обеспечить плавность переходов цве-
тов на границах снимков. В нормальном режиме можно смягчить края изображе-
ний там, где они выделяются по разнице яркости. Я воспользовался инструментом
Smudge (Палец), соединяя в панораму фотографии заката, причем мне пришлось
чередовать работу в обоих режимах, Часто имеет смысл снизить непрозрачность
рисования инструментом до 7-25%. Чем незаметнее и мягче вносимые изменения,
тем лучше. Кроме того, не нужно забывать о периодическом сохранении результа-
тов работы и, возможно, для этой операции стоит увеличить количество запоми-
наемых состояний в палитре History (История) (команда Edit > Preferences > General
(Редактирование > Установки > Общие), поле History States (Состояния истории)), по-
скольку каждое движение пальца сохраняется как целое состояние.

Применение инструмента Clone Stamp
(Клонирование)
В моей панораме одной из основных проблем было то, что небо на разных снимках
не очень хорошо соединялось в одно целое, вероятно, потому, что я наклонил фо-
тоаппарат, когда снимал (у меня, к сожалению, не было штатива, поэтому в каче-
стве точки опоры для камеры я использовал переднее стекло катера), Поэтому
я воспользовался инструментом Clone Stamp (Клонирование), чтобы немного подпра-
вить небо, выровнять линию горизонта и замаскировать действие пальца. Инстру-
мент Clone Stamp (Клонирование) рассматривался в главе 18.

Но более важным для меня было добиться слияния водной глади на разных частях
панорамы. Центральная часть, наиболее освещаемая заходящим солнцем, выделя-
ется своими насыщенными цветами по сравнению с остальными фрагментами.
С помощью инструмента Clone Stamp (Клонирование) я просто скопировал расцве-
ченную бликами воду за пределы центрального снимка, предварительно уменьшив
непрозрачность рисования до 50%. В результате накладываемая копия яркой водной
поверхности плавно соединилась с фоном и сохранилась исходная текстура.

Настройка цвета
Поскольку требовалось объединить снимки в панораму, я настроил каждый из них
так, чтобы облегчить свою задачу. Теперь же нужно восстановить цвета снимка,
максимально приблизив панораму к реальной картине, которую я наблюдал на
озере. Используя специально сохраненную необработанную фотографию в каче-
стве примера, я с помощью нескольких корректирующих слоев настроил насыщен-
ность и яркость панорамы, а затем обрезал лишние части изображения. Получил-
ся довольно неплохой результат, показанный на рис. Б4. Так я обработал только 3
из 25 снимков. Представьте, чего мне стоило объединение всех фотографий!

Рис. Б4. Это был один из прекраснейших закатов!
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Перспектива в панорамах
Иногда при соединении фотографий в панораму с помощью средства Photomerge
(Объединение фотографий) возникают искажения в перспективе — панорама полу-
чается как бы изогнутой по горизонтали. Если появляется такой эффект, восполь-
зуйтесь кнопкой Perspective (Перспектива), находящейся слева от рабочей области
окна Photomerge (Объединение фотографий). Она позволяет определить один из со-
единяемых снимков в качестве центра или точки схода композиции, и все другие
изображения будут настраиваться относительно центрального. Активируйте ин-
струмент V a n i s h i n g Point (Точка схода) (клавиша V), который становится доступен
только после включения средства Perspective (Перспектива), и щелкните на цен-
тральном снимке. Иногда такая коррекция порождает искажение типа «бабочка»,
то есть центральная часть панорамы сжимается, а края растягиваются в высоту.
Чтобы исправить снимок в такой ситуации, воспользуйтесь средством Cylindrical
Mapping (Цилиндрическое отображение). В справке Photoshop Elements есть пример
применения этого типа коррекции.

Предупреждение проблем
Как нетрудно понять, проще всего составить панораму из хороших, согласован-
ных друг с другом фотографий. Если у вас есть штатив, желательно с функцией
панорамирования, используйте его. Снимайте композицию от одного края до дру-
гого, например слева направо, не перемещая фотоаппарат по вертикали (так же
можно создавать вертикальные панорамы -̂  средство Photomerge (Объединение фото-
графий) объединит снимки в одно вертикальное изображение — но тогда камера не
должна двигаться по горизонтали). Часто фотографы пытаются сохранить положе-
ние линии горизонта или побережья в видоискателе, но поскольку снимается пано-
рама, такой подход приведет к искажению картины при объединении снимков.
Старайтесь передвигать фотоаппарат по прямой линии, при этом по возможности
не меняйте настройки экспозиции и фокусного расстояния. Если в фотоаппарате
есть функция ручного определения параметров съемки, воспользуйтесь именно
ею. Наконец, кадры следует снимать так, чтобы они перекрывались на 15-30%.
Меньшее наложение фотографий друг на друга затруднит работу программы в поиске
общих точек изображений, что может привести к ухудшению результатов слияния.

Еще несколько слов
Освоив технику объединения фотографий в панораму, вы обязательно должны
продолжить изучение программ Photoshop Elements, Photoshop и устанавливаю-
щегося вместе с последней приложения ImageReady. В них включено множество
других средств, которые мы не смогли обсудить в этой книге, таких как анимация,
трехмерная обработка изображений и манипуляции с вращением. Уверяю вас, это
будет очень интересно!
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А-В
Adobe

Adobe Acrobat, 166
Adobe Gamma, 301
Illustrator, 95
Photoshop, 95. См. также Photoshop
Photoshop Elements. CM. Photoshop Elements
компания, 95

Adobe Acrobat, программа, 166
PDF, формат, 166

Adobe Gamma, 301
Control Panel, установка всех параметров, 304
запуск, 301
измерение белой точки, 303
работа с мастером, 301

ASA, единицы, 73, 108
BMP, формат, 167

C-D
CIE LAB, цветовая модель. См. LAB, цветовая

модель
CIE, международная комиссия по освещению, 298
CMOS, 39
CMS, система управления цветом, 298
CMYK, цветовая модель, 86, 205, 299
dpi, 156, 309

Easy Share System, 71
EPS, формат, 166

Fire Wire, интерфейс. См. IEEE 1394
FlashPath, адаптер для карт SmartMedia, 180
FlashPIX, формат, 166

G-I
GIF, формат, 165

использование, 261
HSB, цветовая модель, 206
ICC, организация, 299
ICC, профиль, 300

IEEE 1394 (FireWire), 80, 171
Image Expert, программа, 173

загрузка снимков на компьютер, 173
изменение ориентации изображения, 176
коррекция изображения, 176
переименование изображения, 176
сохранение изображения, 176
удаление снимков, 174

IrfanView, программа, 97, 167
возможности, 97
пакетная обработка, 97

пример, 98
установка, 97

ISO, единицы, 63, 73, 108

JPEG, формат, 163
использование, 261
качество изображений, 163, 186
сохрайение изображений из Photoshop, 320
шум, 213

к-о
Kodak, компания, 22
LAB, цветовая модель, 205, 298
LCD. См. Жидкокристаллический экран
LivePix, программа, 96
Ipi, 157, 310
LZW, алгоритм сжатия, 165
Macintosh, компьютер, 75, 171

клавиатурные команды для Photoshop, 184
Mavica, камера, 23
Memory Stick, модуль памяти, 69
Microdrive, миниатюрный жесткий диск, 69
OEM, 172

Paint Shop, программа, 96
PDF, формат, 166
Photoshop, 95, 183

Brightness/Contrast, команда, диалоговое
окно, 195

Canvas Size, диалоговое окно, 188
Color Balance, диалоговое окно, 198
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Photoshop (продолжение)
Color Picker, диалоговое окно, 238
Fill , диалоговое окно, 232
Filter, меню. См. Photoshop, фильтр, Filter
Hue/Saturation, диалоговое окно, 200
Image Size, диалоговое окно, 186
Layer Style, диалоговое окно, 264, 282
Preferences, диалоговое окно, 239, 250
PSD, формат, 185
Select, меню, 219

АИ, команда, 191, 219
Color Range, команда, 219, 226
Deselect, команда, 219
Feather, команда, 220, 229
Grow, команда, 220
Inverse, команда, 219
Load Selection, команда, 220
Modify, команда, 220
Reselect, команда, 219
Save Selection, команда, 220, 227
Similar, команда, 220
Transform Selection, команда, 220

Transform, команда, 189
Undo, команда, 190
Variation, диалоговое окно, 202
векторный объект, 246, 263

преимущества, 263
выделение, 189

Select, меню. См. Photoshop, Select, меню
в форме текста, 260
восстановление выделения, 219
всего изображения, 191, 219
границы, 220
границы, отображение, 229
границы, размытие, 220
границы, скрытие, 229
деформация, 220
загрузка, 220
заливка текстурой, 233
заливка цветом, 232
защита от воздействия инструментов, 218
изменение, 220, 228
инвертирование выделения, 219
инструменты, 218. См. также Инструменты

выделения
копирование фрагментов, 227
копирование фрагментов на новый слой, 274
модификация, 220
па основе цвета, 219, 225, 226
овальной области, 222
определение образца, 233
перемещение. См. Инструмент Move
причины, 217
произвольное, рисованием, 223, 227
произвольное, рисованием, на основе
цвета, 224

произвольное, рисованием отрезков, 223
прямоугольной области, 220
рамка, 220
расширение, 220, 228

Photoshop, выделение (продолжение)
режим Quick Mask, 227
снятие, 219
сохранение, 220, 227
столбца пикселов, 223
строки пикселов, 223
удаление фрагментов, 227

деформация. См. Трансформация
загрузка фотографий с камеры, 177, 180
изображение

восстановление фрагмента, 233, 248
выделение фрагментов. См. Photoshop,

выделение
защита фрагментов от воздействия, 218
зеркальное отражение, 191
изменение неба, пример, 237
изменение формата при сохранении, 185
имитация движения, пример, 289
имитация рисования, пример, 289
контраст, 195
копирование фрагментов, 217, 227, 250, 253
копирование фрагментов, пример, 280
копирование фрагментов со сглаживанием

границ, 281
коррекция. См. Photoshop, коррекция
масштаб, изменение, 187
негатив, 203
обесцвечивание фрагмента, пример, 221
облака, создание, пример, 239
обрезание, 192
ориентация, изменение, 191
открытие, 183
перемещение фрагментов, 228
печать. См. Photoshop, печать
поворот, 191
размер, 155, 186, 320. См. также

Изображение, размер
размер файла, уменьшение, 319
размер холста, 187
размытие, 211
растушевка краев, пример, 229
резкость, 208
ретушь. См. Photoshop, ретушь
создание, 259, 273
сохранение, 185, 263
текст. См. Photoshop: текст
удаление фрагментов, 227
цвета, автоматическая настройка, 195
цвета, настройка вручную, 198, 200
цвета, настройка с помощью вариантов, 202
цвета, настройка с помощью слоев, 201
цветовой режим, изменение, 208
шум, коррекция, 213
яркость, 195

инструмент
Crop, 192
Eyedropper, 237
Gradient, 236
History Brush, 248
Move, 228, 262, 278
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Photoshop, инструмент (продолжение)
Paint Bucket, 233
Pen, 247
Smudge, 290
Type. См. Photoshop: текст
Zoom, 187
выделения. См. Photoshop, инструменты

выделения
клавиатурные комбинации, 216
отображение и скрытие, 216
ретуширующий. См. Photoshop,

инструменты ретуши
рисования. См. Инструменты рисования

инструменты выделения
Elliptical Marquee, 222
Feather, параметр, пример использования, 281
Lasso, 223
Magic Wand, 225
Magnetic Lasso, 224
Polygon Lasso, 223
Rectangular Marquee, 220

инструменты ретуши
Cloner Stamp, 249, 340
Cloner Stamp, параметры, 250
Cloner Stamp, пример использования, 250
Cloner Stamp, работа, 251
Healing Brush, 255
Patch, 256

инструменты рисования. См. Photoshop,
рисование

Art History Brush, 248
Background Eraser, 244
Brush, 239
Brush, выбор цвета, 241
Brush, динамические свойства, 242
Brush, изменение вида, 240
Brush, параметры, 243
Brush, рисование, 243
Custom Shape, 247
Ellipse, 245
Eraser, 244, 279
Eraser, параметры, 245
History Brush, 248
Line, 246
Magic Eraser, 245
Pattern Stamp, 250, 254
Pattern Stamp, пример, 255
Pencil, 243
Pensil, 239
Polygon, 245
Rectangle, 245
Rounded Rectangle, 245
непрозрачность, 241
режимы смешивания. См. Режимы смешивания

клавиатурные комбинации, 216
контраст изображения

автоматическая настройка, 195
настройка вручную, 195

контуры, 247
копирование фрагментов, 217
копирование фрагментов, пример, 280

Photoshop (продолжение)
копирование фрагментов со сглаживанием

границ, 281
коррекция

насыщенность, 200
ретушь. См. Photoshop, ретушь изображений
слои, 201
уровни, 199
цвет, 198, 200, 202
цветовой тон, 200
шум, 213

коррекция геометрических искажений
Distort, команда, 194
Perspective, команда, 193

направляющие, создание, привязка, 313
настройка программы, 239, 250
образец

использование, 255
определение, 233, 255

отмена выполненных действий, 186, 190,
233, 272. См. также изображение,
восстановление фрагмента

палитра
Brushes, 240
Channels, 272
Color, 237, 264
History, 186, 190, 248, 250
History, настройка, 233
Layers, 189, 201, 262
Paths, 272
Styles, 264, 283
Swatches, 264
восстановление расположения, 216
отображение и скрытие, 185
плавающая, 216

панель инструментов, 216. См. также
Photoshop, инструменты

отображение и скрытие. 184
переключение между окнами, 228, 254
перемещение

выделенной области. См. Инструмент Move
изображения. См. Инструмент Move
слоя. См. Инструмент Move

печать. См. Печать, Принтер
изображения, 310
индекс отпечатка, 312
настройка, 311
настройка свойств принтера, 312
нескольких изображений на листе, 313
нескольких копий изображения на листе, 313
параметры страницы, 310
предварительный просмотр, 311
разрешение. См. Разрешение: печать

привязка к
направляющим, 313
сетке, 313

размер
изображения. См. Photoshop, размер

изображения
файла, уменьшение, 319
холста, 187
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Photoshop (продолжение)
размер изображения, 155, 320

пропорции, сохранение или изменение, 186
разрешение. См. Разрешение
свободное изменение, 189

размытие
фильтр Blur, 211
фильтр Blur More, 211
фильтр Gaussian Blur, 212
фильтр Motion Blur, 212
фильтр Smart Blur, 212

режимы смешивания
Behind, 234
Clear, 234
Color, 235
Color Burn, 234
Color Dodge, 234
Darken, 234
Difference, 235
Dissolve, 234
Exclusion, 235
Hard Light, 235
Hue, 235
Lighten, 234
Linear Burn, 234
Linear Dodge, 235
Linear Light, 235
Luminosity, 235
Multiply, 234
Normal, 234
Overlay, 235
Pin Light, 235
Saturation, 235
Screen, 234
Soft Light, 235
Vivid Light, 235

резкость
фильтр Sharpen, 209
фильтр Sharpen Edges, 209
срильтр Sharpen More, 209
фильтр Unsharp Mask, 209

ретушь
фильтр Dust and Scratches, 213

ретушь изображений, 249. См. также
Инструменты ретуши

пример, 250
фильтр Dcspeckle, 213
фильтр Dust and Scratches, 256

рисование
восстановление фрагмента, 233
закругленный прямоугольник, 245
заливка градиентная, 236
заливка текстурой, 233
заливка цветом, 232
звезда, 246
инструменты. См. Инструменты рисования
кистью, 243
кистью, выбор цвета, 241
линии и стрелки, 246
многоугольник, 245

Photoshop, рисование (продолжение)
непрозрачность, 234, 241
припяэка к сетке, 242
произвольная фигура, 247
прямоугольник, 245
режимы наложения. См. Photoshop, режимы

смешивания
свободное, 239
стирание на основе цвета, 244 - 245
стирание свободное, ластик, 244
эллипс, 245

слои
Background, 189, 272
активация, 262, 275
видимый, 275
вращение, 278
деформация, 278. См. также Photoshop,

трансформация
копирование, 268
копирование из одного изображения

в другое, 278
копирование фрагментов, 280
корректирующие, 201
название, 273
непрозрачность, 247, 266, 278
нумерация, 274
объединение, 282
переименование, 268, 274
перемещение. См. Инструмент Move
перестановка, 277
понятие, 271
порядок, перестановка, 276
преобразование фонового в обычный, 189, 272
режим наложения, 282. См. также Режимы

смешивания
свойства, 268
скрытие, 268, 275
создание, автоматическое, 273
создание вручную, 273
создание через копирование выделенной

области, 255, 274
стили, 247, 283
стили, Drop Shadow, 265
стили, Inner Shadow, 255
стили, Outer Glow, 268
стили, выбор вручную, 264
стили, выбор из каталога, 263
стили, параметры, 266
стирание содержимого, 279
текстовый, 260, 262-263
тень, 265
трансформация, 263, 278
удаление, 276
фигур, 246, 247
фоновый, 189, 272

создание сайта-фотогалереи, 325
сохранение

выделения, 220, 227
состояний, 233
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Photoshop (продолжение)
сохранение изображений, 250

Save As, команда, 185
для Интернета, 325
полезные советы, 185
с текстом, 263
формат JPEG, 320

справка, 185
текст

вертикальный, 260
выделенная область, 260
геометрическая деформация, 261, 264
горизонтальный, 260
для Интернета, 261
изменение, 262
инструмент Туре, 260
кегль шрифта, 260
начертание, 260
особенности, 263
панель настроек, 260
параметры, 260
прозрачность, 267
растеризация, 263
режим наложения. См. Режим смешивания
с тенью, пример, 265
светящийся, пример, 268
слой, 260
создание, 260
стили слоев, 263
шрифт, 260

трансформация
выделения, 220
изменение масштаба и пропорций, 189
перспектива, 193
свободная деформация, 194
слоя, 263, 278

указатель мыши
вид, настройка, 239, 250

уровни
Levels, диалоговое окно, 199

фильтр
Add Noise, 292
Blur, 211
Blur More, 211
Chalk & Charcoal, 255
Clouds, 239
Colored Pensil, пример, 288
Custon Filter, 294
Despeckle, 213
Dust and Scratches, 213, 256
Filter, меню, 287
Gaussian Blur, 212
Mosaic. Tiles, 291
Motion Blur, 212
Motion Blur, пример, 289
Patchwork, 291
Radian Blur, 212
Ripple, 293
Sharpen, 209
Sharpen Edges, 209
Sharpen More, 209

Photoshop, фильтр (продолжение) •
Smart Blur, 212
Unsharp Mask, 209
встроенный, 286
группа Artistic, 288
группа Blur, 289
группа Texture, 291
окно предварительного просмотра, 257, 288
определение, 285
особенности работы, 288
применение нескольких, пример, 292
создание произвольного, 294
типы, 288
третьих фирм, 287

холст
изменение размера, 187

цвет
выбор, 237
изображения. См. Photoshop, цвета

изображения
установка цвета переднего плана, 237
установка цвета фона, 229, 238

цвета изображения
автоматическая настройка, 195
настройка вручную, 198, 200
настройка с помощью вариантов, 202
настройка с помощью слоев, 201
уровни, 199

цветовая модель. См. Цветовая модель
изменение, 208

цветовой режим. См. Изображение, режим
изменение, 208

элементы окна, 184
направляющие, 313
отображение и скрытие, 184
палитры. См. Photoshop, палитры
панель инструментов, 184, 216
панель настройки инструментов, 184
полосы прокрутки, 187
сетка, 242, 313
строка меню, 184

яркость изображения
автоматическая настройка, 195
настройка вручную, 195

Photoshop Elements, 96, 177, 183
Create Photoinerge, 336
загрузка фотографий с камеры, 177
создание панорам, 336

PICT, формат, 167
PKZip, архиватор, 161
ppi. См. Разрешение, ppi
PSD, формат, 263

Q-R
QTVR, технология, 30
QuickTake, фотоаппарат, 23
RAM, оперативная память, 77
RGB, цветовая модель, 33, 204, 299
RLE, алгоритм сжатия, 160
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S-Z
Stufflt, архиватор, 162
TIFF, формат, 72, 164, 186, 263
TWAIN, 177, 179
USB, 69, 80, 171
WinZip, архиватор, 161
Zoom. См. Объектив с переменным фокусным

рассточнием

Аберрация, 121
геометрическая, 123

Автоспуск, 73, 143
Автофокус. См. Автофокусировка
Автофокусировка, 61, 117

активная система, 117
дальномер, 117
макросъемка, 118
недостатки, 117
пассивная система, 117
с блокировкой, 118

Адаптер
FlashPath, для карт SmartMedia, 180
для карты памяти, 71, 180

Адаптер переменного тока, 58
Аккумуляторы. См. Элементы питания

Байт, 206
Батарейки. См. Элементы питания
Белая точка, 303
Бит, 206
Битумин, 20

В
Вариообъектив. См. Объектив с переменным

фокусным расстоянием
Веб-камера, 328
Видеокарта, 82

видеопамять, 82
Видоискатель, 36, 45

жидкокристаллический экран, 55, 64
оптический, 65
типы, 64

Вспышка, 63, 144
дополнительная, 145

кронштейн, 146
синхроконтакт, 146

заполняющая, 144
правила работы, 144
рассеянный свет, 145
цвет света, корректировка, 148

Вторичные цвета, 34
Выдержка, 106, 110. См. также Экспозиция

приоритет по выдержке, 112
связь с диафрагмой, 107

Гелиография, 21
Гипосульфит натрия, 21
Глубина резкости, 110
Графика

векторная, 95, 263
растровая, 95

Графический редактор
Adobe Photoshop. См. Photoshop
Adobe Photoshop Elements. См. Photoshop

Elements
LivePix, 96
Paint Shop, 96
возможности, 92

Дагер.Луи, 21
Дагерротип, 21
Дальномер, 45, 117
Диафрагма, 36, 61, 106. См. также Экспозиция

ирисовая, 104
приоритет по диафрагме, 112
связь с выдержкой, 107
связь с глубиной резкости, 111

Диафрагменное число, 61, 106
Дисковод CD-R, CD-RW, 85
Дисторсия, 122
Дополнительный цвет, 33
Драйверы TWAIN, 177, 179

доступ, 177

Ж
Жесткий диск, 78
Жидкокристаллический монитор, 83
Жидкокристаллический экран, 55, 64

Законы оптики, 35, 114
Закрепитель, 22, 37
Затвор, 105

шторный, 105

И
Изображение

векторное. См. Графика векторная
вставка текста. См. Photoshop: текст
для Интернета, 261
качество, 26, 61
констраст, 93
контраст, 195

настройка, 195
копирование фрагментов, 93, 227, 250, 253.

См. также Photoshop, копирование
фрагментов пример, 280

со сглаживанием границ, пример, 281
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Изображение (продолжение)
коррекция. См. Photoshop, коррекция

геометрических искажений, 193
контраст, 195
ретушь. См. Photoshop, ретушь
удаление нежелательных элементов, 251
удаление царапин, 251
цвета, 195
шум, 213
яркость, 195

логотип, 261
миниатюра, 324
негатив, 203
обработка, редактирование. См. Photoshop
обрезание, 92, 130, 192
ориентация

изменение, 176, 191
отправка по электронной почте

Outlook Express, 322
в теле письма, 323
вложение в письмо, 322
подготовка, 319

пакетная обработка, 97
переименование, 176
перемещение фрагментов, 228
печать. См. Photoshop, печать
поворот, 93, 191
просмотр, 98, 173
размер, 157 - 158, 319

изменение, 93, 186
пропорции, сохранение или изменение, 186
разрешение. См. Разрешение
увеличение, 186
файла, 157
файла, уменьшение, 319

размещение на веб-сайте
подготовка, 324

размытие
средствами Photoshop, 211

разрешение. См. Разрешение
растушевка краев, пример, 229
редактирование. См. Photoshop, изображение

изменение неба, пример, 237
имитация движения, пример, 289
имитация рисования карандашом, пример, 289
обесцвечивание фрагмента, пример, 221
облака, создание, пример, 239
растушевка краев, пример, 229

режим
bitmap, 207
изменение, 208
индексированных цветов, 207
полноцветный, 204
полутоновой, 207

резкость, 61
увеличение средствами Photoshop, 208

ретушь. См. Photoshop, ретушь
рисование, 241
сжатие. См. Сжатие

Изображение (продолжение)
создание панорам, 336
создание сайта-фотогалереи, 325
сортировка, 239
сохранение, 167, 176
сохранение в Photoshop, 185
удаление фрагментов, 227
фоновый рисунок на рабочем столе

компьютера, 327
формат. См. Формат
цвета

глубина цвета, 206
искажение, 198
настройка, 93, 195, 198, 200 - 202

эффекты, 93
яркость, 93, 195

настройка, 195
Индекс отпечаток, 94

создание, 313
Интерполяция, 27, 48, 124
Искажение цветов, 28

К
Кабель, 69
Калибровка, 197
Камера-обскура, 19
Карта памяти, 50, 66, 180

CompactFlash, 67, 180
PC Card, 66
PCMCIA, 66, 180
SmartMedia, 67, 180
адаптер, 180
загрузка файлов на компьютер, 180

КМОП-элемепты, 39
Компакт-диск, 85, 168
Композиция, 125

баланс, 129
визуальные линии, 137
горизонтальные линии, 129
горячие точки, 126
движущиеся объекты, 133
задний план, 137 - 138
изменение, 92
контраст, 132
коррекция, 192, 250
линия горизонта, 129
масштаб объектов, 140
мертвые линии, 126
направление кадра, 130
объект кадра, 130

положение, 126
передний план, 137
перспектива, 136
пространство

негативное, 133
позитивное, 133

ракурс, 134
симметрия, отсутствие, 126
текстура, 139
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Композиция (продолжение)
точка съемки, 134
цвет, 131

Компьютер
IEEE 1394 (FireWire), интерфейс, 80, 171
SCSI, интерфейс, 80
Windows, операционная система, 76
модем, 81
периферийные устройства, 84

дисковод CD-R, 85
дисковод CD-RW, 85
принтер. См. Принтер
сканер. См. Сканер

платформа
Macintosh, 75
PC, 75

подключение фотоаппарата, 171
порт

IEEE 1394 (FireWire), 80, 171
USB, 80, 171
последовательный, 80, 171

приобретение, 76
составляющие

видеокарта, 82
жесткий диск, 78
монитор. См. Монитор
оперативная память, 77
центральный процессор, 77
шина, 78

тактовая частота, 78
техническая поддержка, 76

Контраст, 93, 195
влияние на композицию, 132

Корпус фотоаппарата, 55

м
Матрица светочувствительная

КМОП-элементы, 39
линейная, 39
ПЗС-элементы, 39
полнокадровая, цветная

с чередованием элементов, 41
полнокадровая, черно-белая, 40
светочувствительность, 109

изменение, 109
трехлинейная, 40

Мегапиксел, 49
Миниатюрный жесткий диск

Microdrive, 69
PCMCIA, 67

Модем, 81
Монитор

жидкокристаллический (LCD), 83
калибратор, 300
калибровка, 197

модуль Adove Gamma. См. Adobe Gamma
с помощью калибратора, 300
с помощью программы, 301

Монитор (продолжение)
отображение цвета, 297
профиль ICC, 300
разрешение

ppi, 155
изменение, 153

цветовая модель, 299
ЭЛТ, 82

н
Негатив, 37

получение с помощью Photoshop, 203
Непрерывная съемка, 72
Нитрат серебра, 37
Ньепс, Жозеф, 20

Обновление оборудования, 26
Объектив, 36, 45

автофокусировка, 61. См. также
Автофокусировка

без системы фокусировки, 62, 115
вариообъектив. См. Объектив с переменным

фокусным расстоянием
выбор, 60
главная оптическая ось, 114
диафрагма. См. Диафрагма
длиннофокусный, 130

аберрации, 121
визуальное сжатие, 121
подушкообразный эффект, 121
телеэффект, 121

оптическая система, 104
отверстие. См. Диафрагма
относительное отверстие, 105
очистка, 116
покрытие антиотражающее, 116
поле изображения, 119
просветленный, 116
с переменным фокусным расстоянием,

60, 116, 123
кратность, 124

с пластмассовой оптикой, 116
с постоянным фокусным расстоянием, 62, 115
светосила, 61, 106
со стеклянной оптикой, 116
угол зрения, 119
фокус, 114
фокусировка, 111, 114
фокусное расстояние, 105, 118, 120
характеристики, 120

эквивалент 35-мм фотоаппарата, 120
хранение и уход, 116
широкоугольный, 122, 130

бочкообразный эффект, 123
дисторсия, 122

ОЗУ, встроенное. См. Память
Оперативная память, 77
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Оптическая система, 104
Освещение

вспышка. См. Вспышка
естественное, 142
заднее, 143
источники света, 147

верхний, 150
заполняющий, 149
меры предосторожности, 151
основной, 148
отраженный свет, 149
расстановка, 148
цвет света, 148

цвет света, 142, 147
экспонометр, 143

Относительное отверстие, 105

п
Пакетная обработка изображений. См. Irian View
Память

буферная, 66
встроенное ОЗУ, 66
сменная

Memory Stick, 69
карта памяти, 66
миниатюрный жескнй диск, 69

Параллакс, эффект, 45
Первичные цвета, 34
Переходник, 69
Печать

индекс отпечатка
из программы Photoshop, 313
с фотоаппарата, 315

качество, 316
подбор бумаги, 316
разрешение

dpi, 156, 309
цветовая модель, 299

Печать изображений, 157
ПЗС-элементы, 39
Пиксел, 39, 153
Пленка. См. Фотопленка
Поворот, 93
Поле изображения, 119
Порт

USB, 69, 171
последовательный, 69, 171

Принтер
выбор, 85
калибровка

вручную, 305
с помощью калибратора, 304
с помощью программы, 305

лазерный, 88
лшшатура, 310
отображение цвета, 297
печать, 312
подбор бумаги, 316
подготовка к работе, 308

Принтер (продолжение)
разрешение

dpi, 156, 309
Ipi, 157
сравнение принтеров, 156

струйный, 86
термоавтохромный, 88
термовосковой, 88
термодиффузионный, 87
термопринтер, 88
цветовая модель, 299
чернила сторонних фирм, 316

Программы работы с изображениями
графический редактор. См. Графический

редактор
от производителей фотоаппаратов, 172

Image Expert, 173
PhotoWise, 94

просмотр и сортировка, 96
IrfanView. См. IrfanView

сопровождающие фотоаппарат, 93, 172
фотоальбомы, 101

Проявитель, 37

Размер изображения, 159. См. также Photoshop,
размер изображения

изменение, 93, 186
Разрешение, 72, 153

ppi, 155, 309
изображения, 153, 159

ppi, 309
для печати, 309
для печати, оптимальное, 309
изменение, 187
монитора, 153
изменение, 153
недостатки, 26, 27
принтера
dpi, 156, 309
Ipi, 157, 310
линиатура, 310
сравнение принтеров, 156

Разъем
FireWirc, 70, 171
USB, 69, 171
последовательного порта, 171

Режим
непрерывной съемки, 72
приоритетный по выдержке, 72, 112
приоритетный по диафрагме, 72, 112
экономии энергии. См. Спящий режим

Свет
преломление, 114
спектр, 34
температура, 147
цвет, 34, 147

Светосила, 61, 106
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Светофильтры, 61
нейтральный, ИЗ
прозрачный, 116
ультрафиолетовый, 116

Светочувствительность, 27, 73, 108
ASA, единицы, 73, 108
ISO, единицы. См. ISO, единицы
связь с экспозицией, 113

Сжатие, 159
алгоритм

LZW, 165
архиватор, 161, 321

PkZip, 161
Stufflt, 162
WinZip, 161, 186

без потерь, 186
RLE, алгоритм сжатия, 160

изображения
для отправки по электронной почте, 320 - 321
с потерями, 160

Сиихроконтакт, 146
Сканер, 89

планшетный, 89
пленочный, 90
программное обеспечение, 90

Соединение кабельное, 69
Соединитель цветной, 38
Создание сайта-фотогалереи, 325
Спящий режим, 28, 59
CCD, 39
Субтрактивные цвета, 34
Съемка фотографий

выдержка, 106
глубина резкости, 110
движущиеся объекты, 133
диафрагма, 106
композиция. См. Композиция
макросъемка, 118
ночная, 143
объект кадра, 126
освещение. См, Освещение
панорама движения, 134
панорамная, пейзажная, 122
портреты, 121
ракурс, 134
режим

приоритетный по выдержке, 112
приоритетный но диафрагме, 112

связь диафрагмы и выдержки, 107
творчество, 112
точка съемки, 134
удаленные объекты, 121
фокусировка, 111, 114
экспозиция. См, Экспозиция

Съемный накопитель, 69

Т-У
Талбот, Вильям Генри Фокс, 22
Талботип, 22
Тросик, 73, 143, 151

Угол зрения, 119
Устройство хранения информации

сменное, 66. См. также Память сменная

Ф

Фиксаж, 22, 37
Фильтр жидкостный перестаивающийся, 41
Флэш-память. См. Карта памяти
Фокальная плоскость, 114
Фокус, 114
Фокусировка, 111, 114
Фокусное расстояние, 105-106, 118, 120
Формат

BMP, 167
EPS, 166
FlashPIX, 166
GIF, 165
JPEG, 163, 213, 261

запись из Photoshop, 320
качество изображений, 186

PDF, 166
PICT, 167
PSD, 185, 263
TIFF, 164, 186, 263
изменение при сохранении, 185

Фотоальбом виртуальный, 101
Фотоаппарат

DCS 2, 23
автоспуск, 73
вспышка. См. Вспышка
выдержка. См. Выдержка
затвор. См. Затвор
кронштейн для вспышки, 146
объектив. См. Объектив
первый цифровой, 23
система автофокусировки. См. Авто-

фокусировка
тип

SLR, 46 , „ . . , ,, .,. , .,
дальномерные, 45
зеркальные, 46
«мыльницы», 45

устройство, 36
фокальная плоскость, 114
фокусировка, 111, 114
фокусное расстояние, 106
цифровой

веб-камера, 328
двухмегапиксельные, трехмегаппксельпые, 49
загрузка снимков на компьютер, 173
запись видеороликов, 329
интерполяция, 48, 124
корпус, 55
мегапиксельные, 47
переламываемая конструкция, 55
поворотная конструкция, 55
подключение к компьютеру, 171
полупрофессиональные, 51
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Фотоаппарат, цифровой (продолжение)
профессиональные, 51
разрешение, 153
разъемная конструкция, 56
светочувствительность, 109
сжатие изображений, 160
сканирующие приставки, 52
съемные приставки, 52
устройство, 39, 47, 54
четырехмегапиксельные, 51

штатив. См. Штатив
штативное гнездо, 73
экспонометр встроенный, 72

Фотогалерея, 325
Фотография. См. Цифровая фотография

аберрация, 121
вертикальная, 130
глубина резкости, ПО
демонстрация через Интернет

электронная почта, 319
дисторсия, 122
история, 19
композиция. См. Композиция
контраст. См. Контраст
размер, 48, 49
редактирование. См. Изображение
резкость, управление, НО. См. также

Изображение
ретушь. См. Photoshop, ретушь
съемка. См. Съемка фотографий
телеэффект, 121
экспозиция. См. Экспозиция

Фотообъектив. См. Объектив
Фотопленка

цветная, 37
черно-белая, 37

х-ц
Херсчель, Джон, 21
Цвет

аппаратная зависимость, 297
белая точка, 303
влияние на композицию, 131
глубина, 206
настройка, 93. См. также Изображение, цвет,

настройка
насыщенность, 200
света, 142, 147
система управления цветом, 298
температура, 303
тон, 200, 206
яркость, 204

Цвета
аддитивные, 204
аддитивные, первичные, 34
дополнительный, 33
первичные, 204

Цвета (продолжение)
субтрактивные, 205
субтрактивпые, вторичные, 34

Цветовая модель
CIE LAB, 298
CMYK, 86, 205, 299
HSB, 206
LAB, 205, 298
RGB, 33, 204, 299
аггааратно-зависимая, 299
аппаратно-независимая, 298
изменение, 208

Центральный процессор, 77
Цифровая фотография. См. Фотография

загрузка на компьютер, 173, 177, 180
искажение цветов. См. Искажение цветов
качество, 26
недостатки, 26
пакетная обработка, 97
преимущества, 24
просмотр на экране телевизора, 327
разбиение на пикселы, 27
разрешение, 26
эффект ступенек, 28

ш
Шина, 78
Штатив, 73, 143, 151
Шульце, Генрих, 20
Шум, 27, 51, 213

коррекция, 213

э-я
Экспозиция, 104. См. также Диафрагма;

Выдержка
автоматическая установка, 112
определение

матричная система, 112
центровзвешепная система, 112

ручная установка, 112
связь со светочувствительностью матрицы, 113

Экспонометр, 72, 107, 143
Элементы питания

батарейный блок, 59
зарядные устройства, 58
литиевые батареи, 57
никель-металлогидридные аккумуляторы, 57
щелочные батарейки, 57
эффект памяти, 57

Эмульсия, 37
Эффект

бочкообразный, 123
красных глаз, 63
параллакс, 45
подушкообразный, 121
ступенек, 28
телеэффект, 121

Яркость, 93, 195
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